
※本書の著作権は、メンターグラフィックス・ジャパン株式会社が保有しております。
※本書の一部または全部を、メンターグラフィックス・ジャパン株式会社の許可を得ずに 無断で複写・複製することを禁じます。

バージョン：バージョン：

 

EE2007.3EE2007.3

カスタマ・サポート部

 

PCBグループ

2009/3/6

Expedition PCBExpedition PCB
日本語リファレンスマニュアル日本語リファレンスマニュアル



－ 2 －

本書に対する著作権上の権利は、すべてメンター・グラフィックス・ジャパンに帰属しております。また、本書に記載さ

 

れた内容は、メンター・グラフィックス・ジャパンの営業秘密（トレード・シークレット）です。したがいまして、お客様は、

 

本書のいかなる部分も複写、複製、転載または翻訳すること等著作権を侵害する行為およびトレード・シークレットを

 

侵害する一切の行為をすることはできません。また、本書を他に譲渡すること等の処分もできません。
お客様には、善良な管理者としての注意をもって本書を管理していただき、お客様の業務遂行上本書を必要とする

 

お客様の従業員および請負業者（業務委託者を含む）を方以外の第三者に本書を使用させることはおやめ下さい。

 

また、本書を使用する方が、本書に記載された情報を他に漏洩または開示することのなきよう指示または秘密保持契

 

約の締結その他適切な措置をお取り下さい。

本書は、教育を目的として日本のお客様向けに作成いたしました。内容には十分な注意をはらっておりますが、本書

 

記載の機能を本書の対象製品が完全に有していることについての保証もいたしません。また、その内容は、なんら予

 

告なしに変更される場合がありますので、予めご了承ください。
本書に初めより重大な欠落等がございましたら、メンター･グラフィックス･ジャパンまで、お申し出下さい。お取り替え

 

いたします。

メンター･グラフィックス･ジャパンは、記載内容の誤りその他本書から生じたお客様の特別損害、付随的損害、派生

 

的損害（例えば、得べかりし利益の損失等）につきましては、たとえ、事前にそのような損害の発生の可能性をお知ら

 

せいただいたとしても、これを賠償する責任を負担いたしません。

本書記載の内容は、アメリカ合衆国政府の諸機関および商務省の規則にしたがい日本を最終仕向地として輸出許

 

可された情報を含んでおり、米国当局の事前の承認を受けずに再輸出することは、禁止されていることを了解いただ

 

き、また、日本の輸出関連法規を遵守してください。

Copyright  Mentor Graphics Japan 2009. All rights reserved.

販売者：メンター･グラフィックス･ジャパン

本書ご使用上の注意点：



－ 3 －

Table of  Contents

Chapter1
Overview(基本操作) ･･････････････････････････････････････････････････････････････････

 

10P 
Expedition PCBエディタの操作方法

 

･････････････････････････････････････････････

 

11P 
Expedition PCBのエディタ画面
ディスプレイコントロール
エディタ上でのマウス操作
ストロークコマンド
キーインコマンド
スナップモード
距離測定（メジャーコマンド）
エディタのモード切り替え
グリッド設定
表示単位設定（ユニットディスプレイ）
制限値（禁則文字）

Drawコマンド

 

･･･････････････････････････････････････････････････････････････････

 

43P
Drawコマンドの基本操作
プロパティ

 

ダイアログ
文字の追加／Add Text
ラインの追加／Add Line
円弧の追加／Add Arc
折線の追加／Add Polyline
多角形の追加／Add Polygon
長方形の追加／Add Rectangle
円の追加／Add Circle
Drawモードのアイコンコマンド

図形操作

 

･･････････････････････････････････････････････････････････････････････

 

58P
図形の移動とコピー
図形の拡大と縮小
図形のダイナミックな編集
チャンファーとフィレットの追加
図形要素の結合と分解
図形タイプの変更
図形の削除
コマンドのキャンセル
作業のやり直し／Undo
その他のキーボード操作

Drawコマンドの要素作成･････････････････････････････････････････････････････････

 

65P
プレースメニューコマンド
基板外形／Board Outline
NCルータ／Contour
フィデュシャル（合わせマーク）／Fiducials
マウンティングホール（取り付け穴）／Mounting Hole
製造外形／Manufacturing Outline
原点／Origin
コンダクティブシェープ／Conductive Shape
カッパーバランシングシェープ／Copper Balancing Shape
詳細ビュー／Detail View
DRCウィンドウ／DRC Window
配置禁止領域／Placement Obstruct



－ 4 －

プレーン接続禁止領域／Plane No Connect Area
プレーン作成禁止領域／Plane Obstruct
プレーンシェープ／Plane Shape
ルーム（部品配置指定領域）／Room
配線領域／Route Border
配線禁止領域／Route Obstruct
ルールエリア／Rule Area
テストポイント禁止領域／Test Point Obstruct
ビア／Via
テストポイント／Test Point
構築エレメント／Construction Element
サンドボックス／Sandbox

プリント出力

 

･････････････････････････････････････････････････････････････････････

 

80P
印刷設定／Printer Setup
印刷プレビュー／Print Preview
印刷／Print

Chapter2
Process Flow（設計準備） ･･････････････････････････････････････････････････････････････

 

83P
Expedition PCBの作業行程

 

･･････････････････････････････････････････････････････

 

84P
Expedition PCBの作業工程
設計変更時の作業工程

Job Management Wizard

 

･･････････････････････････････････････････････････････････

 

88P
ジョブ

 

マネージメント

 

ウィザード
新規データの作成手順

 

（ネットリストを使用したプロジェクト）
Expedition PCBの起動
ライセンスモジュール

プロジェクトインテグレーションとフォワードアノテーション・バックアノテーション････････

 

101P
プロジェクトインテグレーションとフォワードアノテーション
ネット情報のパス指定
プロジェクトインテグレーション
フォワードアノテーションのオプション
バックアノテーション
CESとのインテグレーション
回路図設定とインテグレーション動作の関係
インジゲータライト
ネットリストタイプ

プロジェクトとレイアウトデータの分離（外部でのレイアウト設計）

 

･･････････････････････

 

112P
Foreign iCDBを使用した設計フロー
ドッグ解除／Undock＆Dock

ローカルライブラリ

 

･･･････････････････････････････････････････････････････････････

 

123P
ローカルライブラリについて
ライブラリサービス

Table of  Contents



－ 5 －

Chapter3
Design Process（デザイン設計） ･････････････････････････････････････････････････････････

 

126P
Verifying Parameters（パラメータ設定）･･････････････････････････････････････････････

 

126P
セットアップパラメータ

 

･･････････････････････････････････････････････････････

 

127P
セットアップパラメータ／Setup Parameters
全般／Generalタブ
ビア定義／Via Definitionsタブ
ビアクリアランス／Via Clearancesタブ
レイヤスタックアップ／Layer Stackupタブ
内層抵抗と立上り時間／Buried Resistor & Rise Timeタブ

ネットクラスとクリアランス

 

････････････････････････････････････････････････････

 

139P
ネットクラスとクリアランス／Net Classes and Clearances
ネットクラス／Net Classesタブ
クリアランス／Clearancesタブ

ネットプロパティと制約条件の設定

 

･･･････････････････････････････････････････

 

149P
ネットプロパティ／Net Properties
ネットオーダ／Net Orderタブ
タイミングとディファレンシャルペア／Timing & Differential Pairsタブ
クロストーク／Crosstalkタブ
その他／Otherタブ
ディレーフォーミュラ／Delay Formulasタブ

エディタコントロール

 

･･･････････････････････････････････････････････････････

 

158P
エディタコントロール／Editor Control
共通設定／Common Settings
配置／Placeタブ

全般設定／General options
ジャンパー／Jumpers

配線／Routeタブ
全般設定／General options
ダイアログ設定／Dialogs
マニュアル配線／Plow
トレースとビアの動作設定／Trace & Via

 

edit behavior
ビアとファンアウトの動作設定／Vias

 

& fanouts
グリッド／Gridsタブ

部品グリッド／Part Grids
配線グリッド／Route Grids
その他グリッド／Other Grids

Placement（配置プロセス）

 

･････････････････････････････････････････････････････････

 

187P
部品配置

 

･････････････････････････････････････････････････････････････････

 

188P
Place Parts and Cellsコマンド

 

部品配置の作業手順
部品配置の編集コマンド

 

･･････････････････････････････････････････････････

 

198P
部品を未配置／Unplace

 

Part
部品スワップ／Swap Parts
移動／Move
ムーブサーキット／Move Circuit
配置面変更／Push
回転／Rotate 90，180
整列／Align Left，Right，Top，Bottom

Table of  Contents



－ 6 －

固定とロック／Fix，Lock
固定解除とロック解除／Unfix，Unlock
コピーサーキット／Copy Circuit
グループ化と解除／Group，Ungroup
グリッドへスナップ／Snap to Grid
自動スワップ／Automatic> Swap/Rotate by Cell Name & Part Number
ポーラ配置／Polar Array Placement

サーキット移動とコピー／Circuit Move & Copy ･･･････････････････････････････

 

209P

回路ブロックの移動・コピー手順
コピーした場合のペースト手順

Routing（配線プロセス）

 

･･･････････････････････････････････････････････････････････

 

223P
マニュアル配線

 

････････････････････････････････････････････････････････････

 

224P
ファンアウト／Fanout
配線／Plow
配線モード切替／Toggle Plow Mode
グロスモード切替／Toggle Gloss Mode
自動終了／Auto Finish
スイッチエンド／Switch Ends
ジャンパー配置／Place Jumper
カーブ切り替え／Toggle Curve
束配線のカーブ切り替え／Toggle Curve in Multi Plow 
束配線／Multi-Plow
ディファレンシャルペア配線／Differential Pair Routing
半自動配線／Route

チューニング／Tune
マニュアルチューン／Manual Tune
チューニングメータ／Tuning Meter
再配線／Reroute
配線コピー／Copy Trace
配線層変更／Push Trace
グロス／Gloss
ハッグトレース／Hug Trace
マルチハッグトレース／Multi Hug Trace
ダイナミックな配線の編集作業
ハンガー配線削除／Remove Hanger
ハンガートレース

 

& ビアの保持／Persistent Trace & Via Hangers
配線の削除
配線幅の変更／Change Width
スワップピン、ゲート／Swap Pins, Gates
配線・ビアの固定化と半固定化／Fix, Semi-fix, Unfix selected Items
ネットライン操作／Net Manipulation
ブレークアウトトレース／Breakout Traces
ティアドロップ／Teardrops
コーナーの変更／Modify Corners
円弧ストレッチ／Arc Stretch
トレース移動時のスペーシング保持／Preserve spacing during move trace 
テストポイントの配置／Place Test Points
テストポイント

 

自動割り当て／Test Point Assignment
ネット名割り当て／Assign Net Name

Table of  Contents



－ 7 －
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Postprocess（出力プロセス）
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Chapter 1
Overview

概要
本章はOverviewとして、Expedition PCBを使用する上で基本となる操作 及び 様々なオブジェクトを作画する際に使用

 

するDrawコマンド等について説明しております。

・

 

Expedition PCBエディタの操作方法

 

－ 11P
・

 

Drawコマンド

 

－ 43P
・

 

図形操作

 

－ 58P
・

 

Drawコマンドの要素作成

 

－ 65P
・ プリント出力

 

－ 80P
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Expedition PCBエディタの操作方法

Chapter1: Overview
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◆Expedition PCBのエディタ画面

Expedition PCBのエディタ画面は、一般のWindowsアプリケーションと同様にWindows GUIを使用して構成されておりますので、

 

エディタ画面の移動や拡大/縮小といった操作が他のWindowsアプリケーションと同様の操作で行なうことができます。

バーナー プルダウンメニュー ツールバー

メッセージバー

ワークスペース

アクションキー

キーインフィールド

メッセージ ウィンドウ プロジェクト

 

インジケータ

カーソルトラッキング
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デザインファイルのフルパス

・プルダウンメニュー

Expedition PCBの全てのコマンドが収納されており、マウスで選択することで実行することができます。

・ツールバー

プルダウンメニュー内に収納された幾つかのコマンドは、ツールバーとしてエディタ上に配置することができます、このツール

 

バーの配置形態は、Route/Place/Drawの各モードによって異なり、ユーザーが使いやすいようカスタマイズすることもできま

 

す。また、これらのツールバーは他のWindowsアプリケーションと同様に、マウスのドラック操作でエディタ画面枠内で自由に

 

移動させることができます。

Routeモード：

Placeモード：

Drawモード：

・ワークスペース

ワークスペースは画面中央に位置し、パネルとデザイン情報を表示します。このワークスペース領域内での右クリック（RMB）

 

にてポップアップメニューを表示します。これらポップアップには使用頻度の高いコマンドが収納されており、表示されるコマ

 

ンドはエディタモードにより変化します。

Drawモード時に右クリック（RMB）で表示さ

 

れるポップアップメニュー

ツールバーのカスタマイズは、View＞

 

Toolbars＞

 

Customize のCommandsタブで可能となります。

Note

・バーナー

バーナーには、現在作業を行っているデザインのファイルパスやジョブ名称を表示します。
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マウスでドラック

・アクションキー

エディタ画面下にある12個のアクションキーは、キーボードのファンクションキーに対応しています。アクションキーへの操作

 

はマウスで選択するか、キーボード上のファンクションキーで行ないます。このアクションキーは、エディタモードなどの状況

 

でその内容が変化し、コマンドを使用している場合にはそのコマンドのオプションが表示されます。

・メッセージバー

エディタ画面下に存在するメッセージバーには、現在のコマンド名やモード情報などの様々なインフォメーションが表示さ

 

れます。

・キーインフィールド

このキーインフィールドはツールバーの１つとなり、キーインコマンドを入力する場合などに使用します。

コマンド名やモード名が表示。 配線作業に関する層や整形モードを表示。
作図の際の図形情報を表示。

アクティブ層を表示。

・カーソルトラッキング

エディタ画面右上にあるカーソルトラッキングのフィールドには、カーソル位置をXY座標で表示します。またdxdy座標には直

 

前にクリックした位置からの相対座標を表示します。単位はSetup＞

 

Setup Parametersで指定した単位系を、表示桁数は

 

Setup＞

 

Units Displayで指定した設定値を使用します。
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・メッセージウィンドウ／Message Window

メッセージウィンドウは、起動時にエディタ下部に表示されます。起動時にはOutputタブ、配線時の警告メッセージはPlow

 

タブに表示されます。ショートカットキー〔Ctrl+M〕にて表示/非表示の切り替えが可能です。

この部分がハイパーリンクテキストとなります。

メッセージウィンドウは、下記の機能がサポートされています。
・エラーメッセージはハイパーリンクテキストになっているため、クリックすることでエラー箇所をハイライトします。
・メッセージウィンドウは、メインウィンドウの上下左右に移動したり、自由な場所に切り離すことが可能です。
・エラーメッセージは、右マウスボタン（RMB）のポップアップより、コピーや印刷をすることが可能です。

EE2007.3バージョンでは配線コマンドのみがサポートされております。その他配置コマンド等の警告メッセージは、

 

以前のバージョン同様にステータスバーに表示されます。
Note
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・Windowコマンド

Expedition PCBでは、複数の作業ウィンドウを表示することができ、1つのデータを複数の視点から作業することができます。

 

プルダウンメニューよりWindow＞ Newコマンドを実行することで新たなウィンドウを表示し、Windowプルダウン以下のコマン

 

ドで表示体系を切り替えることができます。それぞれのウィンドウでは、移動や拡大/縮小といった操作が個別に行なえ、それ

 

ぞれのウィンドウ毎にデータの表示状態を設定することができます。

画面操作を行なう場合には、最初に対象となるウィンドウを選択してウィンドウをアクティブ状態にしておく必要

 

があります。

クリック後、アクティブ状態にする。

Note
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◆ディスプレイコントロール／Display Control

エディタ内での画面表示操作については、ディスプレイコントロールメニューで行ないます。このディスプレイコントロールメニュー

 

は、プルダウンメニューより View> Display Controlコマンドを実行することで表示されます。このメニューは、Layer／General／
Part／Net／Hazard／Groupsの6つのタブで構成されており、各図形要素の画面表示のオン/オフ切り替えや表示色の設定を行な

 

うことができます。

・画面表示のオン/オフ操作

各図形要素の画面表示のオン／オフ切り替え操作については、各項目毎に存在するチェックボックスを使用して行ないます。チ

 

ェックボックスをマウスで選択してチェックを入れることで画面表示が行なわれ、チェックをはずすことで画面表示が行なわれなくな

 

ります。

このメニュー内には、各図形要素とは別に幾つかのチェックボックスが存在しています。これらは、図形要素を属性やグループ単

 

位でコントロールする場合に使用します。

チェックを入れると画面表示。

チェックをはずすと非表示。

グループでの画面表示のオン／オフ

配置面属性での画面表示のオン／オフ

要素属性での画面表示のオン／オフ

Layer ：Trace、Plane、Pad等の銅箔要素 及び グリッドやハイライト等
を制御する際に使用します。

General ：製造データ、ユーザーレイヤ 及びDisplayオプション機能を制御
する際に使用します。

Part ：部品に関連する要素を制御する際に使用します。
Net ：ネット・ネットクラス毎にカラーを制御する際に使用します。
Hazard ：オンライン・バッチDRCのエラー色を制御する際に使用します。
Groups ：Advanced Technology Pro(RF)のオプション機能を使用した

RF設計時に使用します。
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・画面表示色の設定

各図形要素の表示色については、ディスプレイコントロールメニュー内で個別に設定することができます。画面表示のコントロ

 

ールを行なうチェックボックスとともに、各図形要素の項目にはカラータイルが存在します。このカラータイルが表示色を表わし

 

、カラータイルをクリックすることで設定用のパレットメニューを表示することができます。

色をパレットから選んで

 

[OK]ボタンで決定。

・Select a Color Fill Patternメニュー

このパレットメニューでは、単なる色の指示だけではなく、選んだ要素に

 

応じては塗り潰しパターンを指示することができます。塗り潰しパターン

 

を設定可能な要素は配線やパッド等となります。

このメニューで塗り潰しパターンを選択すると、同メニュー内にある

 

Outline（外形線）とTransparent（透過）の指示が行なえます。

・OutlineはディスプレイコントロールメニューにおけるOutlineのオン・オフ

 

切り替えを有効にします。（このスイッチで外形線の表示・非表示がコント

 

ロールできるようになる）

・Transparentをトレース（配線）などに指示すれば、下位層の配線を透か

 

して見えるようにすることができます。

尚、この塗り潰しパターンの設定は、ディスプレイコントロールのGeneralタ

 

ブ内にあるDisplay Patternsスイッチを入れない限り有効にはなりません。
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保存した設定は、リストから選ぶことができます。

・ディスプレイコントロール設定の保存と呼び出し

ディスプレイコントロールメニューで設定された画面表示状態の設定内容は、メニュー下にあるセーブスキームボタンで保存し

 

ておくことができます。保存の際には、それがどういった画面表示状態を表わすかを示す名前を設定することができ、ローカル

 

とシステムの両設定として保存が可能です。システムとして保存されたものは、その端末上で扱われる全てのエディタ上で呼び

 

出すことができますので、作業内容に応じた設定を作成しておけば、面倒な画面表示操作を毎回行なう必要はありません。
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・Layerタブ － トレース・パッドの表示色設定

現在のアクティブレイヤをハイライト表示

トポロジがChain又はカスタムで配線が完了したネットのネットライン

全てのトレースやパッドの表示・非表示を設定

アクティブ配置レイヤでは、部品を配置・編集する層を
Top 又は

 

Bottomに限定します。

Descriptionには、設定されたプレーンタイプと主配線方向

 

(Layer Bias)を表示

トポロジがChain又はカスタムで未配線のネットのネットライン

トポロジがMSTの未配線のネットのネットライン

トレースの選択からネットラインを表示
※OFF時は、パッド-パッドでネットラインを表示します。

パッドの色・フィルを層毎に設定

ネットライン＆クラスラインの設定

トレースの色・フィルを層毎に設定

Place/Route/Drawモードに従い、Display ControlのGridで設定したグリッ

 

ドを表示します。

クラスラインを表示
※ネットクラス内のネット数に基づき、クラスラインの濃さが変化します。

トレース＆パッドとアクティブレイヤの設定

グリッドの設定

パッドの設定

貫通ピン、ビア、テストポイントのパッド色とフィルの設定と表示します。
ここでチェックをONとすると、層毎に指定した設定よりも優先されます。

貫通以外の特定スパンを持つマイクロビアの層番号

アクティブレイヤに存在しないビアパッド
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・Layerタブ － トレース・パッドの表示色設定(続き)

プレーンの設定
プレーンシェープ及びダイナミックプレーンデータの表示・非表示設定と

 

なります。該当する層のトレースが表示されている必要があります。

プレーンシェープと禁止領域

プレーンスケッチ(ダイナミックプレーンの編集)

ダイナミックプレーン

ダイナミックプレーンを塗り潰し表示

プレーンをトレースとパッドの下に表示

カッパーバランシングシェープとデータ

選択＆ハイライトの設定

選択したアイテムのみ表示

ハイライトされたアイテムのみ表示

シャドウモードでその他アイテムをグレー表示

Solid Color(塗り潰し)でアイテムを表示

ハイライトコマンド実行時にネット全体をハイライト表示

ディファレンシャルペアのピンを選択時に、相手側のピンもハイライト表示

ハイライトコマンド実行時にエレクトリカルネットをハイライト表示
※CES使用時のみ有効となります。
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・Generalタブ － 製造データの表示色設定とオプション機能

製造データの設定

ドリルマーク

レッドラインの表示

 

※作画はPCB Viewerでのみ可能となります。

ソルダーマスク(レジスト)

ソルダーペースト(メタルマスク)

ユーザー定義レイヤ

詳細ビュー
※Fablink XEライセンスが必要となります。

基板データの設定

基板外形

フィデュシャル

ホール（マウンティングホール）

ホール（その他-部品ピンのホールなど）

製造外形

オリジンマーク

配線禁止領域

配線領域

ルールエリア

配線フェンス

表示パターンの設定

フィルパターンをどのように表示させるかをコントロールします。Display 
PatternsのチェックをONとした時、各エレメントに設定したフィルパターン

 

が有効となります。OFFの場合、全てのオブジェクトはフィル無しの状態

 

で表示されます。

全てのオブジェクトの外形を表示
※Select a color Fill PatternダイアログのOutlineオプションを全てONとします。

全てのオブジェクトを塗り潰し表示

Contour (NCドリル) 及び貫通以外の特定スパンを持つ
Contourの層番号
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・Generalタブ － 製造データの表示色設定とオプション機能（続き）

オプションの設定 デザイン内のアイテムを見るときのオプション操作の設定となります。

Auto Pan：
自動パンニングの設定。部品のドラッグ移動時に自動的にパンニ
ング表示を行います。

Full Cursor：
Placeモードで部品移動時にフルカーソルを表示。

Display Tuning Meter：
チューニングメータを表示。定義したHighSpeedルール値をメータ
表示します。

Update Only On Apply：
Applyボタンを追加して、Apply選択時のみDisplay Controlで変更
した設定を反映します。

Display Active Layer Only：
アクティブレイヤのみを表示します。

Display Legible Text Only：
ズームサイズに従って、一定のフォントサイズ以上のテキストのみ
を表示します。

Pan Sensitivity：
パンニング操作の感度となります。パンニング操作を遅くするには、
設定値を小さくします。

背景色の設定

垂直方向（Y軸）への反転表示の設定

・Partタブー部品の表示色設定

全てのTop/Bottomのオブジェクトの表示・非表示を設定

部品アイテムの表示

アセンブリ

 

アイテム

シルクスクリーン

 

アイテム

シルクスクリーンジェネレータで作成されたシルクスクリーン

部品選択時に部品外形をフィル表示

セル

 

アイテムの表示

テストポイントアイテム

セル作成時に配置したオリジンマーク
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・Netタブ － ネット名毎の表示色設定

ディスプレイコントロールのNetタブでは、ネット名及びネットクラス名毎に表示色をコントロールすることができます。 Netsタブの

 

上段にある各チェックボックスは、この機能を使用するか否かを定義するためのものとなり、その下のリストで色の設定を行ない

 

ます。

ネット名、ネットクラス名

 

及び コンストレインツクラス名（CES使用時）

で色分けを行なうかを設定

上記で指示した色分けを、どのエレメントに対して行なうか設定

色の設定についてはカラータイルで設定し、これを有効とする場合、
チェックボックスにチェックします。

この機能は、色の設定をしていても、各チェックボックスにチェックを

 

入れない限りは有効にはなりません。

・Hazardタブ － 違反毎の表示色設定

ディスプレイコントロールのHazardタブでは、各違反毎に表示色をコントロールすることができます。 Hazardタブの上段にある

 

各チェックボックスは、この機能を使用するか否かを定義するためのものとなり、その下のリストで色の設定を行ないます。

 

OnlineとBatchの２つの項目があり、Batch側に関してはBatch DRCを実行しないと機能しませんので注意してください。また、

 

Batch側の表示は、Batch DRCの結果をもとに色分け表示していますので、新たにBatch DRCを実行しない限り、その内容

 

が更新されることはありません。

・Color by hazardは、下段アイテムで設定した色でエラーを表示します。
・Shadow modeは、違反個所を判別しやすいよう、他の要素をグレー
表示させる機能です。

・Display hazard symbolsは、違反個所にXマークを表示させる機能です。

Note
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レフトマウスボタン

センターマウスボタン

ライトマウスボタン

◆エディタ上でのマウス操作

Expedition PCBエディタ内でのマウス操作は、下記のような内容となります。

・レフトマウスボタン（LMB）：

プルダウンメニューやツールバー、画面上の図形要素を選択する際に使用します。図形要素選択の際には、ドラック&リリー

 

スの操作で領域を指定することで複数の図形要素を選択することができます。[Shift]キーを押しながら図形要素を選択する

 

ことで、同様に複数を選択することができます。図形要素を選択後に[Tab]キーを選択することで、近接する図形要素に選

 

択図形を切り替えることができます。

・センターマウスボタン（CMB）：

1回の選択でズームイン、“[Shift]キー＋1回”の選択でズームアウトが行なわれ、移動したい方向へドラックすることでパン

 

ニング（画面の移動）が行なわれます。ホイールボタンの場合、ホイールの前後回転で画面の拡大／縮小を行なえます。

・ライトマウスボタン（RMB）：

このボタンを選択すると、ポップアップメニューが表示されます。ドラッグ操作を行なうことで、ストロークコマンドが使えます。
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◆ストロークコマンド

ストロークコマンドは、マウスのドラック操作の動きに対してコマンドを割り当てた機能となります。標準でライトマウスボタン（RMB）

で以下のドラック操作を行なうことで、各動きに割り振られたコマンドを実行することができます。ストロークコマンドを実行する
上でのマウスの操作に関しては、以下の9つのブロック（グリッド）に対応するよう構成されております。
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◆キーインコマンド

キーインはアクション→オブジェクト形式の２文字の省略形です。キーインを使用するには、メインウィンドウをフォーカスし、タイ

 

プします。キーイン フィールドをフォーカスする必要はありません。セッション間で最新のキーインが１０個保存されるので、以前

 

のキーインをドロップダウンで選択することも可能です。

・アクション文字 (キーインコマンド)

アクション文字は下記のいずれかになります。

a 配列
c 変更
d 削除
f 検索
h ハイライト
m 移動
p 配置
r 回転
u ハイライト解除
x 実行 (名前がついたコマンド)
z ズーム

・2番目のオブジェクト文字

 

(キーインコマンド)

2番目のオブジェクトの文字は、下記にあげるいずれかになります。

a 全て
ｂ ボード
c 座標
d 作画オブジェクト
f フィデュシャル
g グリッド
h ハイライトされたアイテム
j ジャンパー
l レイヤ
n ネット
p ピン
r Ref Des 
s 選択されたアイテム
ｔ テストポイント
v ビア
w 幅
x スナップ ポイント

 

("x"として画面に表示されます)。
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as dx=x,y

 

#行

 

#列 配列コピー。選択されたエレメントの配列で、#行と#列によって定

 

義された寸法を持つものをコピーします。配列エレメントはdx=x,y

 

で間隔を指定します。

as dx=50,50 2 2

av

 

dx=x,y

 

#行

 

#列 ビア配列コピー。選択されたエレメントの配列で、#行と#列によっ

 

て定義された寸法を持つものをコピーします。配列エレメントは

 

dx=x,yで間隔を指定します。指定エリア内のその他オブジェクト

 

に重ならない状態でコピーを行います。

av

 

dx=50,50 2 2

<座標>

coo 数値

座標配置と同じ(pc)

デザイン全体のセルオリジンサイズを変更します。

dx=100,247

cco

 

20

cl

 

レイヤ アクティブなレイヤ番号を変更(数値) cl

 

3

cw

 

幅

 

| m | t | e 選択したトレースの幅を変更。配線コマンドがアクティブであれば、

 

配線コマンドが現在の幅を変更します。文字mは最小幅を選択し

 

ます。tが標準幅で、eはトレースの拡張幅です

cw

 

12

dx

●検索系コマンド

既存のスナップ

 

ポイントを全て削除 dx

fa 全てを検索

 

(全てにズームと同じ) fa

fb 基板の検索

 

(基板にズームと同じ) fb

fc

 

<座標> 座標の検索

 

(座標にズームと同じ) fc

 

100,200

fh

ｆｊ

 

{-hsz} refdes

ハイライトされたアイテムを検索

ジャンパーの検索

fh

fj

 

–hsz

 

jumper1

fn {-hsz} ネット名 ネットの検索

 

－

 

オプションとしてハイライト、選択およびズーム。

 

ネット名には?や*のワイルドカードが使えます
fn -hs

 

sig*

fnl 次のオープンネットラインを検索 fnl

fp

 

{-hsz} refdes-ピン名 コンポーネント上のピンを検索

 

－

 

オプションとしてハイライト、選

 

択およびズーム
fp

 

-hsz

 

ic1-a

fr

 

{-hsz} refdes-リスト000 Ref Desリストの検索

 

－

 

オプションとしてハイライト、選択および

 

ズーム
fr

 

-hs

 

u*

fs

ｆt

 

{-hsz} refdes

選択されたアイテムを検索

テストポイントの検索

fs

ft –z tp1

fx スナップ

 

ポイントを検索、表示をスナップ

 

ポイント検索へパンする

 

－

 

スナップ

 

ポイントが定義されていなければ何もしません。
fx

・追加の引き数 (キーインコマンド)

キーインによっては追加の引き数を取ります。括弧{ }内のアイテムはオプションのアイテムです。かなりの数のコマンドが修

 

飾キーイン（ハイフンで始まるもの）を持ち、これらは一文字に短縮されています。例えば、-angleは-aに短縮できます。下記

 

は現在承認されているキーインです。

キーイン

 

説明

 

例
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●ハイライト系コマンド

hn

 

ネット名 ネットをハイライト。ネット名には?や*のワイルドカードが使えます hn

 

sig001

hp refdes-ピン名 ピンをハイライト hp ic1-a

hr refdes-リスト Ref Desリストで特定された部品をハイライトします hr c1:20

hs 選択されたアイテムをハイライト hs

●ハグトレース

htc

 

<値> ハッグトレースで使用するクリアランスを設定。使用される単位は

 

デザインの単位
htc

 

10

・追加の引き数 (キーインコマンド)

キーイン

 

説明

 

例

●移動系コマンド

mp

mp <座標> refdes-pinname

mr

 

refdes-リスト

ピン移動コマンドの実行

指定したピンの移動

全てのものが配置されるまで、一度に１つずつ特定の部品全てを

 

移動。固定／ロック部品は移動されません

mp

mp dx=100,100 
u17-5

mr

 

u*

mr

 

dx=x,y

 

refdes-リスト 全ての特定した部品を相対距離で移動。固定／ロック部品は移

 

動されません
mr

 

dx=,100 *

mr

 

<座標> {-angle=角度} 
refdes

与えられた座標に指定した部品を移動。オプションで角度指定が

 

可能。固定／ロック部品は移動されません
Mr

 

100, 200 IC1

ms dx=x,y 選択オブジェクトを指定した相対距離で移動（配置または作画

 

モードでのみ）。固定／ロック部品は移動されません
ms dx=,100

ms xy=x,y 特定の座標へ選択オブジェクト（１つだけ）を移動（部品の動きの

 

みがサポートされます）。固定／ロック部品は移動されません
ms 100,200

mx

 

<座標> 現在のスナップ

 

ポイントを指定した座標に移動 mx

 

dx=100

●レイヤ系コマンド

of l レイヤリスト レイヤをオフにします(oflも許可されています)。レイヤリストは# ま

 

たは

 

#:#形式で入力し、カンマまたはスペースで区切ります
ofl

 

12

of ua ユーザーレイヤ全てをオフにします。ofとuaの間のスペースは省

 

略可能です
ofua

on l レイヤリスト レイヤをオンにします(onlも許可されています)。レイヤリストは# ま

 

たは

 

#:#形式で入力し、カンマまたはスペースで区切ります
onl

 

1:16, 18

ona ディスプレイ

 

コントロールオプションの選択されたおよびハイライト

 

されたのみをオフにします。全てのグラフィックオブジェクトを表示

 

できます

onh ハイライトされたアイテム(のみ)をオンにします

ons 選択されたアイテム(のみ)をオンにします

onsh

on ua

選択されたアイテムとハイライトされたアイテム(のみ)をオンにしま

 

す
ユーザーレイヤ全てをオンにします。onとua間のスペースは省略

 

可能です
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●配置系コマンド

ｐｂ
pd a
pd c
pd l
pd pg
pd pl
pd r
pd t
pf
pj
pt

Board Outlineの配置
Drawコマンド（アーク）の作成
Drawコマンド（サークル）の作成
Drawコマンド（ライン）の作成
Drawコマンド（ポリゴン）の作成
Drawコマンド（ポリライン）の作成
Drawコマンド（レクトアングル）の作成
Drawコマンド（テキスト）の作成
Fiducialの配置
ジャンパーの配置（Plow実行時のみ有効）
テストポイントの配置

pb

pf
pj
pt

・追加の引き数 (キーインコマンド)

キーイン

 

説明

 

例

pc {-s} <座標> 座標配置－オプションではスナップ

 

ポイント（参照ポイント）を入

 

力した座標へ移動します
pc 100,100
※pcは省略可能

pr refdes-リスト 配置が完了するまで、全ての特定部品を一度に１つずつ配置し

 

ます
pr *

pr -dist { dx=x,y

 

} { -

 

cols=n } {-angle=角度}  
refdes-list

基板の外側右端の５つ

 

(デフォルト) の列に特定の部品を分配

 

(自動配置)します。{dx=x,y}のオプションでは、x、yはそれぞれ部

 

品から部品の距離を表します

pr -dist IC*, U*, 
RP*  pr -

 

dist 
dx=500,200

pr -file=<ファイル名>  {-x}             ファイル制御の配置。ファイルの構文は：

 

.units  in | mm | th

 

| 
um } ファイルにユニットをセットするオプションの命令文。

 

.ref  
<design>  {cellname=<セル名>}  <xy>  <rot>  <top|bottom>  { fix | 
lock } 配置する部品それぞれに付き１行必要ですコメントラインに

 

はプレフィクスで'!'がついています。その部品に関してセル名が

 

デフォルトのPDB入力と違っている場合にのみ、セル名が必要と

 

なります。'-x' の引き数は

 

(供給されていれば) 現在の配置情報

 

を名前がついたファイルにエクスポートします；ファイルの内容は

 

上書きされます。デフォルトファイルはconfig¥xyplace.datです。作

 

成されたログファイルはlogfiles¥xyplace.logです

pr -file=xyplace.dat

pr <座標> {-angle=角度} 
refdes

与えられた座標に特定の部品を配置します。オプションで角度指

 

定ができます
pr 200,500 -a=45 
IC1

pv ビアの配置 pv

px

 

<座標> 特定の座標にスナップ

 

ポイントを配置します px

 

xy=200,400
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●回転系コマンド

r 相対角度

ra

 

相対角度

特定の角度によってオブジェクトをダイナミックに実行できるように

 

回転させます
基板全体の回転

r 30

ra

 

90

rr

 

相対角度

 

refdes-リスト 特定の相対角度で全ての特定部品を回転させます rr

 

90 IC1:6

rs

 

相対角度 特定の角度によって選択オブジェクトを回転させます rs

 

90

rt

 

相対角度

 

refdes-リスト テストポイントリストの回転 rt

 

180 tp*

●リマップコマンド

remap

●ハイライト解除系コマンド

ua

Rule Area

 

Schemeの表示

全てのハイライトを解除します ua

us 選択したもののハイライトを解除します us

●ズーム系コマンド

za 全てにズーム

 

(全体表示) za

zb 基板にズーム

 

(基板の全体表示) zb

zc

 

<座標> 座標にズーム

 

(画面中央の中心座標) zc

 

347,500
（‘xy=’ は省略

可能）

zh ハイライトしたアイテムにズーム zh

zn

 

ネット名 ネット名にズーム。ネット名には?や*のワイルドカードが使えます。 zn

 

net0*

zp

 

refdes-ピン名 特定のコンポーネント上のピン名にズーム zp

 

IC1-A

zr

 

refdes-リスト Ref Desリストにズーム zr

 

IC1:8

zs 選択したものにズーム zs

zx スナップ

 

ポイント回りにズーム zx

・追加の引き数 (キーインコマンド)

キーイン

 

説明

 

例
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・座標 (キーインコマンド)

座標の構文は以下のとおりです。

dx= 相対距離

dx=.1,.1 最後のポイントからｘとｙに0.1インチ動きます

dx=,.1 最後のポイントからｙ方向に0.1インチ動きます

dx=.1 最後のポイントからｘ方向に0.1インチ動きます

dp=r,開始角度{,{終了角度},

 

増分角度}  
半径'r'の円の周辺に一連のポイントを生成します。

 

最初のポイン

 

トは「開始角度」にあり、最後のポイントは「終了角度」にあります

 

(省略された場合は、完全な円を形成するのに充分なポイントが

 

生成されます)。各ポイントは、最後のポイントから増分角度度数

 

で回転されます

dp=1000,12,,72 半径1000、開始角度12度の正5角形（360÷72）を表します。
注: 0度は正のｘ方向です

xy= 絶対座標（デフォルト）

xy=.1,.1 ｘに0.1、ｙに0.1の絶対座標に動きます

xy=.1 ｘに0.1、ｙに0.0の絶対座標に動きます

xy=,.1 ｘに0.0、ｙに0.1の絶対座標に動きます

'xy=' . デフォルトの座標モード、そのため省略可能です

座標の配置には'pc'を入力します。'pc' は省略可能です

・スタティックなスナップ ポイントと一時的なスナップ ポイント

 

（キーインコマンド）

既存のオブジェクトにスナップするには、メインウィンドウに‘s’（スタティック）、もしくは‘t’（一時的）をタイプします。

 

その後、特定の座標を入力するか、マウスの左ボタンをクリックすると、デザイン内のどこでもスナップ ポイントを配

 

置します。オブジェクトに対してスナップした場合、デフォルトで中心、終点、あるいは象限にスナップします。その

 

後Tabキーを使用して、スナップ ポイントをオブジェクトの他の場所へ変更できます。交点にスナップ ポイントを定

 

義することも可能です。

座標を配置している最中にいつでも、マウスの右ボタンとCtrlキーを組み合わせて使い、スナップ

 

ポイントを選択し

 

た参照サイトに配置できます。例えば、移動時、作画時、配置時等に、‘Ctrlと右マウスボタン’を押すと、カーソル

 

は一時的なスナップ ポイントにスナップし、オブジェクトまたは次の頂点をその場所に配置します。

・配線幅の変更 （キーインコマンド）

配線コマンド実行時の配線幅変更は、以下2通りのキーインコマンドを使用することで、異なるモードにて処理が可

 

能となります。
cw m 最小幅を使用
cw t 標準幅を使用
cw e 拡張幅を使用
cw # 指定した幅を使用

選択したトレース幅を変更し、配線コマンド実行時は次ポイントより指定した幅を使用します。指定した配線幅は、

 

配線完了 又は コマンドがキャンセルさせるまで有効となります。

cwm m 最小幅を使用
cwm t 標準幅を使用
cwm e 拡張幅を使用
cwm # 指定した幅を使用
配線コマンド実行時にcwmキーインコマンドを使用することで、選択ネットの配線セッションが完了するまで、選択

 

した配線幅を使用して配線を実行します。その他ネットの配線実行 又は 他のcwmが実行されるまで本コマンドは

 

有効となります。
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・矢印キーでの部品移動 (キーインコマンド)

キーボードの矢印キーを使用して選択した部品を移動するには３通りの方法があります。これらの方法を用いる際

 

には、部品が選択されていることと、動的な状態にはないことが必要になります。

1. ‘矢印キー’を使用すると、部品を１つのグリッド毎に移動します。選択した矢印キーの方向にグリッドが定義され

 

ていなければ、ピクセル毎に移動します。

2. ‘Shiftキーと矢印キー’を使用すると、部品を10個のグリッド毎に移動します。選択した矢印キーの方向にグリッ

 

ドが定義されていなければ、10ピクセル毎に移動します。

3. ‘Ctrlキーと矢印キー’を使用すると、パッド－パッド、部品－部品ネットクラス

 

クリアランスに違反せず、かつ配置

 

グリッドを維持したまま、選択された部品を矢印の方向に、既存の部品にできるだけ近づけて移動します。

・ファイルによる部品移動 （キーイン

 

コマンド）

キーイン コマンドを使用して、デザイン内で移動したい部品 又は 配置したい部品が記載されたファイル指定します。

キーイン コマンド
pr -file=<dir><ファイル名>{-x}

－‘-x’

 

という引数が付与すれば、現在の配置情報を指定のファイルへエクスポートし、ファイルの内容を上書きします。
－デフォルトのファイル名は xyplace.dat です。
－デフォルトのディレクトリは.pcb ファイルがある場所です。
－logfiles¥xyplace.log という名前のログファイルが作成されます。

－メインのディレクトリからファイルをインポートしている場合には、特にディレクトリを指定する必要はありませんが、
configディレクトリからファイルをインポートしている場合には、ディレクトリを指定して下さい。例えば、デフォルトファイルが
config¥xyplace.datの場合、作成されたログファイルはlogfiles¥xyplace.logになります。

ファイルのシンタックス
{.units <th>|<in>|<mm>|<um>}

－.units の行はオプションです。省略された場合は、現在の単位設定が使用されます。部品ごとに単位を変更するために、
行を１度以上特定することも可能です。

.ref <desig> {cellname=<セル名>} <xy> <rot> top|bottom {fix | lock}

－この部品の代替セル名、固定、ロック フラッグはオプションです。
－座標は 'x,y' で指定します。例えば、100,-400などです。

－回転は角度で表します。
－リスト内の部品は新しい位置に移動または配置されます。
－移動または配置したい部品のみがリスト内にあればよく、全ての部品は必要ありません。
－コメント行にはプリフィックス'!' が付きます。その部品のデフォルトであるPDB入力と異なる時のみ、セル名が必要となります。
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◆スナップモード

マウスによるデータポイント指示を支援するためのスナップモード機能が存在します。スナップモードは、ツールバー
View> Toolbars＞ Snap 又は RMBポップアップからオプション選択することができます。

Define Tentative Snap Point

一時的な仮スナップポイントを配置。このポイントは、配置後にTabキーで近傍のポイントへと移動さ

せることが可能です。

Define Static Snap Point

仮原点の配置。このポイントを配置すれば、配置ポイントを一時的な原点としてキーインコマンドなど
による座標指示に使用することが可能です。

Use Snap Point

配置済みの仮スナップポイントや仮原点をデータポイントに使用します。仮スナップポイントや仮原点
を配置後に、配線コマンド選択後にこのオプションを指示することで、開始点を配置済みの仮スナップ
ポイントや仮原点に決定させることができます。

Delete Snap Point

配置した仮スナップポイントや仮原点を画面上から削除します。（仮原点、仮スナップポイントのリセット）

Hover Snap

このオプションを指示すると、マウスカーソルにターゲットスコープが追従してきます。ターゲットスコー
プを表示することで、ポイント指示を容易にしてくれます。

Next Snap Keypoint

配置した仮スナップポイントを近傍のポイントに準じ移動させます。（Tabキーでの移動と同じ）

Previous Snap Keypoint

移動した仮スナップポイントを前の状態に（位置に）戻します。

スナップコマンドに関するキーイン（ショートカット）操作については、Chapter1-Expedition PCBエディタの操作方法の

 

キーインコマンド（P32）を参照ください。
Note
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◆距離測定（メジャーコマンド）／Minimum Distance ＆ Distance

メジャーコマンドは、基板上に配置された各種エレメントの距離を測定する際に使用します。Edit＞Review＞

 

Measure 又は

 

RMB（右マウスボタン）＞

 

Measure

 

コマンドから、Minimum Distance 又は

 

Distanceを選択後、対象となるエレメントを選択する

 

ことで距離の測定が可能となります。

Minimum Distance command ：２つのエレメントを選択して、Toggle/Segmentモードに従った最短距離を測定します。
Distance command ：２つのエレメント

 

又は 任意のポイントを選択して、Toggleモードに従った距離を測定します。
Edge Mode ：エッジ－エッジ間を測定します。
Center Mode ：センター－センター間を測定します。

 

（Trace-Trace、Pad-Padのセンター間距離 など）
Centerline Mode ：幅を持ったLine（Traceなど）のセンター－センター間を測定します。
Segment Mode ：Minimum Distanceコマンド時のみ使用可能となります。ハイライトエレメント全体ではなく、

セグメント単位での測定を可能とします。

Segment ModeのON/OFFコマンドを選択
・Minimum Distance
・Distance

Measureには２つのコマンド、３つのToggleモード、Segmentモードが存在し、アクションキーにマッピングされた[Toggle Mode]

 

ボタン、[Segment]ボタン（又は

 

以下のアイコンコマンド）を選択することで選択モードを切替えることができます。確認したい距

 

離に応じ、モードを切替えながら作業を行ないます。

Toggle Modeを選択
・Edge
・Center
・Centerline

現在使用しているモードを表示 測定距離の結果を表示

・エレメント選択時にTabキーを押すことで、重複したエレメント

 

又は

 

近傍のエレメントを選択して測定が可能となります。
例）

 

Pad選択からSolderMask選択への切り替え
・Measureコマンドは、Place/Route/Drawモードで使用可能です。
・Grid設定（Editor Control＞

 

Grids）を考慮した選択（ポイント指定）動作となります。

Note
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Center

 

Mode ：パッドの中心から中心までの距離。

Edge

 

Mode ：パッドの縁から縁までの最短距離。

Edge

 

Mode ：ハイライトエレメント全体を対象として、
Traceの縁から縁までの最短距離。

Segment/Edge

 

Mode ：セグメントを対象として、Traceの縁から縁までの最短距離。

Toggle Mode Segment Mode 動作

Edge
ON 指定したデータのセグメントを対象に、エッジ-エッジ間の最短距離を測定

OFF 指定したデータの全セグメントを対象に、エッジ-エッジ間の最短距離を測定

Center - 指定したデータのセンター間の最短距離を測定

Center Line
ON 指定したデータのセグメントを対象に、中心線に沿って最短距離を測定

OFF 指定したデータの全セグメントを対象に、中心線に沿って最短距離を測定

Minimum Distanceコマンドを使用した際の各Modeでの動作の違いは以下となります。
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◆エディタのモード切り替え

Expedition PCBでは、3つの作業モード（

 

Routeモード、Placeモード、Drawモード）が供給されています。Routeモードは、配線

 

作業などで使用、Placeモードは部品配置の際に使用、Drawモードは文字や領域といった図形情報の作成に使用します。こ

 

のモード切り替えは、エディタ内の各コマンドを選択することで自動的に行なわれますが、ツールバー内の各モードボタンを

 

選択することで、直接モード切り替えを行なうことができます。各モード違いにより、選択（作業）できる図形要素に制約がかか

 

りますので、作業内容に応じてモード切り替えを行なう必要があります。

Routeモードボタン

Drawモードボタン

◆グリッド設定

エディタ上でのグリッド設定は、エディタコントロールメニューで行なうことができます。このエディタコントロールメニューは、プ

 

ルダウンメニューのSetup> Editor Controlコマンドで表示することができます。また、このメニューは、ツールバーやポップアッ

 

プメニュー内にも存在します。

Placeモードボタン
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グリッド値の設定は、エディタコントロールメニューのグリッドタブで行ないます。設定可能なグリッドは、配線用、ビア用、作画

 

用、配置用となります。値を設定する場合には、各項目をマウスで選択し、カーソルを確認したら値を直接入力して決定しま

 

す。値を入力する際の単位系は、セットアップパラメータで指定したDesign Unitsを使用します。尚、値が

 

Noneは、グリッドレ

 

スを意味します。

部品配置用グリッド

設定した配置グリッドに対するオフセットの定義項目。値を設

 

定すると、グリッド全体にオフセットが与えられます。

プライマリグリッドを使用する部品条件の定義。

配置グリッドに対して部品のどの位置にスナップするかの定義。

配線及びビア用グリッド

設定した配線グリッドに対するオフセットの定義項目。値を設

 

定すると、グリッド全体にオフセットが与えられます。

作画用グリッド

ジャンパー用グリッド

テストポイント用グリッド
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エディタがDrawモードの場合、作画用ツールバー内にあるグリッド設定メニューが使用できます。グリッドボタン横にある矢印

 

ボタンを選択して表示されるリストに対し値を直接入力するか、リスト内の既存値を選択することで作画用のグリッドを変更す

 

ることができます。また、このグリッドボタンは、グリッド表示のオン／オフ切り替えボタンとしても使用することができ、マウス選

 

択することでグリッド表示を切り替えることもできます。尚、このツールバーは、Drawモードの場合にのみ表示され、Routeモー

 

ドでは表示することはできません。

このボタンでリスト表示

値はここに入力

グリッド表示のオン／オフ切り替え

尚、グリッド設定を行なった場合でも、ディスプレイコントロールメニューで各グリッド表示を有効としない限り、

 

画面上にグリ

 

ッドは表示されません。また、各グリッドは、配線グリッドは配線モードの時といったように、各モード時にのみ限定して表示さ

 

れます。

チェック時のみグリッドを表示
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◆表示単位設定（ユニットディスプレイ）／Units Display

ユニットディスプレイ

 

コマンドは、各エディタ内で表示される数値の表記形式、数値の単位系に対する分解能等を設定します

 

。Setup＞ Units Display にて Units Displayダイアログが表示されますので、必要に応じて設定を変更します。

・Electrical units

電気単位の表記形式と分解能（小数点以下の精度）を設定します。

電気単位を使用せずに、完全精度で表記します。

電気ユニットとして使用するフォーマットをチェック。

分解能（小数点以下の精度）を指定。
※0－9の数値で指定が可能となります。

例）

 

PDBのValue(F)として、0.0000000001を入力した際、各フォーマットでの表記は以下となります。

Engineering ：

 

100E-12
European ：

 

100p
Scientific ：

 

1E-10
SI ：

 

100p
SPICE ：

 

100p
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・Physical dimension & other units

その他単位系の分解能を指定します。

Angle Format
部品

 

及び

 

セルの配置角度の分解能を指定。
Percentage

デザインステータス、配線率、レビューハザード等の％表記の分解能を指定。
※現在は2で固定されております。

Time
配線プロパティ内のDelay Summary(ns)等の時間表記の分解能を指定。

Angle Formatが3の時、小

 

数点以下3桁まで表示しま

 

す。

・Suppress trailing zeros

少数点以下の ゼロ（０）表記を抑制します。表示される0の個数は、次項目の“No. of digital after decimal”設定に依存します。

Suppress trailing zeros：ONSuppress trailing zeros：OFF

・Regional Settings

地域の設定として少数点以下の分解能 及び 少数点表記を指定します。

少数点の記号として、“,” か“.”を選択します。

桁区切り記号として、“,” か“.”を選択します。
※Decimal Symbolと同じ記号は使用できません。

データベースに入力可能な分解能（小数点以下の桁数）を設定します。

桁区切りを行う数値（桁数）を選択します。

0の表示方法を、“0.数字”か“.数字”を選択します。

No. of digits after decimalを変更した際、既に入力した値は四捨五入で表示されます。但し、データベースには既に入

 

力した値で保持されておりますのでご注意ください。
例）
・No. of digits after decimal を“3”

 

として、スペーシングルール

 

0.254を入力。
・No. of digits after decimal を“2”に変更すると、0.25として表示されます。
・しかしながらデータベースには0.254で登録されておりますので、スペーシングルールとしては0.254を使用してチェッ

 

クを行います。

Note
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◆制限値（禁則文字）／Limitation

Expedition PCBを使用する上での制限値（禁則文字、文字数制限、基板サイズ、レイヤ・

 

層数の最大値など）となります。各

 

種制限を越えないように設定を行う必要があります。

最大値

 

禁則文字

ピン数(セル内)

 

：10000

 

-
ピン数(シンボル内)

 

：4095

 

-
基板サイズ

 

：60 x 60 Inch

 

-
表示サイズ

 

：84

 

x 84 Inch

 

-
配線/プレーンの層数

 

：120

 

-
User Layer数

 

：250

 

-

CellのDescription文字数

 

：255

 

¥

 

以外全て対応
Cell名の文字数

 

：64

 

¥

 

( ) ! 以外全て対応
Clearance Rule名の文字数

 

：32

 

¥

 

( ) ! 以外全て対応
Cluster名の文字数

 

：32

 

¥

 

( ) ! 以外全て対応
Custom Drill Symbol名の文字数

 

：64

 

¥

 

( ) ! 以外全て対応
Hole名の文字数

 

：64

 

¥

 

( ) ! 以外全て対応
IBIS Component名の文字数

 

：32

 

¥

 

( ) ! 以外全て対応
Net Class名の文字数

 

：40

 

¥

 

! 以外全て対応
Net名の文字数

 

：64

 

¥

 

! 以外全て対応
Net Class Scheme名の文字数

 

：32

 

¥

 

! 以外全て対応
Pad名の文字数

 

：64

 

¥

 

( ) ! 以外全て対応
Padstack名の文字数

 

：64

 

¥

 

( ) ! 以外全て対応
Part Number / Labelの文字数

 

：64

 

¥

 

以外全て対応
Part Pin Numberの文字数

 

：16

 

¥

 

( ) ! 以外全て対応、大文字小文字を区別します
PDB Descriptionの文字数

 

：255

 

¥

 

以外全て対応
Placement Room名の文字数

 

：32

 

¥

 

( ) ! 以外全て対応
Reference Designatorの文字数

 

：32

 

¥

 

以外全て対応
Ref Designator Prefixの文字数

 

：4

 

a-z

 

A-Z

 

のみ対応
Symbol Nameの文字数

 

：27

 

* ? ( ) , ; : ¥

 

" 以外全て対応
Symbol Pin Nameの文字数

 

：32

 

禁則文字なし
Symbol Pin Numberの文字数

 

：16

 

¥

 

( ) ! 以外全て対応
Technology Nameの文字数

 

：32

 

¥

 

( ) ! 以外全て対応
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Chapter1: Overview

Draw コマンド
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◆Drawコマンドの基本操作

Drawモードでは、幾つかの作図用コマンドが供給されます。これらの作図コマンドは、ツールバーにのみ収納されており、Drawモ

 

ードに切り替えた場合にだけエディタ上に表示されます。

・セレクト

 

／Select

図形要素を選択する場合に使用します。初期状態ではこのコマンドが選択されています。

・ポリゴンセレクト／Polygon Select

選択する図形要素を、多角形枠で指定したい場合に使用します。このコマンドを選択後、マウスで多角形の頂点を指定し

 

て枠を形成します。このコマンドでは、形成された枠内にある図形要素すべてが選択されます。

・スナップグリッド／Snap Grid

指定ポイントを、グリッド上に強制したい場合に使用します。このボタンが押されている状態では、マウスで指定可能なポイ

 

ントがグリッド上へと強制され、オフグリッドへのポイント指定は一切行なえません。このボタンをマウスで選択することで、ス

 

ナップロックのON/OFF切り替えが行なわれます。グリッドの設定は、横にある矢印ボタンで行ないます。矢印ボタンを選択

 

するとグリッド設定用のフォームリストが表示されます。このリストに値を直接入力するか、リストからグリッドの値を選んで設

 

定します。

・アングルロック／Angle Lock

指定ポイントに対して角度強制をかけたい場合に使用します。このボタンが押されている状態では、マウスの動き自体が指定

 

された角度に強制され、その角度単位でしかポイント指定ができなくなります。このボタンをマウスで選択することで、アングル

 

ロックのON/OFF切り替えが行なわれます。角度の設定は、横にある矢印ボタンで行ないます。矢印ボタンを選択すると角度

 

設定用のフォームリストが表示されます。このフォームに値を直接入力するか、リストから値を選んで設定します。

値はここに入力

値はここに入力

セレクト

ポリゴンセレクト

スナップグリッド

アングル

 

ロック

アクティブ

 

ラジアス

Note

スナップグリッドがON時、〔Alt〕キーを押すことで一時

 

的にスナップグリッドを無効化します。

Note

アングルロックがOFF時、〔Shift〕キーを押すことで一

 

時的に45度ロックが有効となります。
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・アクティブ

 

ラジアス／Active Radius

アーク入力時に半径を固定したい場合にします。このコマンド選択後、ARC(Three

 

Point)やTangent ARCコマンドを実行

 

すると、指定した半径でアークを入力します。またPolygonやPolylineの作画時は、PropertiesダイアログのVertex Typeを

 

Roundに変更して指定した半径が設定されます。

ラジアス設定は、横にある矢印ボタンで行ないます。矢印ボタンを選択すると半径設定用のフォームリストが表示されます。

 

このリストに値を直接入力するか、リストから半径の値を選んで設定します。
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◆プロパティ

 

ダイアログ／Properties

このボタンを選択すると、プロパティダイアログメニューが表示されます。このメニュー内には、選択された作図コマンドに応じて

 

様々なフォームが表示されます。このフォームを使って、作成する

 

図形要素の線幅や文字の大きさなどを設定することができ

 

ます。Drawモードで図形要素を作成する場合、はじめにこのメニューを表示しておくことで、これから作成する図形要素の種別

 

や特性を設定することができます。また、このメニューは、既存の図形の情報を知る上でも使用されます。対象図形を選択する

 

と、その図形の情報がフォームとして表示されます。表示されたフォームの値を変更することで、その図形の修正作業も行なう

 

ことができます。

※

 

エディタにより、リストされる図形タイプが異なります。

作成する図形要素の種別や特性を設定するフォーム。選んだ

 

種類に応じた詳細設定用のフォームが表示されます。既存図

 

形を選択した場合、その図形要素の情報が表示されます。

選択した作図コマンドに応じたフォームが表示され、線幅や文字

 

の大きさなどの設定を行なうことができます。図形を作成すると、

 

その情報はこのフォーム内に逐次追加されます。既存図形を選

 

択した場合、その図形の形状属性や頂点座標などの情報が表

 

示されます。
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◆文字の追加／Add Text

このコマンドは、リファレンス番号やパートナンバーなどの文字要素を作成する際に使用します。

作業手順：

1. プロパティメニュー上段のTypeフォームで、作成する文字要素のLayerを選択します。

2. 文字のフォントや大きさなどの設定を、プロパティメニュー下段のテキストフォームで設定します。

フォントの種別

文字の大きさと角度

Layer番号

 

：エッチングテキスト
Assembly

 

：アセンブリテキスト
Silkscreen

 

：シルクスクリーンテキスト
Soldermask

 

：ソルダーマスク（レジスト）テキスト
Solderpaste

 

：ソルダーペーストテキスト
DrillDrawing

 

：ドリルドローイングテキスト
User Layer

 

：ユーザ定義レイヤテキスト

Textを選んだ場合、作成先のレイヤを指定します。

3. 配置する文字を、テキストフォーム下にある

 

String項目へ直接キー入力します。

4. 設定した内容の文字がマウスカーソルに追従してきますので、配置場所をマウスで指定します。

文字を直接入力

ペン幅とミラー設定

テキスト原点

ガーバー互換フォントのみ表示します。
その他のフォントはガーバー出力用として推奨されません。
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・テキストのフォント

テキストのフォントとして、True Typeフォントとベクター（Vector）フォントがサポートされます。True Typeフォントは、より滑らかな

 

表現が可能であり図面作成用として利用されます。またVectorフォントは、ガーバー出力時に見たままの状態で出力可能とい

 

う利点があります。

・テキストのペン幅

ガーバー出力時に使用する線幅となります。テキスト選択時は、ペン幅を考慮して四角の枠が表示されます。またテキストオブ

 

ジェクトに対するDRCに関しても、テキスト形状からの距離ではなく、この四角の枠からの距離でチェックされることになります。

True Typeフォント指定時 Vectorフォント指定時

ペン幅は表示されない為、ペン幅を考慮した四

 

角の枠が表示されます。
指定ペン幅で表示されます。テキストと四角の枠

 

は同じサイズとなります。

ベクター（Vector）フォント。
vf

 

から始まるフォント名となります。

・ベクター（Vector）フォントは、インストール時にSDD_HOME¥standard¥config¥pcb

 

フォルダ以下に“.fnt”

 

拡張子

 

を持ったファイルとして格納されます。
・現在、ベクターフォントの日本語はサポートされておりません。英数字のテキストのみ使用可能となります。Note

True TypeフォントはWindowsフォントを使用する為、プリンタドライバに依存したり、マシン固有のフォントが表示されないといっ

 

た状況が発生する可能性があります。またガーバー出力時にベクター変換が行われる関係上、見たままのテキストが出力され

 

ません。これらの問題を軽減するため、ガーバー互換フォントである“VeriBest

 

Gerber0/1”

 

又は

 

“ベクターフォント”の使用が

 

推奨されております。
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◆ラインの追加／Add Line

このコマンドは、ライン要素を作成する際に使用します。

作業手順：

1. プロパティメニュー上段のTypeフォームで、作成するライン要素の種別とLayerを選択します。

2. 作成する線幅を、プロパティメニュー下段のラインフォームで設定します。

3. エディタ画面上で、線分の始点と終点をマウスで順に指定して作成します。

始点

終点

座標入力で作画する場合には、フォーム内のVertices（頂点欄）に絶対値での座標を直接入力します。
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◆円弧の追加／Add Arc

このコマンドは、円弧要素を作成する際に使用します。プルダウンリストより円弧の作成方法を、RadiusとThree Pointから

 

選択することが可能です。

作業手順：

1. プロパティメニュー上段のTypeフォームで、作成する円弧要素の種別を選択します。

2. 作成する線幅を、プロパティメニュー下段のラインフォームで設定します。

3. Arc Mode：Radius選択時

円弧の始点（始点角）->中心点->終点（終点角）の順で、半径を最初の2点で設定し、半時計回りで円弧
の角度を指定して作成します。またTabキーにより円弧を反転することが可能となります。

①

 

始点角③

 

終点角

②

 

中心点

①

 

始点角③

 

終点角

②

 

中心点

Tabキーにより円弧が反転します。

3. Arc Mode：Three Point選択時

円弧の始点（始点角）->終点（終点角）->通過点の順で、3点目で円弧の通過点を指定して作成します。

① 始点 ② 終点

③

 

通過点
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◆折線の追加／Add Polyline

このコマンドは、連続線分要素を作成する際に使用します。

作業手順：

1. プロパティメニュー上段のTypeフォームで、作成するポリライン要素の種別を選択します。

2. 作成する線幅を、プロパティメニュー下段のポリラインフォームで設定します。

3. エディタ画面上で、線分の各頂点をマウスで順に指定します。コマンドを完了する場合には、マウスの右ボタン(RMB)
を選択し、表示されたポップアップメニューより

 

End Polylineを選択します。
※ファンクションキー〔F2:End Polyline〕でも完了することができます。

① 始点

②

③

④

⑤ 右ボタンクリック

⑥ 選択

座標入力で作画する場合には、フォーム内の座標欄に絶対値での座標を直接入力します。
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◆多角形の追加／Add Polygon

このコマンドは、多角形要素を作成する際に使用します。

作業手順：

1. プロパティメニュー上段のTypeフォームで、作成するポリゴン要素の種別を選択します。

2. 作成する線幅を、プロパティメニュー下段のポリゴンフォームで設定します。

3. エディタ画面上で、多角形の各頂点をマウスで順に指定します。多角形の始点と終点が結合された時点でコマンド
は終了します。また、マウスの右ボタンを選択して表示されるポップアップメ

 

ニューより、

 

Close Polygonを選択する
ことでもコマンドを完了することができます。※ファンクションキー〔F2:Close Polygon〕でも完了することができます。

②
始点＆終点

③ ④

⑤⑥

始点＆終点 ②

③ ④

⑤⑥

⑦右ボタンクリック

⑧ 選択

自動的に結合

座標入力で作画する場合には、フォーム内の座標欄に絶対値での座標を直接入力します。

Fillをチェックすると塗り潰しのポリゴンを作成します。

この場合、線幅は指定できません。
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◆長方形の追加／Add Rectangle

このコマンドは、四角形要素を作成する際に使用します。

作業手順：

1. プロパティメニュー上段のTypeフォームで、作成する四角形要素の種別を選択します。

2. 作成する線幅を、プロパティメニュー下段のレクトアングルフォームで設定します。

3. エディタ画面上で、四角形の対角の2点をマウスで指定して作成します。

①

②

1点目入力後、Shiftキーを押すことで正方形に限定したエレメントの作画が可能となります。座標入力で作画する場合には

 

、フォーム内の座標欄に絶対値での座標を直接入力します。

Fillをチェックすると塗り潰

 

しの四角形を作成します。
この場合、線幅は指定でき

 

ません。

四角形からポリゴンへ変更します。
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◆円の追加／Add Circle

このコマンドは、円（真円）要素を作成する際に使用します。

作業手順：

1. プロパティメニュー上段のタイプフォームで、作成する円要素の種別を選択します。

2. 作成する線幅を、プロパティメニュー下段のサークルフォームで設定します。

3. エディタ画面上で、中心点と半径の長さをマウスで指定して作成します。

① ②

座標入力で作画する場合には、フォーム内の各欄に値を直接入力します。

Fillをチェックすると塗り潰しの円を作成します。

 

この場合、線幅は指定できません。
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・左右反転／Flip Horizontal
図形要素を垂直軸を中心にミラー反転する場合に使用します。対象図形を選択した後にこのコマンドを
実行することで、図形を垂直軸を基準にミラー反転することができます。

・上下反転／Flip Vertical
図形要素を水平軸を中心にミラー反転する場合に使用します。対象図形を選択した後にこのコマンドを
実行することで、図形を水平軸を基準にミラー反転することができます。

・回転／Rotate
図形要素を回転させる場合に使用します。対象図形を選択した後にこのコマンドを実行することで、アングル
ロックで設定された角度単位に図形を回転させられます。

◆Drawモードのアイコンコマンド

Drawモードのツールバーに収納されたコマンドとなります。これらのアイコンは、Drawモードに切り替えた場合にだけエディタ上に

 

表示されます。

・グリッド線に合わせる／Snap to Grid
オフグリッドの図形要素を、最も近いグリッドに乗せる場合に使用します。図形要素を選択後にこのコマンド

 

を実行することで、選択された図形の原点（[+]マーク）が近傍グリッドへ移動します。

・結合／Join
2つのライン要素の図形要素を結合し、ポリライン要素の図形にすることができます。対象となるのはライン

 

とポリライン要素の図形のみとなり、アーク要素との結合は行えません。アーク要素を混入したい場合には

 

、クリエイトポリゴンコマンドを使用して下さい。結合対象となるライン要素が交差している場合には、一番

 

近傍に位置する頂点ハンドル間がラインで自動結線されます。

・端点ハンドルの削除／Delete End Point Handle
図形要素の頂点を削除したい場合に使用します。削除対象となる頂点を選択した後にこのコマンドを実行

 

することで、図形の頂点を削除することができます。

・トリム／Trim
図形要素のはみ出し線を削除する場合に使用します。交差する2つの図形を選択した後にこの

 

コマンドを

 

実行することで、交点からのはみ出し線を削除することができます。

・多角形

 

折線作成／Create Polygon Polyline
選択された複数の図形要素を繋ぎ合わせ、ポリゴンやポリライン要素の図形に変換することができます。

 

選択される図形は、何かしらの接点ポイントが必要となり、離れた図形要素やポリゴン要素の繋ぎ合わせ

 

は行えません。

・多角形

 

折線分解／Dissolve Polygon Polyline
選択されたポリゴンやポリライン要素の図形を、ラインやアーク要素の図形に分解することができます。
尚、サークル要素の図形を分解することはできません。
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・前に送る／Bring Forward
選択したプレーンシェープを他のプレーンシェープの前面に配置します。このコマンドを使用することで
プレーンシェープを重ねて配置する場合、どのようにオーバーラップさせるかを制御することが可能となり
ます。

〔注意〕プレーン生成時、前面に配置されたプレーンシェープを優先してプレーンを作成します。

・後ろに送る／Send Backward
選択したプレーンシェープを他のプレーンシェープの背面に配置します。このコマンドを使用することで
プレーンシェープを重ねて配置する場合、どのようにオーバーラップさせるかを制御することが可能となり
ます。

〔注意〕プレーン生成時、背面に配置されたプレーンシェープは無視されプレーンは作成されません。

・移動／Move
選択したオブジェクトを移動する場合に使用します。移動時にF2：Next Key PtやF3：Prev

 

Key PTを
押すことで選択基準点を変更することが可能となります。（単一オブジェクト選択時のみ）

・スケール／Scale
選択した図形を指定した倍率で拡大・縮小します。ドロップダウンメニューを選択することで
倍率を直接入力します。

拡大：1以上のScale値を設定

縮小：1以下（0以上）のScale値を設定

・コピー／Copy
選択したオブジェクトをコピー移動する場合に使用します。コピー時にF2：Next Key PtやF3：Prev

 

Key PT
を押すことで選択基準点を変更することが可能となります。（単一オブジェクト選択時のみ）
またプルダウンメニューのオプションを指定することで、様々なコピー操作が可能となります。

Copy-Parallel ：
コピー対象のオブジェクトと“平行の方向”にのみ限定して、コピー動作が可能となります。

Copy-Perpendicular ：
コピー対象のオブジェクトと“垂直の方向”にのみ限定して、コピー動作が可能となります。

〔注意〕これらのオプションは、ラインオブジェクトにのみ有効となります。
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・マージ／Merge
選択した2つの図形を合成します。合成する2つの図形をShiftキーなどを使って選択し、このコマンドを
実行することで下図のように複数のシェープを合成することができます。
（図形１→[＋]コマンド→図形２の手順でも行なえます。）

・サブトラクション／Subtract
選択した2つの図形の差分図形を作成します。図形１→[－]コマンド→図形２の手順で操作することで
図形１から図形２を差し引いた図形を作成します。

・延長／Extend
選択したラインを引き伸ばしてターゲットとなる図形に結合します。引き伸ばしたラインの先端に赤線ガイド
が表示されるので、ガイドとラインを結合先となる図形に合わせて選択することで結合されます。

・セグメント

 

ライン／Segment Line
選択したラインを指定した数のセグメントに等分割します。
※分割数として指定可能な値は、100以下となります。
※0を指定した場合は、クリックしたポイントでラインを２つに分割します。この場合は等分されません。

・タンジェント

 

アーク／Tangent ARC
選択したサークル又はラインの２つのオブジェクトに接するアークを作成します。
※Tabキーでアークが反転します。

Tabキーにてアークが反転します。
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図形操作

Chapter1: Overview
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Drawモードでは、直接的な図形作成以外にも、移動やコピーといった図形に関する様々な操作を行なうことができます。こ

 

れらの操作は、直接的なコマンドが用意されている訳ではなく、Windows操作環境に準じたオペレーション操作で容易に

 

行なうことが可能です。

◆図形の移動とコピー

図形要素の移動やコピーといった作業は、マウスとキーボードを使用してダイナミックに行なうことができます。図形を移動

 

する場合には、単純にその図形を選択し、マウスカーソルが十字になるポイントを掴んでマウスでドラックします。コピーを

 

行なう場合には[Ctrl]キーを押しながら同様の操作を行ないます。

＜移動操作＞

十字カーソルを確認しマウスでドラック（左ボタン）

＜コピー操作＞

十字カーソルを確認し、[Ctrl]キーを押したままマウスでドラック（左ボタン）

Ctrl +

・同一座標上でのコピーについて

図形要素を同一座標上でコピーしたい場合には、該当図形を選択した後に[Ctrl]キーを押したままその図形をマウスでダブ

 

ルクリックします。コピーされた図形は、無条件に

 

Draw Objectとして同一座標にコピーされ、同時に選択状態となります。プロ

 

パティメニューを表示した状態で、Draw Object 以外の図形要素に対してこの操作を行なった場合、操作後にプロパティメニュ

 

ーのタイプフォームでこの動きを確認することができます。

尚、この操作は複数の図形要素に対して同時に行なうことはできません。複数図形が選択されているか否かの判断について

 

は、選択された図形要素にハンドルが表示されているか否かで行なうことができ、ハンドルが表示されていなければ、複数の

 

図形を選択していることになります。

コピーが完了すると、Draw Objectに変わります。
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◆図形の拡大と縮小

図形要素の拡大/縮小作業は、プロパティダイアログメニューを使用して行ないます。対象となる図形要素を選択し、プロパテ

 

ィダイアログフォーム右下の Grow/Shrinkに対して値を指定します。拡大の場合には正の値を、縮小の場合には負の値を入

 

力します。

ここに値を入力します。

正の値の場合には拡大

負の値の場合には縮小
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◆図形のダイナミックな編集

図形要素を選択すると、頂点やラインのセンターにハンドルといわれるポイントが表示されます。これらのハンドルは、その表示位

 

置によって赤白に色分けされ、頂点ハンドル、センターハンドルとに分別されます。各ハンドル位置にマウスカーソルを置くと、その

 

ポイントに応じた矢印カーソルが表示されます。この状態でマウス左ボタンでのドラック操作を行なうと、図形をダイナミックに編集

 

することができます。

頂点ハンドル

センターハンドル

図形要素の原点ハンドル

矢印カーソルを確認し、ドラックして拡大縮小

矢印カーソルを確認し、ドラックして拡大縮小

矢印カーソルを確認し、[Ctrl]キー＋ドラックしてハンドルの追加

Ctrl ＋

センターハンドルを[Ctrl]キーを押した状態でドラックすると、その両端にセンターハンドルが追加することができます。両端に

 

センターハンドルが追加されると、最初のセンターハンドルは両端にハンドルが追加されたことで頂点ハンドルへと特性をかえ

 

、結果的に頂点を追加することができます。
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◆チャンファーとフィレットの追加

多角形や連続線分の各頂点に対しては、作成時や作成後にChamferやRoundを追加することができます。これらに関する作

 

業は、プロパティメニューを使用して行ないます。

＜作成時からの追加＞

ChamferやRoundの作成時より追加する場合には、プロパティーメニューフォーム内のVertex Typeの設定が必要となります

 

。処理を行なう頂点を指定する前に、デフォルト値の

 

Cornerより追加したい形状を

 

RoundもしくはChamferのいずれかより選

 

択しておくことで、作成する頂点にフィレットもしくはチャンファー処理を施すことができます。

又は

フィレットやチャンファーの大きさは、このフォームで設定

＜既存図形への追加＞

既に作成された多角形や連続線分に対してこれらを追加する場合には、対象となる頂点ハンドルを選択した後にプロパティ

 

メニューのVertex Typeを変更します。また、これとは逆の操作を行なえば、フィレットを頂点から削除することも可能です。チ

 

ャンファーを削除する場合には、チャンファー部のセンターハンドルをマウスで直接ドラックして削除します。

頂点のハンドルを選択します。
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◆図形要素の結合と分解

ラインやアークを個別に作成し、これをひとつのポリゴンとして結合させる場合には、クリエイトポリゴンコマンドを用います。

対象図形を、エリア選択などで全て選択します。

クリエイトポリゴンのボタンを選択。

全ての図形要素が結合され、１つのポリゴン要素に変わります。

対象のポリゴン図形を選択します。

ディススローブのボタンを選択。

ラインやアーク要素に分解されます。

＜結合＞

＜分解＞
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◆図形の削除

図形要素の削除する際には、対象となる図形要素を選択した後に[Delete]キーを選択するか、ツールバーに存在するデリート

 

コマンドアイコンを選択します。

デリートコマンドアイコン

◆コマンドのキャンセル

使用中の作画コマンドをキャンセルしたい場合には、[Esc]キーを選択することでコマンド自体をキャンセルすることができます。

◆作業のやり直し／Undo

一度終了してしまった作業を取り消したい場合には、Undoコマンド

 

又は

 

〔Ctrl＋Z〕キー

 

を使用することで前の作業状態に戻

 

すことができます。このUndoコマンドは、エディタを抜けない限りは無制限にそれまでの作業内容を記憶しています。ツールバ

 

ーのUndoコマンドアイコンを選択する毎に、1つ前の作業状態に戻すことができます。Undoで戻しすぎた場合には、隣にある

 

Redoコマンドアイコン

 

又は

 

〔Ctrl＋Y〕キーを使用してUndoを行なう1つ前の状態に戻すことができます。

Undoコマンド

Redoコマンド

◆図形タイプの変更

Rectangle(四角形)要素の図形は、フィレットやチャンファーなどのコマンドでは編集が出来ないため、一度多角形要素に変更

 

することが必要です。これを行なうには、プロパティメニューにある変換用ボタンを使用します。

このボタンを押すことで、多角形に変更できます。

◆その他のキーボード操作

Tabキー

 

：Tabキーには様々な機能があります。選択位置内に複数配置されたDrawオブジェクトの選択切り替え 及び
スナップポイントの切り替え動作（選択なし状態）を可能とします。

Shiftキー

 

：一時的なAngle-Lock機能として、Angle‐Lock=OFF時の描画時に45度の角度をロックを可能とします。

Ctrlキー

 

：選択オブジェクトのCopy動作、Ctrl＋ダブルクリックでの同一座標Copyなどを可能とします。

Altキー

 

：一時的なGrid-OFF機能として、Snap Grid=ON時に、Snap Gridを無効化した移動や編集を可能とします。

ESCキー

 

：あらゆる操作実行時に、コマンドの中止し直前のコマンド状態へ戻ることを可能とします。
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Drawコマンドの要素作成

Chapter1: Overview
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◆プレースメニューコマンド

エディタプルダウンのEdit> Place以下には、様々な要素を配置するためのコマンドが収納されています。ボードアウトラインや

 

プレーンシェープといった図形は、Drawコマンドを用いても作成することができますが、ここに収納されているコマンドを使用

 

することで直接的な作業を行なうことができます。

ここに収納されるコマンドを実行すると、各図形要素作成に必要なモード切り替えやプロパティタイプの切り替えが自動的に

 

行なわれますので、Drawコマンドで作成する際の設定の煩わしさから開放されます。プルダウンメニュー最上段にある

 

“Action Keys”を実行すると、これ以下に含まれるコマンドをアクションキーにマッピングすることができ、いちいちプルダウン階

 

層を下らなくても済むようになります。

アクションキーにマッピングされたコマンドは、別のアクションキー
などをマッピングしない限りデフォルト値として表示され続けます。
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◆基板外形／Board Outline

ボードアウトラインを作成する際に使用します。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項目にボ

 

ードアウトラインが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンドが使用され、プ

 

ロパティメニューを使った座標入力での作図も行なえます。

ボードアウトラインはデザインファイル上に1つしか存在することができない

 

ため、新たに図形を作成した場合には前の図形が削除されます。

◆NCルータ（基板カットデータ）／Contour

NCルータ（Contour）を作成する際に使用します。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項目に

 

Contourが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンドが使用され、プロパティ

 

メニューを使った座標入力での作図も行なえます。

線幅

頂点形状

Hole Name ：ドリル径（ホール名）
Compensation ：経路上のドリルの位置

Type ：データタイプ
（Internal=基板内スリット、Board=ボードカット）
※ドリル出力時にはInternalからBoardの順に出力されます。

Direction ：方位
（CW=右回り、CCW=左回り

Left

Right

Center

Note

Note

NCルータのスパン（層間）定義となります。これにより、貫通以外の特定スパン

 

を持つContourの作成が可能となります。

Display ControlのContour 
Span Numbersにて表示の

 

ON/OFFが可能。
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◆フィデュシャル（合わせマーク）／Fiducial

このコマンドは、フィデュシャルマーク（合わせマーク）を配置する場合に使用します。このコマンドを実行すると、配置用のメニ

 

ューが表示されます。配置したいフィデュシャルのパッドスタックを選んだ後に、[Apply]もしくは[OK]ボタンを選択して配置し

 

て下さい。

◆マウンティングホール（取り付け穴）／Mounting Hole

このコマンドは、マウンティングホール（取り付け穴）を配置する場合に使用します。このコマンドを実行すると、配置用のメニュ

 

ーが表示されます。配置したいマウンティングホールのパッドスタックを選んだ後に、[Apply]もしくは[OK]ボタンを選択して配

 

置して下さい。

・座標欄に対して値を入力しなかった場合、選んだマウンティングホールがマウスカーソルに追従しますので、配置ポ

 

イントをマウスで直接指定して下さい。
・マウンティングホールの場合、ローカルライブラリにパッドスタックが無くてもマスターとなるライブラリから配置すること

 

ができます。リストされるパッドスタックの頭には“Central”や“Local”の文字が表示され、そのパッドスタックの収納先を

 

確認することができます。セントラルライブラリから配置されたマウンティングホールのパッドスタックは、配置と同時にロ

 

ーカルライブラリへとコピーされます。
・選んだパッドスタックに対してパッド（銅箔）設定がなされている場合にのみ、メニューのNet Nameが有効となり、マ ウ

 

ンティングホールへネット属性を付加することができます。

パッドスタックを選択

座標指定の場合には、絶対座標を入力

固定

 

及び

 

ロック情報の設定

・座標欄に対して値を入力しなかった場合、選んだフィデュシャルはマウスカーソルに追従しますので、配置ポイント

 

をマウスで直接指定して下さい。
・フィデュシャルの場合、ローカルライブラリにパッドスタックが無くてもSetup＞

 

Project Integrationで指定したライブラ

 

リから配置することができます。リストされるパッドスタックの頭には“Central”や“Local”の文字が表示され、そのパッド

 

スタックの収納先を確認することができます。セントラルライブラリから配置されたフィデュシャルのパッドスタックは、配

 

置と同時にローカルライブラリへとコピーされます。

Note

パッドスタックを選択

座標指定の場合には、絶対座標を入力

固定

 

及び

 

ロック情報の設定

ネット名を選択

 

※但しパッドを持つPlatedホールのみ。

Note
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◆製造外形／Manufacturing Outline

製造外形データはFablink XE にて使用され、デザイン上に1つだけ作成可能となります。この領域内に作成したオブジェクト

 

のみがFablink XE上で表示されます。また製造外形を基準に、他のデザインとチェックすることが可能です。このコマンドを実

 

行するとDrawモードへ自動的に切り替わり、タイプ項目にManufacturing Outlineが選択されたプロパティメニューが表示され

 

ます。図形の作成にはDrawモードの作画コマンドが使用され、プロパティメニューを使った座標入力での作図も行なえます。

◆原点／Origin

このコマンドは、オリジン（原点）を配置する場合に使用します。このコマンドを実行すると、配置用のメニューが表示されます。

 

配置する原点の種類を選択した後に現在地からの座標を入力、[Apply]もしくは[OK]ボタンを選択して配置して下さい。

対象となる原点の種類を選択します。（NC Drill=NC用原点、Board=基板原点）

基板原点からの相対座標を入力

・基板原点は、デザインファイル上に必ず存在します。従って、このコマンドは基板原点の移動ということになります。
・NC用の原点については、これを配置しなければ基板原点を基準にNCデータが作成されます。NCオリジンを配置す

 

るのは、基板原点とは異なるポイントをNCデータ用の原点としたい場合のみとなります。
・

 

このオリジン配置コマンドは、座標指定での作業のみが認められており、マウスでのポイント指定は行なえません。

NC DrillBoard

各オリジン位置は、エディタ画面上のマークで確認することができます。

Note
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◆コンダクティブシェープ／Conductive Shape

コンダクティブシェープは配線層にのみ作成可能であり、Layerとネット名を指定することでシェープ領域をもつトレースとして

 

扱われます。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項目にConductive Shapeが選択されたプロ

 

パティメニューが表示されます。図形の作成にはDrawモードの作画コマンドが使用され、プロパティメニューを使った座標入

 

力での作図も行なえます。

Layer ：層
Net ：ネット名

◆カッパーバランシングシェープ／Copper Balancing Shape 〔Fablink XEのライセンスが必要となります〕

カッパーバランシングシェープは、カッパーバランシングを作成する領域を指定します。カッパーバランシングプロセッサーは

 

この領域内に、カッパーバランシングプロセッサーの設定をもとにライン及びシェープを作成します。このコマンドを実行すると

 

Drawモードへ自動的に切り替わり、タイプ項目にCopper Balancing Shapeが選択されたプロパティメニューが表示されます。

 

図形の作成にはDrawモードの作画コマンドが使用され、プロパティメニューを使った座標入力での作図も行なえます。

Layer ：指定層 又は ALLを指定
ポジ層のみ指定可能。ALL指定時はポジ層全てとなります。
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◆詳細ビュー／Detail View 〔Fablink XEのライセンスが必要となります〕

詳細ビューは、ボード上の任意の領域に対してデザインの詳細を表示できるようにスケールを掛けて表示することを可能とし

 

ます。また詳細ビュー内のみ特定のレイヤの表示をON/OFFすることも可能です。このコマンドを実行するとDrawモードへ自

 

動的に切り替わり、タイプ項目にDetail Viewが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの

 

作画コマンドが使用され、プロパティメニューを使った座標入力での作図も行なえます。

User Layer ：詳細ビュー内に作画するユーザーレイヤを指定
※推奨としては、該当レイヤは詳細ビュー内のみで使用すること

View Name ：詳細ビュー名を指定
Name Font ：テキストのフォント名を指定
Name Height ：テキストの高さを指定
Display Border ：詳細ビュー作成時の領域の表示ON/OFF
Border Width ：詳細ビュー作成時の領域の幅を指定
Scale ：倍率の指定
Mirror ：ミラー表示の指定
Active Angle ：角度の指定（0/90/180/270)
Background ：Transparent(透過）/Opaque(不透過）の選択

◆DRCウィンドウ／DRC Window

Batch DRCのチェック領域を作成する際に使用します。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項

 

目にDRCウィンドウが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンドが使用され

 

、プロパティメニューを使った座標入力での作図も行なえます。

DRCウィンドウは、指定領域内にのみDRCを掛けたいという場合に

 

使用します。

デザインに配置できる最大個数は250となります。

Note

Note
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◆配置禁止領域／Placement Obstruct

プレスメントオブストラクトを作成する際に使用します。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項

 

目にプレスメントオブストラクトが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンド

 

が使用され、プロパティメニューを使った座標入力での作図も行なえます。また、このプレスメントオブストラクトでは、部品セル

 

内に施した高さ情報に関する禁則設定も行なえます。

Layer ：配置禁止領域面
Height ：高さ制限のプロパティ

高さ制限は、各プレースメントオブストラクト毎に行なわれ、部品の

 

高さに関係なく配置を禁止させたい場合にはHeight=0とします。

◆プレーン接続禁止領域（非接続プレーン領域）／Plane No Connect

プレーン接続禁止領域は、プレーン生成時のサーマル処理を無効とする領域を定義します。プレーン接続禁止領域内のピ

 

ンはアンチパッド（Anti-pad）として、Viaは接続禁止ビアとして接続されません。このコマンドを実行するとDrawモードへ自動

 

的に切り替わり、タイプ項目にPlane No Connect Areaが選択されたプロパティメニューが表示されます。図形の作成にはDraw 
モードの作画コマンドが使用され、プロパティメニューを使った座標入力での作図も行なえます。

Layer ：指定層 又は ALLを指定。
ポジ層、ネガ層ともに指定可能。

Batch DRCでは、ネガ層上のプレーン接続禁止領域内で接続されたピ

 

ンに対してチェックできません。

Note

Note
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◆プレーン作成禁止領域／Plane Obstruct

プレーン作成禁止領域を作成する際に使用します。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項目

 

にプレーンオブストラクトが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンドが使用

 

され、プロパティメニューを使った座標入力での作図も行なえます。このプレーンオブストラクトとは、プレーン領域内に作成す

 

る中抜き（銅箔の無い）領域を指します。

Layer ：プレーンオブストラクトの配置層

プレーン作成禁止領域は、プレーン領域内に作成する中抜きの領域

 

となります。指定された領域内には、プレーンデータが作成されること

 

はありません。この禁止効果は、プレーンデータに対してのみ有効とな

 

り、他の銅箔要素である配線やビアに関する禁止領域としては認識さ

 

れません。

◆プレーンシェープ／Plane Shape

プレーンシェープを作成する際に使用します。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項目にプ

 

レーンシェープが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンドが使用され、プ

 

ロパティメニューを使った座標入力での作図も行なえます。

・プレーンシェープにはネガ用ポジ用の区別は無く、指定した領域内

 

が一貫してプレーンの領域として判断されます。
・作成されたプレーンシェープの領域は、ディスプレイコントロールで塗

 

り潰し状態で表現させることができます。
・異なるネットのシェープが交差した場合、互いのネットがショートしな

 

いよう、クリアランスが自動的に作成されます。

Note

Layer ：プレーン層
Net ：プレーンネット名
Route Obstruct ：領域内へ異電位の配線の可否
Lock ：移動及び属性のロック
Isolate Plane ：同ネットプレーンのマージ可否
Plane Class : Plane Classes and Parametersの

プレーンクラスを指定

Note
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◆ルーム（部品配置指定領域）／Room

ルームを作成する際に使用します。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項目にルームが選択

 

されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンドが使用され、プロパティメニューを使っ

 

た座標入力での作図も行なえます。

Layer ：配置指定領域の配置面
Name ：配置指定領域の名前

ルームを作成する場合には、各ルーム（領域）毎に名前を付加する必

 

要があります。エディタコントロール＞ Place＞ Cluster & Rooms にて

 

各ルームに割り振られた部品は、所定のルーム以外の領域に配置さ

 

れた時点でDRC違反と判断されます。

◆配線領域／Route Border

Routeボーダーを作成する際に使用します。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項目にRoute 
ボーダーが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンドが使用され、プロパテ

 

ィメニューを使った座標入力での作図も行なえます。

Routeボーダーはデザインファイル上に1つしか存在することができない

 

ため、新たに図形を作成した場合には前の図形が削除されます。

Note

Note
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◆ルールエリア／Rule Area

ルールエリアは、任意のエリアに対して指定したレイヤとネットクラススキームを持つ領域を定義することが可能です。このルー

 

ルエリア内では指定したネットクラススキームでチェックが行われます。このコマンドを実行するとDrawモードへ自動的に切り

 

替わり、タイプ項目にRule Areaが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンド

 

が使用され、プロパティメニューを使った座標入力での作図も行なえます。

Layer ：指定層 又は ALLを指定
Name ：ネットクラススキームを指定

・同層にてルールエリアが重なった場合、小さい領域を持つルールエリア

 

のルールを優先します。
・同一エリアに隣接する層のルールエリアが存在する場合、小さい領域を

 

持つルールエリアのルールを優先します。例として両エリアを追加する

 

VIAなど。また同一サイズを持つエリアの場合は、ネットクラススキーム名（

 

アルファベット）順にて優先度を決定します。
・ルールエリアが削除された場合、既に作成されたエリア内のオブジェクト

 

は変更されません。新たに作成されたオブジェクトのみ影響を受けます。
・ルールエリア内で“Change Width・Change Via”のコマンドが実行される

 

と、ルールエリアのルールを優先します。

◆配線禁止領域／Route Obstruct

Routeオブストラクトを作成する際に使用します。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項目に

 

Routeオブストラクトが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンドが使用され

 

、プロパティメニューを使った座標入力での作図も行なえます。

配線禁止領域は、線やシェープとして作成することができ、線上と

 

シェープ領域内が禁止領域として判断されます。

Layer ：Routeオブストラクトの配置層
Obstruct Type ：禁止領域の種別

（Trace=配線のみ、Via=ビアのみ、Both=両方）

Note

Note
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◆テストポイント禁止領域／Test Point Obstruct

テストポイントオブストラクトを作成する際に使用します。このコマンドを実行するとDrawモードへ自動的に切り替わり、タイプ項

 

目にテストポイントオブストラクトが選択されたプロパティメニューが表示されます。図形の作成にはDrawモードの作画コマンド

 

が使用され、プロパティメニューを使った座標入力での作図も行なえます。

Layer ：禁止領域の配置面
（Top=部品面、Bottom=はんだ面、All=両面）

テストポイントオブストラクトは、領域としてしか作成することができま

 

せんので、RouteオブストラクトのようにDrawモードのラインコマンド

 

の使用が禁止され、シェープ作成コマンドのみが有効になります。

◆ビア／Via

このコマンドは、単独でビアを配置する場合に使用します。このコマンドを実行すると、配置用のメニューが表示されます。配

 

置するビアのパッドスタックやビアスパン、ネット名を選択した後に、[Apply]もしくは[OK]ボタンを選択して配置して下さい。

ビアスパンを選択

・このコマンドで配置可能なビアのパッドスタックは、フィデュシャルやマウンティングホールと同様にローカルライブラ

 

リ内のものとセントラルライブラリのものとなります。各パッドスタックの頭には、収納先を示す“Local”、”Central”の表

 

記されます。セントラルから配置されたビアのパッドスタックは、マウンティングなどと同じくローカルライブラリへとコピ

 

ーされます。
・このメニュー内で座標を指定しなかった場合、マウスカーソルにビアが追従してきますので、マウスで直接配置ポイ

 

ントを指定して下さい。
・メニュー内に表示されるビアスパンは、セットアップパラメータに設定された内容がすべてリストされます。

Note

Note

ビアのパッドスタックを選択

座標指定の場合には、絶対座標を入力

固定

 

及び

 

ロック情報の設定

ネット名を選択
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◆テストポイント／Test Point

このコマンドは、単独でテストポイントを配置する場合に使用します。テストポイントを配置したい配線を選択した後に、このコマ

 

ンドを実行します。マウスカーソルにテストポイントが追従しますので、配置ポイントをマウスで指定して下さい。

テストポイントは、パターン上に配置することもそれ以外の場所に配置することもできます。パターン上以外に配置されたテス

 

トポイントからはネットラインが表示され、配線コマンドを使用して結線させることができます。

テストポイントは、通常のパターンやビアと同様にExpedition PCB上の押しのけ機能に対応しており、テストポイント配置時に

 

クリアランス違反と判断されるパターンは自動的に押しのけられます。

パターン上に配置 パターン上以外に配置

密集ポイントを指定

邪魔なパターンが押しのけられる

テストポイントを使用するには、セットアップパラメータ内のテストポイント設定を事前に行なう必要があります。この設定がなされ

 

ていないデータ上では、テストポイントに関するコマンドは無効となり、下記のメッセージで設定を促されます。

このメッセージに対し[はい(Y)]を選択と、セットアップパラメータメニューが表示されます。

セットアップパラメータへテストポイント設定を行なう場合、ローカルライブラリ内にテストポイント用のパッドスタック

 

が必要となります。ローカルライブラリとしてのテストポイント用パッドスタックが存在しない場合、この設定自体が行

 

なえませんので注意して下さい。Note
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◆構築エレメント／Construction Element

構築エレメント（コンストラクションエレメント）は、セルや図面作画時の補助線として使用できます。このオブジェクトはデータを

 

出力することを目的とせず、あくまで作画時の補助線としてのみ使用します。図形の作成には、Drawモードの作画コマンドが

 

使用され、ライン 又は サークルでのみ作図することができます。

・構築エレメントは、別のオブジェクトタイプに変更することはできません。
・構築エレメントは、DRCやガーバー出力、PDF出力の対象外となります。

・構築エレメントを含んだセルをデザインに配置した場合、その構築エレメントはデザインには表示されません。

作画するLayerをユーザーレイヤから選択します。

Construction Lineを無限化します。

※チェック後の解除はできません。

ライン－ Construction Line サークル－ Construction Points

構築エレメントは、Edit＞ Add to Select Set＞ Construction lines 又は Construction Points にて選択可能です。

Note
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◆サンドボックス／Sandbox

サンドボックスは、特定ユーザーのみが編集可能な領域を作成する際に使用します。サンドボックスは、XtremePCB 及び

 

Expedition PCBで使用することができ、自動配線とマニュアル配線・配置で有効となります。図形の作成には、Drawモードの

 

作画コマンドが使用され、ポリゴン 又は サークルでのみ作図することができます。

サンドボックス名を入力します。デフォルトはハンドル名。

配線編集の可能な層を指定します。
All／None／層から選択します。

配置編集の可能な層を指定します。
All／None／層から選択します。

配線 及び 配置を禁止にした層は、編集はもちろん選択も不

 

可となります。
Note

Sandbox①：

 

アナログ領域 Sandbox②：

 

デジタル領域

Sandbox③：

 

電源ジタル領域

Note

・サンドボックス同士を重ねて作成することは可能ですが、重なった領域は自分も他のユーザーも編集不

 

可な領域となりますので、使用上推奨できません。
・サンドボックスを使用した分割設計の手法に関しては、Appendixを参照ください。
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プリント出力

Chapter1: Overview
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プリント出力に関するコマンドは、Fileプルダウンに収納されています。

◆印刷設定／Printer Setup

Printer Setupコマンドを実行すると、印刷に関する設定メニューが表示されます。このメニューでは、出力先であるプリンター

 

の指定からモノクロ印刷の指定まで、様々な設定を行なうことができます。

出力先のプリンター指定。 出力先のプリンターのプロパティメニュー表示。

用紙に対する印刷方向の指定。

用紙サイズの指定。

ネットワークプリンターの指定。

印刷する画像の指定。
Print entire design:表示されたデザインを基準
Print view：画面の表示状態を基準

Scale

 

：

 

倍率の指定。（100%で原寸）
Fit pages

 

：

 

チェックを入れると用紙サイズで最大化。
（倍率指定の場合には、チェックを外します）

Mirror

 

：

 

反転印刷の指定。
No

 

Footer

 

：

 

ファイル名やページ番号を印刷しない場合には
チェックを入れます。

B&W

 

Only

 

：

 

モノクロ印刷の指定。
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◆印刷プレビュー／Print Preview

このコマンドを実行すると、指定したプリンターへの印刷イメージが表示されます。

このボタンで印刷実行。

◆印刷/Print

このコマンドを実行すると、印刷メニューが表示されます。このメニューは、OS側のプリントマネージャと同様となります。

・印刷の設定は、OS側の設定に依存します。従ってOS側でプリンター設定が行われていない環境では、印刷機能を
使用することはできませんのでご注意ください。
・ここで表示される印刷メニューは、設定されているプリンタードライバに依存します。詳細については、プリンターの
マニュアルを参照ください。

Note
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Chapter 2
Process Flow

概要
本章はExpedition PCBを使用して設計する際の作業フロー

 

及び デザインを開始する前に必要となる設計準備の手順

 

等について説明しております。

・

 

Expedition PCBの作業行程

 

－ 84P
・

 

Job Management Wizard － 88P
・ プロジェクトインテグレーションと

 

－ 101P
フォワードアノテーション・バックアノテーション

・ プロジェクトとレイアウトデータの分離

 

－ 112P
外部でのレイアウト設計

・

 

ローカルライブラリ

 

－ 123P
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Expedition PCBの作業行程

Chapter2: Process Flow
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◆Expedition Enterprise Flow（EEフロー）の作業工程

＜回路図からの設計＞

開始

セントラルライブラリの作成

プロジェクトの作成

回路図の作成

iCDBの作成

プロジェクトの起動

Job Management Wizardによる
PCBデータの新規作成

Expedition PCBの起動

Projectメニューにおけるライブラリパスの設定

Setup Parameterにおける各種設定

基板データの作成（配置、配線を含む全て）

CAMの作成とアウトプットデータ出力

Library Managerでの作業

Front End （回路図）での作業

Expedition PCBでの作業

Project Integrationによるライブラリパスの設定と

フォワードアノテーション

終了
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◆Expedition PCBの作業工程

＜ネットリストからの設計＞

開始

セントラルライブラリの作成

Job Management Wizardによる
PCBデータの新規作成

Project Integrationによるライブラリパスの設定と

フォワードアノテーション

Expedition PCBの起動

Setup Parameterにおける各種設定

基板データの作成（配置、配線を含む全て）

Library Managerでの作業

Expedition PCBでの作業

ネットリストの作成

終了

作業工程には、ライブラリマネージャでのライブラリ作成が最初の工程として記載されています

 

が、既存ライブラリを使用する場合には、この工程を行なう必要はありません。

CAMの作成とアウトプットデータ出力

Note
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◆設計変更時の作業工程

＜ネットの追加/変更/削除、部品の追加/変更/削除のケース＞

開始

Job Management WizardによるPCBデータの新規作成

Project Integrationによるライブラリパスの設定

Expedition PCBの起動

Setup Parameterにおける各種設定

基板外形やプレーン領域などの作成

ネットリストの作成

終了

フォワードアノテーション

部品配置、移動…

配線、修正、プレーンデータ作成

シルクデータ作成 ＆ DRCチェック

どのタイミングでネットが変更されようと、ネット情報

 

が変更された場合には新たなネット（ネットリスト

 

or 
iCDB）を用意した後に、フォワードアノテーションを

 

実行して、変更後の情報を取り込まなければなりま

 

せん、

CAMの作成とアウトプットデータ出力
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Job Management Wizard

Chapter2: Process Flow
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◆ジョブ

 

マネージメント

 

ウィザード

Expedition PCBのデータは全てプロジェクトファイル単位で管理されます。1つの設計データには必ず1つのプロジェクトファイル

 

が存在し、新規で設計作業を開始する場合には始めにプロジェクトファイルを作成する必要があります。プロジェクトファイルを含

 

むデザインファイルは、ジョブマネージメントウィザードを使用して作成されます。ジョブマネージメントウィザードでは、新規プロジ

 

ェクトの作成以外にプロジェクトファイル単位設計データのコピーや移動といった作業が行なえます。また、ジョブマネージャでは

 

、設計作業を終了したデータには不必要となるログファイルの削除（クリーンアップ）なども行なうことができます。ジョブマネージメ

 

ントウィザードの起動は、スタートアップメニューから“スタート＞

 

プログラム＞

 

Mentor Graphics SDD＞

 

Job Management Wizard”

 

を選択して行ないます。

表示されたメニューには、作業内容を選択するためのトグルスイッチが存在します。いずれかのトグルスイッチを選んだ後に [次

 

へ(N)>]ボタンを選択すると、その作業内容に応じたメニューがウィザード形式で表示されますので、メニュー内容に沿って作業

 

を行なうことができます。

作業に応じたウィザード形式の
メニューが表示されます。
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◆新規データの作成手順 （ネットリストを使用したプロジェクト）

1. これから作成されるデータを収納するためのフォルダを新たに作成します。

2. スタートアップメニューより、ジョブマネージメントウィザードを起動します。

3. ジョブマネージメントウィザードメニューより、データの新規作成を示すCreateのトグルスイッチを選び[次へ(N)]ボタンを
選択します。

4. 新規作成用ウィザードメニューの最初のページが表示されますので、Source Project Filename欄に作成するプロジェ
クトファイルの名前を入力指定し[次へ(N)]ボタンを選択します。

プロジェクトファイルの絶対パスを指定。

※ここで指定するプロジェクトファイル名には、必ずプロジェクトファイルであることを示す“.prj”の拡張子を付けて下さい。

 

また、プロジェクトファイルを収納するフォルダについては、最初に作成したフォルダとなりますので注意して下さい。

5. 指定したプロジェクトファイルを作成するかを問われますので、[はい(Y)]ボタンを選択してファイルを作成します。

新規作成時は、Createを選択します。
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6. 次にネット情報を取り込むか否かを問われますので、[はい(Y)]ボタンを選択して下さい。

７. プロジェクトファイルにおけるライブラリパス設定のメニューが表示されますので、設計に使用するライブラリ情報が収納
されたセントラルライブラリへのパスと、使用するサーチパススキームを設定し[OK]ボタンを選択して下さい。

セントラルライブラリへのパス設定

使用するサーチパススキームの設定

この段階でライブラリパスを問われますので、指定するセントラルライブラリを予め作成しておく必要があります。また

 

、ライブラリパスと同様に指定するサーチパススキームについては、特に作成していないのであればデフォルトの値

 

（全ての情報を参照できる）をそのまま使用することができます。

8. Netlistタブを選択後、Keyin Netlistのパスを指定します。

Note
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9. 最初のページが再度表示されますので、設定はそのままの状態で[次へ(N)>]ボタンを選択して次のステップへ移行して下

 

さい。

10. プロジェクトファイルへのライブラリパス設定は前の作業で完了していますので、ウィザードは次のステップへと移行します。

 

表示されたメニューには、作成されるデザインファイルとこれの元となるテンプレートを指定する項目が現れます。

 

作成される

 

デザインファイル名とその元になるテンプレートを指定し、[次へ(N)>]ボタンで作業を継続して下さい。

デザインファイル名

テンプレート名

ここで表示されるデザインファイル名は、プロジェクトファイルと同じ名前が標準値として自動挿入されます。デザイン

 

の名前を変更したい場合には、項目に対して名前の編集を直接行なって下さい。また、この時点でデザインファイル

 

の元になるテンプレートを問われますので、セントラルライブラリ内には最低1つのテンプレートが必要となります。Note
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11. 最後にネット情報の取り込み状況を伝えるメニューが表示されますので、[完了]ボタンを選択して下さい。

今までの作業内容が最後に表示されます。
このメニューは単なるインフォメーションなので、
[Close]ボタンで閉じて下さい。

・ここで示された作業手順は、新規作成手順の１つの例にしか過ぎません。この例ではプロジェクトファイル自体を新

 

規作成していますが、回路図から設計を開始した場合には、回路図側に既存のプロジェクトファイルが必ず存在しま

 

す。回路図とExpedition PCBをリンク（結合）させるためには、プロジェクトファイルを新規作成せずに回路図が使用す

 

るプロジェクトファイルを選択します。従って、プロジェクトファイルを新規作成するのはネットリスト等を使用して設計を

 

行なう場合に限定されますので注意して下さい。
・ここではネットリストを取り込む手順を説明していますが、回路図から出力したForeign iCDBを取り込むことも可能で

 

す。詳細な手順は、“この章にある

 

◆Foreign iCDBを使用した設計フロー”をご参照ください。

Note
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◆Expedition PCBの起動

Expedition PCBを起動する場合、スタートアップメニューでスタート＞

 

プログラム＞

 

Mentor Graphics SDD＞

 

Layout＞
Expedition PCB を選択するか、Expedition PCBの関連ファイルとなる“.pcb”の拡張子のついたファイルをダブルクリックします。

拡張子(.pcb)の付いたファイルのダブルクリックにて、Expedition PCBの

 

起動とデータオープンを行います。
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◆ライセンス

 

モジュール／License Modules

Expedition PCBの起動時、どのライセンスを取得するかを選択するメニューが表示されます。必要となるプロダクトを選択して

 

、〔OK〕ボタンを選択します。この操作は、Expedition PCB起動後の

 

Setup＞

 

License Modules を使用することでも行うことが

 

でき、ライセンスの取得と解除（一部の機能のみ）が可能となります。

保有するライセンスのみ表示されます。

・ Pinnacle

Expedition PCBの最上位構成となります。オプション機能以外の全ての機能が使用可能となります。またHigh Speed設計に必

 

要なHigh Speed

 

Design Option (HSR)は、本構成に含まれております。

・ Ascent LX

本構成では、オプション機能以外の機能が使用可能となります。但し、

 

High Speed

 

Design Option (HSR)は含まれておりません。

・ Ascent 

本構成では、自動配線（Auto Route）とオプション機能以外の機能が使用可能となります。High Speed

 

Design Option (HSR)

 

は含まれておりません。
※自動配線には、テストポイントの自動配置機能も含まれます。
※Ascent構成では、追加できないオプション機能が存在します。
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・

 

High Speed

 

Design Option (HSR)

このライセンスを有効にすることで、ハイスピードルールを考慮した配線・チェックが可能となります。Expedition PCBの製品構

 

成であるPinnacleには、このHSRライセンスが組み込まれております。

使用可能な機能：
・

 

配線時のチューニング動作
・

 

自動配線時のチューニングパス
・

 

ハイスピード情報に関するエラーのリスト表示（Review Hazards）
・

 

チューニングパターン設定（Editor Control）

対象コマンド：Route> Auto Route> Pass Type:Tune, Analysis> Review Hazards, Route> Interactive> Tune
Editor Control> Tuningタブ

・

 

ICX Pro Verify

このライセンスを有効にすることで、CESで設定した電気的な制約条件を考慮して解析・配線が可能となります。
対象コマンド：Setup> ICX Pro Verify Setup, Verifyプルダウンメニュー

HSRのライセンスが無い状態で、Review Hazardsを起動すると以下メッセージが表示されます。

・

 

Advanced Technology Pro（EP）

このライセンスを有効にすることで、Embedded Passive Components（埋め込み受動部品）を使用した設計が可能となります。

使用可能な機能：
・パラメトリックプロパティの各種設定
・

 

Embedded Passives Resistor 及び

 

CapacitorのPlannerダイアログ
・

 

Embedded Passives Resistor 及び

 

CapacitorのOptimizerダイアログ
・

 

Embedded Passives Resistor の編集
・

 

Embedded Passives Capacitorの編集

対象コマンド：
Setup> Material/Process Editor, Setup> Embedded> Planner/Optimizer, Place> Toggle Parametric
ECO> Update Materiales & Processes

関連資料：

 

Expedition PCB User’s Guide-Chapter9 (exp_gd.pdf)
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・

 

Advanced Technology Pro（Flex）

このライセンスを有効にすることで、Flexible Circuits（フレキ基板）の設計に効果的な機能が使用可能となります。

使用可能な機能：
・ ティアドロップ形状の編集
・

 

T分岐上のティアドロップ

 

& Neck Downs 生成
・

 

カーブトレースの束配線
・ Drawエレメントに沿ったカーブトレースの作成
・

 

ハグトレース

 

クリアランスの定義

 

("htc" キーインコマンド使用)
・

 

カーブトレースのPush/Shove操作

前回のセッションで作成されたこれらのデータに対し、Advanced Technology Pro（Flex）ライセンス無しでデータオープンした

 

場合は以下のようになります。
・

 

オプション機能を使用して作成した箇所が削除されることはありません。
・

 

カーブトレースのPush/Shove操作はできません。
・

 

オプション機能を使用したデータは、ロック、固定

 

あるいは保護されません。
・

 

ティアドロップがダイナミックティアドロップなどで編集された場合は削除されます。

対象コマンド：
Route> MultipleHug Traces, Route> Teardrops& Breakout Traces> Teardrops, Route> Interactive> Plow

・

 

Advanced Technology Pro（RF）

このライセンスを有効にすることで、アジレントADS製品と連携してRF設計が可能となります。

使用可能な機能：
・

 

RF形状のパラメータ設定
・

 

RFエレメントのインタラクティブ編集
・

 

RF回路のAuto arrangement（自動接続）
・

 

パラメータに基づいたビア配置

対象コマンド：Setup> RF, View> Toolbars> RF(以下ツールバー内のコマンド), Display Control> Groupsタブ
関連資料：

 

RF in DxDesigner-Expedition Flow User’s Manual (rf_ee_useref.pdf)
RF Design Tools User’s and Reference Manual Supplement (rfads_ref.pdf)

・

 

Advanced Interconnect

 

Option

このライセンスを有効にすることで、マイクロビア（ビルドアップビア）を使用したデザインの自動配線が可能となります。
マイクロビアが定義されたデザインにて、Advanced Interconnect ライセンスを無効の状態で自動配線（Auto Route）ダイアロ

 

グを起動すると、以下エラーメッセージが表示され、Auto Routeは実行できません。

Cannot Auto Route design with Microvias

 

spans because the Advanced Interconnect license is not available.

対象コマンド：

 

Route> Auto Route
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・

 

Design

 

for Fabrication Option (DFF)

このライセンスを有効にすることで、DFF（製造性）検証が可能となります。

使用可能な機能：
・

 

バッチDFF検証
・

 

DFFエラーのリスト表示（Review Hazards）
・

 

DFFエラー毎のカラー設定（Display Control）

対象コマンド：Analysis> DFF, Analysis> Review Hazards, 
View> Display Control

・

 

Fablink XE Option

このライセンスを有効にすることで、Expedition PCB上でFablink XE機能が使用可能となります。

使用可能な機能：
・

 

製造データ（Gerber 又は

 

NCドリル）のインポート
・

 

カッパーバランシングデータの作成
・

 

詳細ビュー（Detailed View）の表示
・

 

PDFの出力
・

 

同種共取り基板の作成

 

※Fablink XEエディタを使用

対象コマンド：File> Import> Gerber/Drill, Output> Manufacturing Output Validation, Output> PDF
Planes> Copper Balancing, Edit> Place> Detailed View

関連資料：

 

Fablink XE Pro User’s Guide-Chapter9 (exp_flxep_user.pdf)

※Drawing Editor

 

（プログラム> Mentor Graphics SDD> Manufacturing）は、Fablink XEライセンスを消費します。

・

 

Fablink XE Pro

 

Option

このライセンスを有効にすることで、Expedition PCB上でFablink XE Pro機能が使用可能となります。

使用可能な機能：
・

 

製造データ（Gerber 又は

 

NCドリル）の差分チェック
・

 

XE Neutral ファイルの出力
・

 

GDSⅡファイルの出力
・

 

IPC-D-356Bファイルの出力
・

 

マスク生成（エレメントの論理演算）
・

 

異種共取り基板の作成

 

※Fablink XEエディタを使用

対象コマンド：Output> Manufacturing Output Validation, Output> XE Neutral File, Output> Mask Generator
File> Export> GDSⅡ, File> Export> IPC-D-356B

関連資料：

 

Fablink XE Pro User’s Guide-Chapter9 (exp_flxep_user.pdf)
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・

 

IFF Interface

 

Option

このライセンスを有効にすることで、アジレントADSで作成されたIFF（Intermediate File Format）のインポート・エクスポートを
可能とします。
対象コマンド：File> Import> IFF, File> Export> IFF

・

 

Reusable Block Option

このライセンスを有効にすることで、リユースブロックを利用した設計が可能となります。Reusable Blockのライセンスは、Library 
Manager 及び

 

Expedition PCBで消費されます。

使用可能な機能：
・

 

リユースブロックの作成と管理

 

※Library Managerエディタを使用
・ リユースブロックの配置
・ リユースブロックの展開

対象コマンド：Place> Place Parts and Cells> Criterion: Reuse Block, Edit>  Modify> Flatten Reuse Block
Library Manager> Tools> Reusable Block Editor

関連資料：

 

Expedition PCB User’s Guide-Chapter8 (exp_gd.pdf)

・ TeamPCB Option

このライセンスを有効にすることで、レイアウトデザインの分割設計が可能となります。

使用可能な機能：
・

 

デザインの分割（Split）
・

 

分割したデザインの結合（Join）
・

 

分割デザインのリアルタイム更新

対象コマンド：File> Split Design, File> Joint Design
File> Update from Other partitions

関連資料：

 

Expedition PCB User’s Guide-Appendix D
(exp_gd.pdf)

・

 

Xtreme

 

Design Client

このライセンスを有効にすることで、１つのデザインに対して同時に複数クライアントがアクセスできる同時設計を可能とします。
XtremePCB Clientライセンスを使用することにより、クライアントとして使用するXtreme

 

Design Client（XDC）を起動します。
尚、クライアントで指定するデザインは、事前に

 

Xtreme

 

Design Session（XDS）によりサーバー起動していることが前提となります。
関連資料：

 

Expedition PCB User’s Guide-Appendix E (exp_gd.pdf)

Client-

 

1

Client-

 

2
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・

 

Topology Planner

このライセンスを有効にすることで、バステクノロジーを使用したTopology Plannerが使用可能となります。バスはグルーピング

 

したネットであり、CESや回路図で定義することができます。Topology PlannerではBus Pathを使用してバス経路のプランニン

 

グを行います。

使用可能な機能：
・バス配線の経路

 

及び

 

シールド配線の指定
・ターゲットエリアの配置

対象コマンド：Place> Bus Path, Route> Target Areas

・

 

Topology Router

このライセンスを有効にすることで、バステクノロジーを使用したTopology Router（自動配線）が使用可能となります。Bus Path

 

により定義されたバス経路の自動配線を行います。

使用可能な機能：
・バスの自動配線
・シールドの発生
・Target Areaに対する配線

対象コマンド：Auto Route> Pass Type: Bus Route, Bus Shielding, Straight Line Interconnects (SLI)

Topology Plannerによるプランニング Topology Routerによる自動配線
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プロジェクトインテグレーションと
フォワードアノテーション・バックアノテーション

Chapter2: Process Flow
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◆プロジェクトインテグレーションとフォワードアノテーション

Expedition PCBで設計作業を開始するには、ネットの情報とライブラリ情報をデザインファイルに取り込む必要があります。

 

ネットの情報を取り込むためには、その情報の入手先となるiCDBやネットリストファイルまでのパス情報が必要となります。

 

設計に必要なライブラリ情報の入手先については、プロジェクト作成時にセントラルライブラリのパスを設定したことで、使

 

用するライブラリのパスに変更が無い限りは設定をし直す必要はありません。ネット情報のパス設定は、プロジェクト作成時

 

にセントラルライブラリパスを設定するために表示されたエディタメニューにて行ないます。

このメニューは、Expedition PCBエディタより起動されるプロジェクトインテグレーションメニューより開くことができ、エディタ

 

起動後の最初の作業としてネット情報までのパス設定を行なう必要があります。

プロジェクトインテグレーションメニューは、プルダウンメニューSetup＞

 

Project Integrationより起動します。
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◆ネット情報のパス指定

ネット情報のパスを設定するためのプロジェクトエディタメニューを表示するには、プロジェクトインテグレーションメニューの

 

Project file項目右側にあるエディットボタンを選択して下さい。

このボタンを選択。

ネット情報へのパス設定は、エディタメニューのNetlistタブメニューにて行ないます。Netlistタブを選択して表示を切り替え、

 

Type項目でその情報ソースの種類を選択します。DxDesignerやDesign Captureが選択されている場合は、回路図側で作成

 

されたIntegrated Common Database（iCDB）までのパスがデフォルトで設定されておりますので、変更する必要はありません

 

。Keyin Netlistなどのネットリストフローを使用する場合は、該当のネットリストタイプを選択して、ネットリストが格納されているパ

 

スを設定下さい。

種類選択。

ネットリストのパス設定にはブラウズ機能を使用し

 

ます。ネットリストの保管場所についての指定は

 

特にありませんが、表示されたブラウズメニューが

 

デフォルト参照するLogicフォルダ内に.kynの拡

 

張子を付けて収納することを推奨します。

パス指定。

Note
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◆プロジェクトインテグレーション／Project Integration

プロジェクトインテグレーションコマンドは、回路図・CES・PCBデザイン間の連携を行い

 

又

 

各ツール間のインテグレーション
状況をインジケータで確認することが可能となります。

フロンドエンド（回路図）でのCESの変更情報

バックエンド（レイアウト）でのCESの変更情報

バックエンド（レイアウト）での変更情報
※ゲート・ピン

 

スワップ情報、REF番号の変更等

フロンドエンド（回路図）での接続情報の変更情報

回路図でネット等の接続情報に変更があった場合、インジケータが黄色（amber）となりForward Annotationが要求されます。
その際は、インジケータをクリックすることでForward Annotation処理が実行され、回路図と同期することができます。

フォワードアノテーションが正常終了すると、全てのインジケータ
が青くなり、設計作業が行なえる状態になります。
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フォワードアノテーションに失敗すると以下のようなメッセージが表示されますので、ファイルビューワでログに記されたエラーメッ

 

セージの内容を確認して下さい。

上記のエラーでは“74LS244”という部品情報が欠落していることを指しており、足りないとされるこの部品情報をライブラリに

 

追加し、再度フォワードアノテーションを実行してやることでエラーは解消されます。フォワードアノテーションが正常に終了

 

しなければ、設計作業を進行することはできませんので、発生するエラーに応じた対処を施し、正常終了するまでフォワー

 

ドアノテーションをくり返し実行して下さい。

以下メッセージはワーニング（警告）があることを示しています。ログ確認後、問題が無いと判断した場合は、そのまま設計を

 

進めることができます。
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◆フォワードアノテーションのオプション

フォワードアノテーションのオプションには幾つかのオプション設定が存在します。このオプションは、主にデザインファイル上に

 

既にデータが存在する2回目以降のための設定項目となります。各設定では、新たに取り込まれる情報に対し、既存データを如

 

何に取り扱うのかを設定することができます。

英字のみのRefDesを許可する否かを設定。
OFF時は、英字のみのRefDesは“英字＋数字”に変更されます。

Trace削除オプションの設定。
・Remove floating trace & vias：チェック時、浮き配線や浮きビア

 

を削除します。（Net0は対象外）
・Remove hangers：リムーブハンガーコマンドを実行して、ピン間

 

で未結線の配線を削除します。
※新しいネット情報に対してショート扱いとなる既存配線につい

 

ては、全てが無条件で削除されます。

基板上の未使用部品の扱いを設定
・Change to Spares：

 

未使用部品をスペア部品として保持します。
・Delete：

 

未使用部品を削除します。

未使用ピンに対して単一ピン信号名を付与し、Fanoutを可能と

 

するか否かを設定します。

回路図のRefDesスワップ情報の扱いを設定。
ON時、基板上に配置された部品をスワップして、配線を保持します。
OFF時、基板上に配置された部品をスワップせず、配線を削除します。

ローカルライブラリの扱いを設定
・Only exact missing library data ：欠落している情報のみをセントラルライブラリよりコピーします。
・Update local libraries with newer Central Library data

：ローカルより新しい日付の情報のみをセントラルライブラリよりコピーします。
・Rebuild local library data ：全ての情報をセントラルライブリから上書きコピーします。

その際、ローカルのみ存在する部品は保持します。
・Delete local data ：全ての情報をセントラルライブリから上書きコピーします。

その際、ローカルのみに存在し 且つ 未使用部品は削除されます。
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◆バックアノテーション／Back Annotation

バックアノテーションコマンドは、レイアウトデザインと回路図データベースとの比較を実施します。回路図ツールではバックアノテ

 

ーションデータを取り込むかどうかの制御が可能であり、そのステップは回路図での設定とプロジェクトインテグレーション設定に

 

より管理されます。特定のコマンドはバックアノテーションの許可が必要となる為、回路図ツールにてバックアノテーションを許可

 

するまで、使用できない状態（Disable）となります。

以下のコマンドは、上記オプションがOFFの時にはDisableとなり実行できません。

 

※ネットリストタイプにより動作は異なります。
Place＞

 

Automatic＞

 

Swap by Part Number
Route＞

 

Swap＞

 

Pins
Route＞

 

Swap＞

 

Gates
ECO＞

 

Renumber Ref. Des.
Planes＞

 

Routed Plane Pins
Setup＞

 

Editor Control＞

 

Place＞

 

Rooms and Clusters 

レイアウト上でピンスワップ等の操作が行われた場合、インジケータが黄色（amber）となりBack Annotation が要求されます。
その際は、インジケータをクリックすることでBack Annotation処理が実行され、回路図と同期することができます。

バックアノテーション

 

コマンドが禁止された状態

以下のコマンド実行後は、データ保存時に自動的にバックアノテーションが実行される場合があります。
※ネットリストタイプにより、動作が異なります。
Place＞

 

Automatic＞

 

Swap by Part Number
Route＞

 

Swap＞

 

Pins
Route＞

 

Swap＞

 

Gates
ECO＞

 

Renumber Ref. Des.
Planes＞

 

Routed Plane Pins
Setup＞

 

Editor Control＞

 

Place＞

 

Rooms and Clusters 

以下のコマンド実行後は、バックアノテーションは要求されませんが、データ保存時に回路図へ送信される場合があり

 

ます。※ネットリストタイプにより、動作が異なります。
Setup＞

 

Setup Parameters
Setup＞

 

NetClass

 

& Clearances
Setup＞

 

Net Properties
Route＞

 

Netline

 

Order
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◆CESとのインテグレーション／CES Integration

CESで設定した各種制約条件は、通常

 

Forward AnnotationやBack Annotationを行うことで同期することが可能です。しかしなが

 

らこれらのアノテーション処理は、長時間の処理を必要としたり、デザインの変更を余儀なくされたりといった状況が考えられます

 

。このような状況を考慮して、回路図において接続情報に変更が無い場合は、CES情報のみの同期を可能とします。

◆回路図設定とインテグレーション動作の関係

回路図（DxDesigner）の設定で、Forward Annotation・Back Annotationが許可されていない状況では、インジケータが赤となり、

 

アノテーション処理が実行できない状況をメッセージします。

・回路図のCESで制約条件が変更された場合

回路図の設定で、Forward Annotation・Back 
Annotationが禁止された状態。

・回路図に変更情報はあるが、Forward Annotationが許可されていない場合

・レイアウトに変更情報はあるが、Back Annotationが許可されていない場合

CESを有効としていないデザインでは、メニューがDisableとなり使用できません。

このボタンをクリックすることで、回路図制約条件を同期します。
レイアウトに存在しないネット等の情報に関する制約条件が変

 

更された場合は、Forward Annotationが必要となります。

Note
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◆インジケータライト／Indicator Lights

インジケータライトはIntegrated Common Database

 

(iCDB)を使用した際に、Front End（回路図）とBack End（レイアウト）間の接続

 

情報

 

及び

 

CES（制約条件）情報の同期ステータスを表示します。

①フロンドエンド（回路図）の接続情報との同期ステータス

①フロンドエンド（回路図）の接続情報との同期ステータス

緑色－

 

接続情報に関するPending情報はありません。同期が取れた状態で、正常にシンクロしています。

黄色－

 

回路図で接続情報が変更されました。クリックすることで、Forward Annotation を実行します。

赤色－

 

回路図で接続情報が変更されました。しかしながら回路図でForward Annotationが許可されておらず、
Forward Annotationが実行できない状態です。

②フロンドエンド（回路図）のCESとの同期ステータス

緑色－

 

CES（回路図）に関するPending情報はありません。同期が取れた状態で、正常にシンクロしています。

黄色－

 

回路図から起動されたCESにて、制約情報が変更されました。クリックすることで、回路図の制約条件を取り込みます。

③バックエンド（レイアウト）のCESとの同期ステータス

緑色－

 

CES（レイアウト）に関するPending情報はありません。同期が取れた状態で、正常にシンクロしています。

黄色－

 

レイアウトから起動されたCESにて、制約情報が変更されました。クリックすることで、レイアウトの制約条件を取り込み
ます。

 

※CESを立ち上げた状態で、リアルタイムに変更した制約条件を反映します。

③バックエンド（レイアウト）のCESとの同期ステータス

②フロンドエンド（回路図）のCESとの同期ステータス
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◆ネットリストタイプ

EE2007.1バージョンのExpedition PCBがサポートするネットリストタイプはKeyin Netlist、CAE Netlist、Foreign iCDBとなります。

 

ネットリストタイプにあるDxDesignerやDesign Captureは、新規プロジェクトの作成時のみ使用されます。

ネットリスト

 

タイプを指定します。

・Keyin Netlist／キーインネットリスト

Keyin Netlistは、ASCIIフォーマットで記載された回路接続情報となります。以下のオプション“Use CES for constraint entry”
をチェックすることで、Keyin Netlistフローにおいても、CESが使用可能となります。

チェックをONとしてCESを有効とする場合、左図の警告が表示

 

されます。
・CESを使用すると、解除することはできません。
・Net Classes & ClearancesやNet Propertiesは使用できません。

・事前にバックアップデータを作成することを推奨します。

・CAE Netlist

CAE Netlistは、%symbolセクションを持つことを除くとKeyin Netlistと殆ど同じASCIIフォーマットのファイルとなります。

・Foreign iCDB

Foreign integrated Common Database (iCDB)は、DxDesigner及びDesign Captureにより作成されます。このForeign iCDBフロ

 

ーは、回路図とレイアウト（Expedition PCB）が異なる場所で設計されるといったメインプロジェクトから分離した環境でレイアウト

 

設計を行う場合に使用されます。また上記のようなASCIIフォーマットのNetlistとは異なり、CESで設定した制約条件の使用が

 

可能となります。
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◆Keyin Netlistのサンプルフォーマット（補足）

;;▲V4.1.0
%net
%Prior=1
%page=0001
¥NetName1¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥……
* ▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥……
* ▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥……
¥NetName2¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥……
¥NetName3¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥……
¥NetName4¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥……
¥NetName5¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥▲¥RefDes¥-¥Pin¥……

・
・
・

%Part
¥PartNumber1¥▲¥RefDes¥▲¥RefDes¥▲¥RefDes¥▲¥RefDes¥…
¥PartNumber2¥▲¥RefDes¥▲¥RefDes¥▲¥RefDes¥▲¥RefDes¥…
¥PartNumber3¥▲¥RefDes¥▲¥RefDes¥▲¥RefDes¥▲¥RefDes¥…
¥PartNumber4¥▲¥RefDes¥▲¥RefDes¥▲¥RefDes¥▲¥RefDes¥…
¥PartNumber5¥▲¥RefDes¥▲¥RefDes¥▲¥RefDes¥▲¥RefDes¥…

・
・
・

※▲マークは、全てスペースを表わします。

説明）
・先頭の;;▲V4.1.0は、ヘッダとなり固定値。
・%netは、下にネットの情報が記されることを宣言し、ネット情報の先頭に必要。
・%Prior=1と%page=0001は、接続の強さや回路図ページ番号示すが、Expedition PCBでは設定効果が無いので、%net以下に

 

上記のように１つずつ追加すればいい。
・¥NetName1¥は、ネット名を示し、¥の間にネット名を入力。
・¥RefDes¥-¥Pin¥は、結線ポイントを示し、RefDesがリファレンス番号でＰｉｎがピン番号となる。
・¥RefDes¥-¥Pin¥の形で１つの結線ポイントを示し、スペースで区切って列挙する。
・行を分ける場合は、同じ¥NetName1¥を追加するか＊で代用することもできる。
・%Partは、下に部品情報が記されることを示し、部品情報の先頭に必要。
・¥PartNumber1¥は部品名を示し、¥の間に部品名を入力。
・¥RefDes¥は部品のリファレンス番号を示し、複数の場合にはスペースを間に入れて列挙します。
・行を分ける場合はネットと同様の手法となる。

注意）
・TAB文字は使用できません。
・ピン番号のPrefixに小文字は使用できません。例として、m10やn10は不可。M10、N10とすること。
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プロジェクトとレイアウトデータの分離
（外部でのレイアウト設計）

Chapter2: Process Flow
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◆Foreign iCDBを使用した設計フロー

Foreign iCDBを使用することにより、メインプロジェクトから離れた場所でのレイアウト設計を可能とします。これを実施するには、

 

回路図（DxDesigner及びDesign Capture）から接続情報と制約情報を含む“Foreign Database”を出力する必要があります。

Foreign iCDBを使用して別サイトで新規にレイアウト設計を行うには、Job Management Wizardを使用してプロジェクトを作成し、

 

ネットリストとして出力したForeign iCDBを指定することで可能となります。但し、ライブラリに関してはメインプロジェクトで使用して

 

いるセントラルライブラリと同じライブラリを使用する必要があります。

また別サイトのレイアウト設計で行われた“REF番号変更やスワップ”といったバックアノテーション情報は、Foreign iCDBに保存さ

 

れますので、それをメインプロジェクトの回路図へインポートすることにより反映することができます。また回路図で変更があった場

 

合は、再度

 

Foreign iCDBを出力して別サイトへオーバーライトすることで、レイアウトと同期可能となります。

Foreign iCDBの運用フロー

回路図
DxDesigner

レイアウト
Expedition PCB

iCDB
コモンデータ

 

ベース

Expedition PCB

メインプロジェクト

 

メインプロジェクト

別サイトにある

 

レイアウト設計チーム

 

別サイトにある
レイアウト設計チーム

Expedition PCB
(変更データ)

変更作業

Back Annotation情報を含むForeign iCDBを

インポートすることでメインプロジェクトへ反映可能。

Foreign
iCDB

Foreign
iCDB(変更データ）

Foreign
iCDB

コピー
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次にForeign iCDBを使用した設計フローの手順を記載します。

①

 

Foreign iCDBのExport（出力）

DxDesignerでは、File> Export> Foreign Databaseコマンドを使用して、Expedition PCBで使用するForeign iCDBを出力します。

出力フォルダを指定することでPackagerが実行され、正常に終了した場合は、以下のようなメッセージが表示されます。

指定フォルダに、プロジェクトファイル（.prj）、PCBフォルダ、foreign iCDBフォルダが出力されます。

PCBフォルダは、既にメインプロジェクトに

 

Expedition PCBデータが存在する場合のみ

 

出力されます。

メインプロジェクトにExpedition PCBデータが存在しない場合は、

 

File> Export> Foreign Databaseコマンド実行後、
Layout Templateの指定を促すメッセージが表示されます。任意のTemplateを指定後、プロジェクトファイル（.prj）、foreign iCDB

 

フォルダが出力されます。
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② Expedition PCBデータの作成 及び 編集

既にメインプロジェクトにてExpedition PCBデータが存在する状態でForeign Databaseを作成した場合は、出力したフォルダを別

 

サイトにコピーすることで、PCBフォルダに存在するレイアウトデータの起動が可能となります。但し、メインプロジェクトと同じセント

 

ラルライブラリが必要となるため、ライブラリ格納パスが異なる場合はパス指定を行ってください。

新規にExpedition PCBデータを作成する場合は、Job Management Wizardを使用して以下手順で作成を行います。

出力したForeign Databaseに存在

 

するプロジェクトファイルを指定。

セントラルライブラリを指定。
メインプロジェクトと同じライブラリであること。

指定したフォルダにExpedition PCBデータを

 

作成します。

作成したExpedition PCBデータの起動後、初めに必ずForward Annotationを実行してください。

ボタンクリックにより、Forward Annotationを実行。

以上の操作により、Foreign iCDBを使用したExpedition PCBデータの作成が完了し、メインプロジェクトから分離した別サイトでの

 

レイアウト設計が可能となります。
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尚、Foreign Databaseを出力することで、メインプロジェクトに存在するExpedition PCBデータは以下のメッセージが表示されて、

 

オープンすることは出来ません。
※別サイトで設計したレイアウトデータをメインプロジェクトへマージする方法は、⑤を参照ください。

③

 

Foreign iCDBのImportによるバックアノテーション

Expedition PCB－CESでの制約条件の編集やREF変更・ピンスワップといったバックアノテーション情報を回路図に取り込むには

 

、DxDesignerにてFile> Import> Foreign Databaseコマンドを実行します。

Expedition-CESで制約条件を追加。

Expedition PCBでECO>Renumber 
RefDesにより、REF番号を変更。

Expedition PCBで上記のような変更を実施後にSaveコマンドを実行することにより、変更情報がForeign iCDBに反映されます。こ

 

の情報を含むForeign iCDBフォルダをメインプロジェクトへコピーして、インポート処理を実行します。
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回路図にレイアウトで行った変更情報をアップデートするために、File> Import> Foreign Databaseコマンドを実行します。

別サイトからコピーしたForeign iCDBが格納されたフォルダ（Foreign iCDBフォルダの上位フォルダ）を指定ください。
“The design is successfully imported”のメッセージが表示されると、正常にアップデートが完了したことになります。
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④

 

回路変更のアップデート方法

回路図でネット名等の接続情報やCESの制約条件が変更となった場合は、①の手順と同様にFile> Export> Foreign Database
コマンドを再度実行ください。2回目以降は以下のように、オーバーライトとなる旨、メッセージが表示されます。

以降は出力したフォルダに存在するForeign iCDBフォルダのみコピーして、別サイトにある同フォルダへ上書きします。
その後、前回同様にExpedition PCBにてForward Annotation処理を実行してください。

ボタンクリックにより、Forward Annotationを実行。

Forward Annotation後、回路図で変更したネット名

 

が反映されます。
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⑤ その他

・ワーニングメッセージの表示

Foreign Databaseのインポートを2度実行した場合、以下メッセージが表示される場合があります。指定したForeign Databaseで誤

 

りがなければ、Yesを選択して処理を実行ください。

・Foreign iCDBを使用したレイアウト情報のマージ方法

Foreign Databaseを出力してメインプロジェクトから分離してレイアウト設計を実施した場合、メインプロジェクトに存在する

 

Expedition PCBデータはオープンできない状態となります。別サイトで行ったExpedition PCBデータをメインプロジェクトに反映す

 

るには、以下操作が必要となります。

メインプロジェクトのプロジェクトファイル（.prj）から、KEY ForeignICDBExported

 

“1”

 

と記載された行を削除します。

・CESの制約条件の整合について

回路図からForeign Databaseを出力後、回路図及びレイアウトの双方で同じ箇所の制約条件を変更した場合、どちらを優先する

 

かは、DxDesignerのSetup> SettingのConflicts resolution設定に依存します。以下のようにFront End always winをチェックした場

 

合は、Foreign Databaseをインポートした際には回路図のCES情報を優先します。

プロジェクトファイルからこの行を削除。
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Foreign iCDBを使用して設計したExpedition PCBデータのフォルダの“Layout”フォルダを、メインプロジェクトのLayoutフォルダ

 

へ上書きコピー操作を実行します。

メインプロジェクトのLayoutフォルダを更新。

その後、メインプロジェクトのExpedition PCBを起動すると、Forward Annotationが促されますので、Yesを選択して処理を実行し

 

ます。以上の操作にて、メインプロジェクトへ最新レイアウトデータのマージが完了します。
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◆ドッグ解除／Undock ＆Dock

Undock機能を使用することで、iCDB（Integrated Common Database）を介してリンクしている回路図データから、Expedition 
PCBデザインを分離することができます。これにより、メインプロジェクトから離れた場所でのレイアウト設計を可能とします。

クロスプロービング用に回路図データ
を含めたUndockデータを作成します。

Undockデータを作成するフォルダを指定。

Undockフォルダに含まれるデータは以下となります。
・

 

back_end

 

フォルダ

 

：Expedition PCBデータ。
・

 

database フォルダ

 

：CESデータ

 

及び

 

回路図データ（Include data to enable crossprobingがチェック時）
・ *.prj ファイル

 

：プロジェクトファイル
・

 

UnDockedBackEnd.log

 

：ログファイル

メインプロジェクト内のExpedition PCBデータをOPENした際に、Undockデータが存在すると以下メッセージが表示されます。

“いいえ（No）”を選択した場合、以下メッセージが表示され、Read Onlyモードでデザインが起動します。

“はい（Yes）”を選択した場合、以下ダイアログが表示されDockするデータを選択します。Dockを実行することで、Undockデー

 

タとして分離した環境で編集されたPCBデザインを正規データとして、メインプロジェクトへ反映します。

Undockデータを全て解除します。（Read Onlyモードの解除）

複数のUndockデータが存在

 

する場合は、Undockデータを

 

選択して、Dockを実行します。
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複数のUndockデータが存在した場合、1つのUndockデータのみがメインプロジェクトのPCBデータへ反映することできる旨、

 

以下メッセージが表示されます。指定したUndockデータで間違いない場合は、“はい（Yes）”を選択することでDock（マージ）
処理が行われます。

Undock/Dock機能は、iCDBを使用するデータのみが対象となります。ネットリストを使用したデザインでは使

 

用できません。

Undock/Dockの運用フロー

回路図
DxDesigner

レイアウト
Expedition PCB

iCDB
コモンデータ

 

ベース

Expedition PCB

メインプロジェクト

 

メインプロジェクト

別サイトにある

 

レイアウト設計チーム

 

別サイトにある
レイアウト設計チーム

Expedition PCB

 

変更データ

変更作業

Undockによりコピー

Dockによりマージ

Undockデータが存在する間に回路図が変更された場合、Dock処理が完了後にForward Annotationを促すメッセージが表示

 

されます。“Yes”を選択しForward Annotationを実行して、回路変更情報を取り込む必要があります。

Note
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ローカルライブラリ

Chapter2: Process Flow
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◆ローカルライブラリ

Expedition PCBでは、設計に必要なライブラリ情報を、必ずローカルライブラリとして保有します。保有するライブラリ情報は、

 

パッドスタック、セル、PDBの3つの情報となり、フォワードアノテーションの際にマスターとなるセントラルライブラリからコピーさ

 

れます。これらローカルライブラリへのアクセスは、Expedition PCBエディタのプルダウンメニューからのみ行なえます。

Setup以下に収納される、Cell Editor、Padstack Editor、PDB Editorの各コマンドを選択することで、ローカルライブラリを編集

 

するための各エディタが起動します。

・セルエディタ／Cell Editor ・パッドスタックエディタ／Padstack Editor

・パーツエディタ／PDB Editor

Note

・各エディタは、ライブラリマネージャ側から起動されるものと

 

全く共通のGUIで構成されています。起動された各エディタ

 

では、このプロジェクトが保有するローカルライブラリへの作

 

業のみが許可され、ライブラリマネージャ時のような他のパー

 

ティションへの作業は一切行なえません。
・ローカルライブラリ内の情報は、常にデザインファイルとリン

 

クされており、ローカルライブラリへの修正内容は直接デザイ

 

ンファイル側に反映されますので、ローカルライブラリの修正

 

作業には注意して下さい。
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◆ライブラリサービス／Library Services

フォワードアノテーションでコピーされるライブラリ情報は、ネット情報内にあるパッケージ部品に限定されます。従って、ネット

 

情報内に記されないビアやメカニカル及びグラフィックセルといった情報は、ローカルライブラリの各エディタを使用して個別

 

に作成するか、ライブラリサービスを使用してマスターとなるセントラルライブラリより個別にコピーする必要があります。

ライブラリサービスを使用してローカルにコピーする場合、Setupプルダウン下にあるローカルモードのライブラリサービスを使

 

用します。

ローカルモードでは、セントラルライブラリを指定できません。
Setup＞ Central Library Assignmentで指定したライブラリの

 

みが対象となります。

青字で表示されたアイテムは、既にローカルライブラリとして

 

保持しているアイテムとなります。
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Chapter 3
Design Process-Verifying Parameters

本章はExpedition PCBを使用して設計する際に必要となる各種パラメータ設定 と

 

各設計工程で行う手順を以下

 

のように5つのパートに分類して説明しております。

１．

 

Verifying Parameters（パラメータ設定）
２．

 

Placement（配置プロセス）
３．

 

Routing（配線プロセス）
４．

 

Reviewing Design（検証プロセス）
５．

 

Postprocess（出力プロセス）

概要
Verifying Parameters（パラメータ設定）では、デザインを設計するのに必要となる各種パラメータ設定 とどのような

 

制約条件と設計でデザインを作成するかを決定する手法を説明します。

・

 

セットアップパラメータ

 

－ 127P
・

 

ネットクラスとクリアランス

 

－ 139P
・

 

ネットプロパティと制約条件の設定

 

－ 149P
・

 

エディタコントロール

 

－ 158P
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セットアップパラメータ

Chapter3: Design Process-Verifying Parameters
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◆セットアップパラメータ／Setup Parameters

設計データに対する基板層数/使用ビア等に関する設定は、各設計データ毎にセットアップパラメータにて行ないます。この

 

セットアップパラメータの各種設定内容は、新規作成の際に使用するテンプレートデザイン内に予め設定しておくことが可能と

 

なります。このセットアップパラメータは、エディタプルダウンのSetup＞ Setup Parametersコマンドで起動します。

セットアップパラメータは5つのタブで構成されており、それぞれのタブで以下のような内容の設定を行います。

General：
基板層数、ユーザーレイヤ（作画専用）、テクノロジタイプ、設計に使用する単位系、テストポイントに関する設定。

Vias Definitions：
設計に使用するビアのパッドスタック名と、ビアスパン（層ペア）の設定。

Via Clearances：
各ビアスパン毎の異電位/同電位間におけるクリアランス設定。

Layer Stackup：
絶縁層や銅箔の厚み、導電率や誘電率といった基板の実パラメータの設定。

Buried Resistor,  Rise Time：
埋め込み部品（パターン抵抗）、部品種別毎の立ち上がり時間に関する設定。
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◆全般／General タブ

①

 

基板の物理的な層数を設定します。Remap Layersボタンで、既存の層構成を変更（2層と5層を入れ替えるなど）すること

 

ができます。また、層数を変更した場合にも、Remap Layersを使用して変更後の層構成を設定します。

層数を途中変更した場合には、層のリマッピング作業が必要となります。
増減させた層に対し、前の各層をマッピングして下さい。

②

 

設計に使用するパッドスタックテクノロジを決定します。ドロップダウンリストには、パッドスタックに定義された全ての
テクノロジがリストされますので、使用するパッドスタックテクノロジを選択します。尚、ここにリストされるパッドスタック
テクノロジは、ローカルライブラリが保有するものとなりますので注意して下さい。

③

 

設計に使用する単位系を設定します。Display Unitsのドロップダウンリストより、使用する単位系を選択して下さい。
尚、リスト内のThousandthsは、インチの1/1000を表わすミルとなります。

④

 

このリストでは、ユーザー定義の作画レイヤを設定します。Newボタンを選択することでエントリがリストに追加されま
す。レイヤの名前を変更する場合には、リスト内を直接選択して編集して下さい。

このボタンでレイヤを追加。

名前は直接キーインして変更。

①基板の層数の設定

②パッドスタックテクノロジ
の指定

③単位系の設定

④ユーザー定義レイヤの
追加、削除、編集

⑤テストポイントの設定
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⑤

 

このデザインファイル上で使用するテストポイントに関する設定を行ないます。

使用するテストポイントのセル名を指定。
（ローカルライブラリ内のセルのみがリスト表示されます。）

テストポイントに使用するREF番号のPrefix

テストポイントを配置する際に使用するグリッド値
（Noneはグリッドレスとなります。）

テストポイントを配置する際に有効とする配置面

テストポイントを配置の際に、部品外形領

 

域を禁止領域とします。

テストポイントを使用しない場合には、この項目への設定は必要ありません。

Note
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この項目を選択することで、ローカル及びセントラルライブラリ内
のビアのパッドスタックがリストされます。表示されたリストより、
使用するビアを選択して下さい。

◆ビア定義／Via Definitions タブ

設計に使用する基本的なビアの条件を設定する項目となります。

こちらの各項目では、ビアに対する容量や遅延値といった情報 及び 設

 

計時にこのビアが使用するグリッドの設定が行なえます。
※CapacitanceとInductanceは、解析ツールでのみ使用されます。

こちらの項目では、設定するビアの層間情報（ビアスパン）をグラフィ
カルに設定します。画面上の緑の部分をクリックすることで、層の追加

 

、削除を行うことができます。

ビルドアップ層にはBuildupを定義します。

Skip Viaの設定

Internal(内層)パッドに関する設定

※こちらの項目は、ビルドアップ層の定義を行います。
ビルドアップ層を定義した自動配線を行うには、Advanced Interconnect Optionライセンスが別途必要となります。
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・ビアスパンの追加と削除

設計に使用するビアスパンを追加する場合には、リスト右上にあるNewボタンを選択します。空のエントリがリスト内に追加され

 

るので、使用するビア形状などの情報を設定します。

選択したビアをリストより‘削除します。

ビアをリストへ追加します。

設計に使用する全てのビアスパンを、リスト内に用意します。

・Skip Viaの設定

3層以上に渡るスパンをもつビアのみにチェックが可能であり、チェックされたビアは最外層のみに接続が許可され、内層パッ

 

ドへの接続が禁止されます。

・Use mount and opposite side pads for start and end layers of blind and buried vias

 

の設定

このオプションにチェックを入れた場合、パッドスタックのMount sideとOpposite sideに定義されているバッドを、ブラインドビア

 

やBuriedビアの最外層のパッドとして使用することが可能です。

Skip Via項目にチェックされたこのビアは、
2層と5層のみ接続可能となり、3層と4層の
接続は禁止されます。

Skip Via を使って配線したあとで、Setup Parameters ダイアログでSkip Via のチェックが外された場合、デザイン上

 

に配置されているそのVia はすべてSkip Via として扱われなくなります。また逆に、通常のVia を使って配線したあ

 

とで、SetupParameters ダイアログでSkip Via にチェックが入れられた場合、デザイン上に配置されているそのVia 
はすべてSkip Viaとして扱われます。これにより、本来許可されていない接続がSkip Via に対して行われている状

 

態になる可能性がありますが、システムがトレースを自動的に削除して接続を切り離すことはありません。このような

 

場合は、以下の警告メッセージを表示し、バッチDRCの実施を促します。※バッチDRCでSkip Viaの内層に対す

 

る接続の検出が可能となります。

ブラインドビアの最外層パッドとして、Mount 
sideとOpposite sideのパッドを使用します。

例）

 

2－5層のブラインドビアにて
・このオプションがOFFの場合は、全てのパッ

 

ドにInternalパッドが使用されます。
・このオプションがONの場合は、

 

Mount side 
とOpposite sideのパッドを使用し、3－4層の

 

みInternalパッドを使用します。

Note
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◆ビアクリアランス／Via Clearances タブ

登録されたビアスパンに対する、クリアランス条件を設定します。

Same Netでは同電位におけるビアスパン毎

 

のクリアランスを指示できます。ここでのクリ

 

アランスの考え方は下図のようなType項目

 

における最小クリアランスの値となります。

Same Netでは同電位間におけるビアクリアランスの定義を行ないます。同電位間で指示を与える場合、その基準をType項目

 

で指示します。

P ：

 

ビアの中心から中心までの最低間隔距離を指示
PE ：

 

パッドの縁と縁の最低クリアランス
HE ：

 

ホール（穴）の縁と縁の最低クリアランス
C ：

 

デフォルトクリアランス以上に近接する場合は中心同士を無条件で重ね合わせる
PEC ：

 

指示したパッドエッジ間のクリアランス以下に近接する場合は重ねる
HEC ：

 

指示したホールエッジ間のクリアランス以下に近接する場合は重ねる

P

HE

PE

C
（中心重ね）

Generalでは異電位間のクリアランスをビアス

 

パン毎に指示できます。Generalで指示する

 

値は、NetClassで指示した値よりも大きな値

 

が指示された場合にのみ有効となります。

これら機能を使用するためには、各項目のチェックボックスにチェックを入れて初

 

めて設定した値での管理が行なわれます。
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配線とビア間、ビアとビア間に対するクリアランス条件を指定する場合、各項目に対してその値を直接
入力します。値が設定されない場合、(Net Class)の表記の通り、ネットクラスで指定されたクリアランス
条件が通常通りに使用されます。

グレーアウトされた項目については設定不可となります。特に指示が無い場合は、ネットクラスで指示した

 

値がデフォルト値として使用されます。タイプでCを選択した場合、値を指示することはできません。

Generalは異なるネット間、Same

 

Netは同電位ネット間での設定となります。ここで設定される値はネットクラス内で定義されるク

 

リアランスよりも小さくなければ適応されません。このメニュー内でクリアランス設定を行なうことで、サンプル図に示すようなビア

 

のコントロールが可能となります。

同層でオーバーラップ可能なように、ビア同士を重

 

ねるためのコントロールが可能。

ドロップダウンリストから、クリアランス定義のTypeを選択します
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◆レイヤスタックアップ／Layer Stackup タブ

基板の層構成の情報を設定します。

①層タイプ ③銅箔層の誘電率 ⑤注釈

⑥プレーン設定から継承 ②層の厚み

④絶縁層の誘電率 ⑦オプション

①基板の構成種別を示します。
Dielectricは絶縁層を表わし、Signal 及びPlane は銅箔層を表わします。

②材質に対する厚みを示します。
項目に明示された単位系での厚みを、キー入力もしくはドロップダウンリストよりの選択で設定します。

選択すると、ドロップダウンリストが表示されます。

③銅箔層に対する導伝率の値を示します。
銅箔層の場合にのみ有効で、導伝率の値をキー入力で設定します。

④絶縁層に対する誘電率の値を示します。
絶縁層の場合にのみ有効となり、誘電率の値をキー入力で設定します。

⑤各層への注釈となります。
各層への注釈を、キー入力で設定します。
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⑥基板の構成種別について、Plane（プレーン層）とSignal（配線層）を区分けするか否かを選択するスイッチとなります。
このスイッチがONの場合、Plane Assignments設定と同期させるため、変更することはできません。

（スイッチがONの場合） （スイッチがOFFの場合）

⑦オプションメニューを起動するためのボタンとなります。
レイヤスタックアップの各パラメータ値から算出される各層毎のインピーダンスを求めることができます。

配線幅配線層 インピーダンス

計算実行のボタン。

Newボタンでリストを追加し、配線層と配線幅を設定します。カリキュレイトボタンが有効になるのでボタンを選択すると、指

 

定した層で指定した幅を使用した場合の伝送インピーダンス値を算出することができます。

Note

・ここで算出された値は、レイヤスタックアップのパラメータに変更が無い限りは有効となり、デリートボタンで削除しない

 

限り情報として残しておくことができます。
・レイヤスタックアップの各パラメータ値は雛形となるデフォルト値が供給され、この値をもとに全ての計算が行なわれま

 

す。算出される値をより精度の高いものとするためには、各パラメータ値を製造工場などから入手する必要があります。
・レイヤスタックアップへ設定する値の具体例に関する質問には回答でき兼ねますので ご了承下さい。
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◆内層抵抗と立上り時間／Buried Resistor & Rise Time タブ

①②

① 部品種別（テクノロジタイプ）毎の立ち上がり時間と、電圧降下を設定します。

テクノロジタイプ毎にデフォルト値が設定されています。変更したい場合には、直接キーインして変更して下さい。

デフォルト値

種別毎の値
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② 埋め込み部品に関する設定を行ないます。

Allow buried resistorsのスイッチを入れることで、埋め込み部品（パターン抵抗）への設定が行なえます。埋め込み部品への

 

設定としては、埋め込み部品に関する配置面の定義のみとなり、リスト内のMIRRORが表記された層間で配置面の変更が行

 

なわれます。

直接選択して切り替えます。

※埋め込み部品を使用しない場合、この項目への設定は一切不要となります。

・Buried Resistor（埋め込み部品）を使用した設計について

1.  Cell Editorにて埋め込み部品を作成します。Package Group：Buriedを指定ください。
2.  埋め込み部品は通常Placement Outlineを含みません。また必要に応じてDrawモードにてResistor Shapeを作成します。
3.  Setup> Setup Parameters> Buried Resistor & Rise Timeタブ にてAllow buried resistorをON、MIRRORポイントを設定。
4.  対象部品を配置後、Pushコマンドを実行することで配置層を変更することが可能となります。

上記で設定したMirrorポイントで部品の配置面が変更されます。
5.  ガーバー出力時に以下を選択することで出力可能となります。

Items：Resistor Areasを選択、Cells-Type：Buriedを選択します。
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ネットクラスとクリアランス

Chapter3: Design Process-Verifying Parameters
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◆ネットクラスとクリアランス／Net Classes and Clearances

Expedition PCBでは、ネットクラスと呼ばれるグループ毎の条件をもとに配線作業が行なわれます。1つのネットクラスには、単

 

一もしくは複数のネットを登録することができ、各ネットクラス毎に配線幅や配線層、ビア形状やクリアランスといった配線条件

 

を設定することができます。ネットクラスでは、デフォルト値となる“Default”クラスが標準値として供給され、ユーザーが作成し

 

たクラスに属さないネット全てがこの“Default”クラスに属すこととなります。デフォルト供給される“Default”クラスの条件が配線

 

に使用される標準値となり、これ以外の条件で配線したいネットが存在する場合には、その条件の数だけネットクラスを作成す

 

ることとなります。

このネットクラスメニューではクリアランスの設定も行ない、トレースやビア・パッドの他、部品間やマウンティングホールに関す

 

るクリアランス設定も行なうことができます。このネットクラスメニューは、プルダウンのSetup＞ Net Class and Clearancesコマンド

 

で起動します。

ルールエリア機能では、領域指定によるクラス条件定義が可能です。指定された領域内では、ネットクラスで設定された条件

 

に基づいて配線作業が行なわれます。
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◆ネットクラス／Net Classes タブ

ネットクラスの追加とネットクラスに対するビアアサイン、配線許可層の指定 及び 配線幅情報の設定を行います。

① 登録されたネットクラスが全てリストされます。ネットクラスを追加する場合には、Newボタンを選択してNewエントリをリストに

 

追加し、キー入力で直接名前を編集して下さい。

クラスを追加する際に選択します。

追加されたNewエントリを、キー入力で直接編集します。

クラスへの条件設定や確認を行なう場合には、リスト内より対象となるクラスを最初に選択する必要があります。

 

リスト内で青くハイライトされたクラスに関する内容がメニューに表示され、これを編集することでクラスへの設定

 

が行なわれます。Note
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②クラスで使用するビア形状を設定します。ここにリスト表示されるビアスパンは、セットアップパラメータ内で設定したビアス

 

パンと同様の内容となります。ここに記される“Default Via”とは、セットアップパラメータ内で指定されたビア形状（パッドス

 

タック）となります。クラス内で使用するビアを変更したい場合には、各ビアスパンのNet Class Viaを選択し、表示されたドロ

 

ップダウンリストから該当するビアを選択して下さい。

ここにリストされるビアは、ローカルライブラリ内に登録

 

されたパッドスタックとなります。リスト内の(None)とは

 

、このビアスパンを使わせないためのものとなります。

ここに表示される内容は、セットアップパラメータ内で
設定されたデフォルト値を示します。

③クラスに対する配線層と配線幅の設定を行ないます。

・Minimum Width

最小の配線幅の値を設定する項目となります。主に表面実装部品に関する引き込み/引き出しの際の配線幅となり、
クリアランス条件に違反してTypical Widthの幅では 配線が行なえない場合にこの配線幅が自動的に使用されます。

・Typical Width

通常の配線幅となり、設定された幅で配線が行なわれます。

・

 

Expansion Width

Editor CtrlメニューでExpansion Widthを有効とするか、自動配線でExpansionのフェーズを流した際に使用される
幅となり、クリアランスに余裕がある場合にのみこの幅が自動的に使用されます。

・Typical Impedance

各層におけるインピーダンス値となり、Typical Widthの値に基づいて簡易計算された値が自動挿入されます。
この欄に値を入れることで、そのインピーダンス値における配線幅をTypical Width欄へ逆算させることも可能です。

・Differential Pair Spacing

各層におけるペア指定配線グループのペア間隔を設定します。ペア指定された配線ペアは、各層で指定された
間隔にペアを形成して配線が行なわれます。

このチェックボックスは、配線層への配線許可の有無を設定するものとなり、
チェックを入れた層にのみ配線が許可されます。
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・ルールエリア（Rule Area）の設定

各クラス毎に領域指定による別ルールを設けるには、Active Scheme name項目にてスキームを新たに作成します。

Newボタンでスキームが追加されます。

追加されたスキーム名が表示されているのを確認したら、Net Classリストより設定を行なうクラスを選択します。

スキームが追加されたら、Newの名前を適当な名前に直接修正します。

メニュー内の各内容は、選択されたスキーム（エリアルール）上の指定したクラスにおける条件が表示されますので、
各条件設定を領域で指定したい内容に編集してください。

この設定は、各スキーム単位で作成することができ、各スキーム毎にクラスの設定が可能となります。

Note
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条件設定が終了すれば、Drawモードにて指定する領域を作成することができます。領域作成はDrawの作画コマンドを用い

 

て作成し、プロパティメニュー内で指定する層や使用するスキーム（エリアルール）を設定することができます。

ルールエリアを使用した配線結果の例

Layer ：指定層 又は ALLを指定
Name ：Active Scheme Nameで作成したスキームを指定

ルールエリアの領域

ルールエリアの領域内のみ、配線幅を変更して配線を実行しています。その他に使用するビアやクリアランスを、

 

定義したルールエリア内のみ適応することが可能となります。
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◆クリアランス／Clearances タブ

スキームに対するクリアランスルールの設定を行います。

①Generalクリアランスとして、各項目にクリアランス値を設定します。

・Contour & Mounting Hole to Mounting Hole

NCルータ（Contour）やマウンティングホール等のホール同士のクリアランス。
マウンティングホール内のパッドは、次ページに記載する②項目のPad-Padクリアランス値を使用します。

・Contour & Mounting Hole to Non-Plane Conductor

NCルータ（Contour）やマウンティングホール等のホールとプレーン以外の銅箔要素（トレースやビアなど）とのクリアランス。

・Contour & Mounting Hole to Plane Conductor

NCルータ（Contour）やマウンティングホール等のホールとプレーンデータとのクリアランス。

・Placement Outline to Placement Outline

部品セルが持つプレースメントアウトライン間のクリアランス。

① Generalクリアランスの設定

② トレース・ビア・パッド・プレーン
に対するクリアランスの設定

③ NetClass対NetClassが使用する
クリアランスルールの設定
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・Placement Outline to Placement Obstruct

部品セルが持つプレースメントアウトラインと禁止領域（配置禁止領域）のクリアランス。

・Placement Outline to Board Edge

部品セルが持つプレースメントアウトラインとボードアウトラインのクリアランス。

・Trace to Buried Resistor

埋め込み部品（パターン抵抗）と配線のクリアランス。

・Pad to Buried Resistor 

埋め込み部品（パターン抵抗）と全てのパッド間におけるクリアランス。

・Testpoint

 

Center to Testpoint

 

Center

テストポイントのパッドの中心間の最小クリアランス。

②配線に関するクリアランス条件ルールを作成/編集します。Newボタンを選択してNewエントリをリストへ追加し、ルール名と

 

各クリアランス値を設定して下さい。

Newボタンを押すと、Rule Name欄にルールが追加されますので、追加されたルールの名前を変更し、
各層毎にクリアランス値を設定します。また、各ルールの内容確認や編集を行なう場合には、Rule Name
欄にて、該当ルールを選択することで下のリストに内容が呼び出されます。
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プレーンとプレーン、プレーンと配線、プレーンとビア、プレーンとパッド間のクリアランスを定義するには、クリアランス値

 

設定項目にあるトグルプレーンクリアランススイッチを入れます。このスイッチを入れると、クリアランス欄にプレーンとのク

 

リアランスカラムが追加表示され、プレーンとの各クリアランスを設定することが可能です。

プレーンクリアランスにはトレースクリアランスの値がデフォルト値として定義されるため、トレースとプレーンを異なるクリ

 

アランスでチェックを行うには、ここでクリアランス値の指定が必要となります。

ここで設定された値は、ダイナミックで作成されるプレーンデータのクリアランス値として使用されます。

Note
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③クラス間におけるクリアランス条件を、層毎に設定します。上部にある各リストを使って条件を設定した後にNewボタン
を選択して条件をリストへ追加して下さい。リストで設定する内容は、クラスと層と条件となります。

Powerというクラスは 全てのクラスに対し 全ての層で Rule1の条件で配線を行なう

条件ができたらNewボタンでリストへ追加。

ここではクラス間というカテゴリでクリアランス条件を作成しますが、クラスという枠組みで作成するということで、All 
（全て）-All（全て）とPower-All（全て）といったように条件に重複する内容が含まれることがあります。このような場

 

合には、より条件範囲の狭いほうが優先され、重複する片側の条件は無視されます。

指定した条件が追加されます。

Note
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ネットプロパティと
制約条件の設定

Chapter3: Design Process-Verifying Parameters
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◆ネットプロパティ／Net Properties

ネットプロパティでは、ネットに対するネットクラス設定を行ないます。また、トポロジー、最大長配線、等長配線、ペア配線とい

 

った条件の他、スタブ長や最大ビア数といった配線条件などもネットプロパティメニュー内で設定することができます。ネットプ

 

ロパティは、プルダウンのSetup＞ Net Propertiesコマンドで起動します。

現在のクラス名

・ネットに対するネットクラス設定

クラス登録を行なう対象ネットをリストより選択し、Net Class項目を選択するとドロップダウンリストに全てのクラスがリストされます

 

。このリストより、ネットを登録するクラスを選択して下さい。

①対象となるネットを選択。

②ドロップダウンリストより該当するネットクラスを選択。
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◆ネットオーダ／Net Order タブ

ネットプロパティメニューのNet Orderタブでは、トポロジー設定を行なうことができます。デフォルト値のMSTはトポロジーの指

 

定がなされていないことを表わします。※エディタ上でトポロジーを指示する方法については、Chapter3-Routingの “ネットライ

 

ン操作／Net Manipulation”コマンド

 

を参照ください。

トポロジーの設定内容

・トポロジーの設定

対象となるネットのType項目を選択すると、ドロップダウンリストが表示されます。このリストより、トポロジーのタイプを選択して

 

下さい。

MST ：指定無し
Chained ：ネットオーダーの指定（配線順序は自動）
Custom ：ネットオーダーの指定（配線順序をユーザーが指定）

Customを選択した場合、右側の項目へそのネットの接続ポイントが全てリストされます。中央の矢印ボタンを使用してForced 
orderリストへ結線順序を作成して下さい。

矢印ボタンで結線順序を指定します。
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◆タイミングとディファレンシャルペア／Timing & Differential Pairs タブ

タイミングとディファレンシャルペアタブでは、最大長指定および等長配線指定、ペア配線指定の3つの配線条件の設定が

 

行なえます。

最大配線長の指定 等長の指定 ペア配線の指定

・最大長指定の設定

Max Length or Delay項目では、長さもしくは遅延時間での最大長指定が行なえます。対象となるネットのMax Length or 
Delay項目をマウスで選択し、カーソルを確認したらその値を直接キーインして下さい。設定した値には必ず単位を付け加え

 

る必要があり、長さでの指定の場合にはその単位となる in、mm、th、umを、遅延時間での指定の場合にはnsを数値の後に付

 

け加えます。

値は単位込みで直接キー入力。

・等長配線指定の設定

Match Set#とMatch Set +/- Tol項目では、等長配線指定を行なうことができます。このMatch Set#とMatch Set +/- Tolの2つの

 

項目を合わせて等長配線指定を行ないます。等長に配線させたい配線全てに対し、両項目に共通値を設定することで、共通

 

のグループ番号のネットが指定された誤差の範囲内で配線されます。グループ設定は番号リストから選択し、誤差の値は直

 

接キー入力で設定します。誤差を指定する際の値は、最大長指定と同様に長さもしくは遅延時間の値で設定することが可能

 

となり、設定する値に対しての単位が必要となります。

項目を選択すると矢印が表示されますので、グループ番号を選択します。

先にグループを設定すれば、1つの項目に

値を入力することで、グループ全てに値が
挿入されます。
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・ペア配線指定の設定

Diff Pair#の項目では、ペア配線指定の設定が行なえます。ペア配線を行ないたい2つのネットのDiff Pair#項目に対し、共通

 

のグループ番号を設定して下さい。グループ番号の設定は、マウスで項目を選択すると矢印ボタンが表示されますので、矢

 

印ボタンを選択して値を設定します。

項目を選択すると矢印が表示されますので、グループ番号を選択します。

共通の番号を持つネットがペア配線の対象となります。

◆クロストーク／Crosstalk タブ

Expedition PCBでは、2.5次元のフィールドソルバーを使用したクロストーク検証の環境を提供しています。このクロストークタ

 

ブでは、ネットへのクロストーク検証を行なう際に使用する条件を設定することができ、ここに設定した条件に違反するネットを

 

エディタ上で簡易的に検出することが可能となります。設定は、影響電圧もしくは物理的条件設定にもとずく係数値のいずれ

 

を各ネット毎に行ないます。

・影響電圧での設定

クロストーク検証の対象となるネットのMax Crosstalk(V)項目に対し、エラー検出のボーダーラインとなる電圧値をキー入力し

 

て下さい。電圧の単位は項目が示す通りV（ボルト）となり、該当ネットが設定された値を越える電圧の影響を受けた場合にエ

 

ラーとして検出されます。

入力は値のみとなり、単位は入力後に自動挿入されます。
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・物理的な設定内容における係数での設定

係数で設定を行なう場合には、始めに係数のもととなる物理的な条件を作成する必要があります。この物理的条件とは、同一

 

層及び異層間におけるクリアランス値に対しての最大平行線長となります。平行線条件としてSame layer側に同層での条件を

 

、Adjacent Layer側に異層間での条件を設定します。

同層の条件

異層間の条件

条件登録は、Newボタンで空のエントリをリストへ追加して

値をキー入力します。

ここに登録する物理的な条件値は、係数のもととなる値となるので実際の検証に使用する値全てを設定する必要はありません

 

。ここに登録した値をもとに、どういった条件で検証を行なうのかを各ネットのParallel Rules Factor項目へキー入力で設定して

 

下さい。

係数の値は、直接キー入力します。

例＞ Edge/Edgeが200umでMax Pallel Lengthが2000umであった場合

係数として1を設定した場合には、該当ネットに200umのクリアランスで2000um平行線を辿っているネット（パターン）が
存在した場合にエラーとして検出され、係数が0.5であった場合には、半分の条件である1000umの平行線でエラー検

出されることになります。

スペーシング値 最大平行
配線長
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◆その他／Other タブ

Otherタブでは、各ネットに対するスタブ長制限指定やビア数の指定が行なえます。Supply Voltage項目では、クロストーク検

 

証の対象外となるネットを判別するための電源ネットに対する電圧値を設定します。この電圧値は、Expedition PCBのオプショ

 

ンとなる伝送線路解析ツールにおける電源電圧のパラメータとしても用いられます。

ビア数。スタブ長。 電源ネットの電圧値。

・スタブ長制限指定の設定

対象となるネットのMax Stub Length項目を選択し、直接値をキー入力して下さい。

スタブ長については長さの単位も合わせて入力します。

・ビア数制限の設定

対象となるネットのMax Vias項目を選択し、矢印ボタンを使用して最大使用数を選択して下さい。

項目を選択すると矢印ボタンが表示されますので、上下の矢印ボタンで
数値を選びます。

・電源ネットへの電圧値の設定

対象となる電源ネットのSupply Voltage(V)項目を選択し、電圧値を直接キー入力して下さい。

値を直接キー入力します。（単位は自動挿入）
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◆ディレーフォーミュラ／Delay Formulas タブ

ディレイフォーミュラタブは、Topology：Customでネットオーダー指定を行なったネットに対してのみ使用できるオプション設定

 

となります。このディレイフォーミュラでは、ピン間指定での配線長や等長配線指定といった設定が行なえます。 ネットの接続

 

ピンは、スプレット形式の表としてリストされます。ディレイフォーミュラにおける各設定には特別な書式が用いられ、各接続ピ

 

ンのカラムに対して長さや等長といった書式を入力して設定を行ないます。

ネット名。
各接続ピン。

・表内における接続ピンの見方

表内における各ネットの接続ピンの見方については、最上段に記されたアルファベットのカラムとIndexカラムに表示される番

 

号を使用します。下図を例に取ってみると、最上段にリストされたネットの“BIG_VOLT_ALT_CURREN1”には、インデックス

 

番号として1が割り付けられており、各接続ピン“J2-AA18、R1-1、R2-1”のカラム文字を合わせて、J2-AA18がA1、R1-1がB1、

 

R2-1がC1という変数として表内では扱われます。

A1（J2-AA18) B1（R1-1) C1（R2-1)

各カラム内に表示された“J2-AA18”などは、ネットの接続ピンを意味します。

 

（Ref番号-ピン番号）

変数の定義

Note
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・ディレイフォーミュラの設定

ディレイフォーミュラでの設定は、各カラムへ特別な書式を用いて行ないます。この書式は、下記のような内容の要素を組み

 

合わせて設定します。

要素の例＞

・数値

 

：

 

1、10、0.5、0.01などのギリシャ数字で値を表わす。

・単位

 

：

 

ps、ns、in、th、mm、umで数値に対する単位を表わす。

・接続ピン

 

：

 

A1、C4、などのカラム記号で接続ポイントを表わす。

・不等号

 

：

 

<、>、=で設定する値への意味付けを行なう。

・演算記号

 

：

 

+0.5ns、-10thの表現で値に対する演算を付加。

・範囲

 

：

 

0.1:0.3nsの表現で 0.1～0,.3nsの範囲を表わす。

・誤差

 

：

 

+/-0.01ns、+3/-1thの表現で誤差の範囲を表わす。

・ピン間

 

：

 

A1@A4の表現でA1ピンからA4ピンまでの長さを表わす。
A4カラムにA2@A4の長さを指定する場合には、自カラムであるA4をはぶいた
@A2の表現で自カラム（A4）からA2までの長さを意味する。

例＞J2-AA18からR1-1までの長さを1.5ns以内で配線し、全体としては3nsで配線したいというような場合、
J2-AA18からR1-1までの長さをB1のカラムに@A1<1.5nsと設定し、全体の長さをC1カラムに@A1=3nsと
設定します。

A1（J2-AA18) B1（R1-1) C1（R2-1)

3ns

1.5ns以内

自カラム記号を省略できるのは同一インデックス番号内のみで、異なるインデックス番号行へ指定する場合にはカラム

 

は省略できません。従って、A2～B2までの長さをA1～B1と同じ長さにしたいという場合には、A2カラム内に

 

@B2=A1@B1と設定する必要があります。Note
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エディタコントロール

Chapter3: Design Process-Verifying Parameters



－ 159 －

◆エディタコントロール／Editor Control

エディタコントロールメニューでは、Expedition PCB上で行なわれる設計作業に関する様々な設定が行なえます。このエディ

 

タコントロールメニューは、プルダウンのSetup＞

 

Editor Controlコマンドで起動します。このメニューには、Place/Route/Grid

 

の３つのタブと、Common Settingsメニューが存在します。

・項目の展開と折りたたみ

＋：すべての設定項目を展開します。
－：すべての設定項目を折りたたみます。

：選択した設定項目を上位に移動させます。
：選択した設定項目を下位に移動させます。

をクリックすると項

 

目が展開されます。
をクリックすると項

 

目を折りたたみます。
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・スキームの保存と削除

エディタコントロールで設定した内容を、メニュー下にあるセーブスキームボタンで保存することができます。スキームに名前

 

を設定することができ、またローカル又はシステム用として保存が可能です。システムとして保存されたものは、その端末上

 

で扱われる全てのエディタ上で呼び出すことが可能であり、作業内容に応じたスキームを作成しておけば、面倒な操作を毎

 

回行なう必要はありません。

スキームの削除

・ドッキングと切り離し

エディタコントロールは、EE2007.3バージョンからAdd-InタイプのGUIになり、アプリケーションウィンドウにドッキングさせたり

 

、切り離したりすることが可能です。

赤いエリアにエディタコントロールを持

 

っていくと、アプリケーションウィンドウに

 

ドッキングします。

ドッキングしたエディタコントロールを切

 

り離すには、マウスでドラッグするか、エ

 

ディタコントロールのタイトルバーをダブ

 

ルクリックすることで切り離すことができ

 

ます。
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・Interactive Place/Route DRC

このスイッチをOFFにすることで、マニュアル配線＆配置作業時のオンラインDRC機能（AutoActive機能）をオフにすることが可

 

能です。

インタラクティブDRCを無効とすると、エディタ上にはオンラインDRCが無効であることを示すマークが表示されます。このマー

 

クが表示されている状況であれば通常では行なえない銅箔同士の干渉を含む配線や部品配置作業が行なえるようになります

 

。一度でもインタラクティブDRCを無効にすると、バッチDRCを実行することを促すメニューが表示されます。このメニューの表

 

示はバッチDRCを実行しない限りエディタ起動時などに毎回表示されます。

上記メッセージをClose 又は

 

Interactive DRCをONとした際、

 

DRC違反を検知する為バッチDRC実行を促すメッセージが表示

 

されます。

Interactive DRCをOFFとした際、DRCが無効である旨

 

メッセージが表示されます。

◆共通設定／Common Settings

自動バックアップ、インタラクティブDRC等のGeneral項目の設定を行います。
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・AutoSave intervals to temp work area 

この項目では、マニュアル配線作業時と自動配線時の自動バックアップ時間を設定することができます。この項目の標準

 

値は、双方60分となります。
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◆配置＞

 

全般設定／Place＞

 

General options

・Place Online DRC（pad-pad errors）

この項目では、部品のオンラインDRCに関する設定を行います。部品の配置や移動時に、部品間でプレースメントアウトライン

 

が接触した場合の動作を定義します。

・Netline display while moving parts

この項目では、部品がマウスカーソルに追従している状態で表示されるネットラインに関する設定が行なえます。

このスイッチを入れると、部品から表示されるネットラインのターゲット

 

が、最も近接するポイントへとダイナミックに変化します。

このスイッチを入れると、その部品のピンから出るネットラインのみが
表示されるようになります。

数値を指定すると、指定した数以上のピンを持つ部品のネットライン

 

が、部品移動時に非表示となります。デフォルトは空欄となり、全て

 

の部品のネットラインが表示されます。

◆配置／Place タブ

部品移動時のDRC設定、スナップポイント、部品回転時のテキストの取り扱い等に関する設定を行います。

Warning ：

 

プレスメントアウトラインの接触を許可して、部品の配置や移動が可能となります。

エラーの際は、ワーニングメッセージが表示されます。
Preventative ：

 

プレスメントアウトラインの接触を禁止し、部品の配置や移動は許可されません。
Shove PartがONの場合、エラーを回避するように接触対象部品の押し退け（部品移動）が行なわれます。

Pushback Part ：

 

Ctrlキーを押した状態にて部品配置を行うと、Pad to Padクリアランス

 

及び プレイスメントアウトライン同士
のエラーを回避するように配置が行われます。

尚、Editor Control > Common Settings> Interactive DRCがOFF時以

 

外は、このDRC設定に関係なく銅箔要素（パッドなど）間の接触を一

 

切認めておりません。Note

ジャンパー設定

全般設定



－ 164 －

・Part alignment

この項目では、部品の整列コマンド（Align                            ）を使用した場合の基準点を設定します。

セル原点を基準とする場合に選択します。

ピンマトリクスの中心を基準とする場合に選択します。

部品のピンを基準とする場合に選択します。

参考：セル原点とピン基準の動きの違い

[初期状態]

一番左の部品に合わせて整列した場合

基準部品

基準部品

基準部品

Pin centers
(ピンを基準)

Cell origin
（セル原点を基準）

セルの原点

ピンマトリクスとは、その部品のピン（パッド）全てを直線で結んでできたシェープ(多角形）形状を指します。

Note
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・Text Rotations

この項目では、部品回転時における、リファレンス番号と部品番号の取り扱いについて設定することができます。

部品の回転に連動して一緒に回転します。

このスイッチを入れると、配置面毎に設定することができます。設定の際は、配置面毎にスイッチを切り替えて設定を行な

 

います。尚このオプションは、Rotate with Partオプションがチェック時のみ有効となります。

上記例では、
・Top面で部品角度が0・180度の時テキスト角度は0度、部品角度が90・270度の時テキスト角度は90度。
・Bottom面で部品角度が0・180度の時テキスト角度は0度（Mirror）、部品角度が90・270度の時テキスト角度は90度
（Mirror）。

Top面の設定

Bottom面の設定

Top面部品を90度又は270度に配置した場合のテキスト角度。

Top面部品を0度又は180度に配置した場合のテキスト角度。

Bottom面部品を90度又は270度に配置した場合のテキスト角度。

Bottom面部品を0度又は180度に配置した場合のテキスト角度。

部品の回転に関わらず、現在の角度が維持されます。
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・Cell Rotations

セル形状に対する配置角度と配置面についての指定が行なえます。設定は各セル毎に行なわれ、リストで選択したセル

 

の内容が、右側のフォーム内で確認できます。

・Any angle （角度制限なし）
この項目を選択した場合には部品に対する角度指定は無く、配置面指定のみとなります。

・Orthogonal （直角）
この項目を選択した場合には、下の項目でセルに対する角度を配置面毎に指定することができます。

0度/90度/180度/270度の項目には、それぞれ配置面を指定する

 

チェックボックスが存在します。有効としたい角度のチェックボック

 

スにチェックを入れることで、その配置面での配置角を指定するこ

 

とができます。ここでチェックが入れられなかった配置面と角度を使

 

用した配置は禁止されます。

尚、ここで設定された内容に違反する配置を認めるか否かについては、

 

Place Online DRC設定に依存します。

 

違反している部品があればReview Hazardで検出が可能です。

Any angleでSideをBothとした場合、配置面、配置角のどちらも指定しない設定となります。

Note
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・Clusters & Rooms

クラスターとルームに関する設定を行ないます。クラスターとは、部品間のつながりの強さを意味し、同一クラスターグループに

 

それらの部品を登録することで、ネットの属性などに関係なく部品間のつながりを強めることができます。これに対してルームと

 

は、基板上に作成された部品の配置領域(Room)を差し、各ルーム毎に部品をグループ化することで、それらの部品の配置

 

領域を指定することができます。

このタブでは、クラスター及びルームの各グループに対する部品の登録作業が行なえます。作業の方法は双方共通となり、

 

Newアイコンでエントリをリストへ追加します。追加されたNewエントリの名前を直接変更して、Excluded parts項目にリストされた

 

部品の中からグループ登録したい部品を選び、[>]ボタンを使ってIncluded partsリストに登録します。

このボタンを選択してNewエントリを追加し、名前を変更します。

グループ名は直接編集。

グループ登録したい部品を移動。

クラスターとルームの登録は、必要と思われる部品にのみ行ないます。
・クラスター登録の内容は、自動スワップ機能などの検討材料に用いられます。
・ルームのグループをここで作成することで、Drawコマンドのルーム作成時、プロパティフォームに登録済み

 

となるルームグループ名がリスト表示されるようになります。

登録済みのグループ名がリストされます。

クラスターに関する設定

ルームに関する設定

Note
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・Jumper placement angle

ジャンパーの配置角度を、Orthogonal（直角のみ）とAny angle（自由角度）から選択します。

・Jumper Table

PDBに登録されたジャンパー部品の選択と、ジャンパー配置後に付加されるジャンパーシルクに関する設定となります。

PDB内に登録されたジャンパー部品がリストされます。

 

使用を許可するジャンパーのチェックボックスにチェッ

 

クを入れることで、ジャンパーの使用が認められます。

Graphics options

 

（作画オプション）

・Assembly and Silkscreen line width

 

：シルク線の太さを設定します。
・Line pullback distance

 

：ジャンパーパッドからシルク線までの距離を設定します。

この距離

◆配置＞

 

ジャンパー設定／Place＞

 

Jumpers

この項目では、ジャンパー部品に関する設定を行います。

・Press spacebar to add jumper

ジャンパー配置を、スペースバーに連動させる場合にチェックを入れます。
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各チェックをはずすと、ネットプロパティ条件に違反する配線作業がマニュアル配線時にのみ行なうことが

 

できるようになります。

・Curved Traces

カーブトレース機能にてカーブトレースを作成する際に使用される配線コーナー円弧の半径を指示します。値を指定しない場

 

合（Variable）、マウスカーソルを使用して任意の大きさの円弧を作成することが可能です。カーブトレース機能の詳細は、

 

Chapter3-Routingの“カーブ切り替え/Toggle Curve”を参照ください。

Radiusに値を指定することで、カーブトレース実行時の右マウス

 

ボタンメニュー（RMB）より候補値として選択可能。

最小の円弧半径を指定。

◆配線／Route タブ

マニュアル、自動配線動作に関する設定を行います。

ダイアログ設定

全般設定

配線設定

トレースとビアの動作設定

ビアとファンアウトの動作設定

◆配線＞

 

全般設定／Route＞

 

General options

・Turn on/off net rules

この項目では、ネットクラスやネットプロパティ等で設定された制約条件をマニュアル配線時に適応させるか否かを設定しま

 

す。

Note
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設定内容をスキームとして登録。

CES使用時のみ表示されます。
Net

 

：Net Classを表示
Constraint

 

：Constraint Classを表示

チェック時にフィルターを有効とします。
Includedリストに含まれるネットのみが選択(編集)可能となります。

チェック時にNetlineに対するフィルターを

 

有効とします。Includedリストに含まれるネ

 

ットのネットラインのみが表示されます。

・Layer Settings

この項目では、配線可能な層と配線層に対する主配線方向

 

及び

 

配線層のペアを設定することができます。

◆配線＞

 

ダイアログ設定／Route＞

 

Dialogs

・Net Filter

この項目では、ネットに対するフィルタリング設定を行なうことができます。Excluded（除外）リストとIncluded（含む）リストへネット

 

を状況に応じて振り分けて使用します。Includedリストに登録されたネットがその作業に対する対象となり、ダイアログ内の

 

チェックボックスで、フィルターを使用するか否かを決定します。
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Enable Layerには、各層にあるチェックボックスで、配線層として有効か否かを設定します。チェックを入れた層へのみ配線が

 

行なえ、チェックが無い層への配線は一切行なえません。尚、この設定は全ての配線コマンドに対して有効となります。

チェックのON/OFFで配線が有効か否かを設定。

各層ごとに配線の方向を設定。
Vertical：

 

垂直方向
Horizontal：

 

水平方向

Biasには、各配線層毎の配線の方向性を設定します。各項目を選択するとドロップダウンリストが表示されますので、

 

Horizontal（横方向）、Vertical（縦方向）の何れかを設定して下さい。ここに設定される方向は、あくまで優先という意味合いと

 

なりますので、指定された方向以外への引き回しも行なわれます。

Layer pairsには、マニュアル配線時にスペースバーやAdd viaを使用してビアを発生させた場合に切り替わる、配線層のペア

 

を設定します。ビアの発生とともに、ペア指定された層間でアクティブな配線が入れ替わります。この項目はマニュアル配線時

 

のみ有効となります。

Layer１とLayer4がペアの設定となります。



－ 172 －

・Tuning

この項目では、ネットプロパティで長さ指定された配線に対して、どのようにチューニングするかについて設定します。

チューニングパターンとして有効な

 

引き回し形状を設定します。使用し

 

ても良い形状に対して“Allow”を設

 

定し、禁止する形状には“Prevent”

 

を設定します。“Prefer”は優先設定

 

となります。

ビアを使用して他層に迂回させるチューニングを

 

指示する場合に指定します。

Tuning pattern rules

 

－

 

チューニングパターンルールの定義

Minimum spacing

 

：

 

チューニングパターン間の最小スペーシング値を設定します。
Default値は0となり、0指定時はNetClassルールに違反しない最小値が自動で定義されます。
またトレース幅に対する係数での指定が、“x”を付与することで可能となります。

例）トレース幅が10thで2xが指定された場合、スペーシング値は20thとなります。

Preferred Minimum

 

：チューニングパターンの最小の高さ値を設定します。Default値は0となります。
height

Maximum height

 

：チューニングパターンの最大の高さ値を設定します。Default値は0となります。
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チューニング機能について

Expedition PCBでは、等長指定や長さ指定が施された配線に対するチューニング（自動長さ整合）機能が提供されま

 

す。長さ指定された配線が結線された後、この配線がその条件を満たしていない場合に長さの整合を行なわせる機

 

能がチューニングとなります。このチューニングは、指定された長さに足りないという場合に有効となり、その配線に対

 

してチューニングパターンを形成することで長さの整合を行ないます。

チューニングパターンで整合が取られる。

マニュアル配線時と自動配線時において、チューニングをどのように実行するのかを設定します。

Tuning iterations－自動配線（Tune Delay）時のチューニング動作の定義
Reduce length

 

：Max length違反を解決する為、最も長いペア配線を短くするよう整形作業を行います。
Add length ：Tune Delayの強度を設定します。Exhaustive設定時は、最大限まで長さを追加するように

整形を行います。

Effort－チューニング実行時のレベル調整
ReTune

 

Only

 

：このスイッチが有効であるとき、許容を超えた分のみの再チューニングに制限されます。
尚、このモードではチューニング済みでないネットに対しての作業は行なわれません。

Tune & Retune

 

：このスイッチが有効であるとき、全体に対する再チューニングが行なわれます。
必要に応じてビアや配線を押しのけて最適なチューニングが行なわれます。

Automatic urgency －自動配線時のチューニングの定義
Off

 

：整形作業を実行しない。
On Netline

 

Routed

 

：配線が終了した時点で、定期的に整形作業を実行する。
At End of Effort

 

：エフォート終了時に、定期的に整形作業を実行する。
At End of Pass

 

：配線パスの終了時、定期的に整形作業を実行する。

Interactive urgency－マニュアル配線時のチューニングの定義
Off

 

：整形作業を自動で行なわない。
On Drag

 

：配線ドラッグ時にも自動で整形作業を行なう。
While Clicking

 

：選択した際に自動で整形作業を実行する。
On Netline Routed

 

：配線が終了した時点で、定期的に整形作業を実行する。
On Idle

 

：常に自動整形作業を行なう。

※双方とも、On Netline Routedとした場合には自動でこのチューニングが行なわれ、ダイナミックな配線修正に対し
ても、チューニング作業が自動追尾するようになります。

 

また、双方Offとした場合には、結線後にチューニング
作業を意図的に行なわない限りは、長さの整合が行なわれませんので注意が必要となります。

Note
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・Diff Pairs

この項目では、ペア配線指定されたディファレンシャルペアを異層間でペア形成させる際の設定を行ないます。グレーアウトさ

 

れた左側の層に対するペア層を異なる値にすることにより、設定された層間を使った異層間ペア配線を形成させることができ

 

ます。

Adjacent and same layer Pairs：
ペア指定ネットは、ここで設定さ

 

れた層設定で異層間ペアを形

 

成します。双方の値が同じ場合

 

、その層では同層でのペア配

 

線が形成されます。

Convergence distance tolerance：

パッドやビア接続時などにおけるペア間隔の拡散部の配線長誤差を指定します。このルールに違反するポイントは、

 

ReviewHazard内で確認することができます。

Max distance to convergence distance：

パッドやビア接続時などにおける一時的なペア間隔の拡散の最大長を指定します。この値はパッドの縁から計算され

 

、パッドやビアからペア配線が指定間隔に収束される端点までの距離として定義します。この設定に違反するポイント

 

は、ReviewHazardで確認することができます。
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Min length to maintain pairing ：

ペア間で指示された間隔を最低限維持させたい長さを指定することができます。ペア形成維持するということは、
下図のような密集したピン間を抜ける際に多くの湾曲が形成されます。

ペアを維持するために湾曲が多くなる

この項目に値を指示すると、指定された値よりも少ない長さの範囲内において下図のように湾曲を
削除することができます。

指示した長さ

長さの範囲内であれば間に湾曲を作らない

Max separation distance：

パッドやビア接続時などにおける一時的なペア間隔の拡散の最大長を指定します。この値はパッドの中心からの距離

 

として計算され、パッドやビアからペア配線が指定間隔に収束される端点までの距離として定義します。この設定に違

 

反するポイントは、ReviewHazardで確認することができます。

During Push & Shove：
既存のペア配線におけるプッシュ＆ショーブの動きの調整を指示することができます。

・Ignore Pair Relationships：

 

ペア関係を無視する。
・Allow Pairs to Split If Necessary：

 

必要な場合にのみペアを分ける。
・Prohibit Splitting of Diff Pairs：

 

ペアが分かれるのを禁止。
・Avoid

 

Splitting of Existing Pairs：

 

ペアが分かれるのを避ける。

Minimize splitting（AutoRoute only）：

AutoRoute時のみ有効となります。チェック時は既存配線を含めて、ペア間隔が小さくなるように整形が行われます。
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・Pad Entry

この項目では、各パッドに対する引き込み方向を指定します。Select pads項目でパッド形状の種類を選び、リストに表示された

 

パッドの中から対象を選択します。引き込み形状を設定するメニューが右側に表示されますので、

 

優先する引き込み形状の

 

チェックボックスに対してチェックを入れます。この設定は各パッド個別に行なうことができ、リスト最上段にある（All ***

 

Pads）

 

を指定することで種別毎の設定も行なえます。また、幾つかのパッドのみをまとめて設定したいという場合には、対象となるパッ

 

ドを[Ctrl]や[Shift]キーを使って選択します。

パッドの種別を以下から選択します。
Rectangular

 

：長方形
Oblong/Octagon

 

：楕円形
Round/Octagon

 

：円形
Square

 

：正方形
Custom

 

：カスタム形状

Select padsで選んだ形状のパッドが全てリストされるので、設定対象となるパッド
を選択します。[Shift]や[Ctrl]キーを併用することで複数同時選択が可能。
※All *** Padsを選択時は、リスト内の全てのパッドが対象となります。

General options項目

・Gridless

 

pad

 

entry for all pads

オフグリッドパッドに対してパッドエントリー設定を有効とします。本設定はEditor Controlにて配線グリッドを指定した場合

 

のみ有効となります。

・Fit view / highlight pad

エディタとのクロスプローブ機能を有効とします。チェック時は、リストで選択したパッド形状を持つピンへパンニング表示し

 

ます。

・Exposed metal clearance on outer layers

トレースの露出箇所(引き出し箇所)

 

と

 

近接するパッド間のクリアランス指定を可能とします。指定したクリアランスルールを

 

もとに、配線禁止領域を擬似的に作成し、トレースの進入を禁止します。これにより、トレースの露出箇所(引き出し箇所)

 

と

 

近接パッドにより引き起こされる、ソルダーブリッジの製造課題を解決することが可能となります。

Exposed Metal Clearanceに設定した値は、パッドからのクリアランス値として使用されます。
→次ページに例を記載

Exposed metal clearance on outer

 

layers:
外層（TOP/BOT毎）にパッドからのオーバーサイズ

 

として、クリアランス値を設定。
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例）

 

20th を設定した場合、パッドから20thオーバーサイズした領域（ピンクの領域）をExposed Metal Clearanceとして扱います。

近接のパッド

パッドクリアランス

トレースの露出箇所

 

（引き出し箇所）

インタラクティブDRCがOFF 又は

 

設計途中にExplosed Metal Clearance

 

を変更した場合、

 

Exposed Matal 
Clearanceに違反したデータが作成されます。その際、エラー箇所は

 

バッチ処理のAnalysis> Batch DFF
(Design for Fabricationのライセンスが必要)でのみ検出可能です。

Exposed Metal 
Clearance 領域

20th

Exposed Metal Clearanceにより、ピンクの領域内

 

へ

 

トレース（パッドクリアランス領域内のトレースの

 

み対象）が進入することを禁止します。

Note
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Rules for all rectangular pads：
図で示される接続を優先する場合にチェックを入れる。

図で示される配線の引き出しを優先する場合にチェックを入れる。

Allow via under padのチェックボックスは、パッドの下へのビア配置を許可するか否かの設定となり、これにチェックを入れ

 

ることで、そのパッドの下にビア配置が認められます。

その下にある各チェックボックスは、パッドに対するビア位置を設定するものとなります。各項目に対し、許可する場合にの

 

みチェックを入れます。

・Allow off pad origin

 

：パッドの中心以外へのビアパッド配置を許可。
・Align on long axis

 

：パッドの長手方向に対しての配置を許可。
・Locate at pad edge

 

：ビアパッドの中心をパッドの縁に配置。
・Keep via center inside pad

 

：ビアパッドの中心がパッドの領域を出ないように配置。

・Keep via pad inside pad

 

：ビアパッドがパッドの領域を出ないように配置。

・Via spans allowed under pads

 

：パッドの下へのビア配置を許可するビアスパンを設定します。

 

チェックしたビアスパンを持つビアのみパッドの下への配置が可能となります。
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Extended Pad Entry

 

（拡張パッドエントリー）のオプションは、“パッドのエッジに対して常に垂直なるように引き出す” という条

 

件で、最適な形状/位置（前述の5種類以外も含む）で引き出すものであり、これにより、5 種類という制限に縛られない、より自

 

然な形状でのトレースの引き出しが可能となります。また、オプションであるAllow Odd Angle によって、パッドのエッジに常に

 

垂直になるように、特殊な角度での引き出しを行うことが可能となります。

Extended Pad Entry：ON

Extended Pad Entry：OFF

Extended Pad Entry：ONではオレンジの状態となり、より自然な形状のトレース引き出しを可能とします。

Extended Pad Entry
：OFF

Extended Pad Entry
：ON

SMD間に配線されたトレースに対して、VIAが

 

接近してトレースが押し退けされた状態となり

 

ます。Extended Pad EntryがON時は、トレース

 

に対して不要なポイントを作成せず、パッド内

 

のみポイントを作成します。

Allow Odd Angle

 

：OFF

特殊な角度で配置されたパッドからの引き出し。

 

Allow Odd AngleがON時は、引き出し時に一時的

 

に特殊な角度で配線を行い、パッドエッジに対し

 

て垂直な引き出しを可能とします。

Allow Odd Angle：

 

ON
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・

 

Route タブのAllow 45 degree corners にチェックが入っていない状態で、Extended Pad Entry やAllow Odd 
Angle にチェックを入れたとしても本機能は有効になりません。またその場合、すべてのPrefer チェックボックスに

 

チェックが入っている時と同じ動きになります。

・本機能が有効な場合、各Prefer チェックボックスでの設定は無視されます。
（Prefer チェックボックスの5 種類以外も含むすべての形状/位置からの引き出しが有効になります。）

・Pad Entry タブのGridless pad entry for all pads は、全パッド形状に共通する設定ですが、Extended Pad Entry 
が有効なパッドからの引き出し時には機能しません。

・これまで“Pad Entry の優先する（Prefer） 引き出し形状” の設定ができなかったRound / Octagon パッド、Custom 
パッドなどに対しても本チェックボックスは追加されています。

・Differential Pair 配線時には、Extended Pad Entry は機能しません。

Allow Odd Angle
：ON

Finger、Round/Octagon、Customパッドへの対応

 

。
Allow Odd AngleがON時は、これらのパッド形状

 

に対しても、常にパッドのエッジから垂直な引き出

 

しを可能とします。

Note

・Expand Traces

この項目では、配線時にどのネットクラスで設定された各配線幅を使用するかの設定を行います。

障害物などの影響で、ExpandからTypicalの幅にパターンが変

 

更された場合に、保持させる最小の長さを設定します。

ネットクラスで設定したExpand width設定を使用するか否かを

 

設定します。これにチェックを入れることで、設定したExpandの

 

配線幅が使用されるようになります。

表面実装ピンから引き出す際に使用される、
Pad Entryの幅の最小の長さを設定します。
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各スイッチは、マニュアル配線（Plow）の際に使用可能とする配線モード
の可否を設定しており、チェックを入れることで使用が認められます。配

 

線モードの詳細は、Chapter3-Routingの“配線モード切替／Toggle Plow 
Mode”を参照ください。

・General options

この項目では、配線のコーナーに対する処理、ループ配線の許可、ダブルクリックでのビアの配置許可を行ないます。

Allow 45 degree corners：
このスイッチは、配線のコーナーを如何に処理するかを設定し、チェック

 

を入れることで45度、チェックをはずすと90度のコーナー処理が行なわ

 

れます。

Prevent loops：
このスイッチは、ループ配線に関しての禁則を設定し、スイッチをはずす

 

ことでループ配線を認めます。

Double click to add via：
このスイッチは、

 

Plowコマンド時にマウスのダブルクリックでビアの発生を

 

認めます。

◆配線＞

 

マニュアル配線／Route＞

 

Plow

・Modes

この項目では、マニュアル配線時における配線モードの設定を行ないます。

・Strength control

この項目では、マニュアル配線の動作における強度の設定を行ないます。

Effort （エフォート）：
自動配線エンジンの強さを示し、Low＜Medium＜Highの順に強くなります。ここで設定するエフォートレベルは、マ

 

ニュアル配線時における自動配線のアルゴリズムとなり、バッチ型に付属されるそれとは異なります。また、ここで設定

 

される最大値のエフォートは、バッチ型の最小エフォートに劣りますので、特に必要がなければ“Medium”として下さい。

Layer bias （レイヤバイアス）：
配線の方向性における拘束の度合いを示し、

 

Low＜Medium＜High の順に拘束度が増します。配線方向に対する

 

拘束度を増すと、配線はその層で指定されていない方向への引き延ばしを嫌い、結果ビアを経由して他層へ迂回しよ

 

うと働き、必要以上にビアを発生させる可能性が高くなりますので、必要がなければ“Medium”としておいて下さい。

Via cost （ビア

 

コスト）：
ビア使用におけるコストを示し、

 

Low＜Medium＜High の順にコストが増します。ビアに対するコストを増すと、配線エ

 

ンジンはビアの使用を控えようと働きますが、これにより配線作業自体が円滑に行なえなくなる可能性がありますので、

 

特に必要がなければ“Medium”としておいて下さい。

Max vias added （最大ビア数）：
配線に対して追加できるビアの数を設定します。ここで設定されたビア数制限は、半自動コマンドのRouteコマンドで

 

有効となり、Plowコマンドでは無効となります。尚、この設定についても値を“0”とすることで、作業が困難となる場合が

 

ありますので、特に必要が無ければ“3”などの数値を指定しておいて下さい。
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Trace shoving

 

:

 

配線の押し退けが行なわれます。
Via shoving

 

:

 

ビアの押し退けが行なわれます。
Allow Odd Angle Escape

 

:

 

一時的に特殊な角度（45度以外）での配線を許可します。
※現在のバージョンでは、部品パッドに対してのみ有効となります。

Pad jumping

 

:

 

パッドを飛び越す押し退けが行なわれます。
Via jumping

 

:

 

ビアを飛び越す押し退けが行なわれます。

・Gloss mode

この項目では、グロスモードの設定を行ないます。配線コマンド（Plow）実行時の〔F4：Toggle Gloss 〕と同じ動作となります。

◆配線＞

 

トレースとビアの動作設定／Route＞

 

Trace & Via edit behavior

・Push & Shove

この項目では、マニュアル配線時における押し退け設定を行います。尚、各設定は異電位間に限定されます。

Gloss ON

 

：グロスモードがOnの場合、パターン全てに対する自動整形がポイント指定毎に行なわれます。
このモードを選んだ場合、パターン形状を細かくチェックする必要はありませんが、ポイント指定毎に
整形が行なわれるため、配線経路を細かく指定したいようなケースには向きません。

Gloss Local

 

：グロスモードがグロスローカルの場合、ポイント指定毎にその区間（1セグメントあたり）の自動整形が
行なわれます。このモードを選んだ場合、奇麗な形状で配線を引き回すことができます。

Gloss Off

 

：グロスモードがOffの場合、パターン形成後に自動整形は一切行なわれません。このモードで配線
されたパターンには半固定（セミフィックス）の属性が与えられ、固定化を解除しない限りは他の
パターンが押しのけることはありません。
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・Advanced gloss options

この項目では、マニュアル配線時における整形処理についての設定を行ないます。Advanced gloss options項目にある各

 

チェックボックスで、マニュアル配線時における整形処理（アクションキーのGlossコマンドや配線の修正作業）の動作を指

 

示します。

Allow traces to jump over pads and holes：
配線パターンがパッドや穴を飛び越すようなGloss動作を有効とします。

Remove excessive meanders：
余分な迂回配線を削除するようなGloss動作を有効とします。

Gloss around deleted traces or vias：
配線とビアの削除後に再整形させるようなGloss動作を有効とします。

Move vias to reduce trace segments：
ビア移動における無駄な配線セグメントを削除するようなGloss動作を有効とします。
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使用例）
・表層（External）を配線禁止層として、Net Classes

 

& Clearances に設定。
・Max trace length on restricted layers＞

 

External に3mmを設定。
結果、表層からファンアウトする際の最大配線長として、3mmまでのトレースを許可

 

します。3mmを超えるトレースを作成しようとすると、以下エラーが発生します。

Auto trim through vias：
Setup Parameters> Via Definitionsにて貫通以外のマイクロビアが定義されている場合、配線コマンド完了時（トレー

 

ス編集時）、置き換え可能な最短スパンを持つビアへの自動置き換えを行います。
※置き換えによりパッド径が大きくなる場合は、置き換え動作は行われません。

Allow one additional via per SMD pin：
表面実装部品のピンに対し、ビア数制限を越えて1つのビアを追加してもよいという場合には、このスイッチを入れま

 

す。

Use place outlines as via obstructs：
セルに施したプレースメントアウトラインをビアの禁止領域とするか否かを設定します。チェックを入れることで、プレー

 

スメントアウトラインがビアの禁止領域として認識されます。

Enable fanout

 

of single pin nets：
1ピンしかないネットに対してもファンアウトを実行させるか否かを指定します。

Max pins per plane fanout

 

via：
Fanout実行時に1つのプレーン接続ビアに対し、何本の配線のつなぎ込みを認めるかを設定します。
※マニュアルでビア及び配線を編集した際は無視されます。

・Max trace length on restricted layers

配線禁止層に対する最大配線長の許容を、表層と内層に指定します。

◆配線＞

 

ビアとファンアウトの動作設定／Route＞

 

Vias

 

& fanouts

Max pins per plane 
fanout

 

via = 1の時、１

 

つのピンに対して１つ

 

のFanoutビアが配置さ

 

れます。

Max pins per plane 
fanout

 

via = 2の時、

 

２つのピンに対して１

 

つのFanoutビアの共

 

用が許可されます。

ファンアウトビアまで

 

のトレース長は3mm

 

まで作成可能。
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◆グリッド／Grids タブ

部品配置、マニュアル配線、Drawコマンドの作画時に使用するグリッドの設定を行います。

部品グリッド

配線及びビアグリッド

その他グリッド

部品配置用グリッド。
Primary gridはSecondary gridで割り切れる数値であること。

部品配置用グリッドに対するオフセットを設定します。

・Criteria for parts using Primary Grid

Minimum # of pinsで指定したピン数以上を持つ部品
且つ
Mount styleで指定したマウントタイプを持つ部品
が配置用グリッドとしてPrimary gridを使用します。

・Part

 

grid

 

snap

この項目では、配置用グリッドに対して部品のどの位置に対してスナップするのかを設定します。

セル原点をグリッド上に乗せる場合に選択します。

ピンマトリクスの中心をグリッド上に乗せる場合に選択します。

◆グリッド＞

 

部品グリッド／Grids＞

 

Part Grids
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配線用グリッド。

ビア用グリッド。
Via gridはRoute gridで割り切れる数値であること。

配線用グリッドに対するオフセットを設定します。

作画用グリッド。
Drawモード時は、アイコン

 

にて設定が可能となります。

ジャンパー配置用グリッド。

テストポイント配置用グリッド。
※このグリッドはセットアップパラメータ内で設定します。

◆グリッド＞

 

配線グリッド／Grids＞

 

Route Grids

◆グリッド＞

 

その他グリッド／Grids＞

 

Other Grids

配置/配線用の各グリッドは、基板の原点を基準に発生します。オフセット値を設定することで、グリッド発生ポイン

 

トの基準点を基板原点位置からずらすことができます。
Note
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Chapter 3
Design Process-Placement

概要
Placement（配置プロセス）では、部品配置の手法 及び 配置工程で有効となる様々なコマンドを説明します。

• 部品配置

 

－ 188P
• 部品配置の編集コマンド

 

－ 198P
• サーキット移動とコピー

 

－ 209P
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部品配置

Chapter3: Design Process-Placement
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◆ 部品配置／Place Parts and Cells

Expedition PCBでは、部品配置を行なうための専用メニューが用意されています。このメニューは、エディタプルダウンの
Place＞ Place Parts and Cellsコマンドを実行することで開くことができます。

最上段にある3つのチェックボックスは、メニュー内にリストされる部品を設定するものとなります。各チェックボックスにチェック

 

を入れることで、それに該当する部品がメニュー内にリストされます。

Unplaced ：未配置部品
Distributed ：基板（ボードアウトライン）の外側に配置された部品
Placed ：既に配置された部品

該当部品がリストされます。
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Criterion項目では、リストされる部品を如何にソートさせるかを設定し、リストより選択したカテゴリでリスト内の部品がソートされ

 

ます。

この項目を選択するとリストが表示されます。

選択したカテゴリでソートがかかる。

パッケージ部品ではないセルや、ネットに存在しない部品を配置する場合には、このCriterion項目の“Mechanical 
Cell”や“Spare by xxx”を選んで下さい。

ネット情報に無い部品の配置時に選択します。

また、Criterion項目横の空欄について検索文字を入力することで、リスト内のターゲットとなる部品を選別することができます。

 

ここに入力する検索文字の後ろには、表示されない＊（ワイルドカード）が常に存在し、Uと入力するとU*としての検索作業を

 

行なうのと同じ効果を得ることができます。

ここに文字を入力することで、入力文字を頭に含む
部品を検索することができます。

結果はリスト内に表示されます。

Note
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Criterion（基準リスト）動作

・Connected to Distributed －基板外に配置された部品に接続する部品をリストします。
・Connected to Placed －配置された部品に接続する部品をリストします。
・Connected to Selected －選択された部品に接続する部品をリストします。
・Connected to Highlighted －ハイライトされた部品に接続する部品をリストします。
上記項目のActiveリストには #項目が表示され、選択された基準に対して各部品がいくつ接続しているかを表します。

・Nets & Net Classes －指定したネット又はネットクラスを持つ部品をリストします。

・Ref Des －Ref Des（回路番号）をキーに部品をリストします。
・Part Number －Part Number（部品番号）をキーに部品をリストします。

・Package Cell －ローカルライブラリに存在するTOPセルの部品をリストします。
・Package Cell by Type －ローカルライブラリに存在するTOPセルをタイプ毎にリストします。
・Package Cell by Mount Type －ローカルライブラリに存在するTOPセルをマウントタイプ毎にリストします。

・Room －エディタコントロールで定義したRoom情報をもとに部品をリストします。
・Cluster －エディタコントロールで定義したRoom情報をもとに部品をリストします。
・Schematic Cross Probe －このオプションはCross Probeで設定した回路図で選択した部品をリスト表示 又は

カーソル表示します。

・Spare by Package Cell －ライブラリに存在する部品をセルを基準にリストして、スペア部品として配置します。
・Spare by Part Number －ライブラリに存在する部品をPart Numberを基準にリストして、スペア部品として配置します。

 

スペア部品は自動的にSP(数字)のRef Desが付与されます。このRef Desは必要により
Renumber Ref Des（Ref Des編集）

 

コマンドで変更可能です。

・Mechanical Cell －リストに表示されたメカニカルセルを配置します。
・Drawing Cell －リストに表示されたドローセルを配置します。
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部品配置を行なうには、作業対象となる部品を上部リストから下にあるActiveリストへ移動させる必要があり、アクティブリスト側

 

へ移された部品に対してのみ作業が許されます。アクティブリストへの移動は、左にある矢印ボタンで行ない、対象となる部品

 

を選択した後に矢印ボタンを押して移動して下さい。

リストから対象を選択してこのボタンを押す。

このリストに移動した部品だけが作業の対象となります。

アクティブリスト内の部品を選択すると、Cell項目に示されたセル形状をプリビュー画面で確認することができます。プリビュー

 

画面右の各設定項目は、作業時時における初期状態を設定する項目となります。

セル形状を表示。

作業時における初期状態。

Active Layer ：初期状態の部品配置面の指定を行ないます。

Active Angle ：初期状態の部品配置角の指定を行ないます。
0,30,45,90の角度がリスト内にあり、これ以外の角度を使用する場合は直接入力となります。

Action ：作業内容を選択します。
Place（配置）、Delete(削除）、Find（検索）の中から選択します。Delete及びFindは、このメニューを使
って基板上の部品を削除もしくは検索したい場合に使用します。

Method ：部品選択の方法を選択します。
連続した操作を行なう場合にはSequenceを、1回ずつ確認しながら行ないたい場合にはManualを選
択します。尚、Sequenceでの連続作業には、[Shift]キーを使って対象となる部品をすべて選択して
おく必要があり、これを行なわなかった場合には毎回部品を選択しなければなりません。



－ 193 －

このアクティブリスト内のCell項目には、その部品で標準的に使用されるTop Cellの値が表示されます。パーツデータベース内

 

にもしBottomやAlternates Cellが登録されていれば、この項目を選択することでそれらがリスト表示されます。配置時から形状

 

を変更したいという場合、ここの値を変更することでTop Cellに登録された形状以外のセルを直接使用することができます。

PDBに登録されたセルがリストされます。

メニュー左下にある2つのボタンは、プロパティメニューとエディタコントロールメニューを表示させるボタンとなります。プロパテ

 

ィメニューは、部品を座標指定で配置する際に使用し、エディタコントロールメニューは部品配置における禁則設定などを行

 

なう場合に使用します。

エディタコントロールメニューでは、部品配置に関するタブが自動的に
表示され、ここで設定された内容を基に部品配置や移動が行なわれます。
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◆部品配置の作業手順

① エディタプルダウンより、Place>>Place Parts and Cellsコマンドを実行してメニューを開きます。

② メニュー最上段のUnplacedにチェックを入れ、リストに未配置部品をすべてリスト表示します。

③ リスト左側にある矢印（下向き[>>]）ボタンを選択して、全ての部品をアクティブリスト側へ移動します。

ここをチェックする。

全てを移動

このボタンですべて移動します。



－ 195 －

④ アクティブリストの部品の先頭と末尾を[Shift]キーを押しながら選択し、全ての部品を選択状態にします。

[Shift]キーを使ってすべてを選択。

⑤ プリビュー画面右のMethodの値を“Sequence”とし、メニュー下の[Apply]ボタンを選択します。

このボタンで作業開始。

アクティブリストの部品をまとめて選択した場合は、
Sequenceを選択して連続作業とします。

⑥ マウスカーソルに部品が追従しますので、配置ポイントをマウスで選択します。

配置するポイントをマウスで指定します。
配置されると、アクティブリストで選択された部品が順次
マウスカーソルに追従しますので、連続作業が行なえます。

※尚、部品がマウスに追従している状態では、Tabキーで
部品配置・移動に使用する基準点を、1番ピン・ピンマトリ

クスの中心・セル原点に切り替えることができます。

作業を中断する場合には、ESCキーを数回押して下さい。コマンドがキャンセルされるとマウスカーソルから部品

 

が無くなります。
Note
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マウスカーソルに部品が追従している状態では、部品配置に関するオプションコマンドを使用することができます。このオプシ

 

ョンコマンドは部品操作時にアクションキーメニューへとマッピングされ、各コマンドを実行することで部品の角度や配置面をリ

 

アルタイムに変更しながらの作業が行なえます。

F3：Rotate 90 ピンが90度回転します。
F4：Rotate 180 ピンが180度回転します。
F5：Push ピンがPushします。
F6：Rip-up Segment ピンに接続された第一セグメントのトレースが削除されます。

またビアを介して他のピンに接続されている場合は、ビア以降の第一セグメントが削除されます。
F7：Rip-up Junction ピン間のトレースが削除されます。

また分岐ポイントが存在する場合は、ピンから分岐ポイントまでのトレースが削除されます。

ビアを介して他のピンに接続されている場合は、ビア以降のセグメントが削除されます。
F8：Rip-up ALL ピン間のトレースが削除されます。

分岐ポイントがあれば、ピンから分岐ポイントまでのトレースが削除されます。
F10：

 

Snap to Grid 部品グリッドへスナップされます。

※Rip-up（リップアップ）によるトレース削除箇所は以下の通りです。

 

が移動部品となります。

ピン間が接続

ピン間に未結

 

線が存在

ビアを介して

 

接続

分岐ポイント

 

が存在

F7 Rip-up
Junction

F6 Rip-up
Segment

F8 Rip-up
All

Rip-up segment

 

では移動部品に

 

接続された第一

 

セグメントが削除

 

されます。

Rip-up segment

 

では移動部品に

 

接続された第一

 

セグメントが削除

 

されます。

Rip-up Junction
/Allでは移動部

 

品に接続された

 

分岐ポイントまで

 

のトレースが削除

 

されます。

Rip-up segment

 

では接続された

 

ビア以降の第一

 

セグメントが削除

 

されます。

 

Junctionでは、ビ

 

ア以降のトレース

 

が削除されます。
Allは全て削除さ

 

れます。
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◆座標指定配置

座標指定で部品を配置したい場合、プロパティメニューを表示させておく必要があります。アクティブリストで部品を選択する

 

前にプロパティメニューを表示しておくと、部品が選択された時点でその部品のプロパティ情報がメニュー 内に表示されます

 

。この時に、メニュー内の座標入力欄に対して値を入力し、プロパティメニューの[Apply]ボタンを選択することで、その部品を

 

座標指定で配置することができます。

座標や角度を入力。

・座標指定配置では、部品への連続作業が行なえません。したがって、対象となる部品をアクティブリストから毎回選

 

択する必要があります。
・ファイルによる座標指定配置（移動）に関するキーイン（ショートカット）操作については、Chapter1-Expedition PCB

 

エディタの操作方法のキーインコマンド（P33）を参照ください。

このボタンで配置決定。

Note
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部品配置の編集コマンド

Chapter3: Design Process-Placement
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Placeプルダウン以下には、部品配置編集に関するコマンドが収納されています。

部品配置に関する編集用コマンド。

◆部品を未配置／Unplace Part

アンプレスパーツコマンドは、配置した部品を削除する場合に使用します。削除対象となる部品を選択した後にこのコマンドを

 

実行することで、その部品を削除することができます尚、このコマンドと同じ効果が、コマンドの変わりにキーボード上の

 

[Delete]キーを押すことで得られます。

◆部品スワップ／Swap Parts

スワップパーツコマンドは、部品の物理的な位置交換を行なう場合に使用します。コマンド実行後に対象となる部品を順に選

 

択することで、部品の配置位置を交換することができます。

順に選択。
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◆移動／Move

ムーブコマンドは、部品を移動する場合に使用します。コマンド実行後に対象部品を選択、もしくは対象部品を選択後にこの

 

コマンドを実行することで部品を移動することができます。また、部品の移動時には、部品配置時と同様にアクションキーにマ

 

ッピングされた各コマンドで部品の回転や配置面の変更がダイナミックに行なえます。

ビアピンと接続されていない浮き配線は削除されます。

部品間で接続された配線は、
移動後に自動で再配線されます。

◆配置面変更／Push

プッシュコマンドは、部品の配置面を変更する場合に使用します。対象となる部品を選択した後にコマンドを実行することで、

 

部品の配置面を変更することができます。

◆回転／Rotate 90，180

ローテートコマンドは、部品の配置角を変更する場合に使用します。対象となる部品を選択した後にコマンドを実行することで

 

、部品の配置角をそれぞれ90度/180度単位に変更することができます。

◆ムーブサーキット／Move Circuit

ムーブサーキットのスイッチでは、移動された部品に結線された配線の取り扱いを設定しています。部品に結線された配線を

 

部品と連動して移動させたい場合には、このスイッチをオン（チェックマークを付けた状態）にして下さい。尚、スイッチで部品

 

と連動して移動する配線は、部品のピンとビアピンを結ぶピン間の配線のみとなり、それ以外の配線は通常通りに再配線の対

 

象となります。移動の際には、エリア選択の後に移動の際の基準点を指定します。
この基準点は、Tabキーを使用することで候補変更が行なえます。

部品移動に関するキーイン（ショートカット）操作については、Chapter1-Expedition PCBエディタの操作方法のキーイ

 

ンコマンド（P33）を参照ください。
Note
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◆整列／Align Left，Right，Top，Bottom

各オリジンコマンドは、複数の部品を整列させる場合に使用します。対象となる部品全てを選択し、整列方向に対応する各コ

 

マンドを実行することで、指定した部品を指定した方向に整列させることができます。尚、部品整列の際に使用される基準点

 

は、エディタコントロールメニューのPartsタブ内にあるPart alignmentで設定します。

セル原点を基準とする場合に選択します。

ピンマトリクスの中心を基準とする場合に選択します。

部品のピンを基準とする場合に選択します。

Align Leftでは選択した部品の最も左側、Align Rightでは選択した部品の最も右側の部品に対して整列させることができます。

Align Leftの基準部品

Align Rightの基準部品

Align Topでは選択した部品の最も上側、Align Bottomでは選択した部品の最も下側の部品に対して整列させることができま

 

す。

Align Topの基準部品

Align Bottomの基準部品
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◆固定とロック／Fix，Lock

フィックス及びロックコマンドは、部品を固定化する場合に使用します。対象となる部品を選択した後にコマンドを実行すること

 

で、部品を固定化することができます。固定化された部品は画面上中抜け表示となり、Unfix/Unlockコマンドを使用して固定

 

化を解除しない限り、移動や削除といった操作が行なえなくなります。このフィックスとロックは、単にフラグ特性が異なるのみと

 

なり、エディタ上での効果に違いはありません。フィックスはアンフィックスコマンドでのみで解除することができ、ロックはアンロ

 

ックコマンドでのみ解除することができます。

◆固定解除とロック解除／Unfix，Unlock

アンフォックス及びアンロックコマンドは、部品の固定化を解除する場合に使用します。対象となる部品を選択した後に固定化

 

特性に応じた解除コマンドを実行することで、部品に施された固定化を解除することができます。フィックスはアンフィックスコ

 

マンドで解除し、ロックはアンロックコマンドで解除することができます。

・複数部品への同時操作について

ここで述べた各編集コマンドは、部品をまとめて選択することで複数の部品に対する一括操作が行なえます。Rotateコ

 

マンドにおける一括操作では、まとめて選択した部品の状態でその効果に違いが生まれます。

選択した部品が基板上の位置にある（マウスカーソルに追従していない）状態でローテートコマンドを実行した場合、
部品の配置位置は変更せずに個々の部品がその場で回転します。

個々の部品がその位置で回転する。

選択した部品がマウスカーソルに追従している状態でローテートコマンドを実行した場合、マウスカーソルに追従した状

 

態で全ての部品がまとめて回転します。

まとめて回転する。
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◆コピーサーキット／Copy Circuit

コピーサーキットコマンドは、既に配線作業が完結した回路部と等価な回路情報を自動的に抽出し、抽出された回路部を既

 

存の形のままに自動作成させるコマンドとなります。この機能を使用するには、エディタプルダウンメニューのPlace>>Copy 
Circuitを選択し、コピーサーキット機能を有効な状態にする必要があります。

コピーサーキットを選択し、この機能を有効にします。
このボタンを押した状態にすることで、コピーサーキットが有効になります。

・コピーサーキットの作業手順：

①コピーサーキットボタンを選択し、コピーサーキットを有効にします。

②対象となる回路部を基板上より選択します。

選択したブロック全体が雛形となります。

③アクションキー内にある[2 Copy]ボタンを選択すると、未配置部品の中から選択されたブロックと等価な回路情報

を検索し、等価な回路情報が見つけられた場合にのみ、雛型となるブロックを模倣してマウスカーソルに追従しま
させます。マウスカーソルに等価回路が表示されれば、あとはポイントをを指定して基板上に配置して下さい。

コピーされた内容が、マウスカーソルに追従する。

回路ブロックがカーソルに追従している状態では、アクションキーの内容は通常の部品移動時と同様の内

 

容を示し、ブロック単位での角度変更が可能です。また、自動検出された回路情報が表示されたもの以外

 

の組み合わせで存在した場合、全候補が無くなる（配置し終える）まで、この

 

コマンドは継続され、アクショ

 

ンキーにある[Next Set]もしくは[Previous Set]にて作業対象候補を順次変更することもできます。

U1 U5 U2 U6

U1 U5
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◆グループ化と解除／Group，Ungroup

グループコマンドは、特定の部品をグループ単位で操作する場合に使用します。グループ化したい部品全てを選択
し、プルダウンメニューよりPlace>>Groupコマンドを選択することで部品をグループ化することができます。このグループは、基

 

板上に複数作成することができます。一度グループ化された部品は、移動や削除といった操作が全てグループ単位で行なわ

 

れ、Ungroupコマンドでグループ化を解除しない限り、このグループ情報は保持されます。

このコマンドは、対象となる部品を先に選択しない限り有効にはなりません。グループ化された部品については、表示

 

上は特に他の部品と変わりませんが、部品選択がグループ単位となります。

◆グリッドへスナップ／Snap to Grid

選択した部品を、Placement Grid上のポイントへオングリットとなるように移動します。
コマンドは、Editor Control＞ Grids＞ Part Grids＞Part grid snapの設定に依存し、Cell Originの設定ではセル原点が、

 

Centroid of Pinの設定ではピンマトリクスの中心がGrid上へスナップされます。

Note

セル原点をグリッド上に乗せる場合に選択します。

ピンマトリクスの中心をグリッド上に乗せる場合に選択します。
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◆自動スワップ（セル名でスワップ、パーツナンバーでスワップ）／Swap/Rotate by Cell Name & Part Number

オートマティックプルダウン以下には、2つの自動系コマンドが収納されています。

スワップ/ローテート・バイ・セルネームコマンドでは、配置済みとなる部品に対する配置情報の最適化を促します。メニュー上

 

段より対象となる部品を選び、Modification Type項目で実行する作業タイプを選択、[Apply]ボタンを押して作業を実行します

 

。

作業内容を選択します。
Flipとは、ネットラインを最短にすべく、部品を180

 

度回転させるもの。

システムに対し、自動的に最適化の余地が無くなるまで作業を
連続して行なわせる場合にチェックを入れます。

作業が終了すると、その結果がリストされます。

対象となる部品はすべてIncludeリストへ
登録します。
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作業内容を選択します。
Flipとは、ネットラインを最短にすべく、部

 

品を180度回転させるもの。

システムに対し、自動的に最適化の余地が無くなるまで作業を
連続して行なわせる場合にチェックを入れます。

対象となる部品はすべてIncludeリストへ
登録します。

作業が終了すると、その結果がリストされます。

・この機能を使用するためには、PDB内にてゲート、ピンスワップが可能となるように設定する必要があります。
・ここで行なわれる自動最適化コマンドの結果は、あくまでもツールのアルゴリズムから判断した結果となります

 

ので注意して下さい。

スワップ・バイ・パートナンバーコマンドでは、配置済みとなる部品に対して配置情報とピン・ゲートスワップの最適化を促します

 

。メニュー上段で対象となる部品を選び、Modification Type項目で実行する作業タイプを選択、[Apply]ボタンを押して作業を

 

実行します。

Note
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◆ポーラー配置／Polar Array Placement

ポーラーアレイプレスメントコマンドは、指定した複数の部品を放射線状に配置するためのコマンドとなります。プルダウンメニ

 

ューのPlace＞

 

Polar Place…コマンドを選択した後に表示されるメニューを使って、指定した座標を基準に、選択した複数の部

 

品を放射線状に円形配置することができます。

円形配置を行なう際の原点（円の中心）座標を設定。

配置面を指定。

Radius

 

：

 

円形配置する際に使用する円の半径を指定します。

Start angle

 

：

 

部品を配置し始める最初の角度を指示します。

Sector angle

 

：

 

こちらのスイッチでは、角度で配置する部品間隔を指定します。
#of sectors

 

：

 

こちらのスイッチでは、何分割にして部品を配置するかを指定します。

Additional rotations

 

：

 

各部品の配置に使用する角度を指示します。

 

（0度、90度、180度、270度のみ）

Place parts on radius by

 

：

 

配置に使用する部品の基準点の扱いを指示します。
・Cell origin

 

：セルの原点
・Centroid

 

of pins

 

：ピンマトリクスの中心
・Pin 1

 

：1番ピン
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リスト表示の対象に、配置済み部品を加える場合にチェックを入れます。

Dialog Listボタンを選択すると、リストが表示されます。対象となる部品を＜Shift＞キーなどを

併用してすべて選択します。

このコマンドは、配置済みの部品を対象にすることもできます。メニュー内で設定された内容での配置が行な

 

われますが、DRC等に違反した場合などにはエディターコントロールメニューなどの設定内容に依存した動作

 

となります。Note
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サーキット移動とコピー
（Circuit Move ＆

 

Copy）

 

コマンド

Chapter3: Design Process-Placement
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◆サーキット移動とコピー／Circuit Move & Copy

Expedition PCBでは、既存のサーキット（回路ブロック）を移動または

 

コピーするための機能を提供しています。この機能でコ

 

ピーされるのは部品の

 

Part Number や相対的な配置座標や角度、またトレースの引き回しの形状などであり、各部品の

 

Ref_Des や

 

ネット名

 

についてはコピー先のデザイン（ホストデザイン）に合わせて変更することが可能です。また、同一デザイ

 

ン内でのコピーはもちろん、クリップボードを使用してのデザイン間でのコピーも可能です。

Circuit Move & Copy… を選択しますと、メニュー等が以下のように変化します。

・

 

自動的に配線モードへ切り替わります。

・

 

アクションバーが以下のように変化します。

・

 

Select by Area ツールバーが表示されます。

・

 

Selection Filter ダイアログボックスが表示されます。 ・マウス右ボタンのポップアップメニューが以下のように変化します。

アクションバーの “12 Finish” （F12）

 

をクリックするか、マウス右ボタンのポップアップメニューから Finish を選択することで、

この状態から抜けることができます。
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◆回路ブロックの移動・コピー手順

①

 

まず、Selection Filter を使って、対象とするオブジェクト

 

および

 

レイヤ

 

を指定します。チェックが入っているものが
移動・コピー対象になります。

Object （タブ）

 

：
オブジェクトタイプ単位でフィルタをか

 

けます。デフォルトは

 

Design reference

 

（基板外形、製造外形、配線領域、原

 

点）

 

のみチェックが外れた状態です。

Layer （タブ）

 

：
作画オブジェクトについて、レイヤ単位

 

でフィルタをかけます。（禁止領域も

 

Layer タブの層番号で制御します。）

② Select By Area ツールバーにてグリッドを指定します。
※ グリッドとしては、Editor Control に設定されている、Primary Part, Secondary Part, Route, Via, Jumper, Test point,

Drawing, Custom Grids および Grid None（グリッドなし）

 

をプルダウンリストから選択できます。

③ Select By Area ツールバーの以下の 3 つのシェイプ形状のいずれかをクリックして選択し、そのシェイプにて、デザイン

 

内の移動・コピーしたいブロックを領域選択します。

④ 領域選択が完了しますと、以下の 3 つのアイコンがアクティブ（選択可能）になります。
※ トレースについては、これらのアイコンで細かい指定が可能です。（部品については、部品を構成するオブジェクト

いずれかの一部（パッドは除く）でもシェイプに掛かれば部品全体が選択されます）

Inside Area Extents
ON の場合、選択された部品のパッドにつながっているトレースのみを選択します。

Split Traces at Area Extents
ON の場合、シェイプの境界線でカットし、内側にあるもののみを選択します。

Reset Selection
一度選択した後でSelection Filterを変更した場合このアイコンでリフレッシュします。
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⑤

 

選択ができましたら処理を選択します。

Inside Area Extents と

 

Split Traces at Area Extents の組み合わせは次の 4 通りです。

※

 

シェイプに掛かるすべてのトレースが選択されます。 ※ 選択されたパッドにつながるトレースのみが選択されます。

※ シェイプに掛かる全てのトーレスが選択され
さらに境界線でカットされます。

※ 選択されたパッドにつながるトレースのみが選択され

さらに境界線でカットされます。

F2 Move ：
選択したブロックを移動します。

F3 Rotate 90 ：
選択したブロックをその場で

 

90 度反時計回りに回転します。DRC エラーとなる場合回転できませんので、
まずは一旦

 

Move（F2）

 

を行い、移動中に

 

Rotate 90（F3）

 

を行うとスムーズに行えます。
F4 Rotate 180 ：

選択したブロックをその場で

 

180 度回転します。Rotate 90（F3）

 

と同様、移動中に行うとスムーズです。
F5 Push ：

 

（次ページ以降にて詳細説明）
選択したブロック内の配置部品や配線要素の配置面を入れ替え、X軸対称にミラー反転します。

F6 Change Layer ：

 

（次ページ以降にて詳細説明）

選択したブロック内の各層を入れ替えます。
F7 Copy Circuit ：

 

（次ページ以降にて詳細説明）

選択したブロックをコピーします。同一デザイン内にペーストする場合に使用します。
Edit > Copy to Layout Clipboard ：

 

（次ページ以降にて詳細説明）

選択したブロックを一旦クリップボードにコピーします。主に、別のデザインにペーストする場合に使用します。
クリップボードのデータは

 

Expedition

 

PCB 終了後もファイルとして保持されています。
これにより他のデザインを開いてペーストする、などといったことが可能です。
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⑥

 

基板外形、製造外形、配線領域、基板原点、ドリル原点のいずれかがコピー対象に含まれていた場合、以下のダイアログ
ボックスが表示されます。処理対象とするオブジェクトにチェックを入れて、

 

OK ボタンをクリックします。

【[F6 Change Layer] を実行した場合】

Change Layer ダイアログボックスが表示されます。このダイアログボックスでは、各層にあるトレース、ビア、プレーンシェイプ、コ

 

ンダクティブシェイプなどの配線要素を他の層と入れ替えるための設定を行います。また、レイアウトデザイン上で追加した作画

 

オブジェクトのレイヤも変更することができます（但し、ユーザー定義レイヤを除く）。設定内容はSchemeとして保存することがで

 

きます。

[F2 Move]、[F3 Rotate 90]、[F4 Rotate 180] を行った場合、すぐに部品の移動、回転が行われます。その他のコマンドを実行

 

した場合については、それぞれ以下に説明します。

Mounted parts:
選択された部品（読み取り専用）

Physical layers:
選択された配線要素のBefore/Afterの層のマッピング
Before

 

:

 

入れ替え前の層
Item Count

 

:

 

その層に存在する選択されたオブジェクト数
After

 

:

 

入れ替える相手となる層
Plane Nets

 

:

 

その層に設定されたPlane net

Scheme

Draft layers:
作画オブジェクトのBefore/Afterのレイヤのマッピング

Before

 

:

 

変更前のレイヤ
Item Count

 

:

 

そのレイヤの選択されたオブジェクト数
After

 

:

 

変更後のレイヤ

・

 

BeforeとAfterの値が異なる層およびレイヤ（すなわち入れ替え/変更が行われる） は青字で表示されます。

・

 

配線要素については、層と層の入れ替えのみができます。ひとつの層を複数の層に移動することはできません。

・

 

作画オブジェクトについては、レイアウトデザイン上で追加したものだけが対象です。セルの中に作成されたオブジェクトは

 

入れ替え対象にはなりません。また、ユーザー定義レイヤも対象にはなりません。

・

 

DRC は考慮していません。入れ替えた先に禁止領域等があってもそのまま入れ替えを行います。

・

 

トレースとビアやパッドの接続状態は処理の際に考慮していません。入れ替えによって接続状態が変わることもあります。

（表面層のパッドにつながるトレースを選択し、内層などと入れ替えると、当然、トレースとパッドの接続は切れます。）
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ビアが処理対象として選択されている場合、入れ替える層に合わせてビアも置き換わります。

※ ただし、いずれの場合も下図のように、入れ替え後に必要となるビアが予めパラメータ設定にて定義されていないと

 

いけません。パッドスタックは同じでなくても問題ありません。ただし径が大きくなる場合、置き換え後に他のオブジェクト

 

と干渉する可能性があります（DRCを考慮せずに置き換えられます）。

例 1 ）

 

1-2 のビアが選択されている状態で、次のような入れ替えを行うと、2-3 のビアに置き換わります。

※ ビアのスパンを長くするような入れ替えはできません。

例）

 

1-2 のビアが選択されている状態で、次のような入れ替えはできません。エラーとなります。

例 2 ）

 

1-2 のビアが選択されている状態で、次のような入れ替えを行うと、3-4 のビアに置き換わります。

定義されていない場合、エラーとなり、層の入れ替え処理は行われません。
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【[F5 Push] を実行した場合】

基本的な動作は [F6 Change Layer] と同じです。ただし次のような特徴があります。

・

 

部品の配置面を反転します。
・

 

配線要素についても、層をすべて反転した設定がデフォルトになります。(変更は可能です。）
・

 

選択したすべてのオブジェクトがX軸対称にミラー反転されます。

Mounted parts:
選択された部品（読み取り専用）

Physical layers:
選択された配線要素のBefore/Afterの層のマッピング
Before

 

:

 

入れ替え前の層
Item Count

 

:

 

その層に存在する選択されたオブジェクト数
After

 

:

 

入れ替える相手となる層
Plane Nets

 

:

 

その層に設定されたPlane net

Scheme

Draft layers:
作画オブジェクトのBefore/Afterのレイヤのマッピング

Before

 

:

 

変更前のレイヤ
Item Count

 

:

 

そのレイヤの選択されたオブジェクト数
After

 

:

 

変更後のレイヤ
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⑤

 

ペーストが完了するとすぐに残りの部品を使って

 

Instantiation Wizard が表示されます。

◆コピーした場合のペースト手順（[Copy Circuit(F7)] および [Edit > Copy to Layout Clipboard] を実行した場合）

①

 

コピーする際に、

 

Copy Circuit(F7) をクリックした場合は、そのまま自動的にペースト処理に入ります。
Edit > Copy to Layout Clipboard でクリップボードにコピーした回路ブロックをペーストする場合は、ペースト先のデザイン
（ホストデザイン）を開き、

 

Edit > Copy to Layout Clipboard を選択します（このとき、サーキット移動とコピーを一旦実行する

 

必要はありません）。

②

 

Instantiation Wizard が表示されます。このウィザードは

 

4 つの

 

タブ

 

を持ち、ここで、コピー元回路ブロックをホストデザイン

 

にペーストする際の

 

Ref Des や

 

Net 名、また

 

ペースト先の層

 

や

 

ユーザーレイヤ

 

のマッピングを行います。
これら

 

4 つのタブは連動しており、一箇所設定を変更することで他のタブ内の値が連動して変わる場合もあります。
はじめは、システムが最適と判断した設定が行われた状態で表示されます。

③ 各タブでの設定が完了したら、 OK ボタンをクリックし、ホストデザインにペーストします。

④ Edit > Copy to Layout Clipboard の場合で、かつ 基板外形、製造外形、配線領域、基板原点、ドリル原点のいずれかが

 

コピーされていた場合、以下のダイアログボックスが表示されます。貼り付けたいオブジェクトにチェックを入れて、

 

OK ボタン

 

をクリックします。
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各タブについての説明 ：

■Ref Des タブ
Ref Des タブでは、コピー元回路ブロック内の Ref Des と ホストデザイン内の Ref Des とのマッピングを行います。

Ref Des

 

:

 

コピー元回路ブロック内での

 

Ref Des
Part Number

 

:

 

コピー元回路ブロック内での

 

Part Number
Number of Pins

 

:

 

コピー元回路ブロック内での

 

ピン数
Equivalent Cell

 

:

 

コピー元回路ブロック内での

 

セル名
Equivalent Ref Des

 

:

 

ホストデザイン上での

 

Ref Des
Lock

 

:

 

ロック

・Equivalent Ref Des の候補となるのは、コピー元回路ブロック内の部品と

 

Part Number が同じで、かつ Unplaced （未配置）

 

かDistributed （基板外）

 

の部品です。

・

 

Lock にチェックを入れることで、システムがその設定を変更してしまうことを防ぐことが出来ます。
Lock にチェックが入った状態でもユーザー自身は変更することができます。

・

 

システムが選び出した Ref Des 以外の値にユーザーが変更した場合、自動的に Lock にチェックが入ります。

・

 

Use same Ref Des only にチェックを入れると、コピー元回路ブロック内 の Ref Des がそのままホストデザイン上で使用され

 

ます。（つまり、Equivalent Ref Des 欄の値が、Ref Des 欄の値と同じになります。）
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この状態で、OK をクリックした場合は、それぞれ以下の警告が表示されます。
Ignore ボタンをクリックすることで、警告を無視してペースト可能なオブジェクトのみをペーストすることが可能です。

-unmapped- の場合

配置済部品が選択されていた場合

■ Nets タブ
Nets タブでは、コピー元回路ブロック内の ネット

 

と

 

ホストデザイン内の

 

ネット

 

とのマッピングを行います。
Ref Des タブで選択した Ref Des を考慮して、自動的に最適なネット名がマッピングされます。

コピー元回路ブロック内での ネット名

ホストデザイン上でのネット名

ロック

Circuit Pin Nets:
部品のピンにつながっているトレースのネット
（必然的にホストデザイン上の部品のピンと同
じネットをマッピングすることになります。）

Floating Items:
部品のピンにつながっていないトレースのネット

・-unmapped- または 配置済 の 部品が Equivalent Ref Des として設定されている場合は、Equivalent Ref Des 欄が赤色となり、

再設定を促します。（マッピングエラーの状態）
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※

 

Ref Des タブ と

 

Nets タブ には共通した2 つのボタンが存在します。

（どちらのタブを表示した状態でクリックしても動きに違いはありません。）

Show Report ：
InstantiationWizard.txt を表示します。主にマッピングの結果レポートです。

Resolve ：
Ref Des タブ、

 

Nets タブ の設定の整合性を保つためにシステムが設定を調整します。
Lock の状態によって結果は変わります。

・ 同じネット名が Nets タブ内に複数設定されているものについては黄色く表示され注意を促します。（必ずしもエラーという

 

わけではありません。）

・

 

Lock にチェックを入れることで、システムがその設定を変更してしまうことを防ぐことが出来ます。
Lock にチェックが入った状態でもユーザー自身は変更することができます。

・

 

システムが選び出した ネット

 

以外の値にユーザーが変更した場合、自動的に Lock にチェックが入ります。

・

 

Circuit Pins Net : の ネットは、Ref Des タブで指定した部品のピンが持つネットと同じネットをマッピングする必要があります。
もし、Nets タブの Circuit Pin Nets: で指定したネット

 

が一致しない場合は、Ref Des の再選択を促すため、Ref Des タブの
Equivalent Ref Des 欄がオレンジ色になります。

この状態で、OK をクリックした場合は、以下の警告が表示されます。
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■

 

Physical Layers タブ
Physical Layers タブでは、コピー元回路ブロック内の各層のオブジェクトを、ホストデザインのどの層にペーストするか、といっ

 

たマッピングを行います。

Circuit Layer:

Layer ：

 

コピー元回路ブロックの層構成
Number of Items ： その層に含まれるオブジェクト数
Map To ：

 

ホストデザインでの層（ペースト先）
Plane nets ：

 

コピー元デザインの Plane Assignments ダイアログボックスに設定されているプレーンネットのうち、

 

回路ブロック内で使用されているネット。

 

黒か赤、どちらかの色で表示されます。

黒 - ホストデザインの Plane Assignments ダイアログボックスに設定が引き継がれるもの。
Map To で選択した層に引き継がれます。

赤 - Map To で none が選ばれるなどしてその設定がホストデザインの Plane Assignments
ダイアログボックスに引き継がれないもの。

Host Design Layers Preview:

Layer ：

 

ホストデザインの層構成
Accepts Circuit Layer ：

 

Circuit Layer 項目でマッピングされた層
Plane Nets ：

 

ホストデザインの Plane Assignments ダイアログボックスで設定されているプレーンネット。

 

黒と青 どちらかの色で表示されます。

黒 - ホストデザインの Plane Assignments ダイアログボックスにすでに設定されているもの。
青 - ホストデザインの Plane Assignments ダイアログボックスに設定が無いため、追加されるもの。

Circuit Layer:
コピー元回路ブロックの層構成を基準として表

 

示します。マッピングの設定はこちらで行いま

 

す。

Host Design Layers Preview:
ホストデザインに対してどのようにマッピングさ

 

れるのかを、ホストデザインを基準として表示し

 

ます。

・

 

Map To で設定できるのは内層のみです。Top , Bot は変更できません。

・

 

Map To で none を設定した場合、コピー元回路ブロック内のその層のオブジェクトはペーストされません。

・

 

”Allow mapping more than one circuit layer to a one host layer” にチェックを入れた場合、Map To に重複した層を指定する

ことが出来るようになります。
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■

 

User Layers タブ
コピー元回路ブロック内に含まれる

 

User Layer オブジェクトをホストデザインのどの User Layer としてペーストするか、といっ

 

たマッピングを行います。

・

 

Map To Host Layer にて none を選択した場合、その User Layer のオブジェクトは、ホストデザインにペーストされません。

・

 

Circuit Layer  が、ホストデザインの Setup Parameters に設定されていない場合、Map To Host Layer の値は青色で表示
され、Create 欄のチェックボックスにチェックが入ります。（デフォルトはチェック有り）。
チェックが入っている場合、ペースト時に自動的にホストデザインの Setup Parameters に対してその User Layer 名が追加
されます。チェックを外した場合、 Map To Host Layer の値が自動的に none になります。

コピー元回路ブロック内で

 

のUser Layer名

コピー元回路ブロック内の

 

オブジェクト数

ホストデザイン上でのUser 
Layer 名

ホストデザインの Setup 
Parameters へのUser 
Layer 名の追加
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-- 補足 --

■ クリップボードの保存先

クリップボードにコピーされた回路ブロックは、デザインファイルとして以下のパスに保存されています。

%USERPROFILE%¥Local Settings¥Temp¥mgc_icc_clipboard¥

ただし、このパスは以下の環境変数で指定することも可能です。

MGC_LAYOUT_CLIPBOARD_PATH = <user defined path>

例）

 

MGC_LAYOUT_CLIPBOARD_PATH = C:¥temp を設定すると、C:¥temp¥mgc_icc_clipboard というフォルダが
作成され、その中に保存されます。

ライセンスに余裕がある場合は Expedition PCB を 2 つ起動し、それぞれでデザインを開いた状態でリアルタイムに コピー＆

 

ペーストすることも可能です。

■ コピーする回路ブロックの原点の設定
マウス右ボタンのポップアップメニューの Set Origin を使うことで、クリップボードに保存される回路ブロックの原点を指定する

 

ことが可能です。（デフォルトはクリップボード内総部品のエクステントの中心）
この原点はペーストする際、確定までの間の移動、回転などの作業で有効です。

なお、Set Origin 実行中、マウス右ボタンのポップアップメニューは以下のように変わります。これで、原点を指定する際のスナ

 

ップの動きを制御することが可能です。

Snap to critical points :
各オブジェクトのポイントにスナップします。（Offの場合、グリッドにスナップします。）

Restrict to selected items :
選択されたオブジェクト上にしかスナップしません。（上の

 

Snap to critical points が ON であることが条件です。）

※ 原点を指定した後は、コピーなどの操作 をアクションバーから忘れずに行ってください。
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Chapter 3
Design Process-Routing

概要
Routing（配線プロセス）では、マニュアル・半自動・自動の配線手法 及び プレーン作成時に必要な設定等を説明します。

・

 

マニュアル配線

 

－224P
・

 

自動配線

 

－281P
・ プレーンデータの作成

 

－303P
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マニュアル配線

Chapter3: Design Process-Routing
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◆マニュアル配線／Interactive Route

Expedition PCBにおける配線作業は、自動配線エンジンによって常に監視されています。これにより全てのマニュアル配線作

 

業では、ネットクラスやネットプロパティで設定されたクロストーク設定を除くほとんどの配線条件に拘束された半自動的な配線

 

作業環境が提供され、配線条件に違反するような配線を一切認めません。また、マニュアル配線時には、この自動配線エン

 

ジンに裏付けされたダイナミックな配線の押しのけ機能も提供され、ネットクラスで設定したクリアランス条件にもとづいた形で

 

、邪魔となる配線を押しのけながらの配線作業が行なえます。

Expedition PCBで配線作業を行なう場合には、Routeモードに切り替える必要があります。エディタをRouteモードに切り替える

 

と、ツールバーやアクションキーに対して配線用コマンドがマッピングされます。

◆ファンアウト／Fanout

ファンアウトコマンドは、表面実装部品のパッドからビアの引き出しを行なう場合に使用します。対象となる部品のパッド全てを

 

選択した後にアクションキーの[2Fanout]コマンドを実行します。尚、このコマンドは対象となるパッドを選択しなければアクティ

 

ブになりません。

配線用コマンドのツールバー

配線用コマンドのアクションキー

プルダウンメニューでは、Route＞

 

Interactive以下に各コマンドは収納されています。

Note
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◆配線／Plow

Plowコマンドは、Expedition PCBにおける一般的なマニュアル配線コマンドとなります。対象となるピンを選択した後にアクショ

 

ンキーの[3Plow]コマンドを実行、もしくは｢3Plow]コマンドを選択した後に対象ピンを選択することでラバーバンドが表示されま

 

すので、マウスでポイントを指定しながら配線を行ないます。

対象ピンを選択。

ラバーバンドを表示。

結線するピンを選択して配線を完了。

選択したピンのネットラインが全て表示されます。

ラバーバンドの頭からは、最短ターゲットまでの
ネットラインが常に表示されます。
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Plowコマンド中、下図のようにビアのゴーストが表示される場合があります。この場合、スペースバーやマウスのダブルクリック

 

を行なうことで、エディタコントロールメニューで指示したペア層間で層を入れ替え、ビアを配置して他層へ引き回すことが可

 

能です。

ビアのゴーストが表示される個所で、スペースバーもしくはマウスの
ダブルクリックを行ないます。

ビアが配置され、他層に引き回すことができます。

多層板の場合、引き回す層を自由に切り替えたい場合には、キーボードの矢印ボタン

 

の上下を使ってください。矢印ボタンの上下を指示することで、引き回しの層をダイナ

 

ミックに切り替えることが可能です。



－ 228 －

Plowコマンド中のマウス右ボタン（RMB）のポップアップメニューより、様々な配線編集動作が可能となります。

Plowコマンド中のRMBでポップアップが表示されます。

・Change Width

ネットクラスで指定したMinimum・Typical・Expansion

 

Widthより配線幅を指定します。

・Curve Trace Radius

カーブ配線時の円弧半径を指定します。詳細は、“カーブ切り替え／Toggle Curve”を参照ください。

・Change Next Via

配線時に使用するビアを変更します。通常ネットクラスで指定したNet Class Viaが使用されますが、このコマンドを使用するこ

 

とで、一時的に配置するビアの変更を可能とします。

ネットクラスで指定したDefault Viaには、（D）が表示されます。

Change Next Viaにリストされるビアは、Setup＞

 

Setup Parameters＞

 

Via DefinitionsのAllowed Via Padstacksで

 

チェックしたLocalビアとなります。
Note

ネットクラス以外の配線幅変更に関するキーイン（ショートカット）操作については、Chapter1-Expedition PCBエディタ

 

の操作方法のキーインコマンド（P32）を参照ください。
Note
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ビルドアップ基板など、マイクロビアが使用されているデータ上では、Plowコマンド中にシフトキーを押しながらマウス右ボタン

 

（RMB）でポップアップメニューを表示することで、指定層に対して階段状に一括して落とし込むことができます。

シフトキー＋RMBでポップアップが表示されます。

ポップアップから指定層を選ぶと、マイクロビアを使って階段状
に並ぶゴーストが表示されるので配置位置を指定します。

またポップアップメニューのTarget Layerより、主配線方向と配線可能な層を判断することができます。

ネットクラスで設定された配線禁止層。
※Max trace length on restricted layersで指定した配線長以内で配線可能。

Editor Controlで設定された配線禁止層。
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Plowコマンドを選択すると、アクションキーにPlowコマンドのオプションがマッピングされます。

◆配線モード切替／Toggle Plow Mode

トグルPlowモードでは、配線に対する動作を選択することができます。トグルPlowモードには、Forced /Route/Angleの3つの

 

モードが用意されており、行ないたい配線作業に応じてモード切り替えることができます。アクションキーにマッピングされた[3 
Toggle Plow Mode]を選択する毎にモードが切り替わり、現在のモードがエディタ画面左下に表示されます。

配線モード切替 グロスモード切替 自動終了

スイッチエンド ジャンパー配置 カーブ切り替え

現在のモードがここに表示されます。

・Forced Plow

フォースドモードは、配線経路を直感的に確認しながら配線作業を行なう場合に用います。このモードでは、ホッケー型のラ

 

バーバンドが常に表示されるため、ポイント指定後の配線形状を把握しながらの作業が行なえます。

ラバーバンドとほぼ同じパターンを
形成できます。

使用可能な配線モードは、Editor Control＞

 

Routeタブの
Plow modesでチェックする必要があります。

Note
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・Route Plow

Routeモードは、単純なポイント指定で配線作業を行ないたい場合に用います。このモードでは、直線のラバーバンドが常に

 

表示されるようになるので、パターン形状に拘束されずに配線作業が行なえます。しかし、実際に配線が作られないとその形

 

状が把握できないというデメリットも持ち合わせています。

実際にパターンが形成されなくては、パターン
の引き回しが確認できません。

直線のラバーバンドが表示されるので、途中の障害物などを気にせずにポイント（経路）指定が行なえます。

・Angle Plow

アングルモードは、90/45度に拘束されない自由角度の配線を行なう場合に用います。このモードでは、Routeモードと同様に

 

直線のラバーバンドが常に表示されますが、Routeモードとの違いは作成されるパターンが角度に拘束されないという点になり

 

ます。このモードで作成されたパターンは、指定したポイントへダイレクトに自由角度で引き回され、フォースドやRouteモード

 

のような90/45度の整形処理は全く行なわれません。

指定したポイントへダイレクトにパターンが
形成されます。

自由角度で配線されるパターンも、通常のパターンと同様にDRCが働きますので、クリアランス違反を起こすよ

 

うなポイントへの配線は認められません。また、アングルモードは配線の押しのけ機能の対象外となり、一切の

 

既存配線を押しのけることはできません。Note
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◆グロスモード切替／Toggle Gloss Mode

トグルグロスモードでは、配線に対する自動整形機能のON/Off切り替えが行なえます。グロスモードは、On/Off/Localの3つ

 

のモードが用意されており、アクションキーにマッピングされた[4 Toggle Gross Mode]を選択することでモードを切り替えること

 

ができます。現在のグロスモードは、エディタ画面右下のメッセージフィールドで確認することができます。

・Gloss On

グロスモードがOnの場合、パターン全てに対する自動整形がポイント指定毎に行なわれます。このモードを選んだ場合、パタ

 

ーン形状を細かくチェックする必要はありませんが、ポイント指定毎に整形が行なわれるため、配線経路を細かく指定したいよ

 

うなケースには向きません。

ポイントを指定しても、最後に
全体の整形が行なわれる。

・Gloss Local

グロスモードがグロスローカルの場合、ポイント指定毎にその区間（1セグメントあたり）の自動整形が行なわれます。このモード

 

を選んだ場合、奇麗な形状で配線を引き回すことができます。

全体ではなく、指定ポイント間での
部分的な整形が行なわれる。
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グロスモードがOffの状態では、ユーザーがパターン経路を正しく指示する必要があります。また、このモードで配線

 

やビア用グリッドを使用すると、Plowモードの設定との組み合わせ如何では配線作業が非常に困難になる場合があ

 

りますので注意して下さい。

このモードで作成されたパターンには半固定の属性が自動的に付与され、他の配線作業で押しのけられないように

 

なっていますが、半固定された配線は通常のドラッグ操作で半固定の属性を失うことなく動かすことが可能です。

・Gloss Off

グロスモードがOffの場合、パターン形成後に自動整形は一切行なわれません。またこのモードで配線されたパターンには
半固定（セミフィックス）の属性が与えられ、固定化を解除しない限りは他のパターンが押しのけることはありません。

整形は行なわれず、半固定状態になる

Note



－ 234 －

◆自動終了／Auto Finish

オートフィニッシュは、引き回し途中のパターンをそのポイントから自動で結線させる場合に使用します。

引き回しの途中で選択すると、
そこから自動結線してくれます。

◆スイッチエンド／Switch Ends

このオプションを使用することで、現在作業中の配線を終端側から配線作業できるように切り替えてくれます。

◆ジャンパー配置／Place Jumper

ジャンパー配置は、パターン間にジャンパーを配置する場合に使用します。これを選択すると、PDBに登録されたジャンパー

 

が配線上に表示されます。ジャンパー部品が複数登録されている場合には、マウスカーソルの動きに応じて長さの異なるジャ

 

ンパーが順に表示され、ポイントを指定した時点で投影されていたジャンパーが配置されます。尚、この機能は、PDBにジャン

 

パー部品が登録されていなければ使用することができません。

Press space bar to add jumpersがONにて
スペースバーでのJumper配置が可能。

複数のジャンパーが登録されている場合、
マウス位置でジャンパーが変更されます。

Plow実行時にジャンパーを配置したい

ポイントでスペースバー。

LMB（左マウスボタン）にて確定。
Plowコマンドは継続されます。
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配線中にRMB(右マウスボタン）で表示されるCurve Trace Radiusを選択することで、カーブ半径を指定することが可能です。

・Variable選択時（Default) 
「Variable」が選択されると、カーソルを使用してカーブ半径を定義する方法となります。

 

・Radius選択時（例、200th）

 

Editor Control＞ Route＞ General options＞ Curve Trace Radius にて設定したRadius値で配線可能となります。

◆カーブ切り替え／Toggle Curve

トグルカーブは、マニュアル配線時の円弧コーナー処理をダイナミックに行なうことが可能です。配線時にF11:Toggle Curve

 

コマンドを選択すると、配線のコーナーに対して円弧処理がダイナミックに行なわれます。

◆束配線のカーブ切り替え／Toggle Curve in Multi Plow 〔Advanced Technology Pro-Flexのライセンスが必要となります〕

Advanced Technology Pro-Flexライセンスが有効な際、トグルカーブは、束配線の円弧コーナー処理をダイナミックに行なうこ

 

とが可能です。束配線時に〔F11〕:Toggle Curveコマンドを選択すると、配線のコーナーに対して円弧処理がダイナミックに行

 

なわれます。
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◆束配線／Multi-Plow

マルチPlowコマンドは、不特定のネットをまとめて束配線するためのコマンドとなります。対象となるピンをまとめて選択した後

 

にアクションキーのF3：Plow/Multi コマンドを選択することで実行することができます。コマンドが実行されると、選択したピン

 

全てからラバーバンドが表示されますので、Plowの時と同様の手順で配線作業を行ないます。

対象ピンをすべて選択。

ラバーバンドがまとめて表示されます。

ターゲットのピンを選択します。

対象ピンを選択するには、エリア指定の他に[Shift]キーや[Ctrl]

 

キーを使った指定方法が使用できます。
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・マルチPlowでの層変更について

マルチPlow実行中に配線層を変更したい場合には、キーボード上の[V]ボタンを選択します。[V]ボタンを選択すると、ラバ

 

ーバンド上にまとめてビアが表示されます。この状態で[9 Via Toggle]を選択すると、表示されているビアの配列が5形態に

 

変化します。形状のゴーストが表示されている状況でマウスを移動すると、ビアの配列をダイナミック微調整することができ、

 

スペースバーを選択することで表示された配列でのビアを配置を決定します。

[Diag1 Via]

[Diag2 Via]

マウスを移動することで、
ダイナミックに配列が変
更されます。

マウスを移動することで、
ダイナミックに配列が変
更されます。
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[Staggered Via]

[Parallel Via]

マウスを移動することで、
ダイナミックに配列が変
更されます。

マウスを移動することで、
ダイナミックに配列が変
更されます。
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[Perpendicular Via]

マウスを移動することで、
ダイナミックに配列が変
更されます。

・モードの確認について

ビア配置モード（トグルビアモード）が現状なんであるかを確認するには、エディタ画面左下枠を参照します。
ここには、現在のビアモードのほかにグロス（整形）モードなども表示されます。



－ 240 －

・結線イメージのゴースト表示について

束配線の最中に[Alt]キーを選択すると、そのポイントからの結線イメージがゴーストとして表示されます。この結線イメージゴ

 

ーストは、[Alt]キーを押している間は常に表示されており、この状態でマウスを移動することで結線イメージをダイナミックに

 

修正することができます。イメージが決まったところで、マウスのデータボタンを選択すれば、イメージに近い配線経路での結

 

線作業が行なえます。

[Alt]キーで結線イメージのゴーストを表示

マウスを移動することで、ダイナミックに結

 

線イメージゴーストが変更されます。
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・マルチPlowのモードのその他オプションについて

マルチPlowコマンド実行中には、トグルグロスとトグルフィニッシュの2つのオプションコマンドが存在します。どちらの場合で

 

も、〔F4：Toggle Finish〕ボタンを押すごとにモードが切り替わるというものとなり、各モードの違いは以下のようになります。

・Toggle Gloss

配線作業中に行なわれる自動整形に関するモード切替を行なうコマンドとなり、選択する毎にGloss OnとGloss Partialの切り

 

替えが行なわれます。現在のモードは、エディタ画面右下に表示されます。

Gloss On : 配線経路を指定する毎に、全体に対する整形が自動で行なわれます。
Gloss Partial : 配線経路を指定する毎に、指定したポイント間での整形が自動で行なわれます。

ボタンを押すごとにモードが切り替わり、エディタ画面の右下で確認。

・Toggle Finish

接続終了後に行われる自動整形に関するモード切替を行うコマンドとなります。

Finish Gloss ALL : 接続終了後に束配線は、配線済みトレース全体に対して整形を行います。
Finish Gloss Last : 最終のトレースセグメントからのみを対象に整形を行います。

ボタンを押すごとにモードが切り替わり、エディタ画面の左下で確認。

整形処理を可能な限り抑制して意図した配線を作成するには、 Gloss Partial / Finish Gloss Last を推奨します。

・

 

Converge IN/OUT

束配線の間隔（スペーシング）

 

を発散・収束することを可能とします。

Note
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・自由角度でのマルチPlow／Any Angle Multi Plow

マルチPlowコマンド実行中の〔F3：Toggle Plow〕ボタンにより、自由角度でのマルチPlowが可能となります。カーブ切り替え（

 

Toggle Curve）によるカーブ配線と併せて使用することで、Flexible Circuits（フレキ基板）の束配線時に、より滑らかなトレー

 

スの作画が行えます。

束配線のカーブ切り替えは、 Advanced Technology Pro-Flexのライセンスが必要となります。

Note
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◆ディファレンシャルペア配線／Differential Pair Routing

ネットプロパティやCESで制約条件としてディファレンシャルペアを定義したネットは、通常のPlowコマンドにて配線が可能とな

 

りますが、配線時に様々なオプション機能を使用することができます。

ディファレンシャルペア間のスペーシングは、Net Classes & Clearances（又は

 

CES）のDiff Pair Spacingの ス

 

ペーシング値を使用します。

ディファレンシャルペアが

 

定義されたネットのピン

単一ピンを選択

自動的にペアピンが選択されて

 

Multi Plow動作となります。

単一ピンのみ配線

 

したい場合は、Alt 
キーを押しながらピ

 

ンを選択します。

Ctrlキーを押してクリック

通常は、Splitを抑制し

 

てペア状態を保持。

Ctrlキーを押すことで一

 

時的にSplitを許可する。

・ペア配線時のスプリット許可

ペア配線は通常、可能な限りペアを保持してスプリットを作成しない動作となりますが、マニュアル配線時には一時的にス

 

プリットを許可して配線することが可能となります。

Note



－ 244 －

◆半自動配線／Route

Routeコマンドは、半自動的な配線作業を行なうためのコマンドとなります。対象となるネットを選択した後に、アクションキーの

 

[8 Route]を選択することで選択したネットへの半自動配線を行なうことができます。

シングルクリックの場合、選択したピンを含む１つのピン間のみがハイライトする。

対象となるネットをシングルクリック（1回のクリック）で指定した場合、選択した

 

ピンを含めた1つのピン

 

間がハイライトします。この状態で、[8 Route]コマンド

 

を実行すると、ハイ

 

ライトされたピン間のみに対して配線が行なわれます。
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トリプルクリック（3回連続のクリック）で選択した場合、全体の
ネットラインがハイライトします。

トリプルクリックでネット全体をハイライトさせた後に[8 Route]コマン

 

ドを実行すると、半自動の対象が選択したネット全体となり、ネット

 

単位で半自動配線が行なえます。
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◆チューニング／Tune

チューニングコマンドは、CESやNet Propertiesで定義した制約条件を満たすことを目的に、配線長を自動で編集する際に使

 

用します。対象となる配線を選択した後、アクションキーの〔７：Tune〕

 

コマンドを実行することで、チューニングパターンの作成

 

を自動で行います。チューニングパターンの形状

 

及び

 

動作については、Editor Control＞

 

Route＞

 

Dialogs＞

 

Tuningをご参

 

照ください。

チューニングの対象となるTuned Nets（Edit＞

 

Add to Select Set＞

 

Tuned Nets）は、以下のルールを持つネットとなります。
Setup＞

 

Net Properties
－最大配線長の設定（Max Length or Delay）
－等長配線の設定（Match Set）
－ディレイフォーミュラ（Delay Formulas）

Setup＞

 

CES
－最大配線長の設定（Minimum/Maximum length or Delay）
－等長配線の設定（Match Set）
－フォーミュラ設定（Formula）

チューニングコマンドの動作条件

・チューニングを実行するには、対象となる全てのネットは、完全に配線されていること。
・既に配線された配線長が、指定ルール＋Toleranceの範囲外であること。
※既に、制約条件を満たす場合はチューニングは動作しません。
・Match Setで定義した等長配線に対しては、最も長い配線長に合わせる動作となります。

チューニング配線は、Rerouteコマンドでチューニングの解除が可能となります。

ルール指定されたいずれかのネット

 

（Trace 又は ピン）を選択

例）Match Set（等長ルール）が指定されたネットのチューニング動作

Note
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◆マニュアルチューン／Manual Tune

マニュアルチューンコマンドは、チューニングボックスに従って、任意の場所と範囲にチューニングパターンの作成を可能とし

 

ます。対象となる配線を選択した後に、Route＞

 

Interactive＞

 

Manual Tune 又は

 

アイコンコマンドを実行することで、チューニ

 

ングボックスが表示されて、そのボックスを移動

 

又は

 

ドラッグすることによりボックス内にチューニングパターンを作成します。
尚、チューニングパターンの形状については、Editor Control＞ Route＞ Dialogs＞

 

Tuningの設定に従います。

Display Control＞ Generalタブ＞ Display Tuning Meterを有効とすることで、制約条件に対する現在の違反状況をリアルタイ

 

ムに確認しながら、チューニングパターンの作成が可能となります。

チューニングボックスを表示。

ドラッグ操作にてチ

 

ューニングボックスを

 

変更。ボックス内に

 

チューニングパター

 

ンを作成します。

定義した制約条件（等長ルール、Delay Formula等）の有無や違反等に関係なく、チューニングボックスで

 

は、チューニングパターンの作成が可能となります。
Note
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◆ チューニングメータ／Tuning Meter 

制約条件が設定されたネットをマニュアルで配線する際、ガイドラインとなるTuning Meterをダイナミックに表示させることがで

 

きます。Tuning Meterは定義された指定長/遅延規制と現在の長さや遅延を表示します。長さや遅延が目標誤差の範囲以下

 

であるとき、チューニングメーターは黄色で表示されます。指定誤差内で配線された配線に対してチューニングメーターは青

 

色で表示され、誤差範囲を超えると赤色に表示されます。

チューニングメーターの表示はディスプレイコントロ

 

ールのGeneralタブにて指示します。チェーニング

 

メーターが表示された場合、最大長指示時に表示

 

される残り配線エリア表示は行なわれません。

チューニングメーターは以下のルールが定義されたネットに対して表示されます。
・Setup＞

 

Net Properties
－最大配線長の設定（Max Length or Delay）
－等長配線の設定（Match Set）
－ディレイフォーミュラ（Delay Formulas）

・Setup＞

 

CES
－最大配線長の設定（Minimum/Maximum length or Delay）
－等長配線の設定（Match Set）
－フォーミュラ設定（Formula）

・H-tree, Star, T-shapeといったようにVPを使ったトポロジバランスルールを与えたネット

ルール以下の場合 ルールを満たした場合 ルールを超えた場合
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◆再配線／Reroute

リルートコマンドは、既存配線への再配線を行なう際に使用します。対象となる配線を選択した後に、アクションキーの
[9 Reroute]

 

コマンドを実行することで再配線が半自動で実行されます。

◆配線コピー／Copy Trace

Copy Traceコマンドは、選択した既存配線（Viaを含む）のコピーを行う際に使用します。対象となる既存配線を選択した後に

 

、アイコン又はCtrl + C キーを実行することで、ピンや任意の場所にコピーが可能となります。
またコマンド実行時は、F3：Rotate90、F4:Mirror、F5：Push のアクションと組み合わせて様々なCopyオブジェクトを作成するこ

 

とを可能とします。（Copyオブジェクトの層変更は、上下の矢印キーも使用可能）

対象個所（Trace 及び Via）を選択

Copy Traceコマンド実行（Ctrl + C）

Copy先をクリック

マイクロビアへのFanoutは、Copy Traceコマンド実行後、複数ピンを選択することで効果的なFanoutが実行可能となります。

Copy先を領域選択
Net0以外のピンへ
Copyが可能。
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◆配線層変更／Push Trace

プッシュトレースコマンドは、既存配線に対する層変更を行なう際に使用するコマンドとなります。対象となる配線の変更箇所

 

を指定し、変更後の層をディスプレイコントロールメニューを使って指定します。この後にアクションキーの[10 Push Trace]コマ

 

ンドを実行することで、指定した範囲を指定した層へと変更させることができます。

◆グロス／Gloss

グロスコマンドは、既存配線への整形を行なう際に使用するコマンドとなります。対象となる配線を選択した後に、アクションキ

 

ーの[11 Gloss]コマンドを実行することで配線への整形作業を行なうことができます。

対象個所を交互に選択する。

移動後の層を選択。

アクションキーの[10 Push Trace]実行で指定層へ移動。

このプッシュトレースコマンドは、選択してハイライトされた配線の領域をアクティブ層へと移動します。



－ 251 －

◆ハッグトレース／Hug Trace

F6にマッピングされたハッグトレースコマンドは、配線済みのガイドパターンに沿わせる形で半自動的に配線を行なわ

 

せる機能となります。以下の手順で作業を行なうことで、ガイドパターンに沿わせる形で配線させることができます。

【作業手順】

①配線するネットを選択します。

②Hug Traceコマンドを選択します。

③ガイドパターンの始点と終点を順番に選択します。

①

②

④ガイドパターンのどちら側を沿わせるか（ガイドパターンの右左どちらかの領域）を最後に指示します。

Hug Traceの制限事項について
ハッグトレースは、連続したトレース セグメントで、ハッグされるセグメント内の接続やビア、ピンに対してのみ作動します。

 

下記の条件のトレースに対しては、ハッグトレース コマンドを使用して配線できません。

 

－選択したスパン内にビアがあるトレース

 

－選択したスパン内にT接続があるトレース

 

－選択したスパン内に、ピンやテストポイントなど、接続を作り出すオブジェクトがあるトレース セグメント
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◆その他のHug Trace編集機能 〔Advanced Technology Pro-Flexのライセンスが必要となります〕

ATP-Flex ライセンスが有効の際、以下のオプション機能が使用可能となります。

・任意のクリアランス指定

通常 Hug Traceのクリアランスは、Defaultとして ”ネットに対して定義されているトレース－トレース

 

クリアランス値と
標準トレース幅” を使用します。

 

Advanced Technology Proのオプションを使用することで、任意のクリアランスを指定してHug Traceを作成することが可

 

能となります。

① 以下のように、Keyinコマンドを実行します。

 

htc クリアランス値

② Hug Traceコマンド実行時のRMB（右クリック）にて以下のPopを表示します。

③ 設定したクリアランス値を選択します。

・Draw-Objectに沿ったHug Traceの作成

Advanced Technology Proのオプションを使用することで、Board Outline(基板外形）やDrawオブジェクトに対して、

 

Hug Trace（ハッグトレース）を作成することが可能となります。

 

対象となるElementは以下の通りです。

 

Route border 
Board outline 
Plane outlines 
Placement keep-outs 
Rule areas 
Contour 
Route Obstruct 
Draw Elements 

使用方法は、以下手順となります。

 

① Hug Traceを実行

 

② 対象となるネットを指定するために、Pin 又は ネットラインを選択
③ Start Point 及び End Pointを選択（×マークが表示されます）

 

③ Copy対象エレメントがハイライトされるので、必要によりTABキーで切り替えを行います

 

④ 必要により、RMBにてHug Trace Clearanceを指定
⑤ CopyしたいSideを選択
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◆マルチハッグトレース／Multi Hug Trace

 

〔Advanced Technology Pro-Flexのライセンスが必要となります〕

ATP-Flexライセンスが有効である時、マルチハグトレースコマンドは、配線済みパターンに沿わせる形で同時に複数の

 

配線を作成する機能となります。

Graphical Net Name selection：
チェック時はエディタ上で選択したオブジェクトよりネット名・Traceの本数
を取得します。

Number of Traces

 

：

 

作成する配線の本数を指定。（最大99本）

Net name

 

：

 

ネット名を指定。リストより変更可能となります。
Separation

 

：

 

配線の間隔を指定。
任意の数値へ変更可能となります。

Width

 

：

 

配線幅を指定。任意の数値へ変更可能となります。

【作業手順：Graphical Net Name selectionがOFF時】

① Multi Hug Traceコマンドを実行します。

② Number of Tracesに作成する配線の本数を指定します。

③ 必要により、Separation 及び Widthを指定します。

④ Apply後、ガイドパターンの始点と終点を順番に選択します。

⑤ ガイドパターンのどちら側に配線を発生させるかを指示します。

⑥ 必要により、配線発生後、Net0の場合はRoute> Assign Net nameにてネット名を付与します。

配線本数を指定

始点

終点

間隔及び配線幅指定
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【作業手順：Graphical Net Name selectionがON時】

① Multi Hug Traceコマンドを実行します。

② Graphical Net name selectionをチェックします。

③ Copyしたいネットオブジェクト（ピン等）を選択します。選択順にNet NameがListに表示されます。

④ 必要により、Separation 及び Widthを指定します。

⑤ Apply後、ガイドパターンの始点と終点を順番に選択します。

⑥ ガイドパターンのどちら側に配線を発生させるかを指示します。

ピンを複数指定
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◆ダイナミックな配線の編集作業

マウスでのドラック操作により配線に関する編集作業がダイナミックに行なわれます。

ビアを直接ドラックする。

接続状態は保持したまま、引き延ばしができます。

他の配線やビアに近づけると、ダイナミックに押しのけ
ながらの作業が行なえます。

ビアどうしを接触させると、不要なビアは削除されます。

ビアを直接ドラックする。

パターンをドラック
パターンを直接ドラックすることで、配線形状を修正できます。
※Any Angleの場合、直線部の平行移動のみダイナミックに修正可能。

移動方向に他のパターンが存在した場合には、それらも一緒に移動されます。
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不要な迂回をしている配線は、途中からPlowコマンドで引き直すことで迂回部を簡単に削除することができます。
尚、

 

エディタコントロールでループ配線を許可している場合には、迂回側の配線は削除されません。

Plowで引き直す。

◆配線の削除

配線を削除するには、幾つかの方法があります。

・選択した配線を削除する

削除対象となる配線を選択し、キーボード上の[Delete]キーを選択するか、ツールバー上のデリートアイコンを

 

選択すること

 

で削除することができます。

・全ての配線を一括削除する

全ての配線を一括削除する場合には、プルダウンメニューのRoute> Delete All Traces and Viasコマンドを選択します。

・浮き配線（ピン間で未結線の配線）を削除する

浮き配線（ピン間で未結線の配線）を一括で削除する場合には、全ての配線を領域指定などの方法で選択した後にプルダウ

 

ンメニューよりRoute> Remove Hangerコマンドを実行して下さい。

交互に指定して範囲選択します。

ドラック操作で部分的に編集できます。
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◆ハンガー配線削除／Remove Hanger

ピン間が結線されていないトレース

 

及び ビアを削除するには、ハンガー削除コマンドを使用します。コマンド実行前に、ハン

 

ガーオブジェクトを選択する必要があります。

ファンアウトしたトレース

 

及び ビアも、ハンガー削除コマンドでは削除対象となります。削除したくないファンアウトは、フィック

 

ス（又は ロック）コマンドで固定ください。但し、プレーンネットのファンアウトトレース

 

及び ビアは削除されることはありません。

◆ハンガートレース&ビアの保持／Persistent Trace&Via Hangers

通常ピン間の結線 及び ハンガー削除コマンドにより、ハンガーのトレース 及び ビアは削除されます。この機能を使用するこ

 

とにより、特定ネットに対してハンガーを許可する設定が可能となります。

ハンガートレース＆ビアを許可するかどうかの設定は、HangerProtection.txtファイル（Configフォルダ内）で行います。

 

HangerProtection.txtファイルにネット名が定義された場合、ピン間の結線 又は

 

Remove Hangerコマンドにより自動的にハン

 

ガートレース＆ビアが削除されることはありません。通常この設定は、シールド配線、ループビア、部分配線等を実施したい特

 

定ネットにのみ定義します。

・

 

HangerProtection.txt のファイルフォーマット
※Configフォルダ内に、新たにHangerProtection.txtファイルを作成し、以下フォーマットに従いネット名を記載します。

GND
VCC

又は
＜ALL＞

ハンガートレース＆ビアを許可したいネット名を記載します。
全ネットを対象とする場合は、<ALL>とします。

・

 

HangerProtection.txt はデータのオープン時に読み込まれます。ファイル編集はデータオープン前に実施ください。
・

 

この機能（HangerProtection.txt）は、Remove Hangerコマンド

 

又は 自動配線のRemove Hangersパスにおいても有効

 

であり、定義したネットはハンガートレース（ビア）として削除されることはありません。
・この機能（HangerProtection.txt）は、

 

Project IntegrationのRemove hangersオプションには影響しません。 Forward 
Annotation実行時にハンガートレース＆ビアを削除したくない場合は、該当チェックをOFFにしてください。

Note

この機能により、以下のハンガートレース＆ビアの保持が可能となります。

①シールド配線

ピン間結線 又は Remove Hangerコマンドにより、以下のようなシールド配線は削除されます。 HangerProtection.txtへのネット

 

名定義により、自動的に削除されることはありません。

シールド配線
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②ループビア（余剰ビア）

ピン間結線 又は Remove Hangerコマンドにより、以下のようなビアは削除されます。

 

HangerProtection.txtへのネット名定義に

 

より、自動的に削除されることはありません。

同一配線層のトレース上に存在

 

する余剰ビア

③部分配線 及び 浮きビア

Remove Hangerコマンドにより、以下のような部分配線 又は 浮きビアは削除されます。

 

HangerProtection.txtへのネット名定義

 

により、自動的に削除されることはありません。

部分配線

浮きビア

⑤ハンガートレース＆ビア（テストポイント用）

ピン間結線 又は Remove Hangerコマンドにより、以下のようなファンアウトしたトレース＆ビアは削除されます。

 

HangerProtection.txtへのネット名定義により、自動的に削除されることはありません。

ファンアウトしたトレース＆ビア
※テストポイント配置等に使用。

④スティッチングビア

ピン間結線 又は Remove Hangerコマンドにより、以下のようなビアは削除されます。HangerProtection.txtへのネット名定義に

 

より、自動的に削除されることはありません。

ビア

部品パッド
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◆配線幅の変更／Change Width

Expedition PCB上での配線作業では、ネットクラスで設定された配線幅が通常使用されます。ネットクラス設定にもとづいて配

 

線されたパターン幅を変更するには、Change Widthコマンドを使用します。このコマンドは、プルダウンメニューの
Route＞

 

Change Widthから実行することができます。

選択したパターンの現在の幅が表示されます。変更後のパターン幅を入力します。

対象となるパターンを選択し、変更後の値をメニ

 

ュー内で指定し[Apply]もしくは[OK]ボタンを選

 

択することで幅を変更することができます。尚、変

 

更対象となる個所は、選択状態にある範囲に限

 

定されますので、配線全体などを一括変更した

 

い場合には、エリアやトリプルクリックなどの操作

 

で全体を選択状態としてから行なって下さい。

・パターン幅を変更する際も、バックグランドで流れる配線エンジンに監視され、幅を変更することでクリアランス

 

違反を起こす個所があった場合には、その個所へのパターン幅の変更は行なわれません。パターン幅の変更が

 

指定した全てに行なわれなかった場合、ワーニングメッセージが表示されます。

・変更できなかった個所については、エディタ上のハイライト表示で明示されます。

Note
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◆スワップピン、ゲート／Swap Pins, Swap Gates

ピン/ゲートスワップをマニュアルで行なうには、プルダウンメニューのRoute＞

 

Swap

 

以下のコマンドを使用します。ピン/ゲー

 

トどちらの場合も作業手順は同様となり、コマンドを選択した後に対象となるピンを選択する形となります。ゲートの場合には、

 

変更対象が同一部品内に固定されるものではないので、スワップ対象が全ての同一パッケージ部品の同一ゲートとしてサー

 

チされます。ピン/ゲートの双方とも、ハイライトされた対象の中から変更するものを選択することでピン/ゲートのスワップを行

 

なうことができます。

ピンを選択。

スワップ対象がハイライトされます。

対象ピンを選択すると、変更後のネットラインが表示され、
変更の承認を求められます。

確認の意味で再度ピンを選択すると、変更が行なわれます。

・ピンスワップ



－ 261 －

・ゲートスワップ

ゲートスワップを選択すると、アクションキーに[2 Swap Dialog]が表示されます。これを選択すると、スワップゲートの

メニューが表示され、スワップ可能なゲートを部品毎に確認することができます。

リスト内の部品を選択することで、スワップゲートを選んだタイプ
毎にハイライト表示で確認できます。

コマンド実行後にピンを選択すると、スワップ対象のゲートがすべて
ハイライト表示されます。（実際にはピン）
ハイライト表示された中から、スワップを行なうゲートを選択すると、
交換されるゲートの情報が画面上ハイライト表示され、変更の承認
を求められます。承認するならばマウスのデータボタンを選択して、
スワップを実行します。

この項目でリスト表示される部品にフィルタリングを行なうことができます。
また、ここで選んだ項目でゲートスワップの対象が同一パッケージに制
限されるか否かが決定されます。

Individual Gates：
全ての部品をリストし、ゲ-トスワップの対象は同一パッケージ内の
ものに制限されます。

Gates With Common Pins：
コモンピンを含むゲートを持つ部品のみをリストし、ゲートスワップの
対象部品がリストされた部品に限定されます。

Symbol Gate Groups：
1パッケージに共通のゲートを複数持つ部品のみがリストされ、ゲート
スワップの対象は全ての共通ゲートとなります。

ゲートスワップコマンド実行時には、アクションキーにゲートを固定化するコマンドがマッピングされます。対象ゲートを選択し

 

た後に、これらのコマンドを実行することでゲートスワップ出来ないように固定化することが出来ます。固定化されたゲートは、

 

配線などと同じように中抜き表示で表現され、固定化を解除しない限り、スワップ不可となります。

・2007.3バージョンより、ビアやトレースに接続されたピンであっても、ピンスワップやゲートスワップが可能となります。

・但し、スワップを行ういずれかのピンが、別のピン又はコンダクティブシェープに接続されている場合は、以下のメッ

 

セージが表示され、スワップできません。
Note
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◆配線・ビアの固定化と半固定化／Fix, Semi-fix, Unfix selected Items

既存配線を固定化することができます。固定化にはフィックスとロック、２つの固定化モードが存在します。両者の違いは、単

 

なる名前と固定化状態にある際の表示形態のみとなります。どちらも固定化を解除しなければ動かせないことに変わりはなく、

 

2つの固定化モードを設けることで、様々な運用に応じて使い分けることが可能です。この2つの固定化モード以外に半固定

 

モードが存在します。固定化とは異なり、この半固定はそれ自体をドラックすることで半固定の属性を加味したままの編修作業

 

が可能となっております。この作業は、どれも対象物を選択した後にプルダウンのEdit以下に収納された各コマンド、もしくは

 

ツールバー上の各コマンドを選択して実行されます。

尚、全ての固定・半固定された配線やビアは、自動配線やマニュアル配線の全ての状況において、押しのけやリップアップ

 

の対象から除外されます。

対象を選択後にコマンドを実行。

プルダウンメニュー

ツールバー

固定・半固定化された配線やビアは、各固定化属性に合わせてUnfixやUnlockといった固定化解除コマンドを使って解

 

除することができます。
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◆ネットラインの操作／Net Manipulation

このコマンドは、配線経路の指定や分岐指定を定義することができます。コマンド実行後、エディタ上に表示される配線

 

パスを使って定義します。コマンドの実行は、アイコンボタン、Ctrl + Wキー、RMB（右マウスボタン）のNet Manipulation

 

より実行可能となります。

・配線経路の指定方法
対象となるピン

 

又は

 

ネットラインを選択後、Net Manipulationコマンドを実行します。

【マウスドラッグでの操作方法】
移動する側のネットラインの端点側をマウスで選択して下図のようにドラックして配線経路を修正します。

【部分区間を削除して追加する方法】
編集対象の区間のネットラインを選択して[Delete]キーで削除。下図の順にピンを選択してピン間にネットラインを追加します。

選択してから
[Delete]キー

 

で削除

①

②

①→②の順にピンを選択して
ネットラインを追加

【全削除からの作成】
ネットラインをマウスのエリア選択で選択して[Delete]キーで全てのネットラインを削除します。
ピン間を下図の順に選択して各ピン間にネットラインを追加します。

①

②

③ ④

ピン間の指示は必ず“From→To”の形

で指示します。
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・ガイドピンの配置／Place Guide PIN

配線経路が指示されたネットに対しては、分岐ポイントである仮想ピン（VP）以外に経由ポイントとなるガイドピン（GP）

の指示が行なえます。ガイドピンを配置は、以下の手順で行なうことができます。
① 〔F4：Place GP

 

〕

 

コマンドを選択し、マウスで配置ポイントを指示してください。
② 配置は連続して行なうことができます。

配置したGPを確定するには、ポップアップメニューのAccept Guide Pinを実行してください。
③ 作業が終了したら、[ESC]キーを選択するか、ポップアップメニューから編集モードを終了してください。

・仮想ピンの配置／Place Virtual PIN

T分岐を指示したいような場合には、F3:Place VP コマンドを選択して、仮想ピンをエディタ上に配置します。

尚、仮想ピンを新たに配置した場合には、続く経路指定を必ずピンから指示するようにしてください。

・Toggle Topology

F5:Toggle Topologyは、Net Properties＞

 

Net Order＞

 

Topology のプロパティと連携して、MSTからChained

 

及び

 

Customへ変更可能となります。

仮想ピン

Routeモード時にVirtual PINやGuide PINを移動するには、選択後 Shift+LMBのドラッグ操作にて可能となります。

Note

GP配置時のRMBポッ

 

プアップメニューより、

 

配線層を指定したガイ

 

ドピンの配置が可能と

 

なります。
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◆ブレイクアウトトレース／Breakout Traces

ブレイクアウトトレースコマンドは、配線パターンとパッド/ビアの結線個所に対する補強を行なうためのコマンドとなります。この

 

機能は、一般的にサブランドやスノーマンとも呼ばれるもので、配線パターンとパッド/ビアの結線個所に対し、ある種の配線

 

パターンを上乗せすることで結線個所への補強を促します。プルダウンのRoute＞

 

Teardrops & Breakout Traces＞

 

Breakout 
Tracesを実行するとことで専用メニューが表示され、このメニュー内で各結線個所に上乗せする補強パターンの設定を行なっ

 

た上で作業を実行します。

補強パターンの設定は各パッドやビア毎に行ない、それぞれに対して上乗せするパターンの幅と長さを設定します。メニュー

 

上部には、全てのパッドやビアに対して一括設定するための項目が存在します。Width項目では、上乗せする補強パターン

 

の幅を設定します。補強パターンの幅を各パッド/ビア径のパーセントで指定するか、一律指定するかをトグルスイッチの切り

 

替えで選択し、それぞれに対する値を入力します。

一律指定。

パッド/ビア径に対するパーセントで指定。

一律とする補強パターンの幅を指定。

算出された値に対する最小分解能を指定します。値が0の場合には、算出されたまま
の値が出力され、10という値を指定した場合には、その1つ下の１の位で四捨五入され

た結果が出力されます。
※尚、ここに指定する値は0、1、10、100…といった値を必ず指定するようにして下さい。

補強パターンの幅を算出する際の
パッド/ビア径に対する％値を指定。

SMDパッドに対する設定

ビアパッドに対する設定

パッド（貫通ピン）に対する設定
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Length項目では、追加する補強パターンの長さを指定します。

追加する補強パターンの幅と長さの設定が完了したら、下にあるボタンを選択します。

メニュー内にリストされた全てのパッドとビアに対し、設定した内容にもとづいて算出された値が一括設定されます。

追加する補強パターンの設定を個別に行ないたい場合には、各項目をマウスで選択して直接値を入力します。

このボタンで一括設定。
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リストの各パッドとビアに設けられたチェックボックスは、このパッドやビアに対して補強を行なうか否かを決定するものとなり、

 

作業対象とする候補を選ぶことができます。

チェックを入れたものに対してのみ補強が行なわれます。

メニュー最下段に設けられたItems to process項目では、もう1つのフィルタリング機能が提供されており、作業対象をドロップ

 

ダウンリストの中から選択指定することができます。

チェックを入れることで、固定化された配線も作業
対象にすることができます。

全ての設定が終了した後に、[OK]もしくは[Apply]ボタンを選択して作業を実行します。

Length

Width

Breakout Trace作成イメージ：

クリアランス条件などの理由で作成されなかった個所は、Analysis＞ Review Hazards＞ Online＞

 

Teardrops/Breakouts で確認することができます。

・All Traces
：全ての配線。

・Pad Without Breakout Traces
：ブレイクアウトトレースの無いパッドのみ。

・Selected Active Layer Pads
：選択されたアクティブレイヤのパッドのみ対象。

・Selected Pads
：選択されたパッドのみ。

・Selected Traces
：選択された配線のみ。

Note



－ 268 －

◆ティアドロップ／Teardrops

プルダウンのRoute＞

 

Teardrops & Breakout Traces＞ Teardropsコマンドを実行すると、ティアドロップ作成用のメニューが表

 

示されます。このメニュー内の各項目に対して設定を行ない、メニュー内の[OK]もしくは[Apply]ボタンを選択することでティア

 

ドロップを作成することができます。

“Pad to trace”にチェックを入れると、部品/ビアパッドと配線パターンの結線個所に対してティアドロップを作成することができ

 

ます。作成されるティアドロップの形状は、この項目で指定される2つの値で決定され、Preferredで指定された値で作成できな

 

い個所についてのみSecondaryの値が用いられます。

Secondary

Preferred

参考：

ティアドロップをパッド径毎の比率で指示する場合には上

 

図のスイッチを入れた上で部品パッド、ビアパッドそれぞれ

 

の項目に値を指示してください。この値が２の場合、パッド

 

径が５０であればティアドロップに指示された値は１００とな

 

ります。この値は、０以上１０以下の値で指示してください。

・Absolute（固定）

 

：

 

パッドエッジからトレースとティアドロップの交点までの長さを指定します。

・Ration（比率）

 

：

 

パッド径とパッドセンターからティアドロップの頂点までの比率を指定します。

Pad ratioが2：1の場合、“Pad径×2の円”に接する

ようにティアドロップを発生します。

参考：
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“Pad to Pad”のチェックボックスにチェックを入れると、近接するパッド－パッドを1つのティアドロップで連結させることができま

 

す。結合させる際の最大ピン間を指定することで、その値を下回って近接するパッド－パッドが1つのティアドロップで連結され

 

ます。対象となるパッドは、ビア-ビア、ビア-部品パッド、ビア-テストパッド、部品パッド-部品パッド、部品パッド-テストパッドと

 

なります。

連結させる際の最大ピン間を指定。

指定しなかった場合 指定した場合

メニュー下段にある項目では、ティアドロップ作成を行なう対象を選択します。

貫通部品のパッドを対象とする

ビアパッドを対象とする

表面実装部品パッドを対象とする

矩形パッドを対象とする

固定トレースを対象とする

・All Pads ：

 

全てのパッドが対象。
・Pads Without Teardrops ：

 

ティアドロップが作成されていないパッドのみを対象。
・Selected Active Layer Pads ：

 

選択されたアクティブレイヤのパッドのみ対象。
・Selected Pads ：

 

選択したパッドのみが対象。

処理対象となる最大パッドサイズ

発生するティアドロップの最大サイズ

ティアドロップの最大サイズ
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・Trace Teardropsタブ

このコマンドを実行するには、Advanced Technology Pro（Flex)のライセンスが必要となります。

 

このタブでは、配線に関して付

 

与するティアドロップに対する設定を行ないます。発生可能な箇所はT分岐とネックダウン箇所に対してとなり、メニュー内で表

 

現される配線幅に対する比率で指示を行ないます。

対象とする配線パターンを選択

・All Traces ：

 

全配線パターンを対象
・Traces without Teardrops ：

 

ティアドロップ以外の配線パターンを対象
・Select Active Layer Traces ：

 

アクティブ層の配線パターンを対象
・Selected Traces ：

 

選択した配線パターンを対象

作成に使用する配線幅の最大値。
指定した値以上の配線幅を持つトレース
は対象外となります。

固定トレースへの作業の有無

Rationフィールドには、0以上10以下の数値

のみ指定可能となります。
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・ティアドロップ形状の編集

このコマンドを実行するには、Advanced Technology Pro（Flex)のライセンスが必要となります。

 

作成されたティアドロップ形状

 

のダイナミックな編集がRouteモードで可能となります。ティアドロップ形状を選択するとハンドルポイントが表示されますので、

 

ドラッグ等の編集動作にて形状を変更することができます。

・ティアドロップの削除

ティアドロップを選択後、

 

Deleteキーにて削除が可能となります。デザイン内の全てのティアドロップを削除するには、

Edit＞

 

Add to Select Set＞

 

Teardropsにて全てのティアドロップが選択後、Deleteキーにて削除します。

ロックトレースに作成されたティアドロップ形状の変更はできません。

・パッド（トレース）と同様にDRC実行／DRC Teardrops/Breakouts as Pads

 

(Traces)

ティアドロップは通常パッドとして扱われる為、DRCについてもパッド（ビア）の項目としてチェックされます。このオプションによ

 

り、ティアドロップをトレースとして扱い、クリアランスチェックを行うことが可能となります。

ティアドロップをパッドとして扱いDRCチェック（デフォルト動作）

ティアドロップをトレースとして扱いDRCチェック

DRC Teardrops/Breakouts as Tracesを選択した場合、ビアと

 

ティアドロップのDRCは、Trace-Via（Pad）クリアランスを参照し

 

ます。※通常は、Via（Pad）-Via（Pad）クリアランスを参照。
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・ダイナミックティアドロップ／Dynamic Teardrops

ダイナミックティアドロップは、メニュー設定で追加したティアドロップの設定でダイナミックにティアドロップを追加・削除する機

 

能です。プルダウンメニュー内にあるDynamic Teardropsを選択してチェックをつけることで、ダイナミックティアドロップのスイッ

 

チを入れることができます。このスイッチが入っている状況では、ティアドロップメニューで設定された内容のティアドロップが、

 

ダイナミックに追加・削除されます。もし設定を変更する場合には、ティアドロップメニューを再度表示して設定内容を変更して

 

ください。アップデートされた内容で即座にティアドロップが追加されます。

設定した内容で追加されなかったティアドロップは、Review

 

HazardsのOnline以下にあるTeardrops/Breakoutsにて確認するこ

 

とができます。

ダイナミックティアドロップのスイッチは一度エディタと閉じるとオフになりますので、必要な場合には再起動後

 

にスイッチをオンにしてください。

・Review Hazards＞

 

Teardrops/Breakouts

Note
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◆コーナーの変更／Modify Corners

このコマンドは、作成された配線パターンの各コーナーに対して円弧処理を施すための環境を提供します。プルダウンの

 

Route＞

 

Modify Cornersコマンドを実行することでメニューを起動され、このメニュー内で設定された値にもとづいて各コーナ

 

ーへの円弧処理が行なわれます。

メニュー内では、円弧処理を行なう際に使用する半径の値として最小値と最大値を指定します。作業対象となった全てのコー

 

ナーに、指定された最小～最大半径範囲の値を用いて円弧処理が行なわれます。

最小径を指定。

最大径を指定。

アクションを選択します。
・円弧処理を行なう場合にはChange to arcs。
・円弧処理を解除する（元に戻す）場合にはChange to Corner。

Missing Arc hazard listでは、Review Hazards＞ Missing Arcのリスト表示方法

を選択します。
・Regenerateはリストを再生成します。
・Appendはリストへ追加されます。

固定化された配線パターンのコーナーも作業対象とする場合には、チェックボックスにチェックを入れます。

対象となるコーナーを選択します。
・All Cornersは、全てのコーナー
・Selected Cornersは、選択されたパターンのコーナー

Note

[OK]もしくは[Apply]ボタンを選択して作業を実行すると、左図の

 

ようなメッセージが表示されることがあります。このメッセージは、

 

指定した半径の値が小さすぎることを意味しており、このメッセー

 

ジが出るような場合には、最小値の値をメッセージで指定される

 

値以上のものにして下さい。
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このモディファイコーナーコマンドは、対象となった全てのコーナーに円弧処理が行なわれるとは限りません。指定さ

 

れた半径の範囲で円弧加工が行なえないとされるコーナーは、下図のように一切の処理が行なわれませんので注意

 

して下さい。

円弧処理が行なえない個所はそのまま残る。

この円弧処理は、メニュー内のAction項目のスイッチ切り替えで元に戻すことができます。これ以外の方法としては、

 

Undoコマンドで元に戻すことができます。

円弧処理された箇所へのダイナミックなパターン修正作業が行えます。円弧処理された箇所をドラックすることで、円弧

 

の大きさをダイナミックに編集することができます。尚、円弧処理箇所に対する他のパターンによる押しのけは行えない

 

ので注意してください。
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◆円弧ストレッチ／Arc Stretch 〔Advanced Technology Pro-Flexのライセンスが必要となります〕

このコマンドは、選択されたトレースセグメント

 

及び コーナーを円弧（Arc）に変更します。単一のトレースを選択後のRMB（右

 

マウスボタン）からArc Stretchを選択してコマンドを起動し、円弧処理を行います。

Arc Stretch可能なトレース形状

Arc Stretch不可なトレース形状

Arc Stretchが可能となるトレース形状は以下となります。

以下のようにストレッチにより、隣接ポイントが拡散する形状（Divergent）や鋭角となる形状は対象外となります。

T分岐（T-Junction）のトレース形状も対象外となります。
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◆トレース移動時のスペーシング保持／Preserve spacing during move trace 
〔Advanced Technology Pro-Flexのライセンスが必要となります〕

このコマンドは、現在のトレース間隔（スペーシング）を保持した状態でのストレッチを可能とします。単一のトレースを選択後

 

のRMB（右マウスボタン）からPreserve spacing during move traceを選択してコマンドを起動し、ストレッチを行います。尚、スト

 

レッチ対象となるトレースは、システムが自動的に判断して選択（ハイライト）されます。

ストレッチ時にスペーシングを保持します。

単一のトレースセグメント

 

及び 円弧が選択された場合に、以下条件を満たす時にこのコマンドは有効となります。

・

 

トレースセグメントが平行であること。
・

 

対象オブジェクトがトレースであること。
・

 

アクティブ層上のトレースのみが対象となります。
・

 

ストレッチ候補となるトレースは、異なるネット名が付与されていること。同ネットのトレースは、本コマンドの対象外です。
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◆テストポイントの配置／Place Test Points

このコマンドは、単独でテストポイントを配置する場合に使用します。テストポイントを配置したい配線を選択した後に、このコマ

 

ンドを実行します。マウスカーソルにテストポイントが追従しますので、配置ポイントをマウスで指定して下さい。

・テストポイントは、パターン上に配置することもそれ以外の場所に配置することもできます。パターン上以外に配置

 

されたテストポイントからはネットラインが表示され、配線コマンドを使用して結線させることができます。
・テストポイントは、通常のパターンやビアと同様にExpedition PCB上の押しのけ機能に対応しており、テストポイント

 

配置時にクリアランス違反と判断されるパターンは自動的に押しのけられます。

パターン上に配置 パターン上以外に配置

密集ポイントを指定

邪魔なパターンが押しのけられる

テストポイントを使用するには、セットアップパラメータ内のテストポイント設定を事前に行なう必要があります。この設定がなされ

 

ていないデータ上では、テストポイントに関するコマンドは無効となり、下記のメッセージで設定を促されます。

セットアップパラメータへテストポイント設定を行なう場合、ローカルライブラリ内にテストポイント用のパッドスタックが

 

必要となります。ローカルライブラリとしてのテストポイント用パッドスタックが存在しない場合、この設定自体が行な

 

えませんので注意して下さい。

Note

Note
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◆テストポイント

 

自動割り当て／Test Point Assignment

このコマンドは、自動でテストポイントを配置する場合に使用します。テストポイントを配置したいネットに対し、配置するテスト

 

ポイントの数や自動配置に使用するポイントをメニュー内で指定してテストポイントの配置を一括して行ないます。

Display only nets needing test points：

テストポイントが必要とされる（リストでテストポイントの配置を指定した）ネットのみをリストしたい場合にチェックを入れます。

Expand (Net0) nets ：

このスイッチを入れた状態でフォワードアノテーションを実行することで、Net0に対するリストが表示されるようになり、

ネット無し配線などへのテストポイント自動配置が行なえるようになります。尚、フォワードアノテーションの際には、
Assign single pin nets to unused pins,enabling fanoutのスイッチを入れておく必要がありますので注意してください。

Net0の情報がリストされます。
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各ネットへのテストポイントの数指定は、リストのRequired項目で行ないます。項目を選択すると、ドロップダウンリストが表示さ

 

れますので、必要な数を指定します。

各ネットへのRequired指定が完了したら、Locations in priority orderの項目で自動配置に使用するポイントを指定します。既

 

存ビア上や配線、貫通部品のパッド上などから選択することが出来ますので、自動配置に使用してもよいとされるポイントすべ

 

てにチェックを入れてください。

Optionsの項目では、配置されたテストポイントに対してFix処理を行なうか否かを指定することができます。Select in graphicsと

 

Fit viewのチェックボックスは、チェックすることでリスト上のネット選択と連動して、バックグランドの画面上で最適化表示や選

 

択といった作業が行なわれます。また、Reportのボタンを選択することで、配置されたテストポイントのレポート情報が出力され

 

ます。

メニュー全ての設定が完了したら、[Place]ボタンを選択して自動配置を実行します。配置されたテストポイントは、
メニューリスト上のPlaced項目にリストされます。尚、テストポイントの自動配置では、設定した内容でリクエストした全てを配置

 

しきるとは限りませんので、配置できなかったネットに対しては、マニュアルで配置を行なうか、テストポイント配置用グリッドな

 

どの条件を変更して再度作業を行なってください。

実際に配置された数がリストされます。
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Graphic Selection Modeを使用することにより、リストからネットを選択するのではなく、ターゲットエレメントを選択することで、コ

 

マンドの実行が可能となります。

①

 

Graphic Selection Modeを選択。

②

 

オリジナルとなるネットオブジェクト（New Net Name）を指定。

 

指定後、ステータスバーにネット名が表示されます。

③

 

ネットを付与したいオブジェクトを指定。（連続して複数のオブジェクトが指定可能。）

◆ネット名割り当て／Assign Net Name

このコマンドは、Drawコマンドなどで作成したネット無し配線に対してネット名を付加することができます。またこのコマンドは、

 

既存配線のネット名変更などにも使用することができます。

コマンド実行後に表示されるメニューには、このデータが持つ全てのネット名がリストされます。作業対象となる配線を選択す

 

ると、メニュー最上段に今現在のネット情報が表示されますので、新たに割り当てたいネット名をリストより選択した後に[OK]も

 

しくは[Apply]ボタンを選択します。

コマンドが実行できない図形要素を選択した際は、Applyボタン 及び OKボタンはDisableとなります。コマンド対

 

象外の図形要素は、以下のエレメントとなります。

・

 

Non-platedのMounting Hole
・

 

Padの無いMounting Hole
・ プレーンやピンに接続されたMounting Hole
・ プレーンやピンに接続されたVIA
・ プレーンやピンに接続された配線
・ プレーンやピンに接続されたTest Point
・

 

回路図より指定されたピン及びその他ネットを持つオブジェクト(Net0を含む)

Note
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自動配線

Chapter3: Design Process-Routing
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◆自動配線／Auto Route

Expedition PCBでは、完全バッチ型の自動配線環境も提供しています。専用メニューから実行される自動配線では、ネットク

 

ラスやネットプロパティで設定された条件設定にもとづいた配線が行なわれます。自動配線用メニューは、プルダウンメニュー

 

Route＞

 

Auto Routeを選択することで起動することができます。

メニュー上段にあるリストは、自動配線をどのように流すのかを定義する項目となります。この項目には、システムが供給する基

 

本的な配線フローがデフォルト値として用意されます。この配線フローは、配線を行なう基板データに応じてユーザーが自由に

 

編集することができます。ここで作成した配線フローは保存することができますので、全ての基板データに流用させることができ

 

ます。自動配線を実行する場合には、メニュー内の各設定を行なった後にメニュー内の[Route]ボタンを選択して下さい。

・Pass

このチェックボックスは、自動配線時にこのパスを流すか否かを指定します。チェックを入れることで、自動配線時にこの配線

 

パスが実行され、チェックを入れなかった場合にこの配線パスは飛ばされます。

・Pass Type

この項目では、実行する配線パスの種類を選択します。ドロップダウンリストから実行したい配線パスを選択して下さい。

◆配線パスの定義／Pass definition

Memory

 

：

 

ビアを一切使用せず、水平/垂直方向に対する配線を試みます。（プレーンネットは対象外）
Simple Fanout    ：

 

Fanoutと同じですが、Effortの強さは１しかありません。
Fanout

 

：

 

表面実装部品から、ビアの引き出しを行ないます。
No Via/Bias

 

：

 

ビアを一切使用しないでピン間の配線を主配線方向を無視して試みます。
この特性上、Effortレベルの上げすぎには注意が必要です。

No Via

 

：

 

ビアを一切使用せず、水平/垂直方向に対する配線を試みます。（プレーンネットを含む）
Route

 

：

 

リップアップのアルゴリズムで、配線率100%を目指して配線を試みます。
Partial Route

 

：

 

自動配線が作業を行なった未結線結果を、消さずにアンテナ配線状態として残させる配線パス。
Tune Delay

 

：

 

全てのチューンピンペアに対し、等長処理を試みます。Effortレベルは１のみ。
Tune Crosstalk

 

：

 

ネットプロパティで指示されたクロストーク規制ルールのネットに対してチューニングを試みます。
このパスは、それ自身のチューニングのためにいつでも流すことができます。

Via Min

 

：

 

不要ビアの削減を試みます。
Remove Hanger

 

：

 

ピン間で未結線の配線を削除します。
Smooth

 

：

 

一般的な配線の整形を試みます。
Expand

 

：

 

クリアランスに余裕がある配線個所に対し、Expand Width値で配線幅の変更を試みます。
Spread

 

：

 

指定されたクリアランス値の2倍の値をもとに、各配線の均一化を試みます。
Partial Route

 

：

 

全てのオープンネットラインに対して、配線を試みます。Effortレベルは１のみ。

このボタンで実行します。



－ 283 －

・Items to Route

この項目は、指定した配線パスで配線させるネットを指定する項目となります。ドロップダウンリストより、対象とするネットを選択

 

して下さい。

All Nets

 

：全てのネットを配線対象とします。
Filtered Nets

 

：エディタコントロールメニューのフィルタ設定で指定したネットを対象とします。
Nets…

 

：これを選択するとネット選択を行なうメニューが表示されます。このメニューで指定したネットのみを
を対象とします。

Net Classes…

 

：対象をネットクラスごとに指示します。
Parts…

 

：対象を部品（RefDes）単位で指示します。
Ordered Nets

 

：トポロジーがMST以外（プレーンネット含む）のネットを対象とします。
Tuned Nets

 

：等長指定や長さ指定（Delay Formula等）されたTuningすべきネットのみ対象とします。
ペア配線（Differential Pair）も対象となります。

Differential Pairs

 

：ペア配線指定されたネットのみを対象とします。
Virtual Pins

 

：仮想ピンが配置されたネットのみを対象とし、あくまでも仮想ピンまでを配線対象とします。
Selected Nets

 

：エディタ上で選択したネットを対象とします。
Selected Pins

 

：エディタ上で選択されたピンのみを対象とし、対象となったピン間のみが配線対象となります。

対象から除外するネット 対象とするネット

・Order

この項目は、配線対象とされたネットをどのような基準（順序）で配線させるかを指示する項目です。

Auto

 

：

 

システムのデフォルト値となり、配線作業の順番は自動選択となります。
Longest First

 

：

 

対象となったネットの中で、ネットラインの長いものから順に配線作業を試みます。
Shortest First

 

：

 

対象となったネットの中で、ネットラインの短いものから順に配線作業を試みます。
Custom…

 

：

 

このオプションを選んだ場合、比率を指示するメニューが表示されます。

対象となったネットの最長から最短までの長さに対する％
指定で

 

対象となるネットを指示することができます。
最大で50%と指示した場合には、長さの長い方から50%
の範囲のネットが配線対象となります。
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・Start/End

この項目は、指定した配線パスをどのような強さでどのくらい流すのかを設定する項目となります。Startが開始の強さとなり、

 

Endが配線パスの終了を意味します。値が大きくなるにつれて配線パスの強さが増し、リップアップの対象領域が広くなります

 

。Startで指定された強さから、Endで指定された強さまでの配線パスが各強さで1回ずつ流れ、Endで指定されたパスが終了し

 

た時点で次のリストのパスへと移行されます。

例）
Routeの配線パスを、Startが1でEndを5として流した場合、通常配線が一番弱いレベルから強いレベルへと
1→2→3→4→5の順に流れ、一番強い5のレベルの配線パスが終了した時点でこのRouteのパスが終了します。
StartとEndの値が同じ場合には、双方に指定された強さのパスを1回だけ流して配線は終了します。

※この自動配線では、指定した強さのパスが必ずしも全て実行されるとは限りません。例えば、配線途中に配線
率が100%となったような場合、次に指定されているより強いパスを流す必要が無いため、後に残されたパス予
約はキャンセルされます。
尚、この動作は、実行中の同一配線パス内においてのみ行なわれ、まだ実行されていない配線パスに関して
のキャンセルは行なわれません。（場合によっては、実行と同時にキャンセルされる場合もあります。）

・Now

この項目には、現在実行中の配線パスエフォートの数値が表示されます。

この表示で、現在実行中の配線パスを確認できます。

・Enable Layers

この項目は、指定した配線パスが使用できる配線層を指定する項目となります。この値がAll Enabledの場合には、エディタコ

 

ントロールメニューで設定した配線層全てがその対象となります。層を限定したい場合には、Use array layerスイッチを有効と

 

し、使わせる各層のチェックボックスにチェックを入れます。

Fanoutパスの場合のみ使用可能なFanout all… 
は、それぞれがマイクロビア・ファンアウトをどの

 

ような順番で実行させるかを指示するためにあり

 

ます。
Top to bottomは部品面からはんだ面へ・・・
Bottom to topははんだ面から部品面へ・・・・

の作業でマイクロビアの引き出しを行ないます。
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・Rte Grid/Via Grid

この項目は、指定した配線パスの配線作業で使用する配線用/ビア用のグリッドを指定する項目となります。デフォルト指定さ

 

れている(Default)とは、エディタコントロールメニューで指定されている現在の各グリッド値となります。各配線パス毎に異なるグ

 

リッドを指定する場合には、項目を直接選択した上で値をキー入力します。一度入力した値は、ドロップダウンリスト内に登録さ

 

れ、以降はリストから選択可能となります。

値を直接キー入力します。
以降はリストから選択可能。

・Fix/Pause

FixとPauseのチェックボックスは、配線パスの終了後に固定化、ポーズ（一時停止）させるための機能です。Fixを設定する

 

場合、項目を選択することで表示されるブラウズボタンを選択し、設定メニューを表示させます。この設定メニューで、固定

 

化させる対象を選択した上で、Fixのチェックボックスにチェックを入れます。この設定をし忘れると、固定化機能が正常に機

 

能しませんので注意して下さい。

Pauseについては、チェックを入れることで、そのパスが終了した時点でルーターが一時停止した状態になりますので、配線

 

結果を途中で確認したい場合などに使用してください。尚、Pauseを解除して再開するには、再度[Route]ボタンを選択しま

 

す。
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◆配線パスの編集

自動配線用メニューを表示すると、デフォルト値の配線フローがリスト表示されます。配線パスを新たに構築する場合には、こ

 

のデフォルト値の配線パスエントリなどを雛形とし、それらを編集する形で構築します。

配線パスエントリの編集については、各エントリ毎に直接行ないます。

リスト内における配線パスエントリの追加/削除や順序変更については、リスト右上にあるアイコンボタンを使用して行ないます。

選択した配線パスエントリをリストより削除します。

配線パスの削除を取り消します（削除のUndo）。

選択した配線パスを上下に移動します。

配線パスエントリをリスト内に追加します。

◆配線モニター

自動配線が実行されると、メニューフォーム内にあるモニターリストにその実行内容がリアルタイムに表示され、現在実行中の

 

配線パスの結果がどのような状態であるのかを確認することができます。

Considered

 

：この配線パスで、配線対象として考慮しているネットの数
Attempted

 

：配線対象のネットで、まだ配線作業が行なわれていないネットの数
To Try

 

：配線対象のネットで、配線作業が行なわれているネットの数
Opens

 

：未配線のネット数
%Routed

 

：配線率
Vias

 

：使用ビア数
CPU(h:m:s)

 

：CPUのみの演算時間
CLK(h:m:s)

 

：全体の時間

※This effortでは、各項目の内容は現在の配線パスに限定され、Totalでは常に全体の内容が表示されます。
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◆配線パススキーム

メニューフォームの左下には、配線パスフローを選択/保存するための項目が存在します。既に幾つかの配線パスフロー（配

 

線パススキーム）を作成してある場合には、ドロップダウンメニューからそれらを選択することができます。また、メニュー内で新

 

たに作成した配線パスフローを保存する場合には、フロッピーのアイコンボタンを選択します。

保存する際の名前。

ローカルとして保存（このデータでのみ使用する場合）。

システムとして保存（全てのデータで使用する場合）。

指定フォルダへ保存（指定先はブラウザで指示）。
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◆オプション設定とその他のアイコンボタン

メニュー下には、オプション設定と幾つかのアイコンボタンが存在します。

このボタンは、自動配線中にメニューを縮小化することができます。

※元に戻すにはこのボタンを選択します。

このボタンを押すと、最後に実行された自動配線のログファイルが
表示されます。

Generate user checkpoint… ：配線結果の状態を途中保存します。

Skip reset of current effort

 

：現在作業中の配線パスをスキップさせます。
Stop at end of current effort

 

：現在作業中の配線パスが終了した時点で中断します。
Stop now keep current results

 

：配線作業を即時中断します。
Stop now revert to last user… ：配線作業を即時中断し、途中保存した状態まで配線状態を戻します。

Stop now discard all routing

 

：配線作業を即時中断し、全ての配線を削除します。

自動配線中にこのボタンを押すと、作業中断用の
メニューが表示されます。メニューより処理内容を
選択した上で、[OK]ボタンを選択して下さい。

このチェックボタンを選択すると、Fanoutパスでピン間の接続処理が

行なわれるようになります。単なる引出しのみを指示したい場合には、
このスイッチは必ずOFFにしてください。
（この機能を使うには、Advanced Interconnectライセンスが必要です。）

配線実行前にデータ保存をする場合にチェックします。

配線率が１００％以下でも整形パスを実行するか否かを指示します。

自動配線時の自動バックアップ時間を分単位で指示します。
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自動配線パスの補足事項

Chapter3: Design Process-Routing
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マイクロビアファンアウトに関する新しい設定機能として追加された有効層指定

 

でのトグルスイッチでは、より簡単にマイクロビアファンアウトを促す設定が行な

 

えます。

貫通ビアの無いデザインにおいて、階段状にビアの落とし込みを行なわせたい

 

場合には、Fanout all top to bottomもしくはbottom to topのいずれかの指示

 

をしてください。これにより、部品面→はんだ面、はんだ面→部品面の方向に向

 

かってマイクロビアファンアウトが行なわれるようになります。

このスイッチは、パスでFanoutを選んだ場合にのみ指示が可能となります。マイ

 

クロビアファンアウトで、ある特定層を落とし込みのターゲットにしたい場合には、

 

このスイッチは使用せずに直接その層までのチェックボックスにチェックを入れ

 

て指示してください。

◆マイクロビアファンアウト

この機能を使用するには、Advanced Interconnect（ビルドアップオプション）が必要となります。

セットアップパラメータ内で下図のようにビルドアップビアの定義がされているデータでは、通常のファンアウトではなくビルドア

 

ップビア設定に対応したマイクロビアファンアウトを自動配線で行なわせることができます。マイクロビアファンアウトを自動配線

 

で行なわせるためには、セットアップパラメータでのビルドアップビアの定義と、自動配線パスの設定方法の2つの条件が必要

 

となります。この2つの条件が満たされない限り、マイクロビアファンアウトは行なわれず、従来どおりのファンアウトで処理される

 

こととなります。

マイクロビアに対するBuildupの指定が必要
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◆No Via/Biasパスにおける注意点

自動配線パスに含まれるNo Via/Biasパスは、ビアを一切使わず、層ごとに定義された（エディタコントロールメニュー内の定義

 

）主配線方向を無視し、純粋にピン間同士（部品間、ビア間）の結線を試みます。

このNo Via/Biasパスで用意されたEffortレベルは1～5までとなりますが、このパスにおいて不用意にエフォートレベルをあげて

 

しまうことは危険なので注意してください。

No Via/Biasパスは主配線方向を無視します。このパスで大きなエフォートレベルを指示するということは、すなわち主配線方

 

向を無視した迂回配線を多く発生させる危険性を自ら上げていることになります。このことから容易に想像できることは、その後

 

に行なわれる主配線方向を考慮した配線パスにおけるチャネル妨害でしか無く、結果としてはあまりいい配線率は得られない

 

ものと考えられます。従って、このNo Via/Biasパスにおけるエフォートレベルの調整は、最低の１で様子をみてから判断するこ

 

とを推奨します。

また、このNo Via/Biasパスは、ビアを一切使用しないバックプレーンなどにも使用することができます。実行時に同時に層を指

 

定すれば、多層に渡る配線方向を無視した迂回を防ぐことができるでしょう。
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◆Tune Crosstalk

自動配線パス内に含まれるTune Crosstalkパスを有効にするには、チューニングを行なうためのルールをあらかじめ設定して

 

おく必要があります。Expedition

 

PCBの場合、このルールはネットプロパティメニューのCrosstalkタブで定義します。

CrosstalkタブにはMax

 

Crosstalk

 

と

 

Parallel Rules Factorの2種類の定義法が提供されていますが、自動配線のクロストーク

 

チューンの対象となるのは

 

Parallel Rules Factor側での設定のみとなります。

Parallel Rules Factorで使用されるルールは単純な平行配線における物理ルールです。このルール定義はメニュー右側に

 

あるAccumulative Parallelism rules欄で同層/異層間に分けて定義します。

同層でのルールをSame layer segmentsに、異層間（隣接層間）におけ

 

るルールをAdjacent layer segmentsに定義します。
ここでは、クロストーク違反を既存配線から見つけだすための基準値と

 

なるルールを定義します。
Edge/Edge Gapに対して指示した配線間のギャップに対する最大平行

 

線長をMax Parallel Lenに定義します。

ここで定義された基準値を越えてはならないネットに対し、１の値を

 

Parallel Rules Factor欄に与えることで違反検出とチューニングが行な

 

われます。

尚、違反検出は同層/異層の双方のルールに対応しますが、自動配線

 

によるチューニングは同層ルールのみに対して有効となっています。
自動チューニングを有効にするためには、Parallel Rules Factor欄で指

 

示する値を必ず”１”にして下さい。
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Same Layer segmentsに対し2つのルールを定義した場合、以下のように指定範囲で自動算出されたルールで各ギャップ値に

 

よるチェックが行なわれます。

Gap Limit Table
30 150 A
| | 自動算出
| | ||
| | ||
| | ||
| | ||

50 200 B

Gap Limit Table
30 150 A
| | 自動算出
| | ||
| | ||
| | ||
| | ||

50 200 B

指定範囲間ギャップにおける最大平行線長 = (Limit-B – Limit-A) / (Gap-B – Gap-A)

Gap Limit
30 150
31 152.5
32 155
33 157.5
34 160
35 162.5
36 165
37 167.5
38 170
39 172.5
40 175
41 177.5
42 180
43 182.5
44 185
45 187.5
46 190
47 192.5
48 195
49 197.5
50 200

Gap Limit
30 150
31 152.5
32 155
33 157.5
34 160
35 162.5
36 165
37 167.5
38 170
39 172.5
40 175
41 177.5
42 180
43 182.5
44 185
45 187.5
46 190
47 192.5
48 195
49 197.5
50 200
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最終的な違反の有無の判断は、各ギャップ値における違反比率の合計で算出され、以下の書式のもとにこの合計値が算出

 

され、

 

Parallel Rules Factorで指示した１をその合計が越えるか否かで違反の有無が判断されます。

Gap = 30 Gap = 35 Gap = 50Gap = 40

配線１

配線２

T1 = 30 T2 = 40 T3 = 35 T4 = 50

1> = 各ギャップ値における最大平行線に対する比率の和

1 >= (T1) + (T2) + (T3) + (T4)

1 >= （30/150）

 

+ （35/162.5）

 

+ （40/175）

 

+ （50/200）

 

= 0.9
↓

合計が1以下なので違反無し
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ネットプロパティメニュー上で設定することができるクロストークルールですが、メニュー上から以外に外部ファイルでコントロー

 

ルすることも可能です。

ファイルで指示する場合には、

 

ParallelRules.txt のファイルをツール起動前にconfigサブフォルダ内に収納しておく必要が

 

あります。ConfigサブフォルダのParallelRules.txt で指示されたクロストークルールは、データ起動時に呼び込まれ、

 

ReviewHazard内でそのエラー内容をチェックすることができ、同層ルールを考慮した自動チューニングが行なえます。ファ

 

イルを読み込む際には内容のチェックが行なわれ正常に取り込めたか否かをlogfileサブフォルダ内に作成される

 

ParallelRulesLog.txtファイルで確認することができます。

フォーマットにはスペース区切りでの指示法と、カンマ＋()での指示法の2通りが提供されます。

【スペース区切りでのフォーマット】

.FILETYPE PARALLELISM_RULES

.UNITS TH

.MODE NONCUMULATIVE

.CLASS2CLASS_RULES SAMELAYER

..CLEARANCE_LENGTH 10 500

..CLEARANCE_LENGTH 5 300

...NETCLASS_NETCLASS "ADDRESS" "(ALL)"

...NETCLASS_NETCLASS "CLOCKS" "(ALL)"

.CLASS2CLASS_RULES ADJACENTLAYER

..CLEARANCE_LENGTH 15 150

..CLEARANCE_LENGTH 5 100

...NETCLASS_NETCLASS "ADDRESS" "(ALL)"

...NETCLASS_NETCLASS "CLOCKS" "(ALL)"

.NET2NET_RULES SAMELAYER

..CLEARANCE_LENGTH 10 200

..CLEARANCE_LENGTH 5 100

...NET_NET "/CLK1" "(ALL)"

...NET_NET "/MEM_CTRL" "(ALL)"

.NET2NET_RULES ADJACENTLAYER

..CLEARANCE_LENGTH 15 150

..CLEARANCE_LENGTH 5 100

...NET_NET "/CLK1" "(ALL)"

... NET_NET "/MEM_CTRL" "(ALL)"

ヘッダー及び単位

クラス対クラスでのグループ指示例
CLEARANCE_LENGTH項目にギャップ

最大平行線長の順に値を指示。
NETCLASS項目に対象となるクラスルール

を指示する。
同層、異層のルールを指示できるが、自動
配線で有効になるのは同層ルールのみ。

ネット対ネットでの個別指示例
CLEARANCE_LENGTH項目にギャップ

最大平行線長の順に値を指示。
NETCLASS項目に対象となるネットルール

を指示する。
同層、異層のルールを指示できるが、自動
配線で有効になるのは同層ルールのみ。

ネット間のルール指定の場合、特定ネット対全てのネットであれば（ALL）で指示することが可能です。
ただし、（ALL)では電源ネットも含まれてしまいますので、(Default)を使用することをお勧めします。
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.FILETYPE PARALLELISM_RULES

.UNITS TH

.MODE NONCUMULATIVE

.CLASS2CLASS_RULES SAMELAYER

..CLEARANCE_LENGTH (10, 500)

..CLEARANCE_LENGTH (5, 300)

...NETCLASS_NETCLASS ("ADDRESS", "(ALL)")

...NETCLASS_NETCLASS "CLOCKS", "(ALL)")

.CLASS2CLASS_RULES ADJACENTLAYER

..CLEARANCE_LENGTH (15, 150)

..CLEARANCE_LENGTH (5, 100)

...NETCLASS_NETCLASS ("ADDRESS", "(ALL)")

...NETCLASS_NETCLASS ("CLOCKS", "(ALL)")

.NET2NET_RULES SAMELAYER

..CLEARANCE_LENGTH (10, 200)

..CLEARANCE_LENGTH (5, 100)

...NET_NET ("/CLK1", "(ALL)")

...NET_NET ("/MEM_CTRL", "(ALL)")

.NET2NET_RULES ADJACENTLAYER

..CLEARANCE_LENGTH (15, 150)

..CLEARANCE_LENGTH (5, 100)

...NET_NET ("/CLK1", "(ALL)")

...NET_NET ("/MEM_CTRL", "(ALL)")

ヘッダー及び単位

クラス対クラスでのグループ指示例
CLEARANCE_LENGTH項目にギャップ

最大平行線長の順に値を指示。
NETCLASS項目に対象となるクラスルール

を指示する。
同層、異層のルールを指示できるが、自動
配線で有効になるのは同層ルールのみ。

ネット対ネットでの個別指示例
CLEARANCE_LENGTH項目にギャップ

最大平行線長の順に値を指示。
NETCLASS項目に対象となるネットルール

を指示する。
同層、異層のルールを指示できるが、自動
配線で有効になるのは同層ルールのみ。

【カンマ＋()区切りでのフォーマット】

ネット間のルール指定の場合、特定ネット対全てのネットであれば（ALL）で指示することが可能です。
ただし、（ALL)では電源ネットも含まれてしまいますので、(Default)を使用することをお勧めします。
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検出された違反（合計が1以上になったネット）は、ReviewHazardメニューのOnline＞Parallelismでチェックすることができます。

自動配線のTune Crosstalkパスは、このようにして検出された同層におけるクロストーク違反を無くすようにVictim（影響を受け

 

ているネット）側とAggressor（影響を与えている）側との配線間に、スペーサーと呼ばれる仮想パターンを埋め込み、双方の間

 

隔を自動で広げようと試みます。
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自動配線のTune Crosstalkパスによって配線間に追加された

雷マークの塗り潰しパターンがスペーサー

追加されたスペーサーは、エディタ上で直接選択することができますがCAMデータ出力の対象にはなりま

 

せん。また、配置されたスペーサーを一括削除する場合には、Edit>Add to Select set>Spacers コマンドで一

 

括選択した後に削除コマンドにて削除してください。

追加されたスペーサーは、ディスプレイコントロール上で表示
指定しなければ表示されません。

Note
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・Hard Fence（ハードフェンス）

ハードフェンスが設定された場合、自動配線は指定したハードフェンス領域内でのみ配線を行います。また配線対象のネット

 

は、配線フェンス内で完結するネット（ピン）のみが対象となります。
※Items to Routeによる配線対象の制限

 

及び

 

Layersによる配線層指定も合わせて考慮します。
※指定したハードフェンスのみが有効となり、その他全てのソフトフェンス・ハードフェンスは無視されます。

使用方法）
1. Route Fence領域をFence Type：Hard、Name：任意のハードフェンス名にて設定
2．自動配線のFence設定にて、上記で指定したハードフェンス名（例、FPGA）を指定後、Route実行。

◆配線フェンス／Route Fence

配線フェンスを使用することで、自動配線は任意に定義した配線エリアを使用して自動配線を行います。配線フェンスには２

 

つのフェンスタイプが存在し、定義した配線エリアに対して

 

自動配線は

 

Tune、Fanout、Route、Rerouteを実施します。
※制限として、Spread，

 

Via Min，

 

SmoothパスはSoft Fenceを考慮することはできません。

配線フェンスの名前を設定します。
256文字までの英数字とスペースが使用可能。

※ユニークなフェンス名であること。

フェンスタイプを選択します。
Hard ：ハードタイプにて配線フェンスを設定。

配線フェンス内でのみ結線します。
Soft ：ソフトタイプにて配線フェンスを設定。

配線フェンス内のネットを対象して結線します。
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・Soft Fence（ソフトフェンス）

ソフトフェンスが設定された場合、自動配線は全てのソフトフェンス領域内にあるネット（ピン）を配線対象として配線を行います

 

。ソフトフェンス内のネットの接続先が配線フェンスの領域外に存在しても、そのネットは配線対象となります。
※Items to Routeによる配線対象の制限

 

及び

 

Layersによる配線層指定も合わせて考慮します。
※ソフトフェンス領域外に存在するネットは、配線フェンスを配線禁止領域として扱い、ソフトフェンス内の進入を禁止します。
※ソフトフェンス内で完結するネット（ピン）はソフトフェンス領域内で配線を行います。

使用方法）
1. Route Fence領域をFence Type：Soft、Name：任意のソフトフェンス名にて設定
2．自動配線のFence設定にて、In-SFencesを指定後、Route実行。

①

 

配線フェンスをHard Fence（ハードフェンス）に設定

②

 

配線フェンスをSoft Fence（ソフトフェンス）に設定

Route Fence（配線フェンス）を使用した自動配線の実行例
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◆Spreadパスの拡張機能

自動配線のSpread パスが2007.2バージョンにて改善されました。Spread パスは、オープンスペースがある場合にトレースと、

 

それに近接する異電位パッドや他のトレースとの間隔を広げる際に使用します。これまでのSpread パスは、間隔を単純に

 

“ネットクラスとクリアランス”ダイアログやCES で定義されたクリアランス値の２倍にすることを試みるものでしたが、2007.2では、

 

外部ファイルを用いることで、層ごとに具体的なクリアランス値を定義できるようになりました。

外部ファイルに定義されたクリアランスがデザイン上で取れていない場合、Auto Router は、近接する異電位パッドや他のト

レースとの間隔を広げ、そのクリアランスを確保することを試みます。両側をトレース以外のパッド等に挟まれているなどして、
設定されたクリアランスを確保することができない場合は、隣り合うトレース含め等間隔になるようにセンタリングします。

【実行手順】

① 予め、外部設定ファイル¥PCB¥Config¥SpreadTo.txt をテキストエディタで作成します。フォーマットは次のとおりです。
<単位>
<層番号> <クリアランス値>
<層番号> <クリアランス値>
：

１行目では、このファイル内で使用する単位を定義します。指定できる単位は、in、th、mm、um の4 つです。
２行目以降では、各層ごとにクリアランス値を定義します。指定できる値は0 より大きな実数です。

（例１）
mm
1 0.5
2 0.7
5 0.7
6 0.5

尚、１行目で単位を定義するのではなく、１行目から各層のクリアランス値を定義し、各行に単位を直接記述することもできま

 

す。
（例２）
1 0.5mm
2 0.7mm
5 0.7mm
6 0.5mm

② Auto Route ダイアログにて、Pass Type としてSpread を選択し、Route ボタンをクリックしてください。
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・

 

Pair 配線やTuning 配線など、配線形状や間隔が重要な意味を持つものに対しては、予めLock/Fix などを行ってくだ

 

さい。
・

 

45 度単位以外の角度のトレースを含んでいるネットは処理対象外です。
・

 

Lock/Fix/Semi-Fix のトレースは処理対象外です。
・

 

SpreadTo.txt に定義されていない層は処理対象外です。
・

 

Spread パスが処理される度、SpreadTo.txt は参照されます。SpreadTo.txt を編集後に、再起動等は不要です。
・ このSpread パスでは、Expand （拡張幅への幅変更）は行なわれません。
・

 

SpreadTo.txt が存在しない場合は、次のメッセージが表示されます。 SpreadTo.txt作成後にSpreadパスを実行ください。

【実行結果】

（例１）
< Spread パス実行前>

SpreadTo.txt
mm
1 0.2
2 0.2
3 0.2
4 0.2
5 0.2
6 0.2

< Spread パス実行後> 
SpreadTo.txt に設定された値でSpread 処理がされます。

Note

Trace-Traceのクリアランスは0.100mmで配線されています。

Trace-Traceのクリアランスは0.200mm間隔に変更されます。
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【実行結果】

（例2）
< Spread パス実行前>

< Spread パス実行後> 
SpreadTo.txt に設定されたクリアランス値が大きすぎて実現できない場合、等間隔になるようセンタリングします。

ビア-ビア間で等間隔にセンタリングが行われます。
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プレーンデータの作成

Chapter3: Design Process-Routing
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◆ダイナミックプレーン（Dynamic Plane）によるプレーン生成

以前のバージョンでは、プレーンプロセッサ(Plane Processor)機能のバッチ処理を使用して、プレーンデータを作成していまし

 

た。新たなプレーン生成機能では、Plane Classes and Parametersダイアログ 及び Plane Assignmentsダイアログを使用してプレ

 

ーンパラメータを管理し、ダイナミックなプレーンデータの生成 及び プレーンのマニュアル編集を行います。

プレーンネットの追加（変更）

 

及び 設計フェ

 

ースに応じて、Plane Classes and Parameters 
やPlane Assignmentsダイアログで設定の追

 

加・変更を行います。

Plane Classes and Parameters ダイアログを使用します。

完了

編集操作
・Plane Editing Sketchによるプレーン形状の変更、削除

・サーマルタイのマニュアル編集
・Thermal Overrideによるサーマルパラメータの変更

Plane Classに対してプレーンパラメータの設定

Plane Assignments ダイアログを使用します。

層・プレーンネットに対してPlane Classの設定

プレーンシェープの配置

Plane Shape プロパティを使用します。

Dynamic Planeの運用フロー
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◆プレーンパラメータ＆プロセッサ／Plane Classes and Parameters

Plane Classes and Parametersダイアログでは、Plane Classとプレーン形状のデフォルト設定を定義します。Plane Class毎にパラメ

 

ータ設定が可能であり、ここで作成したPlane ClassをPlane Assignmentsダイアログに指定することにより、層やネット毎にルール

 

を割り当て、プレーン生成を行います。

・Plane Class の新規作成と編集

メニュー最上段には、Plane Classを選択するためのリストウィンドウが存在します。このリストには、作成した全てのPlane Classがリ

 

ストされますので、任意のPlane Classを選択してパラメータの設定を行います。

Plane Classを作成します。Plane Assignmentsダイアログで使用されているPlane Class名は、編集できません。

編集されたPlane Classに対するパラメータを編集前の状態に戻します。パラメータ変更後のみアクティブとなります。

Plane Classを削除します。但し、Plane Assignmentsダイアログで使用されているPlane Classは削除できません。

ここで定義したPlane Classは、Configフォルダに“.pcdファイル”として格納されます。

Plane Class毎にパラメータを定義します。
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・Thermal Definitionタブでのサーマル定義

このタブでは、サーマル接続に関する定義を行います。

ビアに対するサーマル定義

貫通ピンに対するサーマル定義

表面実装ピンに対するサーマル定義

・Use thermal definition from padstack オプション

このオプションをチェックすることで、パッドスタックに登録されたサーマルパッドを使用して、サーマル接続を行います。
※Plane Type：Negative （ネガ）を使用時は、常にチェックされた状態の動作となります。

オプション機能により、パッドスタックに登

 

録されたPlane Thermal形状を使用して

 

サーマル接続を実施します。
※未登録の場合は、Thermal Definitionタ

 

ブの設定を使用します。
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パッドスタックに登録されたサーマルパッドは、Plane Typeにより、使用するパラメータが異なります。

Plane Type：Positive(ポジ)の場合
Padstackに登録したPad(Mount/Internal/Opposite）と以下のタイ幅とクリアランス値を使用して、サーマル接続を実施します。

Plane Type：Negative(ネガ)の場合
Padstackに登録した以下のサーマル径、タイ幅とクリアランス値を使用して、サーマル接続を実施します。

ポジプレーン作成時は未使用となります。
Padstackに登録したPadを使用します。

・Enable tie bridging

このオプションはPlane Type：Positive(ポジ)のみ使用可能な機能となり、チェックすることで、サーマル同士のタイレグを接続し

 

て、プレーン接続の強化を行います。

隣接する複数のサーマルのタイレグをつなぎ合わ

 

せます。
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・Default connections 設定

この設定は、Use thermal definition from padstackオプションがオフの場合や、パッドスタックにサーマルパッドの定義が無い

 

場合に適応されるパラメータとなります。

ビアに対するサーマル定義

貫通ピンに対するサーマル定義

表面実装ピンに対するサーマル定義

サーマルのクリアランス幅

サーマルのタイレグ幅

オプションがOFF 又は パッドスタックにサーマルパッドの定義

が無い場合、以下パラメータが有効となります。

タイレグのデフォルト接続形状を指定します。
※Tie legs:Eight(8本)は、Thermal Override機能でのみ指定可能。

サーマル配置角度を指定します。
Fixedは完全固定となり、Preferredは優先となります。
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・Clearances/Discard/Negativeタブでのクリアランス定義

このタブでは、クリアランスに関する定義を行います。

・Default Clearances 設定

プレーンとのデフォルトクリアランスを定義します。

プレーンのクリアランス定義

浮島プレーンの削除定義

ネガプレーンのクリアランス定義

Contourやマウンティングホールと

 

プレーンとのクリアランス

その他オブジェクトとプレーンとの

 

最小クリアランス

※Other object (minimum)は、その他のクリアランス値と比較を行い、この値より小さな値を持つクリアランスは、
Other object (minimum)をクリアランス値として採用します。
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・DRC対象オブジェクトとのクリアランス設定

Plane Type：Positive(ポジ)のプレーンとトレース、部品パッド、ビアパッド、プレーンといった異電位を持つオブジェクトとのクリア

 

ランス設定は、Net Classes and Clearancesに定義されたPlane-Trace、Plane-Pad、Plane-Via、Plane-Planeの値を採用します。
※Plane Type：Negative(ネガ)のプレーンと異電位のパッドに関するクリアランスは、Negative clearance pads項目を参照下さい。
※Other object (minimum)より小さな値を持つクリアランスは、Other object (minimum)をクリアランス値として採用します。

・Discard plane area options 設定

このオプションでは、プレーンの浮島に関する取り扱いについて定義します。

浮島(未接続のプレーン）は全て削除します。

1ピンのみに接続されたプレーン

 

を削除します。指定面積以下のプレーンを

 

削除します。

All untied areasがONの場合に指定できる機能となり、浮島状態で1ピンのみが接続しているプレーンを浮島と
して扱い、これを削除させるためのスイッチとなります。

接続はされるが、浮島状態となっている。

Areas tied to single padのスイッチを入れる

ことで削除されます。
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・Negative clearance pads 設定

以下のオプションは、Plane Type：Negative(ネガ)プレーン作成時にのみ有効な設定項目です。

ネガプレーンデータとして作成されるクリアランスパッドを、どのような形で作成させるかを決定しています。どちらを選ぶかによ

 

ってガーバーデータでの取り扱いが変わります。

・Anti-Pad

 

：

 

作成されるクリアランスパッドは1点座標のみのフラッシュデータとして作成します。
※パッドスタックに登録されたPlane Clearanceのパッドを使用します。

・Donut

 

：

 

パッドのフラッシュデータとクリアランス部の作画データでクリアランスパッドを作成します。
※パッドは、パッドスタックパッドに登録されたパッドを使用し、クリアランスは

Net Classes and ClearancesのPad-Planeクリアランスを使用します。

※クリアランスパッドの設定は通常パッドスタック毎に行なわれており、この設定を使用してプレーンデータを作成
する場合には、無条件でAnti-Pad側を選択して下さい。

＋ ＝

以下のオプションは、ネガプレーンデータ作成時にルートボーダ(Route Border)に沿って外側に抜き領域を作成したい場合

 

に使用します。ルートボーダの外側に対して、ここで指定した値のクリアランス領域が作成されます。

この機能は、ボードアウトラインとルートボーダ間に対してプレーンの銅箔データを作成させないための機能となり、この結果を

 

ポジイメージで捕えると、指定した値のクリアランスがラウトボーダーの外側に作成される形になり、これによってボードアウトライ

 

ンとラウトボーダー間の銅箔データを削除することができます。
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・Hatch Optionsタブでの塗り込みパターン定義

このタブでは、Plane Type：Positive(ポジ)の場合に有効な、ハッチ(塗り込みパターン)に関する定義を行います。

塗り込みパターン幅・間隔の定義

塗り込みパターンに関する定義

塗り込みパターンのオプション定義

以下オプションでは、塗り込みパターンの幅と間隔について定義します。

Width

Distance

・塗り込みパターンをオーバーラップさせたい場合、Width>Distanceとなるように

 

設定して下さい。
・Metalに値を設定することで、Distance値を計算して設定することが可能です。
例）

 

上記設定では、Metal:50%とすることで、Distance値：0.300を設定します。
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以下オプションでは、塗り込みパターンが格子状で、Metal percentageの値が100%を下回る場合にのみ設定可能な機能とな

 

り、このスイッチを入れることで、作成されるプレーンの矩形以外の領域は全て塗りつぶされます。

・Fill non-square hatch areasスイッチは、矩形にならない部位を全て塗りつぶすために使用します。

・Restrict plane to orthogonal patternsスイッチは、塗り込みパターンが垂直/水平及び垂直格子状の場合にのみ設定可能
な機能となり、このスイッチを入れることで、全てのクリアランスが矩形で作成されます。

・Snap to hatch gridスイッチは、Restrict plane・・・をONとした場合に使用できる機能で、これを入れることで塗り込み
パターンやクリ

 

アランスがすべてハッチグリッド上に作成されるようになります。尚、このハッチグリッドとは、基板原
点（ボードオリジン）からこのメニューのDistanceに指定された値の間隔で発生するグリッドとなります。
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◆プレーン割当／Plane Assignments

Plane Assignmentsダイアログでは、プレーン層の定義、プレーンタイプ(Positive 又は Negative)の指定、Plane Classの割り当て

 

及び プレーンステータス（Dynamic、Batch、Static）の指定など作成されるプレーンデータの状態を管理します。

・Layer/Net 項目

この項目では、各層のプレーン情報が表示されます。各層を選択することで、その層に存在するプレーンを確認することが可能

 

となります。

基板の層構成を表示

各層に割り当てられたプレーンネット

 

又は

 

配置されたPlane Shapeのネット名を表示。

・Add/remove nets from plane layer 設定

Layer Usage：Planeとして対象層をプレーン層として定義することで“･･･”ボタンが表示されます。このボタンを選択することで

 

Netsウィンドウが表示され、プレーンネットの指定（複数可）が可能となります。プレーンネットをアサインする場合は、Excludedに

 

あるネットをIncludedへ移動します。

プレーンネットとして

 

設定されたネット名。
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・Use route border as plane shape 設定

このスイッチは、プレーン領域としてRoute Border(ルートボーダ)を使用する場合にチェックします。Layer Usage：Planeであり且

 

つプレーンネットが存在する場合に使用することが可能となります。各層で1つのプレーンネットのみ選択することができ、チェッ

 

クしたネットは、全面プレーンとして扱われます。

・Layer Usage 設定

この項目では、プレーン層の定義を行います。マウスクリックにてドロップダウンリストが表示され、Planeを選択することでプレー

 

ン層として設定されます。この設定は、Setup ParametersのLayer StackupタブやDisplay ControlのLayerタブに反映されます。

・Plane Type 設定

この項目では、プレーン層のタイプをPositive（ポジ）

 

又は Negative(ネガ)から選択します。 Layer Usage：Planeの場合のみ、使

 

用可能となります。Negativeが選択された場合は、Plane Date Stateは自動的にBatchにセットされます。
※ネガティブプレーンを作成するには、Planes> Generate Negative Planesコマンドの実行が必要となります。

・Plane Class 設定

この項目では、Plane Class and Parametersで作成したPlane Classを設定します。このPlane Classは、層（Layer1,2,3..) とプレーン

 

ネットにそれぞれに割り当てることができます。プレーンネットにはデフォルトでInheritedが設定されます。Inheritedは、層のPlane 
Class設定を継承する設定となりますので、必要により任意のPlane Classへ変更ください。

Plane Classとして、
・層（Layer1,2,3..) には、“Default” 又は “Plane Class and Parametersで作成したPlane Class”、
・プレーンネットには、“Default”、“Inherited” 又は “Plane Class and Parametersで作成したPlane Class”
から選択して設定することができます。

プレーンネットに対する

 

Plane Class設定

層に対するPlane Class設定
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・Plane Data State 設定

この項目では、プレーンデータの状態を選択します。

Plane Data Stateとして、
・層（Layer1,2,3..) には、“Draft”、“Dynamic” 又は “Static”、
・プレーンネットには、

 

“Draft”、“Dynamic”、“Static” 又は“Inherited”

 

から選択して設定することができます。

Inherited：
層に割り当てられたネットは、デフォルトでInherited が設定されます。Inherited 設定では、層に割り当てられたPlane 
Data State の状態が継承されます。

Draft：
このモードでは、実際のプレーンデータは表示されず、プレーン分割を行った際のクリアランス

 

及び プレーンシェイプ

 

の境界線だけ表示されます。主に設計の初期段階に使用されます。Draftのプレーンデータはガーバーへ出力されま

 

せん。

Dynamic：
このモードでは、編集時にダイナミックにアップデートされる実際のプレーンデータが表示されます。デザインが再ロード

 

される度にプレーンエンジンが自動的にプレーンデータを再生成します。またこのモードではPlane Editing Sketchを使

 

用したプレーン形状の変更やサーマルのタイレグを編集等の変更作業が行えます。

Static：
このモードでは、プレーンデータの編集やアップデートは実行されません。主に設計の最終段階に使用され、また編集

 

されたプレーンデータのロック等の目的でも利用できます。Staticのプレーンデータは、トレース層に割り当てられたカ

 

ラーの50%のフィルパターンで表示されます。
※EXP2005.ｘ

 

バージョンで生成された既存のプレーンデータ 及び APS （アクチャルプレーンシェープ）は、Static プ

 

レーンとして扱われます。

Batch：
このモードは、Plane TypeがNegative(ネガ) に設定された場合のみ指定され、変更することが出来ません。
ネガティブプレーンデータを生成するために、Planes> Generate Negative Planesコマンド

 

を実行し、削除には
Planes> Delete Negative Plane Dataコマンドを実行します。
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◆プレーンシェープ／Plane Shape

プレーンシェープを作画することにより、指定した領域内にのみプレーンの発生が可能となります。プレーン層として全面プレー

 

ンを作成する場合は、プレーンシェープを作成する必要はありません。その際は、

 

Plane AssignmentsダイアログのUse route 
border as plane shapeをチェックすることで、ルートボーダをプレーンシェープとして扱い全面プレーンの定義が可能となります。

・プレーン関連の表示設定

Display Control> LayerタブのPlanes項目でプレーンの表示設定の変更が可能となります。

・プレーンシェープのオーバーラップ設定

プレーンシェープ同士がオーバーラップする場合は、必ず小さなエリアを持つシェープが前面に作画される必要があります。以下

 

の例では、Plane Shape-BをPlane Shape-Aの前面に作成して下さい。前に移動するには、Bring Forwardコマンド

 

、後に移動す

 

るにはSend Backwardコマンド

 

を使用して調整します。またオーバーラップ時に表示されるスリットは、Plane-Planeクリアランス

 

設定が使用されます。

Plane Shape-A

Plane Shape-B

Plane-Planeクリアランス

 

設定にてスリットを表示。
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・プレーンシェープのプロパティ設定

プレーンシェープには以下のような属性の定義が可能となります。

Layer：
プレーンシェープの層を指定します。

Net：
プレーンシェープのネット名を指定します。リストからネット名を選択するか、リストの先頭にあるMouse Selectを選択

 

することで、左マウスボタン(LMB)で指定したネットオブジェクト(ピン、ピア、トレース等)からネット名を継承します。

Route Obstruct：
プレーンシェープ内へ異電位を持つトレースの進入を禁止します。

Lock：
プレーンシェープの移動 及び 属性の変更を禁止します。

 

移動を試みた場合は、以下メッセージが表示されます。
Can’t modify fixed or locked objects.

Isolate Plane：
同じネット名を持つプレーンシェープが重なった場合に、そのプレーンデータ同士をマージするかどうかを制御しま

 

す。チェックボックスがOFFの場合にはマージされ、ONの場合にはPlane-Planeクリアランスを使用して分割します。

※マージするには、両方のプレーンシェープが“Isolate Plane：OFF”である必要があります。

Plane Class：
Plane Classを変更する場合は、リストより

 

Plane Classes and Parametersで作成したPlane Class 又は Parameter 
Overrides を選択します。デフォルトでは、Inheritedが指定されており、Plane Assignmentsで指定したPlane Class設

 

定を継承することになります。ここで異なるPlane Classを割り当てることで、Plane Assignments設定より優先され、
プレーンシェープに固有のPlane Classを設定することが可能となります。

Isolate Plane：OFF Isolate Plane：ON
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またParameter Overridesを選択することで、指定していたPlane Class設定を一部変更することが可能となります。表示された

 

Plane Classes and Parametersダイアログ上でパラメータの変更が行え、プレーンシェープに固有のパラメータ設定の定義が可能

 

となります。

Plane Classで設定されていた値を変

 

更すると、変更箇所が黄色で表示され

 

ます。

Parameter Overrideで変更されたPlane Class 
は黄色で表示され、オリジナルのPlane Class 
設定が変更されたことを表しています。



－ 320 －

◆プレーン編集スケッチ／Plane Editing Sketch 

Plane Editing Sketch機能を使用することで、Plane Assignments> Plane Data State：Dynamicにより生成されたプレーンデータの

 

整形編集が可能となります。

入力したPlane Editing Sketch

Plane Editing Sketchにより

削除されたプレーンデータ
（グレー箇所）

Plane Editing Sketchを入力するには、以下のように4つの方法があります。
①Planes> Place Plane Editing Sketch コマンドの実行。
②Routeモードで、ファンクションキー〔F5〕Plane Sketch の実行。
③Drawモードで、Type：Plane Editing Sketchを選択して作画。

④キーインコマンド“PDS”を入力。

・アクションキーとポップアップメニュー コマンド

Plane Editing Sketchコマンドを実行すると、メニューが変更されて様々なコマンドの実行を行うことが可能となります。

アクションキー

ポップアップメニュー
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〔F2〕End Sketch：
2点以上のSketchラインポイントが指定された際に有効となり、Sketchラインの入力を終了します。

〔F3〕Close Sketch：
3点以上のSketchラインポイントが指定された際に有効となり、始点と最終ポイントを結んだポリゴン形状を作成します。

〔F9〕Metal Side：
Sketchラインのどちら側にあるプレーンを削除するか（又は保持するか)の指定を行います。
Auto ：システムが自動判断します。Sketchラインにより分断された面積の小さいプレーンを浮島と判断して削除します。
Left   ：Sketchラインの左側のプレーンを保持、右側のプレーンを削除します。
Right ：

 

Sketchラインの右側のプレーンを保持、左側のプレーンを削除します。

〔F10〕Toggle Snap：
Snap On時は、プレーンデータのエッジにSketchラインがスナップされます。Snap Offの時には、プレーンエッジ以外の
ポイントにSketchラインの作成が可能となります。

〔F11〕Toggle Curve：
アーク形状のSketchラインの作画が可能となります。

Left選択時 Right選択時

※ステータスバーに現在のMetal Side状態が表示されます。

※ステータスバーに現在のSnap状態が表示されます。

・その他のコマンド

作画したSketchラインをドラッグすることで、プレーン形状の変更が可能となります。

選択コマンドとしては、Sketchラインを選択後のポップアップメニューコマンド：Add Partly Selected Plane Sketchにより、選択した

 

Sketchラインに接続されたSketchラインの選択が可能となります。

またSketchラインを全て選択するには、Edit> Add to Select Set> Plane Sketchesコマンド、未使用のSketchラインを全て選択する

 

には、Edit> Add to Select Set> Unused Plane Sketchesコマンドを使用します。

右側へドラッグ
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◆サーマルタイ(Tie Leg)の編集

Plane Assignments> Plane Data State：Dynamicにより生成されたプレーンデータのサーマルタイ(Tie Leg)の編集が、Drawモー

 

ドで可能となります。

Tie Leg選択後に、
・Deleteキーで削除。

・ドラッグ操作で移動。

サーマルタイの編集操作は、幅(Line width)の変更、追加・削除、移動といった操作がありますが、これらの変更は

 

Thermal Overrideコマンドのような特殊な操作を行う以外は、保持される動作となります。

◆サーマルオーバーライド／Place Thermal Override

Place Thermal Override機能を使用することで、選択したピン（複数ピンの指定が可能）に対してのみ、サーマル接続のパラメー

 

タ変更を可能とします。ピン選択後、ポップアップメニューコマンド：Place Thermal Overrideコマンドを選択すると、Pin Thermal
ダイアログが起動します。尚、この機能はPositive(ポジ）プレーンにのみ有効な機能となっております。

Note
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サーマルタイの角度は、パッドの角度に依存します。もしパッドの角度が270度を持つ場合、Rotation：Fixed 0のオ

 

ーバーライド設定をした時には、90度のサーマルが発生することになります。

選択したピンのネット名を表示します。

 

※異ネットが存在する場合は、空白とな

 

ります。

選択したピンの“REF番号-ピン番号”を

 

表示します。

ポジ層のLayerが表示されます。
Override項目にチェックを入れた層に対してパラ

 

メータ変更を実施します。

選択したピンに対して有効な項目のみが変更可能なアイテムとして表示されます。以下の例では、Tie legsを4から8本に変更し

 

た場合の動作となります。※Tie legs:8は、Thermal Overrideでのみ設定可能です。

Tie legs設定を4から8本へ変更。

◆サーマルオーバーライドの削除／Remove Thermal Override

Remove Thermal Override機能を使用することで、Thermal Overrideによるサーマル設定の削除を行います。削除したいピン（複

 

数ピンの指定が可能）を選択して、ポップアップメニューコマンド：Remove Thermal Overrideの実行することで、オーバーライド

 

設定がクリアされて、Plane Class設定を有効とします。

Plane Class設定の変更は、Thermal Override設定に影響を与えません。その為

 

、Plane Class設定を有効にするには、一旦Remove Thermal Overrideによる削

 

除が必要となります。

Note
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◆ピン接続コントロール／Routed Pins

Expedition PCBでは、貫通部品の場合でも表面実装部品のようにビアを引き出してからプレーン接続させる指定が行えます。

 

この設定は、Routed Plane Controlメニュー内で行い、各プレーンネットに対して部品毎に設定することが可能です。この設定

 

を行った部品に関しては、その部品のピンで直接プレーン接続は行なわれずに、ビアもしくは他の部品を経由して間接的に

 

プレーン接続されます。このラウテッドプレーンピンコントロールメニューは、プルダウンメニューPlanes＞

 

Routed Pinsを実行

 

することで起動することができます。

メニュー説明：

メニュー最上段にあるPlane net項目では、プレーン設定されたネット名が全て表示されます。この項目でネット名を指定すると

 

、下のリストに対して指定したネットの接続情報を持つ貫通部品が全てリストされます。

ネット名を選択。

指定したネットの接続情報を持つ
部品が全てリストされます。

このチェックボックスにチェックを入れることで、表面実装部品の

 

情報もリスト内に表示させることができます。

このコマンドは、フォワードアノテーション（バックアノ）が有効で且つPlane層が存在（Setup Parameters>Planes）が

 

する場合のみ使用可能となります。
Note
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リスト表示された部品を選択すると、右側のRouted Pinリストにその部品が持つ接続ピン情報がリストされます。このピン情報に

 

はそれぞれにチェックボックスが存在し、このチェックボックスにチェックを入れることで、そのピンへの間接的なプレーン接続

 

指定が行なわれます。基本的な作業は、ネット別に個々の部品毎に対して行なわれますが、リスト上に存在する2つのボタン

 

を使用することで、そのネットの接続情報を持つ全ての部品に対して一括設定することもできます。

設定対象の部品を選択。 間接接続を指定する任意のピンにチェックを入れます。

全ての部品の全てのピンに対して間接接続を一括設定。全ての部品の設定を一括解除

設定した内容を保存する場合には、メニュー下にある{OK]もしくは{Apply]のボタンを選択します。このメニューを[Cancel]ボタ

 

ンで抜けた場合、設定した内容は一切保存されません。

この設定を行なった後は、保存やデータを閉じるといった作業を行なうと自動的にバックアノテーションが実行され、プレーン

 

ピンコントロールの設定内容をLogicサブフォルダ内のrtdplane.cafファイルへと収納します。このファイルのフォーマットは下記

 

のようになり、ファイルとして予め用意しておくことも可能となります。尚、事前に用意されたファイルの内容を設計データに反

 

映させるにはフォワードアノテーションの作業が必要となりますので注意して下さい。

rtdplane.cafファイルフォーマット：

PlaneNetName△ReferenceDesignator△AlphanumericPinNumber

 

<-

 

ヘッダ部
GND△U5△7
VCC△U1△14

・
・
・

ネット名△RefDes△Pin

 

No

※△印は全てタブとなります。
※このファイルは、デザインファイルのLogicサブフォルダ内に必ず収納します。

・Batch DRCのチェックでは、ネガティブプレーン層のプレーンに接続されたRouted Plane Pinは検出できません。
・全てのSMDピンに対してプレーンへの直接的な接続を禁止する場合は、全てのSMDピンをRouted Plane Pinとし

 

て設定して下さい。Note
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結果のイメージ

ビアなどで間接的にプレーン接続される。
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Chapter 3
Design Process-Reviewing Design

概要
Reviewing Design（検証プロセス）では、デザイン検証の手法を説明します。

• デザインルールチェック（DRC） －328P
• その他の検証コマンド

 

－356P
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デザインルールチェック（DRC）

Chapter3: Design Process-Reviewing Design
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◆レビューハザード／Review Hazard

Expedition PCB上でのデザインルールに関するチェックは、レビューハザードメニューを使用して確認します。このレビューハ

 

ザードメニューには幾つかのプルダウンメニューが存在し、Online、Batch、Summary、Verify以下に収納される各項目を選択

 

することで、その項目に関する違反内容をメニュー内で確認することができます。このレビューハザードメニューでは、オンライ

 

ンでリアルタイムに確認できるものと、Batch DRCコマンドを実行した後にはじめて確認できるようになるものが存在します。ど

 

ちらの場合でも、メニュー内に表示される内容は基本的に違反として認識されたもののみとなりますが、ネットの物理的な長さ

 

や伝送遅延といった単なる情報を表示するといった項目も存在します。このレビューハザードメニューは、プルダウンの

 

Analysis＞

 

Review Hazardsコマンドを実行することで起動することができます。

レビューハザードは、設計開始後のどの時点で使用して頂いても構いません。Batch DRCコマンドを実行しないと確認できな

 

い…というもの以外であれば、設計作業のどの段階であっても違反情報の確認作業が行なえます。Online以下は全てエディ

 

タが常に監視している項目となり、その内容もリアルタイムに更新されます。従って、部品に関する違反が検出されたような場

 

合でも、その部品への修正作業を違反が解消されたのか否かをリアルタイムに確認しながら作業が行なえます。

検出された部品

検出された部品に対し修正を施す。

解消されればリストから削除
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検出された違反内容をリストから選択すると、下の項目に対しその詳しい内容が表示されます。

ここに詳細内容が表示されます

確認したいものを選択

メニュー下には、リストで選択した違反個所を検索するためのオプション設定が存在します。リストで選択した違反対象を如何

 

にしたいか設定した上で、メニューの

 

[Review]もしくは[Apply]ボタンを選択すると、リストで選択した違反対象に対して設定項

 

目で指定した作業が行なわれます。

選択状態にする

最適化表示（拡大表示）させる

ハイライト表示させる

選択状態を保持させる

例えば、リストで選択した違反個所を確認したいというようなケースでは、この中のFit viewにチェックを入れた上で[Apply]ボタ

 

ンを選択すれば、その部品を即座に拡大表示させることができ、同時にSelectを入れておくことで違反個所に対する編集作業

 

へと速やかに移行することができます。この操作の対象はリストで選択されたもの全てとなり、複数を選択した場合には指定し

 

た操作がまとめて行なわれます。

検索
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・All Nets

 

－全てのネットを対象としたハザードが表示されます。またその他フィルターオプション
が選択されている場合は、全てのネットにリセットします。

・Nets in Selection Filter

 

－エディタコントロールのフィルターが有効な際に、フィルター設定を参照してハザード
を表示します。

・Selected Nets

 

－デザイン内で現在選択中のネットに対してのみハザード表示します。
・User Filter

 

－3つのユーザー定義フィルターが存在し、いずれかを選択後文字列を入力することで、
現在ソートをかけている列に対してフィルタ設定が可能となります。

ハザードフィルター

Hazard filter（ハザードフィルター）を使用することで、リストされたハザードをフィルター表示することが可能となります。

ユーザーフィルターの使用例

1.

 

ハザードタイプを選択して、ハザードリストを生成します。

2.

 

ハザードフィルターからUser Filterの1つを選択します。

3.

 

ハザードフィルターフィールドに任意の英数字を入力して、フィルター定義します。

4. ハザードフィルター内でフィルターをかけたい列を選択します。
例えばネット名でフィルタしたい場合は“Net Name”列のヘッダーを選択します。

ここをクリック

定義したフィルタでハザードリストを作成
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◆Onlineチェック項目

Components：
部品間

 

及び

 

部品と基板オブジェクト間

 

で発生するエラーを検出します。
部品間のクリアランス違反、配置禁止領域への配置違反、指定ルーム（Room）以外などの配置違反。

Open Fanouts：
ビア

 

又は

 

貫通ピンに接続していない未接続のSMDピンをエラーとして検出します。

Open

 

Netlines：
未結線の配線をエラーとして検出します。

Trace Widths：
ネットクラスで指定したMinimum・Typical・Expansion

 

Width以外の配線幅を使用した配線をエラーとして検出します。
※Batch DRCのTrace Widthでは、

 

Minimum～Expansion

 

Width範囲外をエラーとして検出します。

Pad Entry：
エディタコントロール> Pad Entryで指定された、パッドへの引込み/引出し方向以外のものを使用して結線された配

 

線をエラーとして検出します。

Node Entry：
RF設計用のハザードとなります。

Layer Restrictions：
ネットクラスでの配線層指定に違反した配線が存在する場合、エディタコントロール> Routesで指定した
Max length on restricted layers

 

(External(外層)/Internal(内層)）を超える配線をエラーとして検出します。

Vias Per Net：
ネットプロパティでのビア数指定に違反した配線をエラーとして検出します。
エディタコントロール> RoutesにてAllow one additional via per SMD pinがONの場合、SMDピン数によりビア数は
増加します。

Via Usage：
ネットクラスで各クラス毎に指定したネットクラスビア以外のビア使用をエラーとして検出します。

Teardrops/Breakouts：
Teardrops/Breakoutsのパラメータに当てはまるパッド・ビアに対して、スペーシングやスタブ長の影響により
生成できないパッド・ビアをエラーとして検出します。

Missing Arcs：
Route＞

 

Modify Cornersコマンドで円弧処理できなかったトレースコーナーをエラーとして検出します。

Grids：
エディタコントロールで設定した、各グリッドに違反する配線、ビア、部品、テストポイント、

 

ジャンパー
をエラーとして検出します。

 

（尚、配線の場合には、ネット毎にピン、ビア、配線経路がリストされます。）

Placement Rotation：
エディタコントロールでセル毎に指定した、配置面/配置角の指定に違反した

 

部品（セル）をエラーとして検出します。

Trace T-Junctions：
T分岐のトレースをエラーとして検出します。このチェックを行うには、Configフォルダ内の定義ファイル

 

(TraceTJunction.txt)にエラーとして検出したいNet名

 

又は

 

Netclass名(Constraint名)の設定が必要となります。

Stub Length：
ネットプロパティでのスタブ長指定に違反する配線をエラーとして検出します。
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Topology （CES使用時のみ有効）：
トポロジーに違反する配線をエラーとして検出します。
Topology Balancingは、許容値としてDefault tolerances 又は

 

ネットに指定したDelay値を超える配線が対象。
Topology Mismatchは、Virtualピンを含むトポロジー（Order）に違反がある配線が対象。

Lengths：
ネットプロパティでの長さ指定に関する違反をした配線をエラーとして検出します。
Min/MaxはLength値での最長に違反する配線が対象となり、未結線のNetlineが存在する場合はマンハッタン長
が使用されます。MatchedはLength値での等長指定の許容誤差（Tolerance）を超える配線が対象となります。

Delays：
ネットプロパティでの遅延（Delay）指定に関する違反をした配線をエラーとして検出します。
Min/MaxはDelay値での最長に違反する配線が対象となります。
MatchedはDelay値での等長指定の許容誤差（Tolerance）を超える配線が対象となります。

Delay Formulas：
ネットプロパティのディレイフォーミュラで設定された、カスタムオーダーネットのピン-ピン配線長（Delay)に違反する
配線をエラーとして検出します。

Parallelism：
ネットプロパティにおけるクロストーク設定の許容値を越える影響を受けた配線をエラーとして検出します。
Parallel Rules Factorでの設定に対してのみ有効となります。

Estimated Crosstalk：
ネットプロパティにおけるクロストーク設定の許容値を越える影響を受けた配線をエラーとして検出します。
Max Crosstalk [V]に関する設定に対してのみ有効となります。

Differential Pairs：
ネットプロパティでのディファレンシャルペアに関する違反をした配線をエラーとして検出します。
Convergenceは、エディタコントロール> Routes> Max distance to convergence(又はCES）で設定した最大長を超える
配線が対象となります。

Convergence Toleranceは、エディタコントロール> Routes> Convergence distance tolerance(又はCES）で設定した
許容誤差を超える配線が対象となります。（パッドエッジからの距離が対象となります。）

Separationは、エディタコントロール> Routes> Max separation distance（又は

 

CES）で設定した配線長が、
ネットクラスのDiff Pairクリアランスより離れた箇所の配線長を超える配線が対象となります。

Delay Toleranceは、ネットプロパティで設定したDelay値でのディファレンシャルペア許容誤差（Diff Pair Tol）
を超える配線が対象となります。

Length Toleranceは、ネットプロパティで設定したLength値でのディファレンシャルペア許容誤差（Diff Pair Tol）
を超える配線が対象となります。
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◆Batchチェック項目 ※ここに記される項目については、Batch DRCコマンド実行後に確認が可能となります。

Proximity：
オブジェクト間のクリアランスに関する違反を検出します。

Hangers：
浮き配線（ピン間が未結線の配線）

 

及び

 

アンテナ

 

を検出します。ネット名の無い配線（Net0)は対象外となります。

Trace Loops：
単一の層

 

及び

 

複数層にまたがるループ配線を検出します。

Trace Widths：
ネットクラスで指定されたMinimum～Expansion値の範囲に収まらない配線幅を使用した配線を検出します。

Plane Violations：
浮島などのプレーン（Generated Plane Data 及び

 

Actual Plane）に関する違反を検出します。
プレーンシェープは対象となりません。

Single Point Nets：
1ピンしか存在しないネットを検出します。（ネット名の無い配線（Net0)は対象外）

Unrouted/Partial Nets：
完全に接続されていないネットを検出します。Partial Netとは２つ以上のピンが存在し

 

且つ トレースやプレーン
で完全に接続されていないネットとなります。尚、このエラーは各ネットに対して２つ以上のエラーが検出されます。

Dangling Vias/Jumpers：
配線が不完全な浮きビア及び浮きジャンパーセルを検出します。

Unplated

 

Connected Pins：
非メッキ接続ピン（None Plated）に配線が接続されているピンを検出します。

Vias Under Parts：
部品外形の下に存在するビアを検出します。このチェックにより、部品外形外のビアを検査パッドとして使用可能
とすることができます。

Test Point Centers：
ネットクラスのTestPoint

 

Center to TestPoint

 

Centerの違反を検出します。

Vias Under SMD Pads：
エディタコントロール> Pad Entryで指定した以外のSMDパッドの真下に配置されたビアを検出します。

Minimum Annular Ring：
Annular Ring距離より、パッドエッジ-ホール間の距離が小さい箇所を検出します。
このチェックにより、規定のホールに対して不適切なパッドサイズが指定されることを防ぐことが可能となります。

Missing Pads：
Conductiveは指定した配線層にパッドが存在しないピンを検出します。
Solder Maskはソルダーマスクが存在しないピンを部品・ビア毎に検出します。
Solder Pasteはソルダーペーストが存在しないピンを検出します。

Unplaced Parts：
Part Numberを持つ部品で

 

且つ

 

未配置の部品を検出します。

ネットクラスでルール定義したクリアランス値。

エラーの実距離。
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◆Summaryチェック項目

Length：
各ネットの配線長情報をリストします。未配線個所に対しては、残り分のマンハッタン長が加算されて総配線長として
出力されます。
Meanderでは、ネットのマンハッタン長に対する増加分の長さが出力されます。マンハッタン長よりも総配線長が短い場合

 

、一律で０の値が出力されます。
%Meanderでは、マンハッタン長に対する増加分の長さがパーセント値で出力されます。マンハッタン長よりも短い場合、
Meanderと同様に０の値が出力されます。部品の未配置により基板上でネットのマンハッタン長が正確に算出できない
状況では、

 

そのネットに対する%Meanderには999.00という値が出力されますので注意してください。

Delay：
Expedition PCBが簡易的に算出した、伝送遅延が各ネット毎に確認できます。
この値は、Summary Lengthにおける長さを元に算出されますので、配線パターンが無い状況でもマンハッタン長をもと
に算出されます。

Electrical Net Length/Delay （CES使用時のみ有効） ：

CESで定義したエレクトリカルネットを考慮した配線長（又は遅延）情報をリストします。

◆Optionsコマンド

Duplicate Dialog：
レビューハザードメニューを画面上に1つ追加表示します。

Report Selected Hazards：
表示された違反リストから、マウスで選択した情報のみをレポートファイルとして出力します。
（ファイル名は、各項目別に存在します。）

Report All PCB Hazards：
Expedition PCB上で検出された全ての違反内容を、レポートファイルとして出力します。
（ファイル名は、AllPCBHazards.txtとなります。）

Report All Simulation Hazards：
Signal Analyzerで解析された解析結果から、違反となる内容を全てレポートファイルとして出力します。
※作成されるレポートファイルは全て、LogFilesサブフォルダ内に追加されます。
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◆Verifyチェック項目 ※尚、ここに記される項目については、オプションソフトであるSignal Analyzerが必要となります。

Unable To Simulate：
何らかの原因でシミュレーションが行なえないネット。

Invalid Logic State：
シュミレーション結果としてインバリッドが検出されたネット。

Incomplete Simulation：
シュミレーションが不完全に終わったネット。

Needing Simulation：
シュミレーションが実行されていないネット。

Overshoot：
シュミレーション結果としてオーバーシュートが検出されたネット。

Undershoot：
シュミレーション結果としてアンダーシュートが検出されたネット。

Non-Monotonic Edge：
シュミレーション結果としてノンモノシリックエッジが検出されたネット。

Delay Summary：
Signal Analyzerが解析したネットの伝送遅延値と、Expedition PCBが概算で算出した値との差分。

Estimated/Simulated Delays：
Expedition PCBが概算として算出した伝送遅延と、Signal Analyzerが解析した伝送遅延の値。

Crosstalk Summary：
シュミレーション結果として算出された、ネットが受けるクロストーク値。
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◆バッチDRC／Batch DRC

Expedition PCBでは、レビューハザードで行なわれるオンラインチェック機能以外にも、バッチプロセスとして実行するDRC機

 

能が存在します。このバッチDRCには専用のメニューが用意されており、実行されるチェックの内容をユーザーが指定すること

 

ができます。プルダウンのAnalysis>>Batch DRCを実行することで、バッチDRCメニューを起動することができます。

このメニューには2つのタブが存在し、各タブメニュー内で選択された内容にもとづいてチェックが行なわれます。また、DRC 
Settingsタブ内にはAdvanced Element to Element Rulesボタンが存在し、このボタンを選択して表示される設定メニュー内で、

 

様々な図形要素間のクリアランス条件を定義することもできます。バッチDRCでは、必ず選ばなければならないというチェック

 

項目が存在するわけではなく、その都度必要と思われる項目についてのみ選択実行します。

DRC Settingsタブでは、主にDRC実行に際しての基本的な項目についての設定を行ないます。メニューの最上段にある2つ

 

のトグルボタンは、DRCの実行範囲を基板外形の内側とするか、予め作成してあるDRCウィンドウの領域に限定するかを決定

 

します。

通常の場合はこちらを選択し、基板外形の内側を
DRCの対象とします。

基板上に作成したDRCウィンドウ内をDRCの対象とする場合に選択します。
このスイッチは、DRCウィンドウが存在しないと無効化されます。
※尚、DRCウィンドウはConnectivity and special rulesに適応されません。
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Rules to check
Check selected nets only：

ネットを選択した状態でBatch-DRCを実行した場合のみ、このオプションは有効となります。
DRCはNets Selectedに表示されたネット数のみ実行されることとなります。全ネットに対してDRCを実行する
場合は、ワークエリア上でネット選択を解除を行ってください。
Nets Selectedで指定されたネット名は実行後のDRC.ｔｘｔで確認可能です。

Connectivity and special rules：
Connectivity and Special Rulesタブで設定された項目についてのチェックを行なうか否かを指定。

Proximity options
Net Class clearances and rules：

ネットクラスメニューで設定されたクリアランス条件についてのチェックを行なうか否かを指定。

Plane clearances and rules：
ネットクラスメニューで設定されたPlane-Planeクリアランス

 

及び

 

Plane Classes Parametersで設定された
デフォルトクリアランス（Mounting Hole/ContourとOther object）のチェックを行うか否かを指定。

General and element to element rules：
Advanced Element to Element Rulesメニューで設定された各要素間のクリアランスについてのチェックを
行なうか否かを指定。

Pad to pad checks
Disable within same cell：

同一セル内について、パッドクリアランスのチェックを行なうか否かを指定。
※チェックすることで同一セル内でのチェックが行なわれなくなります。

Enable for same net：
同一ネット（同電位）間で、パッド

 

及び

 

ビアのクリアランスチェックを行なうか否かを指定。
※チェックすることで同一ネット間のチェックを行ないます。
※対象となるパッドは、部品パッド（Part Pad）同士、ビアパッド（Via Pad）同士、Part PadとVia Padとなります。

バッチDRCメニュー内の各チェックボックスは、その項目へのチェックを行なうか否かを選択するためのものとなります。チェッ

 

クボックス以外にも、配線層を指定するための項目が存在し、選択したものに対してチェックが行なわれるということに変わりあ

 

りません。

チェック対象とする配線層の指定。

この項目はネットクラスで設定されたGeneral clearance rulesへのチェックを行なう場合に必須となり、この項

 

目を選ばなかった場合、General clearance rulesで設定されたクリアランスについてのチェックが一切行な

 

われませんので注意して下さい。Note
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Traces
Hangers：

浮き配線 及び アンテナ を検出します。（ネット名の無い配線（Net0)は対象外）
Loops：

単一の層 及び 複数層にまたがるループ配線を検出します。
Trace Widths：

ネットクラスで指定されたMinimum～Expansion値の範囲に収まらない配線幅を使用した配線を検出します。

Nets
Single Point Nets：

1ピンしか存在しないネットを検出します。（ネット名の無い配線（Net0)は対象外）
Unrouted/Partial Nets：

完全に接続されていないネット(プレーンネット以外）を検出します。
Partial Netとは２つ以上のピンが存在し

 

且つ トレースやプレーンで完全に接続されていないネットとなります。
尚、このエラーは各ネットに対して２つ以上のエラーが検出されます。

Planes
Plane islands：

浮島などのプレーン（Generated Plane Data 及び Actual Plane）に関する違反を検出します。
プレーンシェープは対象となりません。

Unrouted/Partial plane Nets：
完全に接続されていないプレーンネットを検出します。Partial Netとは２つ以上のピンが存在し 且つ トレースや
プレーンで完全に接続されていないネットとなります。尚、このエラーは各ネットに対して２つ以上のエラーが検出

 

されます。

◆コネクティビティおよび特殊ルール／Connectivity and Special Rules

Connectivity and Special Rulesタブでは、クリアランス事項以外に関するチェック項目が収納されています。必要と思われる項

 

目に対してチェックを入れることで、指定した項目に関するチェックが行なわれます。
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Holes/Pads/Vias
Dangling vias/jumpers:

配線が不完全な浮きビア及び浮きジャンパーセルを検出します。
Unrouted

 

pins:

トレースやプレーン接続のないビア・ピンを検出します。
Connected unplated

 

pins:
非メッキ接続ピン（None Plated）に配線が接続されているピンを検出します。

Minimum annular ring:
穴径の縁からパッドの縁までの最小値を指定します。

Vias

 

under
SMD pads、Top Place outlines、Bottom place outlines:

表面実装部品のパッド、部品面に配置された部品の部品外形、はんだ面に配置された部品の部品
外形の下に存在するビアを検出します。

Minimum annular ringとは：

最小限確保しなければいけない
銅箔領域に対するチェック。

Missing pads

ミッシングパッド項目では、各レイヤに対するパッドの有無をチェックすることができます。パッドの有無をチェックしたいレイヤ

 

をConductive及びOther項目より選択します。

All pads on all layers:
全層に対してピンにパッドが存在するかチェックを行なう。

All pads on cover and connected internal layers:
表層及び内層においては結線情報を持ったピンにのみ
チェックを行なう。

Only pads on selected layers:
配線リストより指定した層のみにチェックを行なう。

部品へのソルダーマスク用パッド、ビアへの
ソルダーマスク用パッド、表面実装部品への
ペースト用パッドへのチェックを行なう。
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◆エレメント-エレメント拡張ルール／Advanced Element to Element Rules

Element to Elementの設定メニューには、様々な要素間のクリアランス条件が対戦表のイメージでリスト表示されます。ここに

 

デフォルト表示された内容は、ネットクラスメニューのGeneral clearances rulesの設定項目リンクしており、ネットクラスメニュー

 

で設定された値がすべてこちらにリストされます。

この表の使用法は至ってシンプルなもので、各要素が交差するカラムに対して設定するクリアランス値を入力する形になり、

 

一般的な対戦表と何らその扱いは変わりません。

例えば、ビアのパッドとリファレンス番号のクリア
ランスを設定/確認する場合、双方の要素が交差
するカラムを設定/確認します。

ネットクラスの設定と、このメニューは連動しています。

テキストのカラーにより、入力状態が確認できます。
黒色：Net Classes and Clearancesで定義したGeneral Clearanceルール

赤色：上記ルールを上書きしたルール
青色：新たに追加したルール
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設定したい図形要素が表の中に存在しない場合には、メニュー上段にある項目で必要な図形要素を表内に追加することが

 

できます。この項目には、Expedition PCBが標準値として持つ図形要素以外にも、独自に作成したユーザー定義レイヤなども

 

リストされます。標準値として持つ各図形要素には、個々の要素に対するレイヤ属性を指定するようになっております。

ユーザー定義レイヤ標準要素

レイヤ属性

対戦表内に追加したい要素をリストから選択し、[Add Elements to Matrix]ボタンを選択することでその項目を表内に追加する

 

ことができます。
このボタンで追加。

・追加された図形要素については、他の全ての要素とのクリアランスが必ずしも設定できるとは限りません。この対

 

戦表内でクリアランスが設定可能なのは、白抜きされたカラムに対してのみとなり、グレーアウトされたカラムが指す

 

要素間のクリアランスの設定は行なえませんので注意して下さい。
・このメニュー内の設定を保存する場合には、必ず[OK]ボタンでメニューを抜けます。[Cancel]ボタンでメニューを

 

抜けた場合、設定した内容は一切保存されませんので注意して下さい。
・パッドスタック内のエレメントでパッド同士が同電位の場合、以下エレメントのみチェック対象となります。
チェック対象エレメント：

 

Solder Mask同士、Part Hole同士、Via Hole同士、Part HoleとVia Hole
※これ以外のエレメントはユーザー定義レイヤ含めチェック対象となりません。

一番後ろに追加されます。

Note

追加したUser Layersは項目を選択後の〔Delete〕キーで削除することができます。また項目選択後のドラッグ操作にて表内の

 

移動が可能となります。

選択後 Deleteキーで削除されます。
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◆セルオーバーハングを許可／Allow cell overhang

コネクタ部品など、基板外形（Board Outline）と部品外形（Placement Outline）の重なりを許可するオプションが追加されました

 

。Cell Editor＞

 

Package Cell Propertiesダイアログ上で

 

Allow cell overhangオプションをONとすることで、基板外形との重なり

 

を許可します。

コネクタ部品の部品外形と基板外形が重なっている。
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この設定により、部品配置・移動時のオンラインDRC 及び

 

バッチDRCにおいて、以下のようなPlacement Outline to Board 
Outlineに関するエラーは発生しません。

Review Hazards> Online> 
Components

Review Hazards> Batch> 
Proximity

Allow cell overhangオプションをチェックすることにより、部品プロパティに“Cell Overhang: Allowed”が設定されます。
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◆DRC違反のダイナミック表示／Dynamic DRC Visualization

インタラクティブDRCがOFFの編集作業でクリアランス違反が作成された場合、DRC違反となる箇所のフィルパターンをダイナ

 

ミックに変更して、エラー箇所を表示します。この機能により、DRC OFF状態で違反状況を確認しながら、配線編集作業を行

 

うことが可能となります。また右マウスボタン（RMB）のRepair Selectedコマンドより、選択した違反箇所を自動で解消します。

DRC違反箇所のフィルパターンがダイナミックに変化します。

エラーオブジェクト選択後のRepair Selectedコマンドにより、エラーとフィルパターンが解消されます。

・フィルパターンを表示するには、Display Control＞

 

General＞

 

Display PatternsがONであること。
・DRC違反箇所のフィルパターンは、以下オブジェクトで表示されます。
トレース

 

と

 

トレース、トレースとビア、トレースとパッド、トレースと禁止領域、ビアと禁止領域
※パッドとパッド、プレーンに対する違反は対象外となります。

・DRC違反箇所のフィルパターンは、エラーオブジェクトの片方のみに表示されます。
・DRC違反箇所のフィルパターンは、固定となります。

Note
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DRC違反箇所のフィルパターン表示は、通常インタラクティブDRCがOFFの編集作業で作成されます。しかしながら、以下２

 

つのケースでは、DRC違反のフィルパターン表示は行われません。
①

 

配線作業後にクリアランス等の制約条件を変更。
②

 

ドローモードでコンダクティブシェープを作画。

このような場合は、ツールバーにあるDRC Visualizationアイコン

 

又は

 

キーインコマンド（fpv）を実行ください。

DRC Visualizationアイコンにより、DRC違反箇所のフィルパターンが変更されます。
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◆

 

パッケージタイプクリアランス／Package Type Clearances 

パッケージタイプクリアランスは、

 

Cell Editor＞

 

Package Cell Propertiesダイアログ上で

 

定義したPackage Group 又は

 

特定セ

 

ルにのみ有効なClearance Typeを使用して、様々な部品間のスペーシングチェックを可能とします。

Clearance Typeへ任意の値を設定した場合は、該当部品に独自のクリアランスを設定することが可能です。このClearance 
Typeは、セントラルライブラリ

 

又は

 

ローカルライブラリにて定義することが可能です。

パッケージタイプクリアランスの設定は、CESからEdit＞

 

Clearances＞

 

Assign Package Type Clearances にて行います。

定義したPackage Groupを使用
して部品間チェックが可能。

任意のClearance Typeの入力
又は

 

既に定義された
Package Type Clearanceから

 

の選択が可能。

Note

パッケージタイプクリアランスはCES 使用時のみ有効となります。
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・

 

パッケージタイプクリアランスの設定

Package clearance type override rules:
同一グループ間のパッケージクリアランスを指定
します。
例）
‐

 

Package Group：IC-SOIC vs

 

IC-SOIC
‐ Clearance Type：SO14 vs SO14

Clearance type to Clearance type clearance 
override rules:
上記で定義したパッケージクリアランスタイプの

 

オーバーライドルールを指定します。
例）
‐

 

Package Group：IC-SOIC vs

 

IC-SOIC 
のDirectionルール
‐

 

Clearance Type：IC-SOIC vs

 

SO14
の異なるグループ間ルール

・

 

Package clearance type override rulesには、以下3項目を設定します。

①

 

Package Clearance Typeをリストから選択

 

又は

 

新規にClearance Typeを入力します。
②

 

SideをBoth/Top/Bottomより選択。
③

 

Clearance値を入力。設定した値は、General Clearance＞

 

Placement Outline to Placement Outlineのオーバーライドルール
として扱われます。

・

 

Clearance type to Clearance type clearance override rulesには、以下４項目を設定します。

①

 

Package Clearance Typeをリストから選択。
②

 

SideをBoth/Top/Bottomより選択。
③

 

DirectionをAll/ Side to Side/ End to End/ Side to End

 

より選択。

④

 

Clearance値を入力。設定した値は、

 

Package clearance type override rulesのオーバーライドルールとして扱われます。
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クリアランスルール設定

クリアランスチェック結果①

Package clearance type override ruleのクリアランス設定により、該当部品のみGeneral

 

Clearance Rulesの値（10th)ではなく、

 

設定したPackage clearance type override ruleのクリアランスルールを使用。

IC-SOIC部品 IC-SOIC部品

S014部品 S014部品

IC-SOIC間はクリアランス30th

SO14間はクリアランス20th
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クリアランスルール設定

クリアランスチェック結果②

Clearance type to Clearance type clearance override rulesのクリアランス設定により、該当部品のみGeneral

 

Clearance Rules

 

の値（10th)やPackage clearance type override rulesのクリアランスルール（30th, 20th)ではなく、設定したClearance type to 
Clearance type clearance override rulesのクリアランスルールを使用。

IC-SOIC部品

IC-SOIC間のEnd to End方向はクリアランス15th

IC-SOICとSO14間はクリアランス18th

IC-SOIC部品

S014部品
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◆

 

Z軸クリアランス／Z-Axis Clearances

同層に存在するオブジェクトのみでなく、異層に存在するオブジェクトとのクリアランスチェックも可能になりました。オンライン

 

DRC、バッチDRC、自動配線などあらゆる操作でZ軸クリアランスは考慮されます。

CESにZ-Axis

 

Clearancesタブが追加されました。このタブの中でZ-Axis Clearancesの設定を行います。同層に存在するオブジ

 

ェクトとのクリアランス設定は、これまでと同様にClearances

 

タブで行います。

Z-Axis Clearanceルールの設定は、通常のClearanceルール設定と同様に、テンプレートのクリアランス値の組み合わせ

 

ルールを作成し、別途

 

Class to Class Clearances（Z-Axis用）にて、対戦表形式（ネットクラス

 

vs

 

ネットクラス）でルールを割り

 

当てます。組み合わせとして設定できるルールは、各層に対して、

 

Trace vs

 

他の層のオブジェクト（5種類）です。

Trace To …
Trace

 

：

 

異なる信号層にあるトレースとの最小クリアランス値。
Pad

 

：

 

異なる信号層にあるパッドとの最小クリアランス値。
Via

 

：

 

異なる信号層にあるビアとの最小クリアランス値。
Plane

 

：

 

異なる信号層にあるプレーンとの最小クリアランス値。
SMD Pad

 

：

 

異なる信号層にあるSMDパッドとの最小クリアランス値。

Note

Z軸クリアランスはCES使用時のみ有効となります。



－ 352 －

②

 

設定すべきクリアランス値を計算します。
今回、「4 層にある

 

Power ネットのトレースに対して、2層/3層のトレースを交差させたくない」

 

とします。
この場合、4層、2層間に挟まれた3つのレイヤー（下図の赤色部分）の厚さを足します。

0.5

 

(mm)

 

+ 0.02

 

(mm)

 

+ 0.5

 

(mm)

 

= 1.02

 

(mm)

このThickness（層の厚さ）に、Z-Axis Clearanceとして設定したい値（今回は0.01）を追加します。

1.02

 

(mm)

 

+ 0.01

 

(mm)

 

= 1.03

 

(mm)

【Z-Axis Clearancesの設定手順】

①

 

CES から

 

アイコンをクリックしてスタックアップエディタを起動し、Thickness （層の厚さ）を正しく設定します。
Expedition PCBのSetup＞

 

Setup Parameters＞

 

Layer Stackup

 

タブからも設定できます。
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③

 

CESのZ-Axis Clearancesタブを開き、新規作成ボタンをクリックします。
下図の設定の場合、

 

Rule Trace 4

 

は「4層トレース

 

に対して他の層のトレースは

 

1.03 mm以上近づけない」

 

という
ルールになります。

ルール名は右クリックポップアップメニューから
Rename を選択して変更する。

④

 

続いて、Z-Axis Class to Class Clearances にて、ネットクラスに対するルールを割り当てます。
下図の設定の場合、

 

４層トレースが

 

Power ネットクラスの場合のみルールが適用されます。

ルールの割り当て方法は２つあります。

①

 

カラムを選択して表示されるプルダウンから選択
②

 

…

 

ボタンをクリックして表示されるウィンドウから選択

プルダウンから選んだ場合、

 

Max layer depth は0となります。

Max layer depth

 

：
何層先までルールを適用するかの設定です。
1の場合は隣接する層まで。
0の場合は制限なし（デフォルト）。
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以上のように設定することで、以下のようなルールになります。
※4層に存在する他のトレースとのクリアランスについては、これまで通りClearanceタブの設定が参照されます。

下図は、4

 

層のPower

 

ネットトレースを下から上方向に引き出した後、各層からトレースを左方向に引き出しています。3

 

層ト

 

レースには

 

0.9 mm、2

 

層トレースには

 

0.02mm

 

のクリアランスが必要となるため、オンラインDRCによってPowerネットトレースが

 

左側に押しのけられています。1

 

層トレースは今回のルール範囲外ですので影響しません。

4層のPowerネット

2層トレースとは0.02のクリアランス

3層トレースとは0.09のクリアランス
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ルール名をあとから変更した場合、

 

Z-Axis Class to Class Clearances には自動的には反映されません。Z-Axis Class 
to Class Clearances 側でも変更する必要があります（変更しない場合、設定は無効になります）。

連動しないため、再度設定

 

が必要となります。

Note
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その他の検証コマンド

Chapter3: Design Process-Reviewing Design
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◆ローカルセントラルライブラリ間検証／Verify Local to Central Library

ローカル・セントラルライブラリ検証コマンドは、マスターとなるセントラルライブラリとデザインファイルのローカルライブラリの内

 

容を比較し、その結果をレポートファイルとして出力します。比較は存在の有無と日付で行われ、Only in local library（ローカ

 

ルのみに存在）・ Newer than Central Library（セントラルライブラリよりも新しい）・Older than Central Library（セントラルライブラ

 

リより古い）の３つの区分に分類されます。



－ 358 －

出力されたファイルには、“セントラルライブラリと比較してどのような状態なのか”という形式で結果が記され、パッドスタックや

 

セル、パートナンバー等のカテゴリ別にリストされます。このファイルはVerifylocal2CentralLibrary.txt という名前で固定されて

 

おり、サブフォルダのLogFiles内に収納されます。

例：VerifyLocal2CentralLibrary.txt ファイル

-----------------------------------------------------------------------------
Padstack Name

-----------------------------------------------------------------------------

Newer  than Central Library
---------------------------------
VIA020

-----------------------------------------------------------------------------
Cell Name

-----------------------------------------------------------------------------

Older  than Central Library
---------------------------------
DIP14H
SOP14H

Only in local library
---------------------------------
Jumper1

-----------------------------------------------------------------------------
Part Number

-----------------------------------------------------------------------------

Only in local library
---------------------------------
Jumper1

Summary:    
Library Object       # Newer    # Older    # Only in Local Library    
Pad Names               0          0          0             
Hole Names              0          0          0             
Padstack Names        1          0          0             
Cell Names               0          2          1            
Part Numbers            0          0          1 

セントラルライブラリよりもローカルが新しい。

セントラルライブラリよりもローカルが古い。

ローカルライブラリにしか無い。

統計が最後にリストされます。
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◆パッドスタックの検証／Verify Padstack Instance Changes

インスタンスパッドスタックの検証コマンドは、

 

Padstack Processor等にて基板上のパッド形状を変更したり、ピン移動コマンドに

 

てピン位置を変更した際、ローカルライブラリと比較して、変更された部品とマウンティングホールのパッドスタックを検出します

 

。ビアとテストポイントは対象外となります。比較結果は、VerifyPadstackInstanceChanges.txtとしてLogFilesフォルダに作成さ

 

れます。
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◆ガーバー比較／Gerber Compare 〔Fablink XEのライセンスが必要となります〕

ガーバー比較コマンドは、File＞ Import＞ Gerber コマンドによりインポートされたユーザーレイヤの差分を検証します。実行

 

結果は、GerberCompare.txt 又は GerberCompareErrorLog.txt としてLogFilesフォルダに作成されます。

ガーバーインポート後の異なるユーザーレイヤを指定。 比較結果を出力するユーザーレイヤを指定。

設定内容をスキームとして保存します。

比較結果のResult LayerにFillを設定します。

Layer1で指定した

ユーザーレイヤ

Layer2で指定した

ユーザーレイヤ

Layer1とLayer2の差分のみを

 

Result Layerに出力します。
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Chapter 3
Design Process-Postprocess

概要
Postprocess（出力プロセス）では、配置配線工程の終了後の製造データ作成 及び ドキュメント作成の手法を説明します。

・

 

その他の編集とECOコマンド

 

－362P
・

 

寸法線の作成

 

－375P
・

 

リファレンス番号の編集

 

－381P
・

 

シルクデータの編集

 

－388P
・

 

穴図とドリルデータの作成

 

－393P
・

 

ガーバーデータの作成

 

－403P
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その他編集コマンドとECOコマンド

Chapter3: Design Process-Postprocess
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◆スペアパートナンバーの編集／Edit Spare Part Number

このコマンドは、スペア部品として配置された既存セルに対する部品番号の編集を行なう際に用います。プルダウンのEdit＞

 

Modify＞

 

Edit Spare Part Numberコマンドを実行すると、編集用のメニューが表示されます。リストされた部品の中から対象と

 

なる部品を選択し、その部品へ付加したい部品名を選んでから[Apply]もしくは[OK]ボタンを選択します。尚、このコマンドは、

 

基板上に最低1つのスペアセルがなければ使用することができません。

配置されたスペアセルが全てリストされます。

選択されたセルで使用可能な部品名をPartNumberへリストします。

選択されたセルで使用可能な部品名を、
未配置の部品から候補としてPartへリストします。

ドロップダウンリストより、指定したセルに付加する
部品名を選択します。

・List valid part numbers based on selected cell name

選択したSpare Cell Nameと同じCELL名を持つPart Numberを全てリスト表示し、Spare CellのPart Numberを指定したPart 
Numberへ変更します。

・List valid unplaced parts based on selected cell name

選択したSpare Cell Nameと同じCELL名を持つ未配置部品が存在した場合、Part項目に“REF番号－Part Number”をリスト表

 

示し、Spare CELLに指定したREF番号（Part Number）を付与します。使用方法としては、仮配置したスペア部品に対して、フォ

 

ワードアノテーション後の回路図指定のREF番号を付与することを可能とします。
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◆パッドスタックプロセッサ／Padstack Processor

このパッドスタックプロセッサコマンドでは、デザイン上に配置されたパッドスタックへの編集作業が行なえます。プルダウンメ

 

ニューのEdit＞

 

Modify＞

 

Padstack Processorコマンドを実行すると、作業を行なうための専用メニューが表示され、デザイン

 

上のパッドスタックに関する編集作業を行います。このメニューには2つのタブが存在し、Padsタブではパッド単位での編集が

 

、Padstacksタブではパッドスタック単位での編集作業が行なえます。

パッドスタックプロセッサで実施できるアクション
・指定したパッドのみの形状変更
・結線済みパッドのみの形状変更
・接続の無い内層パッドのみの削除
・Via、Mounting Hole、Fiducial で使用したパッドスタックの変更
・変更したパッドスタックのリセット（変更内容の解除）

Padsタブ：

このタブでは、パッドに関する変更/削除といった操作がパッド単位で行なえます。Action項目でその作業内容を選択し、対

 

象となる層やパッドをメニュー内で指定します。メニュー最下段にあるApply to項目では、編集対象のパッドをデザインファイ

 

ル上の全てとするか、デザイン上で選択指定したパッドにのみ限定するかを選択することができ、メニュー設定が終了した後

 

に[Process Pads]ボタンを選択して編集を実行します。

Changeを選択。

作業層を選択。

リストから変更したいパッド

 

を選択します。

対象とするパッドを全てとするか、選択したもののみと
するかを選択。

結線済みパッドに対してのみ作業する場合にチェックを入れます。

Action: Changeにてパッド形状を変更する場合
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パッドを削除する場合には、変更と

 

違って対象となる層とパッドを指定し

 

ます。マウスで選択して、作業対象を

 

全てハイライトさせてください。

Action: Deleteにて不要パッドを削除する場合

Delete を選択。

作業層を選択。

Skip Vias Onlyオプションを使用することで、Setup Parameters＞ Via Definitionsで設定したスキッ

 

プビアに対してのみ処理を行います。
※スキップビアとは、最外層のみに接続が許可され内層パッドへの接続が禁止されたビアであり、

接続禁止の内層が削除対象となります。

DRCエラーの対象となっているパッドの削除はできません。DRCエラーを解消した後、処理を行う必要があり

 

ます。
Note
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リストから変更したいパッドスタックを選択します。
※同一タイプのパッドスタックのみ変更可能。

Padstacksタブ：

このタブでは、パッドスタックに関する変更/リセットといった操作がパッドスタック単位で行なえます。Action項目でその作業内

 

容を選択し、対象となる層やパッドスタックをメニュー内で指定します。メニュー最下段にあるApply to項目では、Padsタブと同

 

様に編集対象のパッドスタックをデザインファイル上の全てとするか、デザイン上で選択指定したパッドスタックにのみ限定する

 

かを選択することができ、メニュー設定が終了した後に[Process Pads]ボタンを選択して編集を実行します。

Action: Changeにて変更パッドスタックをリセットする場合

Action: Changeにてパッドスタックを変更する場合

対象となるパッドスタックにチェックマークを付けた上で、メニュー

 

下の[Process Padstacks]のボタンを選択して下さい。

※パッドスタックのResetとは、変更したパッドスタック情報をリセッ

 

トすることを指し、この際に使用されるパッドスタックは、ローカル

 

ライブラリのものとなります。
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◆複数ビア選択でのビアプロパティ変更

複数のビアを選択して、ビアのプロパティ変更が可能となりました。複数のビアを選択した場合、パッドスタックプロパティには

 

共通のパッドスタック名

 

又は

 

ビアスパン名のみが表示されます。この状態で、変更したいパッドスタック名

 

又は

 

ビアスパン名

 

を指定することで、ビアプロパティの変更が行われます。

・

 

操作方法
①ビア選択＞RMB（右マウスボタン）＞Propertiesを選択して、Padstack Propertiesダイアログを表示。
②変更したいビアを複数選択。その際、Padstack Propertiesには共通項目名のみ表示されます。
③変更した項目（Padstack 又は

 

Span）から値を選択して、Applyボタン。

Padstack名が同じ 且つ
Spanが異なる複数ビアを選択した場合

複数ビア選択時、共

 

通項目（Padstack）

 

のみ表示されます。

Span変更により、選

 

択ビア全てのSpan 
が変更されます。
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・制限事項

①トレースと接続できないスパンを持つビアに変更された場合、そのトレースは削除されます。

②ネットクラスビア以外のビアへの変更も可能です。その際は、Review HazardのVia Usageでエラーを確認ください。

Spanが同じ 且つ
Padstackが異なる複数ビアを選択した場合

複数ビア選択時、共

 

通項目（Span）のみ

 

表示されます。

Padstack変更により、

 

選択ビア全ての

 

Padstack名が変更さ

 

れます。

Span変更により接続

 

不可なトレースは削

 

除されます。

ネットクラスビアの定義

ネットクラスビア以外のビアへ変

 

更された場合、Review Hazardの

 

Via Usageにリストされます。
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◆セルグラフィックス編集を許可／Allow Cell Graphics Edits

Allow Cell Graphics Edits コマンドはトグルボタンとなっております。チェック時にコマンドが有効となり、Drawモードにてセル

 

が持つグラフィックスエレメント（例、Placement Outlineや各種Text 等）が編集可能となります。プルダウンメニューのEdit> 
Modify> Allow Cell Graphics Edits コマンドにてON/OFFの切り替えを行います。

編集したグラフィックスエレメントは、該当セルに変更が加わった時点で編集内容はクリアされます。（Text以外の

 

エレメントが対象となります。）例えば、Cell‐Editorで該当セルを編集後

 

Saveすることで、基板上のリファレンスされ

 

た部品の編集内容は一旦クリアされ、Saveした状態が全てのセルへ反映されます。Note
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◆ピン移動／Move Pin

Move Pinsコマンドを使用することで、デザイン上に配置された部品のピンを移動・回転することが可能となります。このコマンド

 

を使用するには、Cell Editor＞ Package Cell Propertiesダイアログ上で MovableオプションをONとしてください。

CELLのMovableオプションがONの場合、Edit＞ Modify＞ Move pinコマンド

 

又は キーインコマンド（mp) を使用することで、

 

部品のピンを移動・回転することができます。

① 部品ピンをRouteモードにて選択。

② Edit> Modify > Move Pin コマンド

 

又は キーインコマンド（mp）を実行。
※キーインコマンドを使用すると、特定のピンを指定座標に移動可能です。

 

mp dx=50,50 u17-5

③ ピンがマウスに追従して移動モードとなります。左マウスボタン（LMB)にて確定。

移動したピン
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このコマンド実行時に以下アクションキーが使用可能となります。

・アクションキー

F3：Rotate 90 ピンが90度回転します。

F4：Rotate 180 ピンが180度回転します。

F5：Push ピンがPushします。

F6：Rip-up Segment ピンに接続された第一セグメントのトレースが削除されます。
またビアを介して他のピンに接続されている場合は、ビア以降の第一セグメントが削除されます。

F7：Rip-up Junction ピン間のトレースが削除されます。
また分岐ポイントが存在する場合は、ピンから分岐ポイントまでのトレースが削除されます。

ビアを介して他のピンに接続されている場合は、ビア以降のセグメントが削除されます。

F8：Rip-up ALL ピン間のトレースが削除されます。
分岐ポイントがあれば、ピンから分岐ポイントまでのトレースが削除されます。

F10：

 

Snap to Grid 部品グリッドへスナップされます。

移動した部品ピンをリセットしたい場合は、ECO＞ Replace CellのResetを使用してください。

Note
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◆セルの置換／Replace Cell

セルの置換コマンドは、基板上に配置された各セルに対する置き換えや、ローカルライブラリの最新情報へのアップデート作

 

業を行なう際に使用します。エディタプルダウンECO＞

 

Replace Cellコマンドを実行することでメニューが表示されますので、

 

Process type項目で置き換え（Replace）

 

又は

 

リセット（Reset）かを選択して作業を行ないます。

・Process type

この項目では、置き換え（Replace） 又は リセット（Reset）のいずれかより、作業内容を選択します。選択された作業に応じて、

 

Cells to processの内容が変わります。

・Options

この項目では、配置面毎に作業対象となるセルを選択することができます。作業対象とするセルの配置面を限定したい場合

 

には、Top（表面）もしくはBottom（裏面）を選択して下さい。この項目で配置面を限定することで、対象セルリストの内容が指

 

定した面の部品に限定されます。

この項目にあるチェックボックス“Keep text attributes during replace”は、作業対象となったセルの文字情報（RefDesや

 

PartNumberの文字寸法、位置、角度など）に対する扱いについての設定となり、このチェックを入れておくことで、セルが置き

 

直された後も前の状態の文字情報を維持させることができます。このチェックを外して作業を行なった場合には、全てがライブ

 

ラリの状態で置き直されます。

・Selection filter

この項目は、作業対象となるセルに対するフィルター設定となります。配置面などでは限定しきれない部品を対象としたい場

 

合などは、Selected Partsとすることでアップデート作業時でもRefDes指定などによる選択が可能となります。
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・Cells to process

選択された内容に応じて、対象となるセルがリストされます。各作業内容に応じてリスト内に設定を行ない、[OK]もしくは

 

[Apply]ボタンを選択して実行します。

作業対象にチェックを入れます。

選択した部品のセルがリストされるので、各RefDes毎に変更する
形状を設定します。

<セルの置換（Replace）の場合>

<リセット（Reset）の場合>

作業対象にチェックを入れます。

形状変更作業を行なうには、PDB内の設定に注意が必要となります。ここにリストされる部品は、Alternate CellがPDBで設定さ

 

れている部品に限られ、交換対象にリストされる形状はすべてAlternate Cellに登録されたセルのみとなります。

デザイン内で変更された情報を全てリセットして、ローカル部品の状態へ変更します。
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◆セルとパッドスタックの更新／Update Cells & Padstacks

ECO＞

 

Update Cells & Padstacksコマンドは、ローカルライブラリのセルとパッドスタックの内容をセントラルライブラリのものと

 

比べ、セントラルライブラリよりも古いものだけをアップデート（セントラルの内容で上書き）させるためのコマンドとなります。この

 

コマンドを実行すると、ライブラリが上書きされる可能性を示唆するメニューが表示され、このメッセージに対して“はい”をかえ

 

した場合のみローカルライブラリへのアップデートが行なわれます。

ここでアップデートされるのは、セントラルライブラリよりも日付が古い物だけとなります。また、セントラルよりも

 

古い場合であっても、パッドスタックに使用されていないパッドやホールはアップデートの対象とはなりません

 

ので注意して下さい。Note
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寸法線の作成

Chapter3: Design Process-Postprocess
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◆寸法パラメータ／Dimension Parameters

Expedition PCB上で作成される寸法線は、プルダウンメニューのSetup＞

 

Dimension Parametersコマンドを実行して表示され

 

るディメンジョン・パラメータメニューで定義された内容に応じて作成されます。

・Dimension項目

Method－作画する寸法線の種類を指定します。
Associative

 

：通常の矢印を持つ寸法線

Ordinate

 

：縦座標の寸法線

寸法線にて使用するLayerを指定します。

Measurement－寸法値の定義方法を指定します。

Actual

 

：通常通り、実際の寸法値を使用します。
Implied

 

：ポイントを指定して、寸法線を発生するタイミングでウィンドウを表示し、
任意の寸法値を入力します。
※角度、半径に対しては使用不可となります。

設定内容をスキームとして保存することができます。
スキームを選択することで、設定した値を呼び出すことが可能です。
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・Additional data項目

Diameter prefix ：
直径寸法の頭文字を指定します。

Radius prefix ：
半径寸法の頭文字を指定します。

Leading dimension text：
寸法線の先頭にテキストを挿入します。

Trailing dimension text：
寸法線の末尾にテキストを挿入します。

寸法線を2段で作成します。

これにより上段と下段でフォーマットの異なる寸法

 

値の表示が可能となります。
※Lower列にて下段のフォーマットを定義します。

Format にて寸法値のフォーマットを定義します。

Dimension style －寸法線テキストを囲む枠を指定します。

Basic：

 

Reference：

Standard：

 

Bracketed：

Tolerance style －Toleranceのスタイルを指定します。

Blank ：

Equal Bilateral ：

 

※＋と－は同じ値に設定する必要があります。

Limit(Single line) ：

Limit(Stacked) ：

Unequal Bilateral ：

 

※＋と－に同じ値は設定できません。

Unilateral ： ※どちらか片方を0に設定する必要があります。

Value －誤差の値を指定します。
Units －寸法線の単位系を指定します。
Precision －小数点以下の桁数を指定します。
Leading zero －整数桁の先頭の0を省略します。
Trailing zero －少数桁の0を省略します。
Decimal symbol －小数点の区切り文字を指定します。Comma指定にてカンマに変更可能となります。
Include units －寸法値に単位系を追加します。
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Placementタブでの設定項目

Terminator Style－矢印の形状を選択します。
Style ：矢印のスタイルを指定します。
Height ：矢印の高さを指定します。
Width ：矢印の幅を指定します。

Line－ラインの形状を選択します。
Style ：ラインのスタイルを指定します。
Width ：ラインの幅を指定します。

Crosshair－＋字カーソルの形状を選択します。
Add crosshairにチェックを入れることで、＋字マークを追加します。

チェックあり

 

チェックなし
Height ：＋字カーソルの高さを指定します。
Width ：＋字カーソルの幅を指定します。

垂直な寸法線に対

 

する文字角度を指定

 

します。

寸法線に対する文

 

字位置を指定しま

 

す。

寸法線が積重なったケースに

 

おける、寸法線の間隔を指定し

 

ます。

対象物と引き出し

 

線の開始点の間隔

 

を指定します。
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◆寸法線／Dimension

 

コマンド

DrawモードでDimensionアイコンを選択した際、以下のようなToolbarが表示され、各種Dimensionコマンドを実行することが可

 

能となります。

寸法線オプション／Dimension Options：
Setup> Dimension Parametersコマンドを実行して表示されるディメンジョン・パラメータメニューを表示します。

一直線上エレメントの寸法線配置／Place Dimension along a linear dimension：
1つの線分を選択することにより、直線上のエレメントに対して寸法線を発生します。

二つのエレメント間の寸法線配置／Place dimension between two elements：
２つのエレメントを選択することにより、任意のポイントに寸法線を発生します。

重なり寸法線の配置／Place stacked dimension：
任意のポイントで計測した距離をスタック形式の寸法線を使用して、連続して発生します。

縦座標寸法線の配置／Place an ordinate dimension：
任意のポイントにオリジンポイントから計測した距離の寸法線を連続して発生します。

 

（片側引き出し線を使用）
※必ずボードオリジン（基板原点）からのX

 

又は

 

Y座標の値として寸法線は作成されます。
※始点から水平方向に引き出した際はオリジンからのY座標、垂直方向に引き出した際はX座標の値となります。

寸法線が作成できるエレメントは、Board Outline、Mounting Hole、部品ピン、テストポイント、Fiducial、Contour、

 

Drawing要素のみとなります。TraceやViaは対象となりません。
Note
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直線エレメントのX軸からの角度／Angle from X-Axis of Linear Element：
選択した線分とX軸からの角度を基準に寸法線を発生します。

二つの線上エレメント間の角度付き寸法線／Angular Dimension Between Two Linear Elements：
2つの線分を選択してその線分間の角度に対して寸法線を発生します。

半径または直径寸法線の配置／Place a Radius or Diameter Dimension ：
選択したサークルに対しては半径又は直径、アークに対しては半径の寸法線を発生します。
※サークルに対して寸法線を発生する際は、F11：Dia/Radにて半径か直径を切り替えます。

・Dimension ファンクションキー
寸法線コマンドを実行時にファンクションキー操作にて様々な編集が可能となります。

F2：

 

Rotate

 

－ 寸法線Textを回転します。

F3：

 

Mirror

 

－ 寸法線TextをY軸ミラーします。

F4：

 

Flip

 

－ 寸法線TextをX軸ミラーします。

F5：

 

Add Text

 

－ 新規にTextを作成します。

F6：

 

Undo

 

－ Undoを実行します。

F7：

 

Increase

 

－ 5th 又は 15um 単位で寸法線Textサイズを拡大します。
（Dimension ParameterのUnitに依存します。）

F8：

 

Decrease

 

－ 5th 又は 15um 単位で寸法線Textサイズを縮小します。
（Dimension ParameterのUnitに依存します。）

F9：

 

Dimensioning － F5：

 

Add Text実行時に、Dimension-modeに戻ります。

F11：

 

Dia/Rad

 

－ サークルに寸法線作成時に半径か直径かを切り替えます。
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リファレンス番号の編集

Chapter3: Design Process-Postprocess
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◆Ref Des編集／Renumber Ref Des

リファレンス番号の編集作業は、リナンバーリファレンスデジグネータコマンドを使用して行ないます。プルダウンより、ECO＞

 

Renumber Ref Desコマンドを実行すると、リファレンス番号を編集するための専用メニューが表示されます。Expedition PCBで

 

は、このメニューを使用してリファレンス番号の編集（振り直しや変更）作業を行ないます。

部品配置のイメージ画像。
（Top/Bottomの配置面毎に表示。）

配置済み部品のリファレンス番号リスト

Old側は既存状態のリファレンス番号を表わし、New側は変更後のリファレンス番号を表わします。

Old側リファレンス横にある図は、その部品の配置面を表現しています。

図形上に表示されないリファレンス番号
は、マウスカーソルを乗せることで確認
できます。
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メニュー左上部には、フィルタ設定用の項目が幾つか存在します。各設定項目で設定された内容が、リストやイメージ画像に

 

表示される部品を決定します。リストとイメージ画像はリンクしており、ここに表示された部品が編集対象ということになります。

配置面を指定します。

対象部品をイメージウィンドウ内で、領域指定する
場合にチェックを入れます。

※領域は、イメージウィンドウ内での対角2点を指定
するマウスでのドラック操作で作成します。

各チェックボックスは、それぞれの部品を作業対象と
するか否かを決定し、チェックを入れることで部品が
リストされるようになります。

リファレンス番号の頭文字に関する指定項目となり、指定した頭文字のリファレンスがリスト表示されます。
デフォルト値の“＊”は全てを意味し、特定の頭文字をという場合には“U R …”といったように各頭文字を
スペースで分けて列挙します。
IncludeとExcludeのトグルスイッチは、指定したリファレンスを含ませる（Include）か除外する（Exclude）かの
意味付けを切り替えるためのスイッチとなります。

例＞リファレンスの頭文字として“U”のみを指定すると、下図のようにリスト、イメージ画像ともにUのみが表示され、
編集対象をUのリファレンス番号に限定することができます。
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個別にリファレンス番号を編集する場合には、リストのNew側に表示された値をマウスで選択し直接編集します。

マウスで選択し、値を直接キーインします。

編集した後の状態をイメージ画像で確認するには、リスト上段にあるNew Ref Des項目を選択します。

編集前と編集後の確認は、リスト最上段の項目を
選択して切り替えます。

編集後の結果は、イメージ画像で確認します。

イメージ画像で編集内容を確認し、その内容でいいとされるならばメニュー右下にある[OK]もしくは[Apply]ボタンを選択し、編

 

集結果をデザインファイル側にバックアノテートします。

このメニューで行なわれる全ての編集作業は、メニュー内でのみ行なわれており、[OK]もしくは[Apply]のボタ

 

ンを選択してはじめてデザインファイル側へ反映され、[Cancel]ボタンを選択すると全ての作業内容は無効とな

 

ります。Note
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このリナンバーリファレンスコマンドには、リファレンス番号を整列させた形で自動で振り直させる機能も含まれます。この機能

 

を使用するためには、イメージ画像側でのグループ分けと、整列の方向性を指示する必要があります。

イメージ画像下にあるRenumber band widthは、グループ分けを行なう際のバンド幅を設定する項目となり、ここに指定した幅

 

の間隔でバンドラインがイメージ画像上に表示されます。

指定した幅の間隔でバンドラインが表示される。

各部品のグループ分けは、バンドラインに挟まれた領域内にある部品という条件で分けられます。どういったグループ分けに

 

なるのかを確認したい場合には、各領域に対してマウスカーソルを乗せ、部品のハイライト表示で確認します。

ライン上の部品は、部品のセンターがどちらに含まれる
かでグループ分けを行います。

バンドラインは、マウスでドラックして移動することが
できます。バンドラインの移動により、認識される各
グループの構成は変化します。
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このバンドラインの方向はイメージ画像枠上の矢印ボタンで決定され、選択した矢印ボタンと平行になるようにバンドラインは

 

表示されます。この矢印ボタンは、バンドラインの方向を決定するとともに、リファレンス番号を整列する際の方向性も決定して

 

います。

各コーナーに存在する矢印ボタンの意味合いは、下図のような内容となり、各図が示す流れで整列が行なわれます。
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対象とする部品をフィルタ項目で限定し、イメージ画面でグループ分け及び整列方向を設定した後にリストしたにあるAuto 
Renumberのボタンを選択します。自動振り直しのための設定メニューが表示されるので、新たに振り分けるリファレンス番号の

 

頭文字や開始番号についての設定を行ない、[OK]もしくは[Apply]ボタンを選択して作業を実行します。

リファレンスの頭文字

リファレンスの拡張子

自動で行なった場合でも、作業内容がメニュー内のみで行なわれていることには変わりありませんので、最後にメニューの[OK]

 

もしくは[Apply]ボタンを選択しなければ全ての作業は無効となります。

リファレンスへの編集後に[OK]もしくは[Apply]ボタンを選択すると、下図のようなメッセージが表示され、変更内容をネットにバッ

 

クアノテートするか否かを問われます。このメッセージに対して“はい”の返事を返したとき、はじめて最終的なリファレンスの編集

 

結果がネット情報へとバックアノテートされます。

バックアノテーションが実行されると、何がどう変更されたのかを示すWasIsログが生成されます。このファイルは、

 

Logicサブフォルダ内にNetlistBackAnno.txtファイルとして作成され、初期と最終の対比情報として保持されます。

 

何かしらのバックアノテーションが実行された場合には、それら全ての情報はこのファイルへと随時更新されていき

 

、常に最終の状態として保存されています。

尚、このファイルはフォワードアノテーションを実行すると内容がリセットされますので注意して下さい。

Note
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シルクデータの編集

Chapter3: Design Process-Postprocess
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◆シルクスクリーン生成／Silkscreen Generator

シルクスクリーン生成コマンドでは、シルクデータを作成します。基板上に作成された部品のシルク図形を元に、指定したパラ

 

メータに添ってシルクデータを自動的に作成します。プルダウンより、Output＞

 

Silkscreen Generatorコマンドを実行すると、シ

 

ルクデータを作成するためのメニューが表示されます。

・Silkscreen side to process

シルクデータの作成を実行する部品配置面を指定します。シルクスクリーンジェネレータは、ここで指定された基板面に対す

 

るシルクデータのみを作成します。ドロップダウンリストより、作業を実行する基板面を指定して下さい。

・Break silkscreen using

どのオブジェクトに対してシルクカットを行なうかを指定します。ドロップダウンリストより、シルクカット対象とするパッドを選びま

 

す。

シルクカット対象のパッドを選択。
Conductive Pads ：通常のパッド
Soldermask

 

Pads ：マスク用のパッド

データを作成する層を指定。
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・Package Groups

シルクデータを作成する際の対象部品を選択します。対象部品を限定したい場合には、Process項目をSelected Package 
Groupsとし、下のリストから対象とする部品を[Shift]や[Ctrl]キーを併用して選択して下さい。

Process項目でSelected Package Groupsを選択した場合
のみ、このリストから部品が選択できます。

・Break graphics

部品外形シルクに対してシルクカットを行なうか否かを設定する項目となり、Break text項目はシルク文字に対してシルクカット

 

を行なうか否かを設定する項目となります。双方の項目にはパッド/ビアに関する項目が用意され、それぞれのチェックボック

 

スにチェックを入れることでパッド/ビアに対するシルクカットが行なわれます。それぞれに用意されたクリアランス指定項目は、

 

シルクカットを行なう際の増減を指示するものとなり、指定した値がパッド/ビアの直径に上乗せされてシルクカット処理が行な

 

われます。
チェックボックスにチェックを入れると、それに対する
シルクカット処理が行なわれます。

部品外形シルク用の設定項目。

シルク文字用の設定項目。

指定したクリアランス値を上乗せしてカットされます。

※クリアランス値が0の場合、パッド/ビアの直径でシルクカットは行なわれます。
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・Width options

作成されるシルクデータの線幅を指定します。部品外形シルク、シルク文字毎に線幅を指定して下さい。尚、セル内に既存の

 

外形シルクデータやシルク文字の設定が施されたものについては、設定された線幅の値がそれぞれ適応されます。
※Textの線幅（Pen width）が0の時のみ本設定が有効となります。

部品外形シルクの線幅。

シルク文字の線幅。

・Top/Bottom silkscreen for selected cell types項目

シルクデータを作成する際に使用する元の図形要素を選択します。シルクジェネレータは、ここで指定された図形に対して指

 

定されたシルクカット処理を施し、出来上がった図形をシルクスクリーンレイヤ（Silkscreen Layer）へと新たに構築します。

シルクスクリーンレイヤに作成する図形要素を、[Shift]や[Ctrl]キーを併用しながら全て指定します。

・尚、シルクデータ作成に使用できる図形要素はここにリストされるもののみとなり、セル内に作成したAssembly

 

関連の図形はシルクデータを作成するための雛形には利用できません。シルクデータ作成に利用可能な図形

 

要素は、Silkscreen関連の図形とユーザー定義レイヤ内に作成された図形要素がメインとなりますので、シルク

 

ジェネレータを実行する前にこれらの図形要素を用意しておくことが必要となります。

・シルクデータは、各図形の基板上の状態をもとに作成されますので、シルク文字の移動や大きさの編集は、

 

DrawモードでSilkscreen Ref Des等の図形要素に対して事前に行なって下さい。

移動は図形を直接ドラック

Note
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シルクカット個所。

シルクスクリーン生成後のイメージ図：

・シルクジェネレータで作成された図形は、線要素のみで構成された単なる図形要素となります。
・シルクスクリーンレイヤに保存された内容は、シルクスクリーンジェネレータを実行するたびに再構築されま

 

すので、データを残したい場合には異なるレイヤへの移動やコピーといった作業を行なう必要があります。Note
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穴図とドリルデータの作成

Chapter3: Design Process-Postprocess
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◆NCドリルデータ／NC Drill

NCドリルデータは、NCドリルデータコマンドを使用して作成します。このコマンドを実行すると、ドリルデータの他に穴図データ

 

がデザインファイル上に作成されます。プルダウンより、Output＞

 

NC Drillを実行すると作成用のメニューが表示され、使用す

 

るドリルパラメータファイルなどの設定を行なった後にデータを作成します。

・NC drill machine format file

ドリルデータを作成する際に使用するパラメータファイルを指定する項目となります。このパラメータファイルとは、ドリルデータ

 

のフォーマットやNCマシンの指示を行なっているファイルとなります。

デフォルト値として供給される2つのファイルは、インチ系、ミリ系用のものとして用意されており、

ユーザーがその内容をメモ帳等で自由に編集することが可能です。

NC Drill 実行後に作成されるドリルファイルは、

 

../Output/NCDrill

 

ディレクトリに作成されます。ドリルファイル名は、ホールタ

 

イプ・スパン・プレートタイプなどにより、定義されたネーミングのファイル名で作成されます。

1-2 Plated.ncd

 

：貫通以外のホール（ビルドアップビアなど）用であり、ピアスパン毎に作成されます。
ContourNonPlated.ncd ：ContourのNone-Plated用のドリルファイル。
ContourPlated.ncd ：ContourのPlated用のドリルファイル。

1-2 ContourPlated.ncd

 

：貫通以外のContourのPlated用のドリルファイル。Contourスパン毎に作成されます。
ThruHoleNonPlated.ncd ：貫通ホールのNone-Plated用のドリルファイル。
ThruHolePlated.ncd ：貫通ホールのPlated用のドリルファイル。
ThruHolePunchNonPlated.ncd ：PunchのTypeを持った貫通ホールのNone-Plated用のドリルファイル。
ThruHolePunchPlated.ncd ：PunchのTypeを持った貫通ホールのPlated用のドリルファイル。
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.FILETYPE DRILL_MACHINE_FILE

.VERSION "1.0"

.CREATOR WG2002

.DataType

 

Excellon

 

! ドリルマシンタイプをExcellonかTruDrillで指示
.Unit               MM         ! 単位をINかMMで指示
.DataFormat

 

3,3         ! データ分解能を指示（2,4と3,3は共通分解能）
.StepMode

 

Absolute    ! 絶対座標か相対かをAbsoluteかIncrementalで指示
.ZeroTruncation

 

Leading     ! ゼロ処理をLeadingかTrailingかNoneで指定
.DataMode

 

Modal       ! データモードをModalかNon_Modalで指示
.ArcStyle

 

Radius      ! 円弧補完処理をQuadrantかRadiusかNoneで指示
.SequenceNumbering

 

OFF         ! シーケンス番号表示をONかOFFで指定
.CharacterSet

 

Ascii

 

! キャラクタセットをAsciiかEbcdicで指定
.Delimiter          "*"         ! デリミタ（コマンド区切りの記号）を指示
.Comments           ON        ! コメント追加をONかOFFで指定
.CommentStr

 

"; "

 

! コメントの先頭キャラクタの指定（; for Excellon）
.RecordLength

 

0      ! レコード長の指示（通常は

 

0）

参考：パラメータファイル（DrillMetric.dff）

このパラメータファイルはWG2002.2から変更されており、WG2002が使用していた*.mmmファイルを指示された
データは、起動時に自動で対応する*.dffファイルに設定変更されます。

Note
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・Drill generation options

ドリルデータを作成する際のオプション設定を行ないます。

NCマシンが水平/垂直のどちら向きにスイープするのかの

方向性を指定します。

NCマシンがスイープするバンド幅を指定します。

出力されるデータファイルの拡張子を指定します。

※スイープの方向性とは？

このスイープの方向性とは、NCマシンが穴あけを行なう際の方向性となり、同時にNCドリルジェネレータが
データを作成する（読み取る）際の方向性となります。これに対するバンド幅とは、その方向で1回に読み取る

領域の幅を指しています。

バンド幅

(0,0)

このスイッチをONにし値を入力することで、指定した値よりも大きな穴を優先的に
先に穴あけするよう指示することができます。指定できる値は0から9999の間の値

となり、大きな穴位置の正確性を向上します。

最下段の項目では、出力されるドリルファイルに対するヘッダーや注釈を入力してください。
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メニュー内にあるDrill Chart Optionsタブを選択すると、穴図作成時におけるオプションメニューが表示されます。このメニュー

 

は、穴図に追加される穴図表についての設定を行なうためのものとなり、表に関する文字の大きさ、フォント、行間等を設定す

 

ることができます。

メニュー左上にあるリストでは、穴図表に追加する項目を設定します。リスト上部にある各ボタンを用いて、穴図表に必要な項

 

目を設定して下さい。

項目を追加する。

空のエントリが追加されるので、追加されたエントリを選択し、
ドロップダウンリストより追加項目を選択。

順番を入れ替える場合には、対象項目を選択した後に
矢印ボタンで変更し、削除の場合には項目を選択後に
デリートボタンを選択します。
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Text settings項目では、穴図表の文字に関する設定を行ないます。各項目で使用する文字フォントや文字の大きさ、行間や

 

文字の太さなどを設定して下さい。一番下にあるフォーマットとは、データ作成時の分解能ではなく、単に穴図表に記載する

 

際のツールの分解能となります。

文字フォント

穴図表上の分解能

文字の大きさ、行間、線幅

その下にある項目では、穴図表のタイトルや注釈を指示することが可能です。

各ツールの誤差値のデフォルト値。

メニュー内の[OK]ボタンを選択すると、設定された内容でドリルデータ及び穴図が作成されます。作成された各ドリルデータ

 

はサブフォルダのOutput¥NCDrill以下に全て収納され、貫通ホールの穴図データは同一デザインのDrill Drawing - Through

 

レイヤへと収納されます。

貫通ホールの穴図データはこのレイヤに収納され、データ

 

作成毎に毎回上書きされます。

単位

Auto assign drill symbolsでは、各ホールに設定された穴図キャラクタが自動設定の場合にのみ適応されます。自動定義の穴

 

図キャラクタをA～Z、a～zのキャラクタで割り当てるか、シンボルで割り当てるかを選択を行ないます。

貫通以外のホール（ビルドアップビアなど）の穴図データは、
ユーザ定義レイヤのピアスパン毎のレイヤに作成されます。
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・Drill Symbols

メニュー内にあるDrill Symbolsタブを選択すると、ドリルシンボルの割り当てメニューが表示されます。このメニューは、各ホー

 

ルに対する穴図シンボルの割り当てを行うためのものとなります。デフォルトで表示される設定は、Setup＞

 

Padstack Editor＞

 

Holesタブで設定されたものであり、ここで変更した内容が優先されることとなります。また変更した内容は、スキームとして保存

 

、読み込みを可能とします。

Assignment method （穴図シンボルの割り当て方法）

・Automatically assign during output

ホールに固定した穴図シンボルを指定せずに、システムが自動で穴図シンボル（A～Z、a～ｚ）の割り当てを行います。

・None

ホールに穴図シンボルの割り当てを行いません。ここで指定したホールは穴図として作成されません。

・Use character as drill symbol

ホールに対する穴図シンボルをキャラクタのA～Z、a～ｚより指定します。

・Use drill symbol from list

ホールに対する穴図シンボルをシンボルリストより指定します。

選択された図柄には、青い縁取りがされます。

穴図シンボルの割り当て方法を指定。

穴図シンボルのサイズを指定。
Preview画面にて確認が可能となります。
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スキーム名の指定 及び 保存先を指定します。
Save locally with design ： プロジェクト¥Configフォルダに格納
Save with product system files ： システムフォルダ（SDD_HOME¥standard¥config¥pcb）に格納
Save with user-defined location ：

 

指定したフォルダに格納

セーブアイコンを選択した場合

 

又は

 

NC Drillの初回起動時には次のSave Schemeメニューが表示されます。スキームとして登

 

録されたファイルは、.dsf

 

の拡張子を持つファイルとなります。
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穴図イメージ：

穴図表の移動はPlaceモードで行なってください。

作成される穴図のキャラクタ（文字）の大きさは、パッドスタック

 

テーブル内で設定された各ホール設定 又は ドリルシンボルタブ

 

での設定に依存します。作成された穴図キャラクタの大きさを変

 

更したい場合には、各ホールに対するSizeを変更した後、穴図を

 

再作成ください。

基板上の穴図キャラクタの大きさは、Size値で決定されます。

Note
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◆NCルータ(Contour)の作成

Expedition PCB上でボードカットデータを作成する場合、Drawコマンドの作画機能を使用してその形状を作成します。ボード

 

カットやスリットといった図形要素はNCルータ（Contour）として認識されており、この要素タイプとして図形を作成することで、

 

NCドリルジェネレーションコマンドでドリルデータとして抽出されます。

NCルータ要素を作成する場合には必ずプロパティメニューを開き、その内容を確認した上で図形を作成するようにしてくださ

 

い。NCルータには、経路上のドリル位置、データタイプ、ツール径やデータ方向などを指定する必要があります。

NCルータに対する穴図は、ボードカットや各スリットの始点ポイントにのみ指定されたツール径を表わすキャラクタが作成され

 

、出力されるファイルは通常のドリルデータとは分別されます。

NCルータの穴図キャラクタ

NCルータ用のドリルファイル

NCルータ

Hole Name ：ドリル径（ホール名）
Compensation ：経路上のドリルの位置

Type ：データタイプ
（Internal=基板内スリット、Board=ボードカット）
※ドリル出力時にはInternalからBoardの順に出力されます。

Direction ：方位
（CW=右回り、CCW=左回り

Left

Right

Center

Note

NCルータのスパン（層間）定義となります。これにより、貫通以外の特定スパン

 

を持つContourの作成が可能となりました。



－ 403 －

ガーバーデータの作成

Chapter3: Design Process-Postprocess
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◆ガーバーマシンフォーマット／Gerber Machine Format

ガーバーデータを作成するには、ガーバーマシンのフォーマットを予め作成しておく必要があります。ガーバーマシンフォー

 

マットの作成は、エディタプルダウンのSetup＞ Gerber Machine Formatコマンドで表示されるメニューにて行ないます。

このフォームで、ガーバーマシンフォーマットの内容を設定します。

作成されたガーバーマシンフォーマットのファイル名
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設定項目の内容

Data Type

 

：ガーバーデータのフォーマットタイプを選択します。
デフォルトでは拡張タイプである

 

274Xとなり、通常タイプの

 

274Dも選択可能となります。
※尚、274Dを使用する場合、アパーチャ定義ファイル（Dコードマッピングファイル）を別途用意する必要があります。

Data Mode

 

：データ構造を選択します。
Modal

 

－

 

X座標、Y座標を出力する際に、次のステップには変更された座標のみが出力されます。
Non-Modal

 

－

 

省略することなく全てのデータ（座標）が出力されます。

Step Mode

 

：座標値をAbsolute（絶対座標）もしくは、Incremental（相対座標）より選択します。

Data Format

 

：データの桁数及び小数点位置を設定します。

Zero Truncation

 

：０データの取り扱いを設定します。
Leading

 

－

 

前のゼロを省略します。
Trailing

 

－

 

後ろのゼロを省略します。
None

 

－

 

省略することなく全てを出力します。

Character Set

 

：データをASCII・EBCDECの何れで出力するかを設定します。

Arc Style

 

：円弧補間の方法を選択します。
Full（完全補間）・Quadrant（1/4円弧補間）・None（直線補間）

Delimiter

 

：各コマンド末に付加するキャラクタを設定します。

Comments

 

: コメントを出力するか否かを設定します。

Sequence Number：

 

ONの場合にのみ、各行の先頭に行番号を付与します。

Units

 

：

 

出力データの単位系を指定します。（デザインの単位は使用しません。）

Polygon fill method：

 

ポリゴン（塗り潰し）データの出力形態を選択します。

 

274Xフォーマットの場合にのみ有効です。
Draw

 

－

 

パッドはアパーチャにてFlash処理、プレーン等の多角形はガーバーマシンフォーマットファイル（.gmf）
の［.SHAPEFILLWIDTHS ］で定義された値で塗り潰しを行います。

Raster

 

－

 

アパーチャを使用せず、線幅

 

0 の多角形として扱い、図形の外周座標が出力されます。
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◆ガーバー出力／Gerber

ガーバーデータは、ガーバー出力コマンドを使用して作成します。プルダウンより、Output＞

 

Gerberを実行することでガーバ

 

ーアウトメニューを開くことができます。

ParametersタブのFiles to Processリストには、出力されるガーバーデータのファイル名や使用されるアパーチャーファイル名

 

が全てリスト表示されます。各ファイルの左横に存在するチェックボックスは、ガーバーデータ作成を行なうか否かを指定する

 

ものとなり、チェックを入れたファイルに対してのみガーバーデータ作成作業が実行されます。

使用されるアパーチャーファイルが表示されます。

※.dmfファイルでアパーチャー固定する場合、この項

 

目
を選択することでブラウズ機能を使用できます。

作成後のガーバーデータのファイル名がリスト表示
されます。ここに表示されたファイルは、データ作成
後にOutput¥gerberサブフォルダ下に収納されます。

チェックを入れたものにのみ作成作業が行なわれます。
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リスト内へのファイル名追加や削除といった作業は、リスト右上にあるアイコンを使用します。Newボタンを選択すると、新しい

 

エントリがNew.gdoのファイル名で追加されます。ファイル名については、マウスで選択してキー入力で直接編集することがで

 

きます。削除の場合には、対象をリストから選択した後にDeleteボタンを選択します。

このボタンでエントリが追加されます。

ファイル名は、マウスで選択して直接編集します。

・Header text、Trailer text

各ガーバーデータのファイルにはHeader textとTrailer textの項目が存在し、リストから選択した各ファイル毎にヘッダーやフ

 

ッターの設定が行なえます。ここに設定された値は、作成されたガーバーファイル内にコメントとして追加されます。

ファイル内にコメントとして追加したい内容を、各ファイル毎に設定します。

・Generate Macros

カスタムパッドを出力する場合、ガーバーファイルにアパーチャー・マクロ（AM）コマンドを使用するかどうかの設定が行えます

 

。アパーチャー・マクロ（AM）コマンドを使用すると、サードパーティ社の製品（CAD350等）やAMコマンドに対応していないフ

 

ォトマシンでは、正常にAMコマンドのカスタムパッドを読み込むことができません。その際は、このオプションをOFFとして、ガ

 

ーバー出力を行ってください。

※このオプションは、拡張ガーバー（274Xフォーマット）、

 

Polygon fill methodがDraw設定時のみ影響します。

Generate Macros＝OFF
標準アパーチャーの組み合せ

 

でカスタムパッドを作画します。

Generate Macros＝ON
AMコマンドを使用して特殊形状のアパーチャー

 

のFlashにてカスタムパッドを作画します。
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X/Y軸方向へのコピー数の指定。

Offset from originとCopy options項目では、出力されるガーバーファイルへの原点のオフセットや、コピー数を指定することが

 

できます。

ガーバーデータ作成時の原点へのオフセットを指定。

※デフォルト値の0,0では、デザインファイル上のボードオリジンを基準にデータが作成されます。

(0,0)

(X,Y)

出力されるデータにオフセットが掛かります。

コピーする際の間隔。

X軸へのコピー数

Y軸へのコピー数

(0,0)

X軸のコピー間隔

Y軸のコピー間隔

(0,0)
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・Gerber machine format file

ガーバーデータ作成に使用されるガーバーマシンフォーマットファイルの名前が表示されます。作成されるガーバーデータは

 

、すべてこのファイルで設定されたフォーマットにもとづいて作成されます。

使用されるフォーマットファイルの表示。

メニュー右下にある[Process Checked Output Files]ボタンを選択すると、リスト内でチェックされた全てのガーバーファイルの

 

作成作業が行なわれます。

このボタンを選択して、データ作成を実行します。

作成されたガーバーファイルは、リストで指定した名前でOutput¥Gerberサブフォルダ内に収納されます。

ブラウズボタンで選択。

Note
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◆Dコードマッピングファイル(DMFファイル)／D-code Mapping File

DMFファイルを使用することで、拡張ガーバー（274Xフォーマット）であってもアパーチャーを指定したものに固定して出力す

 

ることができます。DMFファイルとはDコードマッピングファイルの略で、その名が示す通りガーバーデータ作成に使用する各

 

アパーチャーのDコードをマッピングしたファイルとなります。

メニュー内のD-Code Mapping File項目を選択すると、デフォルトの(Automatic)以外に

 

Browse…がリストされます。この

 

Browse…を選択するとブラウズメニューが表示され、使用するDMFファイルを選択することができます。

Browse…を選択

使用するDMFファイルは、予めデータのConfigサブフォルダに収納
しておきます。（拡張子は

 

.dmf）

DMFファイルでのアパーチャー指定はガーバーデータファイル単位となり、アパーチャー指定が必要なファイル全てに対して

 

この作業は行ないます。拡張ガーバー標準の自動アパーチャー生成に切り替えるには、D-Code Mapping Fileの項目をデフ

 

ォルトの(Automatic)に戻して下さい。
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・DMFファイルフォーマット

DMFファイルは、下記のフォーマットでASCIIテキストとして作成します。作成したファイルは.dmfの拡張子を付け、各デザイン

 

ファイルのConfigサブフォルダ内に収納しておいて下さい。このファイルにおけるコメントアウト文は、行の頭に！を挿入して作

 

成して下さい。

フォーマット内容：

 

（※

 

文中の△はスペースを意味します。）

◇ファイルヘッダー

以下の内容は、DMFファイルのヘッダー部となり、“”内以外はすべて固定値となります。

.FILETYPE△DcodeMappingFile

.VERSION△"VB2000"

.CREATOR△"VeriBest, Inc."

.DATE△"Monday, Dec 13, 1999 08:05 AM“

◇単位系設定

ここでは、DMFファイル内に登録するアパーチャー寸法に使用する単位系を設定します。
単位系の指定は、mm、in、um、thの何れかで指定します。

.Units△th

※アパーチャー（Dコード）設定

これ以降にアパーチャー（Dコード）の設定を行ないますが、この定義方法にはパッドスタックテーブルに登録した際の
パッド名での登録と、パッドの形状に対する登録の2種類の設定方法を選んで登録することができます。以下にこれら
2種類の登録フォーマットを記します。

◇パッド名でのアパーチャー設定

パッド名でアパーチャー設定を行なう場合、以下の書式で登録を行ないます。

.pad△

 

..Dcode△番号

 

△..Name △“パッド名”

 

△..Angle △角度

・角度には、そのDコードをどのパッドの角度で使用（併用）するのかを

 

０、９０、１８０、２７０の値で
設定し、複数の角度を登録する場合には、０，９０，１８０，２７０といったようにカンマで繋げます。

例＞

.pad  ..Dcode

 

30   ..Name "Rectangle 25x80"     ..Angle 0,180
.pad  ..Dcode

 

31   ..Name "Rectangle 25x80"     ..Angle 90,270
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◇パッド形状でのアパーチャー設定

パッド形状でアパーチャー設定を行なう場合、各形状毎に指定されるフォーマットで登録を行ないます。

○円形パッド

.Round△

 

..Dcode△

 

番号△

 

..Dia△

 

直径

例＞

.Round

 

..Dcode

 

10   ..Dia

 

10

○正方形パッド

.Square△

 

..Dcode△

 

番号△

 

..Width△

 

横幅△

 

..Angle 角度

例＞

.Square   ..Dcode

 

14   ..Width .030    ..Angle 0,90,180,270

○正方形ラウンドコーナーパッド

.RadiusSquare△

 

..Dcode△

 

番号△

 

..Width△

 

横幅△

 

..Angle 角度

例＞

.RadiusSquare

 

..Dcode

 

95   ..Width .030    ..Angle 0,90,180,270

○長方形パッド

.Rectangle△

 

..Dcode△

 

番号△

 

..Width△

 

横幅△

 

..Height△

 

縦幅△

 

..Angle△

 

角度

例＞

.Rectangle    ..Dcode

 

50 ..Width 25 ..Height 80 ..Angle 0,180

○長方形ラウンドコーナーパッド

.RadiusRect△

 

..Dcode△

 

番号△

 

..Width△

 

横幅△

 

..Height△

 

縦幅△

 

..Angle△

 

角度

例＞

.RadiusRect△

 

..Dcode

 

150 ..Width 25 ..Height 80 ..Angle 0,180

○楕円パッド

.Oblong△

 

..Dcode△

 

番号△

 

..Width△

 

横幅△

 

..Height△

 

縦幅△

 

..Angle△

 

角度

例＞

.Oblong      ..Dcode

 

12   ..Width .045 ..Height .020   ..Angle 0,180
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○フィンガーパッド

.RoundFinger△

 

..Dcode△

 

番号△

 

..Width△

 

横幅△

 

..Height△

 

縦幅△

 

..Angle△

 

角度

例＞

.RoundFinger

 

..Dcode

 

13   ..Width .040   ..Height .020  ..Angle 0

○八角形パッド

.Octagon△

 

..Dcode△

 

番号△

 

..Width△

 

横幅△

 

..Angle△

 

角度

例＞

.Octagon   ..Dcode

 

16   ..Width .050   ..Angle 90

○八角長方形パッド

.ElongOctagonr△

 

..Dcode△

 

番号△

 

..Width△

 

横幅△

 

..Height△

 

縦幅△

 

..Angle△

 

角度

例＞

.ElongOctagon

 

..Dcode

 

17   ..Width .050  ..Height .035   ..Angle 0,180

○矩形フィンガーパッド

.OctFinger△

 

..Dcode△

 

番号△

 

..Width△

 

横幅△

 

..Height△

 

縦幅△

 

..Angle△

 

角度

例＞

.OctFinger

 

..Dcode

 

18   ..Width .075   ..Height .025   ..Angle 0

○ドーナッツ形パッド

.Donu△

 

..Dcode△

 

番号△

 

..Dia△

 

直径△

 

..ThermClr△

 

線の幅

例＞

.Donut   ..Dcode

 

19   ..Dia

 

.065

 

..ThermClr

 

.015

○矩形ドーナッツパッド

.SqDonu△

 

..Dcode△

 

番号△

 

..Dia△

 

直径△

 

..ThermClr△

 

線の幅△

 

..Angle△

 

角度

例＞

.SqDonut

 

..Dcode

 

20   ..Width .075  ..ThermClr

 

.020   ..Angle 0,90,180,270
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○円形サーマル各種

.形状名△

 

..Dcode△

 

番号△

 

..Dia△

 

直径△

 

..ThermWidth△

 

タイレグ幅△

 

..ThermClr△

 

線の幅△

 

..Angle△

 

角度

・形状名には、以下の内容がそれぞれの形状毎に代入されます。

Thermal  →

 

90度4方向接続サーマル
Thermal45 →

 

45度4方向接続サーマル
2WThermal →

 

90度2方向接続サーマル
2WThermal45 →

 

45度2方向接続サーマル

例＞

.Thermal      ..Dcode

 

21   ..Dia

 

.060  ..ThermWidth

 

.015 ..ThermClr

 

.015  ..Angle 0,90,180,270
.Thermal45    ..Dcode

 

22   ..Dia

 

.060   ..ThermWidth

 

.015 ..ThermClr

 

.015  ..Angle 0,90,180,270
.2WThermal    ..Dcode

 

25   ..Dia

 

.065  ..ThermWidth

 

.015 ..ThermClr

 

.020  ..Angle 0,180
.2WThermal45  ..Dcode

 

26   ..Dia

 

.070   ..ThermWidth

 

.015 ..ThermClr

 

.015  ..Angle 0,180

○矩形サーマル各種

.形状名△

 

..Dcode△

 

番号△

 

..Width△

 

幅△

 

..ThermWidth△

 

タイレグ幅△

 

..ThermClr△

 

線の幅△

 

..Angle△

 

角度

・形状名には、以下の内容がそれぞれの形状毎に代入されます。

SqThermal

 

→ 90度4方向接続矩形サーマル
SqThermal45 →

 

45度4方向接続矩形サーマル

例＞

.SqThermal

 

..Dcode

 

23   ..Width .055  ..ThermWidth

 

.010 ..ThermClr

 

.012  ..Angle 0,90,180,270
.SqThermal45  ..Dcode

 

24   ..Width .062  ..ThermWidth

 

.012 ..ThermClr

 

.020  ..Angle 0,90,180,270

○カスタムパッド

.Custom△

 

..Dcode△

 

番号△

 

..Name△

 

“カスタムパッド名”△

 

..Angle△

 

角度

・カスタムパッド名には、パッドスタックテーブル内のカスタムパッド名を入れます。

例＞

.Custom  ..Dcode

 

100  ..Name "Smiley Face 30 x 35 _1" ..Angle 0



－ 415 －

◆274Dフォーマット出力

ガーバーマシンフォーマット内に、データタイプとして274Dを設定したマシンフォーマットを追加すると、Gerber Outputメニュー

 

内のマシンフォーマット選択項目で274D出力フォーマットを指定することができます。

この欄には、選択されたマシンフォーマットのデータタイプが表示されます。

274Dフォーマットを指定すると、Files to process項目の内容が変化します。247Dフォーマット出力では、274Xのような自動ア

 

パーチャー生成機能はないので、D-Code Mapping File項目で必ずDMFファイルを定義する必要があり、これを設定しない

 

限り、274Dフォーマットでの出力は行なえません。Flash/Draw Pads項目では、指定したDMFファイルに定義された各パッドへ

 

のアパーチャー指定を無視し、全てのパッドを作画データとして出力するような場合に使用します。この項目のデフォルト値は

 

Flashとなり、各パッドはDMFファイルで定義された内容に応じてフラッシュデータとして作成され、Drawに設定することで全て

 

のパッドを作画データとして作成するようになります。

274DフォーマットのDraw設定は、274X側に対しても有効となってしまうため、デフォルトの274X出力に戻すような場合に

 

は、Flash/Draw Padsの設定内容もデフォルトのFlashに戻しておくことを忘れないようにして下さい。
Note
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メニュー左上にあるOutput files項目では、作成したファイル名がドロップダウンリスト内に全てリストされます。この項目は、設

 

定対象となるファイル名の選択や設定内容の確認の際に使用します。

作業対象をリストから選択。

ここにリストされるファイル名は、Parametersタブメニューで作成されたファイル名となり、最初に必要なファイ

ル名を作成しておく必要があります。

◆出力内容タブ／Contentsタブ

Contentsタブメニューでは、Parametersタブで作成した各ガーバーファイルとしてどのような図形要素が必要なのかを定義します。
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作業対象となるファイルをリストより選択すると、メニューの各項目に対してその設定内容が表示されます。選んだファイルとし

 

て必要とされる図形要素を、メニューの各項目から選択することでガーバーデータの中身を構築します。

Conductors項目では、配線層（プレーン層を含む銅箔層）に関する指定を行ないます。必要とされるデータを収納したレイヤ

 

をLayer項目より選び、その下にあるItemsのリストから必要な図形要素を全て選択して下さい。

必要な情報を収納した配線レイヤを指定。
※配線レイヤのデータが不要な場合は、（None）を選択します。

ガーバーデータとして必要とされる図形要素を選択します。
※選択の際には、[Shift]や[Ctrl]キーを併用しながら行なって下さい。

Itemsリストで選択したパッド要素に対して、接続情報を持つパッドのみ

 

ガーバーデータとして抽出させたいという場合にチェックを入れます。

Itemsリストで選択する内容を、各レイヤ毎に用意されたデフォルト値で行ないたい場合にチェックを入れます。

各層のデフォルト値：

（表層のデフォルト値） （内層のデフォルト値） （ネガ層のデフォルト値）

システムが供給するデフォルト値は、その層のデータとして必要と想定されるものがはじめから選択され

 

ます。内層のデフォルト値は通常の配線層及びポジプレーン層に対するもので、内層では必要ない（存

 

在しない）とされるテストポイント部品のパッドが無効化されます。これに対し、ネガプレーン層におけるデ

 

フォルト値はPlane Dataのみが選択された状態のものとなります。これらの値は、各層毎にそうでなけれ

 

ばならないというものではないので、これらの値を必要に応じて修正することは可能です。

Note
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User-defined layers項目には、セットアップパラメータで設定されたユーザー定義の各作画レイヤがリストされます。各ユーザ

 

ー定義レイヤに作成された図形要素をガーバーデータとして抽出する場合には、ここにリストされた各レイヤを指定して下さい

 

。

指定したユーザーレイヤ内にある全ての図形要素が
ガーバーデータとして抽出されます。

Cells項目では、セル内に作成された銅箔要素（パッド、フィデュシャル、マウンティングホールなど）以外の図形要素を指定す

 

る際に使用します。セル内に作成された図形要素をガーバーデータとして抽出したい場合には、必要な図形を含むセルの搭

 

載面をSide項目で選び、その下のリストで必要な図形要素を選択します。左側にあるTypes項目は、セルから図形要素を抽出

 

する際のフィルタ設定となり、セルタイプが全てリストされています。

セルの搭載面を指定。
※必要のない場合には、配線のときと同様に(None)を選択します。

抽出の対象とするセルタイプのみを
選択します。

必要とされる図形要素を全て選択します。

Board items項目では、基板外形やシルクなどの図形要素に関する指定を行ないます。必要とされる図形要素を、リスト内より

 

[Shift]や[Ctrl]キーを併用しながら全て選択します。

銅箔要素以外の図形要素が必要な場合には、ここから必要な
ものを探して指定します。

・作成される各ガーバーデータの内容は、コンテンツタブの設定内容に依存し、選択された図形要素全て含む内容
が1つのファイル内に集約されることを踏まえた上で設定を行なうようにして下さい。
・このメニュー内で設定された内容は、メニューを[OK]ボタンで閉じない限り保存されませんので注意して下さ

 

い。
・作成されるガーバーデータは、ファイル名が変わらない限りは毎回の作成作業で全て上書きされます。
・Textは指定したPen Width（ペン幅）を使用して出力されます。Pen Widthが0の場合は、gmfファイルの

.DEFAULTDRAWWIDTHを使用して出力します。

Note
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Chapter 4
Product Integration

概要
本章はExpedition PCBと他プロダクト間のインテグレーション機能

 

と

 

更なる設計工数の短縮に向けたインターフェイス等

 

を説明しております。

・ インポート・エクスポート機能

 

－420P
・

 

出力機能

 

－437P
・

 

Report Writer －454P
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インポート/エクスポート

 

機能

Chapter4：

 

Product Integration



－ 421 －

◆インポート・エクスポート／Import・Export機能

Expedition PCBに搭載されている入出力機能は、Fileプルダウン以下のImport及びExportプルダウン以下に収納されていま

 

す。

インポートコマンド

エクスポートコマンド
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◆インポート／Import DXF

Import DXFコマンドでは、機構系CADで用いられるDXFフォーマットを使ったインポート機能を提供します。コマンドを実行す

 

ると、インポート作業を行なうためのメニューが表示されます。このメニューで、インポートするデータを収納したDXFファイルや

 

、取り込み時のモード、各データの収納先となる作画レイヤを指定した上でインポートを行ないます。

インポートするDXFファイルを指定。 インポート時の単位系を指定。
※インポートファイル作成時の単位を指定します。

インポート先の作画レイヤを指定。
※インポート可能なのは、ユーザー定義の作画レイヤ

のみとなります。

選択したファイル内に収納された
DXFレイヤが全てリストされます。

必要な情報が収納されたDXFレイヤにのみチェックを入れます。
※どのレイヤに何が収納されているかについては、出力側で確認して下さい。

インポートセル名を指定。
DXF_から始まるセル名である必要があります。

フォントのマッピングを指定。
（True Typeフォントのみ指定可能。）

DXF ARC ARC要素として変換

DXF Circle Circle要素として変換

DXF Dimension Polyline要素として変換

DXF Ellipse（楕円） ARC要素として変換

DXF Line Polyline要素として変換

DXF Polyline Polyline要素として変換

DXF Text TEXT要素として変換

インポート対象となるDXFのエレメントタイプ

スケール値を指定します。
Scale値を２とした場合、サイズを2倍してインポート

 

します。

インポート時のモードを指定。
・New（新規）
・Append Cell（追加：既存CELLに追加されます）
・Overwrite Cell（上書き：既存CELLは削除されます）
・Overwrite Layers Only（上書き：指定したUserLayer
のみが置換され、その他UserLayerは保持されます）

DXFのエクステント領域が表示されます。
インポートするDXFファイルは、84インチ以下であること。

・インポートの対象となるDXFのバージョンはR14となり、それ以外のバージョンはサポート対象外となります。
・Import DXFにて作成されたエレメントのオブジェクトタイプは変更できません。変更する際は、対象エレメント
をコピーして、コピーしたエレメントのオブジェクトタイプを変更ください。
例）DXFからBoardOutlineを作成するには、Drawモードにて対象エレメント選択後、CTLキー＋ダブルクリック

でエレメントコピー。

 

コピーしたエレメントのタイプをBoardOutlineへ変更します。
・Padstack Editor＞

 

Custom Pads & Drill SymbolでのImport modeは、Append CellとOverwrite Cellのみ可能です。

Note
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◆エクスポート／Export DXF

Export DXFコマンドでは、機構系CADで用いられるDXFフォーマットを使ったエクスポート機能を提供します。コマンドを実行す

 

ると、エクスポート作業を行なうためのメニューが表示されます。このメニューで、エクスポートしたデータを収納するDXFファイル

 

名や、データの単位系、出力する図形とそれを収納するためのDXFレイヤ名を指定した上でエクスポートを実行します。

出力DXFファイル名を指定。Defaultは、

 

./Output/(デザイン名).dxf

 

となります。

データの単位系を指定。

各図形要素を収納するDXFレイヤ名を指定します。
※各要素には、デフォルト値が用意され、これ以外のものを使用する場合

にのみ直接修正します。３１文字以内、スペースは不可。

PCB ElementとDXF Layer Nameの設定について、スキームの選択

 

及び

 

保存が可能。

DXF Line 全てのLine要素

DXF Arc 全てのARC要素

DXF Polyline 全ての閉じたShape要素

DXF Text 全てのTEXT要素

DXF Circle 全てのCircle要素

DXF Solid 0/90/180/270度で配置されたRectangle（Fill付き）

DXF Hatch 閉じたPolylineとCircle（Fill付き）

出力されるDXFのエレメントタイプ

出力する図形要素に対しチェックを入れます。
※DXF出力可能な図形要素が全てリストされます。

Y軸ミラー出力オプションFill付きでパッドを出力
※Part Pads、Via Pads選択時に有効。

作成されるDXFファイルのバージョンは14となり、これをサポートしないツールではインポートが行なえない可能性

 

がありますので注意して下さい。
Note
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◆インポート／Import EDIF Netlist

Import EDIF Netlistコマンドは、EDIF200フォーマットで作成されたネットリストをExpedition PCB用にインポートするためのコ

 

マンドとなります。

インポートするEDIFネットリストファイルを指定。

EDIFネットリストを取り込むには、コントロールファイルであるedifcfg.cafファイルを、必要によりデータのconfigサブフォルダ内に

 

格納します。このファイルは、インストールフォルダ内のconfig（¥SDD_HOME¥standard¥config¥pcb）下に収納されていますの

 

で、EDIFネットリストからCAEネットリストへの変換が行なえない場合には、このファイルをconfigサブフォルダ内にコピーしてか

 

ら、インポートを行なってください。

インポートされたEDIF200のネットリストは、Logicサブフォルダ内にNetlist.caeファイルとしてインポートされます。このファイルを

 

Expedition PCB上で使用する場合には、プロジェクトエディタメニューでソースとなるネットリストのタイプをCAE Netlistとしてか

 

らファイルを指定して下さい。
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・インターフェース／Interface Name

Hyperlynx Thermal ：
熱解析に使用されるインターフェースファイルを出力します。ファイル名は、thermal.inp/thermal.ini/thermal.inb/

 

thermal.inl

 

です。

C-Link ：
C-Link DIFファイル用の物理ボード情報を出力します。ファイル名は、ジョブ名.dif

 

です。

Fabmaster

 

：
FATF(FABmaster

 

ASCII Transfer Format)用の物理ボード情報を出力します。ファイル名は、ジョブ名.fab

 

です。

Generic AIS/ATE ：
AIS(Automatic

 

Insertion Systems)とATE(Automatic

 

Test Equipment)用のCAM情報を出力します。ファイル名は、
vb_ais.txt

 

又は

 

vb_ate.txt

 

です。

Mitron

 

Gencad

 

：
Mitron社

 

CIM Bridge用のインターフェースファイルを出力します。ボード及びパネルからの出力が可能となります。
ファイル名は、gencad.cad

 

です。

◆エクスポート

 

汎用インタフェース／General Interface

Export＞

 

General Interfaceコマンドでは、様々な他社ツールへのインターフェース機能を提供しています。表示されたメニュ

 

ー内にリストされた中から対象を選択することで、そのツールへのインターフェースファイルを出力することができます。

・C-Link/Fabmasterは、Fablink XEのライセンスが必要となります。
・Mitron GenCadのみ、Fablink XEからパネルデータでの出力が可能となります。
・General AISを除く全てのインターフェースは、Cell OriginをXY座標として使用します。General AISのみ

 

Assemblyを使用します。
・全てのインターフェース共通で、ログファイルとして GeneraIinterfaces.txt が作成されます。

Note

部品の識別方法を指定します。

チェックON時は、各パッドは一回のみ出力されます。

チェックON時は、パッド形状の情報を含むTESTFILE.PSH

 

を出力

 

します。

チェックON時は、テストポイントをPARTSセクションに出力します。

 

チェックOFF時は、TESTPOINTSセクションに出力します。

チェックON時、マイナス座標を許可します。

PACKAGESセクションに出力するセル外形として使用するレイヤを

 

選択します。

測定単位を指定します。1th, 1/10th, 1/100th から選択します。
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◆インポート／Import Design Data

Expedition PCBでは、ASCIIファイルによるインターフェース機能が提供されています。決められた書式にもとづいて作成され

 

たASCIIファイルであれば、Expedition PCBのデータとしてインポートすることができます。

インポートするファイルが収納されたフォルダ名を指定。

インポート後に作成されるログファイルに関する扱いを指定。
・Overwrite（上書き）
・Append（追加）

◆エクスポート／Export Design Data

Export Design Dataコマンドでは、Expedition PCBで作成された各データをHKPフォーマットのASCIIファイルに出力すること

 

ができます。

ファイルを出力するフォルダ名を指定。

ASCIIとして出力するデータを選択します。
※選択された情報が、項目に記載されているファイル名で指定したフォルダ内に出力されます。

Padstacks

 

→ Padstack.hkp

 

Jpb

 

Preferences →

 

JobPrefs.hkp
Cells →

 

Cell.hkp

 

Net Class →

 

NetClass.hkp
Parts →

 

PDB.hkp

 

Net Properties →

 

NetProps.hkp
Layout →

 

Layout.hkp

インポートする情報を選択します。
指定したフォルダ内に収納されるファイルの内

 

容により、有効となるチェックボックスが変動し

 

ます。フォルダ内にファイルが存在しなければ、

 

その項目はグレーアウトで選択不可となります。

2007.3バージョンより、暗号化されたASCIIファイルが出力されます。

Note

2007.3バージョンより、暗号化されたASCIIファイルのみインポート可能となります。

Note
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◆HKP ASCIIファイルの暗号化

2007.3バージョンより、出力されるHKP ASCIIファイルは全て暗号化されております。インポート時にも暗号化されたHKP 
ASCIIファイルのみが対象となります。HKP ASCIIファイルの編集が必要な際は、以下のプロセスを実行ください。

① Expedition PCBから暗号化されたデータのエクスポート。
②

 

DataConvert.exeソフトウェアによるデータの暗号化の解除。
③

 

これまでと同様にDataConvert.exeソフトウェアから出力されたHKP ASCIIデータの編集。
④

 

DataConvert.exeソフトウェアによる編集したHKP ASCIIデータの暗号化。
⑤

 

暗号化されたデータをExpedition PCBにインポート。

DataConvert.exeソフトウェアは2007.3バージョンより提供され、SDD_HOME/common/win32/binディレクトリ内にインストールさ

 

れ、実行時に引数を変更することにより暗号化/非暗号化の処理を行うことができます。

DataConvert.exeを実行するのに必要なライセンスは、無償でライセンス提供が可能です。（１つのライセンスで同時に

 

複数の起動が行えます。）

 

ライセンスをご希望のお客様は弊社担当営業までご連絡ください。
Note

・DataConvert.exeの実行方法

DataConvert

 

–decrypt（又は –encrypt） -i <入力ファイル名> [-o <出力ファイル名>] [-h] [-w]

オプション）
-decrypt

 

ファイルを非暗号化（暗号化の解除）します。
-encrypt

 

ファイルを暗号化します。
-i 変換する入力ファイルパスを指定します。
-o

 

変換によって出力されるファイルパスを指定します。
-h

 

コマンドラインオプションをリストします。
-w

 

指定された出力ファイルがすでに存在する場合上書きします。

入力ファイルのみの指定でDataConvertを実行することが可能です。例えば"DataConver

 

-i Cell.hkp"と実行すると、指定され

 

た入力ファイルのフォーマットを認識し、それと逆のフォーマットでファイルを出力します

暗号化の実行例

DataConvert

 

-encrypt -i C:¥project¥ExportDesignData¥Padstack.hkp

暗号化解除の実行例

DataConvert

 

-decrypt -i C:¥project¥ExportDesignData¥Padstack.hkp

入力ファイルパスには、ドライブ名を含めたフルパスで指定する必要があります。又は

 

入力ファイルが存在するフォルダから

 

のDataConvertコマンドを実行した際は、ファイル名のみの指定で動作が行えます。
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・Update component placement status
IDF内のMCAD属性をインポートして、部品の移動を許可します。

・Force update of fixed MCAD components
OFF時－レイアウトを優先して、Fixed部品の移動は行いません。
ON時

 

－IDF内のMCAD属性を優先して、Fixed部品を移動します。但しFixed属性は維持します。

・Replace Route Obstructs
配線禁止領域は一旦削除されて全て再構築されます。

・Replace only external Placement Obstructs
既存の配置禁止領域を保持して、IDF内の配置禁止領域を追加します。

・Map Other Outlines to User Layers
IDF内のアウトラインをUser Layerへマッピングします。

・Process Other Outline coutouts
IDF内のOther Outlineセクションのエレメントに対して、Cutout（抜き）処理を行います。

No tool assignment to contoursの動作。
このオプションを有効とした場合、内側にオフセットの掛かった

 

輪郭データとして作成されます。
この時、Hole Nameは

 

No Tool Contour として作成されますの

 

で、インポート後に任意のHole名を割り当てることが可能となりま

 

す。

◆インポート／Import

 

IDF

Import IDFコマンドでは、Pro-Engineerといったメカ系CADで用いられるIDFフォーマットを使ったインポート機能を提供します

 

。コマンドを実行すると、インポート作業を行なうためのメニューが表示されますので、各メニューで必要とされるパラメータを設

 

定した上で作業を行なって下さい。

IDFインポートに関する制限事項があります。（バージョンにより制限事項は変更される場合があります。）
・ビア禁止領域（Via Obstruct）はALL Layerでのみインポート可能です。特定層でのインポートはできません。
・部品の移動は、既に配置されている部品のみが対象となります。IDFインポートで配置は行われません。
・部品移動時は、DRCを考慮しません。IDFで指定された座標にエラーを考慮せず移動されます。

インポートするボードファイルの指定。

ライブラリにマウンティングホールが存在しない場合、自動で作成

 

します。
※ネーミングは、“IDF_MTG_Rnd

 

ホール径”となります。

ON時は、No Tool Contourという名称でContourが作成されます。
OFF時、以下項目のSelect holeで指定したホール幅で、全ての

 

Contour（NCルータ）が作成されます。

Note



－ 429 －

◆エクスポート／Export IDF

Export IDFコマンドでは、Pro-Engineerといったメカ系CADで用いられるIDFフォーマットを使ったエクスポート機能を提供しま

 

す。コマンドを実行すると、エクスポート作業を行なうためのメニューが表示されますので、各メニューで必要とされるパラメータ

 

を設定した上で作業を行なって下さい。

ボードファイルの出力先を指定。
拡張子は、.emn となります。

IDF出力に関して、以下の制限事項があります。（バージョンにより制限事項は変更される場合があります。）
・Nested Mechanical CELLは出力されません。
・Buried 及び Nested Drawing CELLは出力されません。
・Test Point（Test Pointコマンドで配置されたもの）は出力されません。

基板の厚みを指定。
Use Board thickness をチェック時は、Setup Parameters＞Layer 
Stackup の Thicknessを使用します。OFF時には、Board thickness 
に値を設定します。

部品の高さを指定。
PDBのHeight属性が設定されていない部品にのみ適応されます。

Version 2.0又は 3.0 を選択。

Route Obstruct（配線禁止領域）を出力します。
Exclude Cell Route ObstructsがON時は、ボードレベルの配線禁

 

止領域を出力、OFF時はセル内の禁止も出力します。

出力される情報について
・出力される情報は、IDFのバージョンによって若干異なりますが、Board Outline、Route Boarder、Mounting 
Hole、Placement Outline等の情報を出力することができます。
・IDFデータとして出力される各部品の高さ情報については、PDB内に設定されたHeightプロパティの値が用い

 

られ、形状についてはPlacement Outlineが使用され、簡単な3次元ポリゴンデータとして出力されます。
・ECAD/MCAD名の対比のために、ecad_hint.mapファイルが出力されます。このファイルはPro-Eでのみ使用可

 

能となります。

ライブラリファイルの出力先を指定。
拡張子は、.emp となります。

部品ピンとビアホール情報を出力します。

Note

Note



－ 430 －

◆インポート ドリル／Import Drill 〔Fablink XEのライセンスが必要となります〕

Import Drillコマンドは、

 

Expedition PCB 及び Fablink XEにて作成されたドリルデータをインポートするためのコマンドとなりま

 

す。対象となるドリルデータは、

 

Expedition PCB 及び Fablink XEにて作成されたデータのみをサポートします。

インポートドリルファイルが格納さ

 

れたディレクトリを指定。

インポート時のモードを指定。
・New（新規）
・Append Cell（追加：既存CELLに追加されます）
・Overwrite Cell（上書き：既存CELLは削除されます）
・Overwrite Layers Only（上書き：指定したUserLayer
のみが置換され、その他UserLayerは保持されます）

インポートセル名を指定。
Drillから始まるセル名である必要があります。

インポートしたい情報が収納されたドリルファイルにのみチェックを入れます。
※DefaultではNCDrill directoryで指定したフォルダに存在するドリルファイル

全てがリストされます。

インポート先の作画レイヤを指定。
※インポート可能なのは、ユーザー定義レイヤのみとなります。

Defaultでは、DRL_（ドリルファイル名）。

・その他オプション

Drill Targets －ターゲットマーク（＋）を追加します。
Drill Target Diameter －上記チェック時に、マークサイズ（直径）を指定します。

・本処理を実行するには、DrillPreferences.hkpが../Configフォルダに作成されていることが前提となります。
※ DrillPreferences.hkpはNC Drill出力時に自動作成され、その際の各種設定がファイルに記載されます。

・処理後の実行Logは、DrillImportLog.txtをご確認ください。Note
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◆インポート

 

ガーバー／Import Gerber  〔Fablink XEのライセンスが必要となります〕

Import Gerberコマンドは、

 

指定したGPFファイルに設定されているExpedition PCB 及び Fablink XEにて作成されたガーバ

 

ーデータをインポートするためのコマンドとなります。対象となるガーバーデータは、

 

Expedition PCB、Fablink XE 及び

 

BoardStationにて作成されたデータのみをサポートします。

GPFファイル（ガーバープロット設定ファイル）を指定。

インポート時のモードを指定。
・New（新規）
・Append Cell（追加：既存CELLに追加されます）
・Overwrite Cell（上書き：既存CELLは削除されます）
・Overwrite Layers Only（上書き：指定したUserLayer
のみが置換され、その他UserLayerは保持されます）

インポートセル名を指定。
Gerberから始まるセル名である必要があります。

インポートしたい情報が収納されたガーバーファイルにのみチェックを入れます。
※ GPFファイルに設定されているファイルのみリストされます。

インポート先の作画レイヤを指定。
※インポート可能なのは、ユーザー定義レイヤのみとな

 

ります。Defaultでは、GER_（ガーバーファイル名）。

・GPFファイルが指定されたガーバーファイルよりタイムスタンプが新しい場合（出力以後に編集されている等）、

整合の確認のため以下のようなメッセージが表示されます。

・処理後の実行Logは、GerberImportLog.txtをご確認ください。

Note
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BoardStationにて作成されたガーバーデータをインポートするには、Import fromオプションにて、BoardStationを選択します。
これによりFormat Optionsタブがアクティブとなりますので、必要に応じて設定変更を行い、インポートを実行します。

フォーマットタイプを274X、274Dから選択。

274D選択時に、BS用アパーチャファイルを指定。

座標値をAbsolute（絶対座標）、Incremental

 

（相対座標）から選択。

データの桁数及び小数点位置を指定。

Zero Truncation

 

：０データの取り扱いを設定します。
Leading

 

－

 

前のゼロを省略します。
Trailing

 

－

 

後ろのゼロを省略します。
None

 

－

 

省略することなく全てを出力します。

各コマンド末に付与するキャラクタの設定。

ガーバーデータの単位系をIN,MMから選択。

※Boardstation選択時に、Format Optionsが有効となります。
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◆エクスポート／Export CCZ

Export CCZ コマンドは、

 

CAMCADやvisECADで読み込み可能なCCファイル（又はCCZファイル）を作成します。

CCファイルはXMLベースのASCIIファイルであり、CCZファイルはCCファイルを圧縮したものとなります。

CCZファイルを作成します。

CCファイルの出力先 及び ファイル

 

名を指定します。

CC 
（CCZ）

 

ファイルExpedition PCB

CAMCAD visECAD
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◆エクスポート／Export GDSⅡ 〔Fablink XE Proのライセンスが必要となります〕

Export GDSⅡコマンドは、

 

Expedition PCB 及び Fablink XEから、GDSⅡフォーマットのファイル（バイナリ形式）を作成します。

出力したいレイヤネームのみチェックを入れます。

出力ファイル名を指定。

出力可能なレイヤ数を選択。

ストロークフォントとして出力。

階層構造を持った形式にて出力。

フォーマットとしてARC/Circleは許

 

可されない為、指定した分割数で

 

出力。

Hybridデザイン用の設定となります。
Trace出力時のPath Typeを指定します。

Blind/Buried ビアをShape/SRefの

 

どちらで出力するかを指定します。

GDSセットアップファイルを指定。
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Contentsタブメニューでは、GDSⅡファイルとしてどのような図形要素が必要なのかを、出力レイヤ毎に定義します。

File Setupタブにて設定したGDSⅡLayer Nameを指定。

出力したい配線レイヤのみチェックを入れます。

必要とする図形要素を選択します。

その他オプション：
・Board Items－基板外形やシルクなどの図形要素を選択。
・User-defined layers－セットアップパラメータで設定されたユーザー定義レイヤを選択。
・Cells
Types－出力対象とするセルタイプを選択。
Items－セル内に作画された図形要素を選択。
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◆エクスポート／Export IPC-D-356B 〔Fablink XE Proのライセンスが必要となります〕

Export IPC-D-356Bコマンドは、ベアボートテストデータの標準フォーマットであるIPC-365Bフォーマットファイルを作成します。

出力先及びファイル名を指定。
Defaultは、../Output/（デザイン名）.ipc356

・出力パラメータ
Data title：
TITLEセクションに出力される文字を指定
Identification nubmer：
NUMセクションに出力される文字を指定
Revision：
REVセクションに出力される文字を指定

CODEセクションに出力される文字を指定。

・出力オプション
Plane data：チェック時はPlaneデータを出力します。
Conductive shape data：チェック時はConductive shapeデータを出力します。
Exclude net graphics：
対象外とするネットを選択します。チェックされたネットは、REMOVED_CONDUCTORS行
にのみ出力され、出力対象から除外されます。
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出力機能

Chapter4：

 

Product Integration
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◆デザインステータス／Design Status

デザインステータスでは、基板の寸法や使用ピン数、プレーン設定層などの情報をレポートファイルとして確認することができ

 

ます。プルダウンより、Edit＞ Review＞

 

Design Status（又は

 

Output＞

 

Design Status）コマンドを実行することで、
DesignStatus_番号.txt のファイルが作成されます。

・

 

Placement Areas（Required）

 

は、全ての部品を配置した際に必要とされる部品外形のエリアより算出されます。
・

 

Pinsは、全ての部品を配置した際の部品ピンをカウントします。
・

 

Through Holesは、配置された貫通ピン、貫通ビア 及び Mounting-Holeをカウントします。
（Net0は対象外となります。）

・

 

Mounting Holesは、Net0を含む全てのMounting-Holeをカウントします。

又は

Note



－ 439 －

◆ダイナミックプレーンステータス／Dynamic Plane Status

ダイナミックプレーンステータスでは、プレーンシェープ数、プレーンパラメータ、プレーン作成状況といった情報をレポートフ

 

ァイルとして作成、確認することが可能となります。プルダウンより、Output＞

 

Dynamic Plane Status コマンドを実行することで

 

、DynamicPlanes_番号.txt のファイルが作成されます。
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◆ODBGインターフェース／ODBG Interface

ODBG Interfaceコマンドは、Valor社ソフトウェアで使用されるODB++Gateway（ODBG）ファイルを作成します。出力されたファ

 

イルは、 ../Output/（デザイン名）.odb （ODB++Convertor がOFF時）として作成されます。

出力オプションを指定。
チェックONのエレメントを出力します。

Package Outline Layerを指定。

以下より選択が可能となります。
Placement Outline（Default)
Assembly Outline
Insertion Outline
SilkScreen Outline
任意のUserLayer

UserLayerの出力を指定。

チェックON時にUserLayerのマッピング

 

を指定します。複数Layer指定可能。

チェック時、ODBGファイルをODB++フォーマットへ変換可能なプログラム（GW2ODB）を実行します。
・Launch ODB++ Convertor をチェック時の出力ファイルは、

 

（デザイン名）_dir.odb フォルダ
・Compress Outputをチェック時の出力ファイルは、 （デザイン名）_dir.odb.tgz
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◆ODB++ Output

ODBG Interfaceコマンドは、Valor社ソフトウェアで使用されるODB++ファイルを、

 

ODB++ Convertor（GW2ODBプログラム）

 

経由ではなくダイレクトに作成します。（作成されたファイルの単位は、ｔｈとなります。）

出力フォルダ及びジョブ名を
指定。Defaultの出力フォルダ

 

は、../Output、ジョブ名は（デザイ

 

ン名）odbとなります。

出力オプション④
UserLayerのマッピングを指定します。複数Layer指定

 

可能。チェックON時のみ出力対象となります。

Compress Outputをチェック時はフォルダ圧縮を実行します。
出力ファイルは、

 

（ジョブ名）odb.tgz となります。

出力オプション③
拡張オプションを指定。

出力オプション①
標準出力オプションを指定。

・出力オプション① －Basic expert options

Export mode
Full ：全て出力します。
Fab ：Fablicationデータのみ出力します。
Assy ：Assemblyデータのみ出力します。

Remove EDA data ：

 

Net・Component・Package情報が出力されません。
Neutralize nets ：

 

Netにランダムなネット名を付与します。
Generated Silkscreen data ：

 

Silkscreen Generatorで作成されたSilkscreenデータを出力します。
Part numbers ：

 

PartNumberを出力します。
Board Outline ：

 

Board Outline以外のアウトライン情報を出力します。
※この項目は、Fablink XEではPanel/Board Outlineとして表示されます。

ODB++セットアップファイル（.ocf）を指定

出力オプション②
Pin、Via、PakageOutlineの出

 

力方法を指定。

Logファイル（ODBPPOut.txt）

 

の出力フォルダを指定
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・出力オプション③ － Additional parameters

Read DRC features ：DRCデータ を出力します。
DRCボタンにより、出力Layerの制御 及び Layer名の変更が可能となります。

Round corners ：Round Cornerを作成します。
Read net0 informataion ：Net0情報を出力します。（チェックOFF時には、Net0のピンは出力されません。）
Read in unplated ：Unplated-HoleのPadstack情報を出力します。
Ignore component layout ：Component Layout Type属性を無視します。

・出力オプション② － Pins,Pads,Vias and Package options

Non-functional pad removal ：

 

ネットが付与されていない未使用ピン/ビアの検査を可能とします。

Pins
None －ネットが付与されていない未使用ピンの削除は行いません。
Unused Pins －未接続のPadのみ削除します。
Pin with NoNets －ネット名がNoneのPadを削除します。

※Padを削除する際の条件は、以下となります。
a) PadはSignal層のみが削除対象となります。
b) 外層Padは削除対象となりません。
c) SMDピンは削除対象となりません。
d) 未接続Padのみが削除対象となります。
e) Pin with NoNets 設定時は、b)とd)のルールは無効となります。

Vias
None －ネットが付与されていない未使用ビアの削除は行いません。
Unused Vias －未接続のViaのみ削除します。
※Viaを削除する際の条件は、Pins項目のa)-d)と同様となります。

Package Outline Layer ： 使用するPackage OutlineのLayerを指定します。

チェックした項目が出力されます。

クリックにより、任意のLayer名へ変

 

更可能です。
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・出力オプション④ － Define User Layer Mapping

UserLayerのマッピングを指定します。User Layerで作成されたテキストやグラフィックデータをDOCUMENTだけでなく、シ

 

ステムレイヤとしてマッピングし、出力することが可能となります。

複数のLayerへマッピングすることも出来ます。
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◆ニュートラルファイル／Neutral File  〔Fablink XE Proのライセンスが必要となります〕

Neutral Fileコマンドは、

 

XE Neutralファイルを作成します。このファイルは製造データ（Board属性、部品情報、ネット等）を含

 

む中間フォーマットファイルであり、容易に読み取ることができるアスキーフォーマットとして使用可能となります。また出力され

 

たファイルは、

 

../Output/XEneutralFile.txt として作成されます。

ボードのオフセット値を指定します。

Board Attributes ：Board属性を出力します。（Board属性、ドリル情報等）

Components ：部品属性を出力します。（PartNumber、Ref番号、部品位置、配置面、角度等）

Geometries ：Geometry情報を出力します。（部品形状、Attribute、Pin番号・位置、ドリルサイズ等）

Holes ：ホール情報を出力します。（ホール径、Plateステータス、位置等）

Nets ：ネット情報を出力します。（ネット名、プロパティ、ピン、Ref番号、ビア等）

Pads ：パッド情報を出力します。（パッドスタック、ビアタイプ、ホール径、パッド形状等）

Testpoints ：テストポイント情報を出力します。（ネット名、位置、配置面等）

Variants ：仕向（Variant）情報を出力します。（プロパティ、部品番号、Ref番号等）

Board Added Parts ：ボードアイテム 及び セルアイテムを出力します。（マウンティングホール、メカニカルセル等）

チェックした項目が出力されます。
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◆部品表／Bill Of Materials

 

〔Fablink XEのライセンスが必要となります〕

Bill of Materialsコマンドは、PDBに設定した部品情報や部品数といった情報をレポートファイルを作成します。プルダウンより

 

、Output＞ Bill Of Material コマンドを実行することで、ジョブ名.bom（Output¥BOMフォルダ）ファイルが作成されます。ダイア

 

ログで設定した情報は、BOMSettings.bsf（Configフォルダ）として保存されます。

出力フォルダ、ファイル名を指定。

Part Numberでソートした部品表を作成します。

REF番号でソートした部品表を作成します。

メカニカルセル（電気外部品）を部品表に出力します。

出力する項目のみチェックすること。

Description項目として出力したいPDB属性

 

のみチェックします。

出力順序を変更します。

・

 

Variant Settings

仕向地情報を設定（Output＞ Variants コマンド）した際、仕向毎の部品表作成が可能となります。



－ 446 －

Part Numberでソートした部品表

REF番号でソートした部品表

Part Number
※ソート基準

CELL名 個数 指定したPDB属性 Ref番号

Part Number CELL名 指定したPDB属性 Ref番号

※ソート基準
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◆PDF  〔Fablink XEのライセンスが必要となります〕

PDFコマンドは、Contentsタブで設定した内容をもとに、一括で複数SheetのPDFファイルを作成することを可能とするコマンド

 

となります。

PDFセットアップファイル（.pcf）を指定

出力したいシートのみチェックを入れます。

ページサイズを指定
None：ボードサイズ
Custom：高さ・幅を指定可能
Letter/Legal/A0-A4,B5など

出力方向を指定
BestFit：自動
（Page Size:None時は固定）
Landscape：ページを横方向
Portrait：ページを縦方向

Page Size：None時のみ

 

スケール値を指定

ヘッダー・フッターテキストを設定
例）ジョブ名、会社名、日付等
Max128文字まで設定可能となります。

出力先 及び ファイル名を指定します。
Defaultは、../Output/PDF/（デザイン名）.pdf

出力オプションを指定

・出力オプション

White as background ：

 

背景色として白色を使用します。
Color ：

 

カラー設定をします。
Color －デザインのカラーを使用して、PDFを作成します。
Black&White －モノクロでPDFファイルを作成します。
Grey Scale －グレースケール色を使用して、PDFを作成します。

Launch Reader ：

 

PDFファイル作成後に、Adobe Acrobatを起動します。（事前にインストールが必要）
Enable Page Numbering ：

 

ページ番号を付与します。
Fill Text ：

 

全てのテキストにフィルを設定し、塗り潰し処理を行います。



－ 448 －

Contentsタブメニューでは、PDFファイルとしてどのような図形要素が必要なのかを、出力レイヤ毎に定義します。

Sheets Setupタブにて設定したSheet Nameを指定。

出力したい配線レイヤのみチェックを入れます。

必要とする図形要素を選択します。

その他オプション：
・Board Items－基板外形やシルクなどの図形要素を選択。
・User-defined layers－セットアップパラメータで設定されたユーザー定義レイヤを選択。
・Cells
Types－出力対象とするセルタイプを選択。
Items－セル内に作画された図形要素を選択。

チェック時は、現在表示しているアイテムだけが適

 

応されます。（その他項目は無効となります。）

PDFファイル作成において、以下の制限事項があります。（バージョンにより制限事項は変更される場合があります。）

・ミラー出力はサポートされておりません。
・Netline 及び Netclass-lineは出力されません。
・Fillパターン 及び Gridはサポートされておりません。
・Select/Highlightアイテムの表示は出力されません。

Note
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◆マスク生成／Output Mask Generator

 

〔Fablink XE Proのライセンスが必要となります〕

Mask Generatorコマンドは、デザイン検証・出図・面積計算・ドキュメント作成等で利用できる様々な図形要素をMask処理を使

 

用して作成するコマンドとなります。処理後のエレメントは、全て定義したUserLayer 及び

 

Drawing‐CELLへ出力されます。ま

 

た全てのエレメントは、“Extract As Is”のMask処理を除いて、Shape（閉じたPolygon 及び

 

Circle）として作成されることとなりま

 

す。

エレメントAを選択。

エレメントBを選択。

Mask処理を選択。

必要により、伸縮スケー

 

ル値、Fillを設定。

出力方法を指定。
Mask、UserLayer、

 

Drawing-CELLへの出力

 

が可能。

設定したMask名を表示。
またMaskの編集、処理

 

順位の設定が可能。

作成したMaskをSchemeとして選択 及び 保存します。

・Select Element A/B

① Mask処理で使用したいエレメントA 及び B を選択（チェック）します。
また既に作成されたMask名（Mask listingに表示されているMask名）も指定可能となります。

② 選択したエレメントに対して、任意のLayerを指定します。
Via Holesなどの特定のエレメントのみ、“…”を指定した際は、From/To Layersにて複数Layerが指定可能となります。
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③ Pad/Cell Filter
処理対象となるPad 及び Cell タイプをフィルタすることが可能となります。

④ Grow/Shrink
Mask処理の前工程として、該当のエレメントを伸縮することが可能となります。
数値のみの場合は拡大、マイナスを付与することで縮小を行います。Text等の
特定エレメントでは、本設定は不可（Disable）となります。

・Operation

12種類のオペレーション（Mask処理）が可能となります。また下記項目のGrow/Shrinkでは、Mask処理（Extract As Isを除く）
により作成された結果エレメントに対して、伸縮やFillの設定が可能となります。

Operation：AND
エレメント（A) とエレメント（B）とが、オーバーラップしている部分をShapeとして

出力します。

Operation：OR
エレメント（A) とエレメント（B）とが、マージされた部分をShapeとして出力します。

Operation：MINUS
エレメント（A) からエレメント（B）を、マイナスした部分をShapeとして出力します。

Operation：XOR
エレメント（A) とエレメント（B）とが、オーバーラップする箇所を除いた部分をShape
として出力します。
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・Operation 続き

Operation：Extract As Is
エレメント（A) と同じ形状のエレメントを出力します。
その際、エレメント（A)のCopyとして、ShapeだけではなくText/Line等の形状も保持されます。

Operation：Extract As Shape
エレメント（A) をShapeとして出力します。
同一Layer同士のOR処理は、本処理を使用することで可能となります。

Operation：Touching
エレメント（B）と接する全てのエレメント（A) を出力します。
本処理は後述の、CROSSINGとENCLOSEDを合わせた処理となります。

Operation：Not Touching
エレメント（B）と接することのない全てのエレメント（A) を出力します。
本処理は後述の、NOT CROSSINGとNOT ENCLOSEDを合わせた処理となります。
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・Operation 続き

Operation：Enclosed By
エレメント（B）に完全に含まれる、全てのエレメント（A)を出力します。

Operation：Not Enclosed By
エレメント（B）に完全に含まれていない、全てのエレメント（A)を出力します。

Operation：Crossing
エレメント（B）と接する（クロスする）、全てのエレメント（A)を出力します。

Operation：Not Crossing
エレメント（B）と接していない（クロスしていない）、全てのエレメント（A)を出力します。
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・Output to

Mask処理結果を、どのように出力するかを指定します。

Mask ：Mask名を指定します。

User Layer ：既存のUserLayer 及び 新規のUserLayerを指定します。

Output mode ：UserLayerを選択時のみ、選択可能となります。
Append －追加
OverwriteCell －上書き（既存CELLは削除されます）
OverwriteLayersOnly －対象Layerのみ上書き

Output cell name ：UserLayerを選択時のみ、選択可能となります。
空白

 

－データ上（Board）に作成されます。
既存CELL －Output modeに依存した動作となります。
新規CELL －新規にDrawing-CELLを作成します。
※CELL名を設定した際は、データ上には作成されません。

・Mask listing

上記Output to にて各種設定を完了後、ADDボタンにてリストボックスにMask名が設定されます。

ボタンにて、処理順序を変更します。（上段より処理が開始されます。）

ボタンにて、選択したMaskの編集を可能とします。
（画面上部に設定内容が表示されます。変更後、ADDボタンにて編集内容が反映されます。）

ボタンにて、選択したMaskを削除します。

中間処理として出力データを作成しない場合は、Mask/UserLayerともにOFF（選択なし）としてADDボタンを実行

 

すると、Select Element A/Bで指定できるMaskエレメントを作成します。
Note
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Report Writer

Chapter4：

 

Product Integration
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◆Report Writer

Expedition PCB Pinnacleに標準搭載されるレポートライターでは、様々なレポート作成環境が提供されます。このレポートライ

 

ターは、プルダウンのOutput>>Report Writerコマンドを実行することで起動することができます。レポートライターは、起動環

 

境となったデザインファイルが持つ様々な情報をデータベース化した上でレポートライターは起動します。

コマンドを実行後には必ず抽出するデータ属性を問われ、指定した側のデータ抽出を行ないツールが起動します。

基板外形や部品配置情報などの物理的な情報
を抽出する場合に指定。

ネットの伝送遅延などの論理的な情報を抽出する
場合に指定。

データを抽出後にツールが開きます。
※抽出される情報は、起動時の状態をもとに作成されますので、

設計作業の進行状況やデータの大きさ（設計規模）により、起動
までの時間に差が出ます。
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このツールの基本的な使用方法は、市販されているデータベースソフトと同様のクエリ参照方式となります。これは、複数のテ

 

ーブルに分けられた各情報を、必要な情報を収納したテーブルを指定することでその情報を得るというもので、これを行なうた

 

めのコマンドがQueryプルダウン以下に収納されています。

◆Interactive Query

インタラクティブクエリコマンドは、レポートライターで行なわれるもっとも一般的なコマンドとなります。コマンドを実行すると、デ

 

ータベースから情報を抽出するためのメニューが表示されます。

Tablesリスト内のテーブルを選択すると、右のリストにそのテーブル内に保管された情報ソースがリストされます。この中から必

 

要とされるものを[Shift]キーや[Ctrl]キーを併用しながら全て選択し、メニュー左上のRun SQLボタンを押すことで
必要な情報を取り出すことができます。

このボタンで抽出

このボタンは、選んだ情報ソースの並びを変更したい

 

場合に選択。

抽出された情報は、表形式のメニュー内に表示されます。
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必要とする情報次第では、1つのテーブルだけでは賄えないケースが発生します。例えば、TCompというテーブルには、Ref 
Des情報は含まれますが、Part Numberの情報が含まれていません。部品表を作成するような場合に、Ref Des情報以外に部品

 

名であるPart Numberも必要な場合、Tcompのテーブルだけでは必要な情報が取り出せないことになります。このような場合に

 

は、ジョインテーブル機能を使用して2つのテーブルを共通の情報ソースで結合させた上で情報を抽出する必要があります。

ジョインテーブルの作業手順：

1.テーブルリストから、[Ctrl]キーを押しながら必要な情報を持つ2つのテーブルを選択します。

[Ctrl]キーを押した状態で選択。

3.メニュー左の全てのテーブルを選択し、各テーブルの内容をリスト表示します。。

2.メニュー左上にあるJoin Tablesボタンを選択し、設定メニューを表示します。

選択したテーブルがリストされます。

テーブルが持つ情報ソースが、分かれてリスト表示されます。
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4.リスト表示された情報ソースから、2つに共通するものを探して選択し、[Add]ボタンでテーブルジョインインフォメーショ
ンリストへ追加します。これが確認できたら[Close]ボタンでメニューを閉じて下さい。

共通する情報ソースを選択します。

Addボタンでリストに追加。

5.ここまでの作業を終えたら、後は通常どおりに必要な情報ソースを選択してSQLを実行します。

2つのテーブル情報が一括して
リスト表示されます。
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結果：

Tcompからの情報 TPartNumberからの情報

・このジョインテーブル機能は、共通する情報ソースが存在してはじめて成り立つ機能となります。選んだテーブル

 

によっては、共通する情報ソースを見つけられないケースが発生します。そのような場合には、それらを結合する

 

役割を果たすテーブルを見つけ出し、間接的に結合させるという方法を用います。
・このように、情報抽出の際に行なわれるテーブル選択などの一連作業がSQLとなり、リポートライターではこの

 

SQLを使用して様々なレポートを作成することができます。

Note
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表示されたリストメニュー内には幾つかのコマンドボタンが存在し、これらを使用することで抽出された情報に対する検索やフ

 

ィルタリング、印刷やファイルへの出力といった作業が行なえます。

テキストファイルへの出力。

検索。 フィルタリング。

情報のリロード。

ソート。 印刷イメージの表示。

◆情報へのフィルタリング

フィルタリングボタンを選択すると、フィルター設定メニューが表示されます。何についてフィルターを掛けたいのか？基準とな

 

るソースを左上のデータベースフィールドより選び、右横にあるオペレーションで書式を選択し、この書式に対する値をその横

 

のバリュー項目で指定します。

リファレンス番号に対し Cという頭文字を持つ部品のみをリスト

バリューへの値には＊が使用できます。
例では“C*”で、Cの頭文字を持つもの

 

全てとなります。

作成した書式は、Addボタンでフィルターリスト追加します。

SQL設定の保存。
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フィルタリングの結果：

Cの頭文字を持つ部品のみがリストされます。

フィルタリングでは、これ以外にも数値に対して以上/以下といった内容でのフィルタリングが可能です。設定するフィルタの内

 

容は複数でも構いません。この場合、それぞれの条件に対しANDなのかORなのかの指定をメニュー内で行なう必要がありま

 

す。

◆ソート

ソートボタンを選択すると、ソートを行なう際の設定メニューが表示されます。このメニューでは、表のどの項目に対してソート

 

するのかを設定します。メニュー内の3つの設定項目は、左から右への順にソートの際の優先順位を付けることができ、1つの

 

項目だけでソートを掛けたい場合には一番左の項目のみ設定を行ないます。

このトグルスイッチは、ソートを上位順で行なうか下位順とするかを指定します。
（Ascending：上位順

 

/ Descending：下位順）
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◆SQL設定の保存

このSave SQLコマンドとは、情報抽出時に行なったテーブルや情報ソース指定など、その情報抽出までに行なった一連の作

 

業内容を保存する機能となります。この機能を使用することで、面倒なレポート抽出作業を簡素化することができます。

保存する名前を指定。

Localはそのデータ上でのみ使用可能なものとして保存され、Masterはその端末上であれば全てのデータで共有する

 

ことができます。
Save Local   －

 

プロジェクト¥¥PCB¥vbreport¥output¥VBPCBP.mdc 
Save Master －

 

MentorGraphics¥2007EE¥SDD_HOME¥standard¥config¥vbreport¥mdc16.sql

保存したSQLを使用するには、プルダウンのQuery>>Run Defined Queryコマンドを実行します。

保存したSQLがリストされますので、選んで
から[Run Query]ボタンを選択します。

SQLを保存した際の設定で情報が抽出されます。
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◆印刷イメージの表示

このPrint Previewコマンドは、プリントマネージャ上で認識されたプリンターへの出力イメージを確認することができます。出力

 

イメージメニューでは、そのままプリンターへ印刷することもできますが、エクスポート機能を使用することでExcelやWord、ロー

 

タス、といった一般ソフトのデータとして出力させることも可能です。

プリンターへ印刷データを送ります。

出力するデータの種類とファイルの出力先を指定。

他のソフトのデータとして出力します。
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◆テキストファイルへの出力

コマンドボタンの一番右にあるテキストファイル出力を実行すると、以下のようなメニューが表示されます。このメニューでは、

 

各情報ソースのカラム分けを如何にするかを指定する形となり、テキストファイルに出力される内容は指定した形態で分割され

 

ます。

各カラムをタブで分けるかカンマで区切るか
などを指定します。

出力先はブラウザ上でファイル名指定します。
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◆標準出力機能

レポートライターには、標準的なレポート生成機能も含まれます。プルダウンよりFile>>Open Reportコマンドを実行すると、ツ

 

ールが供給する各種雛形ファイルをブラウザで確認することができます。この中から雛形を選択することで、簡単にレポートを

 

作成することができます。

※この雛形は、クリスタルリポートを使用してユーザーが作成することも可能です。

Report WriterReport Writer
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Appendix
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サンドボックスを使用した分割設計

Appendix-1
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◆サンドボックス／Sandbox

XtremePCB 及び Expedition PCBにサンドボックスが追加されました。サンドボックスは、特定ユーザーのみが編集可能な領

 

域です。サンドボックスにより、他のユーザーに編集させたくない領域として使用したり、自分が編集する領域を制限したりす

 

ることが可能となります。この機能は自動配線やインタラクティブの編集(配置/配線/ドロー)で有効になります。

特にXtremePCBでは、自動配線の実行時に効果を発揮します。他者が自動配線を実行中であっても、サンドボックス内の領

 

域は保護されるため、変更されることはありません。

XtremePCB 又は Expedition PCBの起動時に、ハンドル名を指定します。

ハンドル名

Drawモードで、プロパティをSandboxに設定して、各情報を入力します。

サンドボックス名を入力します。デフォルトはハンドル名。

配線編集の可能な層を指定します。
All／None／層から選択します。

配置編集の可能な層を指定します。
All／None／層から選択します。

配線 及び 配置を禁止にした層は、編集はもちろん選択も不可となります。

Note
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Sandbox①：

 

アナログ領域 Sandbox②：

 

デジタル領域

Sandbox③：

 

電源ジタル領域

ポリゴン 又は サークルのいずれかで領域を作成します。

Setup＞

 

Sandboxes を実行すると、作成したサンドボックスのリストが現れます。自分だけが編集可能とするサンドボックスの

 

チェックボタンをONにします。Activate Realtimeボタンをクリックすると、選択されたサンドボックスがActiveになり、リストに自
分のハンドル名が表示されます。この時、サンドボックスは複数選択可能ですが、他のユーザーが既にActiveにしている
サンドボックスはActiveにできません。

StateがActive Realtimeになり、Owner 
にハンドル名が表示されます。

サンドボックスをActiveにした結果、配置/配線/ドローの編集に制限がかかり、サンドボックスに設定した配線層、配置層のオ

 

ブジェクトだけを作成/選択/編集が可能になります。そして、他のユーザーはこの領域内のオブジェクトの作成/選択/編集は
禁止されます。ディスプレイコントロールのGeneral＞

 

Multiple Designer＞

 

Shadow ModeをONにすると、自分が編集できる領

 

域のみをカラー表示し、それ以外をグレー表示します。
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サンドボックスに完全に含まれないオブジェクトは編集できません。編集できないオブジェクトは朱色で表現されます。

移動不可な部品。

移動可能な部品。

Note

編集不可な部品を操作すると、以下のエラーメッセージが表示されます。

サンドボックスを無効にするには、再度Setup＞

 

Sandboxesを実行します。リストから無効にしたいサンドボックスを選択して、

 

Inactivateボタンをクリックします。この操作で、無効になります。ただし、自分がOwnerのサンドボックスのみ無効にすることが

 

可能です。他のユーザーがOwnerとなっているサンドボックスの操作は出来ません。
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【注意点】

・サンドボックスStateの保存

サンドボックスのActive状態は保存可能です。そのため、XtremePCB 及び

 

Expedition PCBを起動した時に、サンドボックスは

 

Activeのまま使用できます。この際、他のユーザー（ハンドル名）がデータを開いた時、Activeのサンドボックス領域のオブジェ

 

クトは編集が出来ません。この場合、サンドボックスのOwnerのハンドル名を確認して、

 

XtremePCB 及び

 

Expedition PCBをそ

 

のハンドル名で起動してください。そのサンドボックスのOwnerであれば、Setup＞

 

SandboxesからInactiveに変更できます。

・重複したサンドボックス領域

サンドボックス同士を重ねて作成することは可能です。しかし、その場合最初に有効にしたサンドボックスと重なった他のサン

 

ドボックスは編集不可となります。結果、自分も他のユーザーも編集不可になったサンドボックスとなり、またActiveにすることも

 

できません。あまり有効な使い方ではございませんので、サンドボックス同士は重ならないように作成いただくことをお勧めしま

 

す。

Sandbox① Sandbox②

Sandbox①と②が重なった領域

左側のSandBox①をActiveにします。その結果、中央の重なった領域は編集可能領域となります。そして、右側のSandBox②

 

はActiveになったSandBox①に一部含まれているため、自分も他のユーザーも編集できない状態になります。
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